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Introduction for students

This second edition of Photography production and 

appreciation is designed to provide students with an 

exciting and relevant resource to enhance their studies  

in photography. The information is presented in a clear  

and precise manner to ensure that it is straightforward  

and easy to understand.

The material in this book provides students with a 

starting point for their own research and encourages 

experimentation in areas of photography that they might 

find particularly interesting. Students are encouraged to 

explore and develop their own individual photographic style, 

in addition to increasing their appreciation of the history of 

photography and its artistic qualities.

Please note that the book assumes that students will 

be working with 35 mm black and white and/or digital 

photography.

Introduction for teachers

This text is an ideal resource for all students studying 

photography. It assists teachers to meet the curriculum 

needs of the art, media, photography and digital media 

courses for Years 7 to 10 students in the various states 

and territories. It is also an ideal reference for students in 

Years 11 and 12 studying art, visual art, media and studio 

art. Photography production and appreciation, second edition 

is also a valuable resource for tertiary students studying  

introductory units in photography.

The content is not intended to act as a curriculum, 

but rather as an aid for teachers to use within their 

own program. Photography production and appreciation 

acknowledges that teachers approach the instruction  

of photography in a variety of ways. 

The book is divided into seven parts: 

1. Making

2. Creating 

3. Presenting 

4. Art criticism and aesthetics 

5. Past and present context

6. Gallery of student photographs

7. General information about photography.

The book is not structured with the expectation that a 

student will work sequentially from chapter 1 to chapter 14. 

The intention is for students to tackle a section from each 

part of the book within the course of a term or semester. 

Ideally, the intentions of the various state requirements 

would be best met if teachers structured their courses 

through the integration of the different sections using  

a common theme or approach. For example, if students are 

given the task of taking creative portrait photographs, then 

they should look at and analyse portrait photographs, in 

addition to developing an understanding of the history  

of portraiture.

Students may begin the study of photography at  

different year levels and ages. Therefore, teachers will need 

to select tasks and activities that are appropriate for their 

group, while taking into consideration the requirements 

of their particular course. The book also allows for more 

advanced students to extend themselves with more difficult 

and challenging tasks.

Teachers should keep in mind that they will need to 

select activities according to the amount of photographic 

experience of their class. For example, if a class 

commences its photographic education in Year 10, it 

will need to integrate the development of basic skills 

with appropriate activities directed towards meeting the 

appropriate learning outcomes.

Please be aware that most of the information and 

activities relating to learning outcomes and course 

requirements within this text overlap, both from section to 

section and from chapter to chapter. 

It is recommended that, while covering the different 

course requirements, the possibilities for well-structured 

assessment could be formulated under the following 

assessment tasks:

Workbook / Journal: contains all exercises, 

experimentation, negatives, test prints, proof sheets, 

inspiration, motivation and general material relating to the 

subject (this could be practical and theoretical, and may 

take the form of a sketchbook).

Folio: contains all minor photographs completed during 

the course.

Research project: relates to an aspect of the history and 

appreciation of photography.
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Major piece of artwork: reflects a creative and technical 

understanding of photography.

Refer to the assessment and evaluation sheets at 

the end of the text to assist with your assessment 

requirements.

Curriculum grids for teachers
Various Australian state curriculum grids can be found 

online at the JacarandaPLUS website (www.jacplus.com.au). 

These grids can help teachers select relevant chapters and 

sections to use with their students. The grids can be used 

as an initial guide to achieve learning outcomes and course 

requirements.



Next generation teaching and learning

Using the JacarandaPLUS 

website

To access your eBookPLUS 

resources, simply log on to 

www.jacplus.com.au using your 

existing JacarandaPLUS login and enter the registration 

code. If you are new to JacarandaPLUS, follow the three 

easy steps below.

Step 1. Create a user account

The first time you use the JacarandaPLUS system, you will 

need to create a user account. Go to the JacarandaPLUS 

home page ( www.jacplus.com.au ), click on the button 

to create a new account and follow the instructions on 

screen. You can then use your nominated email address 

and password to log in to the JacarandaPLUS system.

Step 2. Enter your registration code

Once you have logged in, enter your unique registration 

code for this book, which is printed on the inside front 

cover of your textbook. The title of your textbook will 

appear in your bookshelf. Click on the link to open your 

eBookPLUS.

Step 3. View or download eBookPLUS 

resources

Your eBookPLUS and supporting resources are provided 

in a chapter-by-chapter format. Simply select the desired 

chapter from the drop-down list. Your eBookPLUS contains 

the entire textbook’s content in easy-to-use HTML. The 

student resources panel contains supporting multimedia 

resources for each chapter.

Using eBookPLUS references

eBookPLUS logos are used throughout 

the printed books to inform you that a 

multimedia resource is available for the 

content you are studying. 

Searchlight IDs (e.g. INT-0001) give 

you instant access to multimedia 

resources. Once you are logged in, 

simply enter the searchlight ID for that 

resource and it will open immediately. 

Minimum requirements

JacarandaPLUS requires you to use a supported 

internet browser and version, otherwise you will 

not be able to access your resources or view all 

features and upgrades. Please view the complete 

list of JacPLUS minimum system requirements 

at http://jacplus.desk.com/customer/portal/

articles/463717.

Troubleshooting

• Go to the JacarandaPLUS help page at 

www.jacplus.com.au/jsp/help.jsp.

• Contact John Wiley & Sons Australia, Ltd.

Email: support@jacplus.com.au

Phone: 1800 JAC PLUS (1800 522 7587)

This book features eBookPLUS: 

an electronic version of the 

entire textbook and supporting 

multimedia resources. It is 

available for you online at the 

JacarandaPLUS website 

( www.jacplus.com.au ). 

Once you have created your account, you can use the same 

email address and password in the future to register any 

JacarandaPLUS titles you own.

About eBookPLUS
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1.

Types of camera

The two most common types of camera are the single lens 

re�ex (SLR) and the compact camera. These cameras can 

be 35 mm, requiring �lm to record the image, or digital, 

which records the image on an imaging sensor and then 

stores it on a memory card. Modern cameras tend to 

offer a variety of settings options such as fully automatic, 

specialised for different subject matter, and fully manual. 

Some older types of 35 mm SLR cameras can be fully 

manual, requiring the user to ensure correct focus and 

light exposure. A fully automatic camera is easier to use, 

with some allowing the photographer to select from a 

range of manual and creative options (see �gure 1.1H, 

page 6). Using a manual setting can allow greater control 

over the photographs taken.

All cameras work on the same principles and contain 

similar devices, the main features being the view�nder, 

lens, focus, aperture and shutter speed.

Single lens re�ex cameras allow the photographer 

to see (through the view�nder) the exact image being 

photographed. This is achieved by means of a hinged 

mirror between the lens and the �lm (see �gure 1.1C).

Object Image

Figure 1.1A Example 

of a camera obscura

Object Image

Figure 1.1A Example 

of a camera obscura

The camera and taking 
photographs

 1.1  THE CAMERA
The camera was developed from the principles of the camera 

obscura. The camera obscura (dark chamber) was �rst used 

by artists as an aid to creating an exact likeness of a subject. 

It worked on the principle that an image can be created by 

placing a subject in front of a light-tight box that has a small 

hole at one end. Light rays re�ect off the subject and move 

through the hole, creating a reversed image on the opposite 

side wall of the box. Artists traced this image to help them 

record a detailed likeness of the subject (see �gure 1.1A).

No-one can be certain exactly how long the principles of 

the camera obscura have been known; however, they are 

mentioned as far back as the writings of Leonardo da Vinci 

(1452�1519). Around 1860, a scientist named Joseph 

Ni�pce created a light-sensitive material that captured and 

recorded the full image and produced the �rst photograph.

Today, new technologies have placed cameras within 

the reach of everyone, whether it is to capture family 

snapshots or to produce creative and imaginative 

artworks. Nowadays, most people have access to some 

kind of camera. There is a large variety of camera sizes, 

designs and models on the market.
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the SLR (single lens re� ex) camera
The SLR camera is very popular and is ideal to use when 

developing your photographic skills. These cameras include 

the 35 mm and the digital, and vary from those that are 

automatic (with basic, creative and manual options) to 

those that are fully manual.

The manual and creative options allow greater 

control over the photographs taken. They also give the 

photographer a chance to develop an understanding of 

how the camera works. After selecting the image to be 

photographed, the user is at liberty to direct the focus 

and choose how light enters the camera by means of 

the aperture and the shutter speed.

All SLR cameras contain some type of light meter. 

It is essential to use this meter to ensure that the 

aperture and shutter speed are working together to 

create a correctly exposed photograph (see section 1.5, 

pages 20�26).

A mirror mechanism has been designed for SLR cameras 

to ensure that what is seen through the view� nder is what is 

photographed through the lens. Most SLR cameras are also 

very versatile. The photographer can choose to interchange 

lenses for close-up (macro), wide-angle or telephoto shots. 

Special effect � lters and � ash mechanisms for taking 

photographs under poor light conditions (for example, 

inside or at night) may also be added to SLR cameras.
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Figure 1.1C The light path (viewing system) of an SLR camera
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when the shutter release is pressed
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35 mm SLR cameras

All 35 mm SLR cameras use � lm. They are called 35 mm 

because this is the size of the � lm that they use. Within 

these cameras the light travels through the camera�s lens 

and is recorded directly onto light-sensitive � lm. Once 

the � lm is processed, the impression of the image (what 

was taken) can be seen on the � lm strip, generally as 

a negative image. The � lm image can then be projected 

onto light-sensitive paper in the darkroom and processed 

through a range of chemicals to produce a photograph of 

the image (see � gure 1.1D and chapter 2).
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Figure 1.1E The working parts of a standard 35 mm SLR camera

�OR�I�� PARTS O� A STA�DARD 35 MM SI��LE LE�S 

RE�LE� �AMERA

  1.  Frame counter: records how many photographs have 

been taken. The frame counter will always go back to 

zero whenever the camera is opened.

  2.  Transport lever: moves the � lm from one frame to the 

next. This lever must never be forced. If it is dif� cult to 

move, the � lm may be near the end. Most contemporary 

SLR cameras will transport the � lm automatically.

  3.  Shutter release: the button pressed to take a 

photograph. Some automatic SLR cameras will focus 

automatically when the shutter release is pressed 

halfway down.

  4.  ISO setting: tells the camera what � lm speed is 

being used. Film speed refers to the measurement 

of the � lm�s sensitivity to light. (ISO stands for 

International Organization for Standardization. 

Their standard, ISO 5800:1987, de� nes 

the scale for measuring � lm speed.)

  5.  Shutter speed: controls the speed at which the shutter 

opens and closes. A shutter speed slower than 
1

60
 of 

a second should not be used without a tripod because 

the � lm will generally be affected by hand movements. 

The correct shutter speed should be checked on the 

camera when using a � ash (it is generally 
1

60
 and is 

indicated by a star, cross or lightning bolt next to the 

speed number on the dial).

  6. Hot shoe for attaching � ash: the electrical contact or 

connection between the � ash and the camera, which 

ensures synchronisation. The � ash is attached to 

the camera through the hot shoe, where it becomes 

mechanically connected to the rest of the camera. The 

� ash emits light when the shutter release is pressed.

Ensure that the � ash is on and charged before use. 

Also, check for the appropriate shutter speed and 

aperture setting.

  7.  Camera opener and rewind lever: will normally open 

the camera and rewind the � lm back into the canister 

after the shots have been taken. Most contemporary 

SLR cameras will rewind the � lm automatically.

Do not force any lever on the camera. If the � lm is 

hard to rewind, the sprocket release button may not 

have been pressed (see point 13).

The image is

recorded on

black and

white film.

The image is

stored in the

unprocessed

film cassete.

Film is placed on a reel 

in a light-tight tank and 

processed with chemicals

(see page 253).

The processed

film emerges

with the images

as negatives.

In the darkroom the

image is projected

onto light-sensitive

paper.

The final printThe paper is processed 

through a number of

trays of chemicals

(see page 253).

Developer

Negatives

Stop bath

Fixer

Light

Figure 1.1D Outline of how an image is created using a 35 mm SLR camera
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  8.  Lens: controls the way light enters the camera  

and records the image. Lenses come in a variety  

of shapes and sizes, with the standard lens being  

40 to 50 mm. Always check that the lens is clean 

on both sides, as it can collect grit and dust that will 

ultimately appear (out of focus) on the photographs. 

The lens can be removed and changed while there is 

�lm in the camera without damaging the �lm.

  9.  Focus ring: controls and sharpens the clarity of the 

photograph. The focus scale will also show the distance 

from the focused subject, usually in both feet and metres.

Be fully aware of how the focus works. Most 

beginners initially �nd it dif�cult to achieve correctly 

focused photographs (see section 1.2, pages 11�13).

10. Depth of �eld scale: shows the depth of �eld (focus)  

for each shot. Be aware of the f number (aperture). 

Look at the scale and read the distance of focus in  

feet and metres from the focus ring (see section 1.4, 

pages 16�19).

11. Aperture ring: controls the size of the hole in the  

lens through which the image and light enter the 

camera. The size of the hole is indicated by an f-stop 

number. This number indicates a fraction of the hole 

size (for example, f.11 = 
1

11
 of the diameter of the 

lens). The smaller the lens hole, the larger the f-stop 

number. The image becomes sharper as the hole 

gets smaller. The distance of focus (depth of �eld) 

increases as the f-stop number becomes higher (see 

section 1.4, pages 16�19).

12.  Self-delayed timer: triggers the shutter release button to 

go off automatically after a set period of time (normally 

about ten seconds). This allows photographers to take 

photographs of themselves by placing a camera on 

a tripod, setting the timer and moving in front of the 

camera in time for the photograph to be taken.

13.  Sprocket release button: to rewind the �lm, this  

button must be pressed to release the �lm from  

the grooves or sprockets that move the �lm forward.  

If a user tries to rewind the �lm without pressing  

this button, they will �nd it very dif�cult. Forcing the 

�lm will generally tear and ruin it. Many beginners 

forget to push the button and their �lm is torn. 

Contemporary SLR cameras will generally rewind  

the �lm automatically.

14.  Flash cable socket: allows the �ash to be connected  

to the camera in a place other than the hot shoe  

(see point 6) and still have the mechanical connection 

between the camera and the �ash. This is normally 

used when a photographer chooses to use a large-

format �ash. Some contemporary SLR cameras have 

a built-in �ash to allow the user access to extra light 

when required.

Digital cameras
Digital cameras do not use �lm. Instead, they record 

images in digital form, in the same manner as all 

computer �les. With digital cameras, light travels 

through the lens and is recorded on a sensor, 

consisting of a panel of assorted light-sensitive pixels. 

The colours and tones within the image are then 

converted into a series of numbers that can later be 

read by a computer or printer to recreate an accurate 

record of the image. The image is then converted into a 

digital signal and stored on a memory card. The image 

can be viewed directly on the colour monitor LCD screen 

at the back of the camera. Alternatively, the camera or 

memory card can be connected to a computer to view 

the image. Ultimately, the image can be sent from the 

camera or computer to a printer to produce a hard-copy 

photographic image.

The image is

converted to

a digital signal.

The image is

stored on a 

memory card.

The camera can be

connected to a computer

and the image can be 

downloaded, viewed 

and stored.

The computer can be

connected to a printer

where the image can

be printed.

The memory card can be

placed in a computer to

download, view and store

the image.

Light

or

MENU

The image is recorded on an imaging sensor 

where colour and tones are transformed into a 

sequence of numbers. These numbers stand 

for specific colours and tones.

The image can be 

viewed instantly on a 

colour monitor at the 

back of the digital camera.

Figure 1.1F How an image is created using a digital camera
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Figure 1.1F How an image is created using a digital camera



PART 1 MAking: using skills, TECHniquEs And PRoCEssEs6

Digital SLR cameras
Digital SLR cameras are the preferred device of the 

photographic industry and are used by most contemporary 

professional photographers. In the early years of digital 

photography, many photographers did not believe that the 

quality of the digital image could meet the high standard 

achieved by � lm. This is no longer the case. The quality 

of a digital image now matches that achieved by � lm. 

Digital cameras tend to be a lot more forgiving than their 

older counterpart. This is because you can review your 

photograph instantly and you have the opportunity to 

enhance or alter it once downloaded on the computer 

(see section 3.4, pages 80�88). When using a 35 mm 

camera, you need to process the � lm yourself or send 

it out to a lab to be processed before you have the 

opportunity to view your images.
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Figure 1.1G Front view of a digital SLR camera

�OR�I�� PARTS O� A DI�ITAL SLR �AMERA

  1.  Shutter release: the button pressed to take a 

photograph.

  2. On/off button: switches the camera on and off. Most 

digital cameras will switch off automatically after a 

given or chosen period of time.

  3.  LCD panel: provides information about the camera, 

such as the number of shots/space remaining on the 

memory card, shutter speed and aperture settings, 

dive mode, image recording quality, white balance, ISO 

and battery check. Not all digital SLR cameras have 

this panel. Some provide this information on the LCD 

screen at the back of the camera.

  4. Hot shoe: for attaching an external � ash. This provides 

electrical contact or connection between an external 

� ash and the camera, which ensures synchronisation. 

The � ash is attached to the camera through the hot 

shoe, where it becomes mechanically connected to 

the rest of the camera. The � ash emits light when the 

shutter release is pressed. Before selecting a � ash, 

ensure that it will work well with the type of camera 

you are using. Digital � ashes only tend to work well 

with a digital camera.

  5. Built-in � ash: provides an extra burst of light to 

allow photographs to be taken under poor lighting 

conditions. In most cases, if the camera is set to an 

automatic option, the � ash will go off as required. 

On other settings the photographer has the choice of 

whether or not to use the � ash.

  6. Mode dial: provides a range of basic and creative zone 

settings (see � gure 1.1H). The modes on this dial can 

vary considerably from camera to camera.

  7. Depth of � eld/preview button: allows the depth 

of � eld for a particular setting to be seen through 

the view� nder.

  8. Memory card slot cover: the memory card is under 

this cover.

  9.  Auto focus or manual focus option: the switch will allow 

you to choose between both options.

10.  Zoom ring: most digital cameras will have some type 

of zoom or wide-angle lens option. These lenses 

provide an option to get a close-up, distant- or 

wide- angle view of the subject.

11.  Focus ring: controls and sharpens the clarity 

of the photograph.

12.  Lens: controls the way light enters the camera 

and records the image. Lenses come in a variety 

of shapes and sizes, with the standard lens being 

40 to 50 mm. Always ensure that the lens is clean 

on both sides, as it can collect grit and dust that will 

ultimately appear on the photographs. A lens can 

be removed easily and changed at any time without 

affecting any photographs already taken.
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Figure 1.1H Close-up view of a mode dial
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S�M�OLS �O��D O� A MODE DIAL

� is best for photographing portraits. It provides a  

small depth of �eld, ensuring a highlighted facial focus.

� is ideal for photographing landscapes. It provides 

a large depth of �eld, ensuring a broad and extending 

focus zone.

� is best for photographing objects close up and 

allows photographers to move closer to their subject 

matter while maintaining a clear focus. It also tends  

to provide a very small depth of �eld.

� is best for photographing a moving subject and 

presents a very fast shutter speed. This ensures that 

the subject is captured frozen in motion.

� is ideal for photographing people in night settings. 

It allows the �ash to go off, achieving correct exposure for 

the portrait. At the same time, it selects a slow shutter 

speed to ensure the background is adequately lit.

� ensures that the �ash does not automatically go off.

� P program allows you to create and save your own 

choice of camera settings. So when you switch to this 

mode it will convert to your saved settings.

� is Auto. The camera will automatically select what 

it considers to be the most appropriate settings for each 

individual shot.

� TV or S is shutter speed priority. This allows for  

a choice of shutter speed. When a fast shutter speed  

of  
1

2000 is selected, it allows for a frozen motion shot.  

The selection of a slower shutter speed of  
1

15 can 

capture a blurred movement shot (see section 1.3 

on shutter speed, pages 13�16). The camera will 

automatically set the aperture to ensure correct 

exposure of the image. It will also generally alert the 

user by �ashing the aperture setting if there is not 

enough or too much light for the chosen setting.

� AV or A is aperture priority, which will allow for a choice 

of aperture setting. A small-numbered aperture such as 

f.2.8 creates a small depth of �eld, while an aperture of 

f.22 can be selected to implement a large dept of �eld 

(see section 1.4 on aperture, pages 16�19). The camera 

will automatically set the shutter speed to ensure correct 

exposure of the image. It will generally also alert the user 

by �ashing the shutter speed setting if there is not the 

appropriate light for the chosen setting.

� M is manual setting. This allows the selection of shutter 

speed and aperture, but a light meter will need to be 

used to ensure correct exposure (see section 1.5,  

pages 20�26).

� A-DEP maximises the depth of �eld and focus range 

within a photograph.
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Figure 1.1I Back view of a digital SLR camera
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  1.  View�nder: the small glass window used to frame and 

view the image to be recorded.

  2.  Index display: used in combination with the playback 

button, allows up to nine thumbnail images from the 

memory card to appear on the LCD screen.

  3. Dial: used to select the preferred setting from  

looking at the LCD panel or through the view�nder.  

It is commonly used to select shutter speed  

or aperture settings on TV or AV modes.

  4. Magni�ed view: when viewing an image on  

the playback option, this can be used to gain  

a magni�ed view of the selected image.

  5.  Cursor: used to manoeuvre around the LCD screen 

menu, enabling the selection and re�nement  

of camera settings.

  6. OK command: activates selected settings.

  7.  Function: will highlight ISO, �ash, WB and shooting 

modes on the LCD screen for selection and 

modi�cation. (The appearance and location of this 

option will vary from camera to camera.)

  8.  Coloured monitor/LCD screen: used to play back  

images and to access function and menu options.

  9.  Function and menu options: by pressing the function  

or menu buttons (see points 7 and 13), the setting 

options appear on the LCD screen. The cursor  

and OK command can then be used for selection  

and modi�cation.

10.  Image playback: enables the images previously  

taken to appear on the LCD screen for viewing.

11.  Info: provides an overview of all current camera settings.

12. Rubbish bin: provides the option to delete previously 

taken images.

13. Menu: displays on the LCD screen a variety of options 

for modifying camera modes and settings.

14.  Flash up: will pop the �ash up.
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Digital compact cameras
The compact camera was developed to allow everyone 

the opportunity to take photographs. Digital compact 

cameras are fully automatic, with most having basic mode 

settings to allow some control over the photographs 

taken. They record images quickly and ef�ciently, and are 

generally very easy to use. They are ideal for beginners or 

people who are mainly interested in recording snapshots 

of family, friends, events and holidays. There is a great 

variety of compact cameras on the market, and with 

technical development they will continue to become more 

sophisticated and easier to use.

4

1 2 3

i. Front view

5

6

7 8

9

ON/OFF

ii. Top view

MENU

OK

W T 13
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21:35

iii. Back view

Figure 1.1J The working parts of a compact digital camera

T�E �OR�I�� PARTS O� A �OMPA�T DI�ITAL �AMERA 

  1.  Light sensor: helps record the amount of light that will 

enter the camera.

  2.  View�nder: the small glass window used to frame and 

view the image to be recorded.

  3. Built-in �ash: produces an extra burst of light to allow 

photographs to be taken under poor lighting conditions 

(for example, inside). On most automatic cameras, the 

�ash will come on automatically as required.

  4.  Lens cover: helps protect the lens. Generally, when 

you switch your camera on, the lens cover will 

automatically open.

  5.  Lens: controls the way light enters the camera and the 

clarity (focus) of the image.

  6.  Zoom lens: most compact digital cameras have zoom 

and/or wide-angle lenses that can be used as required 

by the photographer.

  7.  Shutter release: the button pressed to take a 

photograph.

  8. On/off button: switches the camera on and off. Most 

digital cameras will switch off automatically after a 

given or chosen period of time.

  9. Mode dial: provides a range of basic zone settings that 

allow the camera to be placed on a shooting mode 

that will correspond directly to the subject matter, thus 

ensuring the image is captured in the most effective 

way. The modes on this dial can vary considerably 

from camera to camera.

10.  Coloured monitor/LCD screen: used as a view�nder to 

compose the image and then to play back captured 

photographs. It is also used to access the function 

and menu options and to display the current camera 

set up (such as shots remaining, battery level, image 

quality and ISO).

11.  Function and menu options: enable the modi�cation 

and re�nement of settings.

12. Rubbish bin: provides the option of deleting images 

previously taken.

13. Wide-angle/telephoto option: activates the zoom lens, 

providing the option to gain a close-up view of the 

subject or a more distant view of the subject.

14.  Index display: by combining this option with pressing 

the playback button, up to nine thumbnail images from 

the memory card will appear on the LCD screen.

15. Magni�ed view: when viewing an image on the 

playback option, this setting can be used to gain a 

magni�ed view of the selected image.

16. Menu: will display on the LCD screen a variety of 

options to enable the modi�cation of camera modes 

and settings.

17.  Image playback: enables the images previously taken 

to appear on the LCD screen.

18. Memory card slot cover: the memory card is positioned 

in the camera under this cover.
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19.  Four-way cursor: used to manoeuvre around the LCD 

screen menu, enabling the selection and re�nement of 

camera settings.

20. OK command: activates selected settings.

�ASI� �O�E SETTI��S

A choice of basic zone settings is often found on compact 

digital cameras as well as SLR digital cameras. Zone 

settings allow for quick access to capture ideal settings for 

a variety of situations. Different setting options are available 

on different cameras. Below are some of the most common.

� Auto shooting mode is best for photographing 

general subject matter.

� is best for photographing portraits and provides a 

small depth of �eld, which ensures a highlighted facial 

focus.

� is best for photographing landscape  

and provides a large depth of �eld, which ensures  

a broad and extending focus zone.

� is best for photographing a moving subject  

and provides a very fast shutter speed, which ensures 

that the subject is captured frozen in motion.

� is ideal for photographing people in night settings. 

The �ash will go off, achieving correct exposure for the 

portrait, while at the same time selecting a slow shutter 

speed to ensure the background is adequately lit.

� provides a menu on the LCD screen  

of various options, including change of date,  

monitor brightness, language and so on.

� provides the option of taking short moving images 

at times with sound.

� provides a series of settings options for a 

number of different popular photographic situations:

� captures superior indoor lighting when  

only a minimum of light is available.

� This captures the vibrant atmosphere  

of light-�lled snow and beach scenes.

� captures the large array of vivid colours  

in a sunrise or sunset (NB: slow shutter speed).

� captures night lights and cityscapes  

(NB: slow shutter speed).

� captures a close-up view of objects,  

with the background blurred.

� captures indoor objects, exhibits and pictures 

without the use of a �ash (NB: slow shutter speed).

� captures expanding bursts of �reworks  

(NB: slow shutter speed).

SET UPSET UP

SCENESCENE

� captures an expansive, wide view of a scene.

� captures a correctly lit subject when the light  

is coming from behind.

Be aware that slow shutter speed is linked to some  

of these settings, so the camera needs to be held �rmly 

with some kind of support (see �gure 1.6F, page 29). 

Ideally, a tripod should be used to prevent blurring.

Not all of these scene modes may be available on your 

camera; on the other hand, you may �nd that your camera 

has additional modes and settings.

��ALIT� OPTIO�

Most digital cameras will allow you to choose the quality 

of the images that you photograph. If you select a high 

quality image, it will take up a large amount of memory 

and will be of a high resolution. This means that the 

quality of the image will be maintained even when printed 

to a large format. Lower resolution images take up much 

less space on the memory card but the image quality is 

compromised and pixilation will be evident if the image is 

printed in large format.

Highest
quality

Lowest
quality

Figure 1.1K Common symbols used to indicate the �le size and quality  

of the image being recorded

� Large format, 2272 × 1704 pixels, is appropriate for 

large-format printing.

� Medium format, 1600 × 1200 pixels, is appropriate for 

large prints.

� Medium 2 format, 1024 × 768 pixels, is appropriate for 

standard-size prints and email attachments.

� Small format, 640 × 480 pixels, is appropriate for very 

small-size prints and posting on the web.

Figure 1.1L Different types of memory card
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IMA�E �APA�IT� O� A MEMOR� �ARD

The amount of memory on a memory card will vary. 

The number of photographs that the memory card can 

hold is determined by the image quality you select and 

the storage space on the card (a 32 MB memory card will 

hold half as many images as a 64 MB memory card). If you 

choose to take high quality images (which will be large 

� les) then you will not be able to take as many photos as if 

you choose low quality images (which are small � les). Most 

cameras will calculate and display the number of shots you 

have remaining, but this � gure will change if you choose to 

increase or decrease the quality of the image you are taking.

DRIVE MODE

Most digital cameras have a variety of drive mode options. 

The location of these option settings can vary from one 

camera model to the next. The most common options 

allow you the choice of taking a single shot or taking a 

series of continuous shots. Continuous shots are ideal 

when photographing moving subjects. They can also record 

a sequence of shots that could be used in an animation. 

A further choice is a self-timer that triggers the shutter to 

go off automatically after a set period of time � normally 

about 10 seconds.

i. Single shot mode ii. Continuous shot mode iii. Self-timer mode

Figure 1.1M Symbols used for drive modes

��ILT-I� �LAS�

Most digital cameras provide a series of options for using 

the built-in � ash. If the setting is on �auto� the � ash will 

pop up in poor lighting conditions. The common options 

are shown below.

� 
AUTO

The � ash will pop up whenever there is not enough 

light. If there is enough light, the � ash will not go off.

� The � ash will go off whenever a picture is taken. 

Even if there is enough light, you may consider using this 

setting to even out the light or to highlight your subject.

� 

A

Prevents a person�s eyes from appearing red in 

a photo, which occurs when the subject�s retinas re� ect 

the light from the � ash (see � gure 1.1N). This option 

works well, but there is often a small delay from the 

time the trigger is pressed on the camera to when the 

shot is taken, which can be a problem if the subject 

moves during the delay.

� This manually combines the red-eye reduction and 

� ash mode.

� The � ash will not go off even in poor light.

� Combines the � ash with a slow shutter speed. 

Ideal for photographing people in night scenes when 

some exposure of the background is desired.

Figure 1.1N  i.  A photograph of a 
subject with red eyes

ii.  A photograph of the same subject 
without red eyes

1.  In your workbook or journal, complete a drawing of 

the camera you will be using. Alternatively, you could 

photograph or scan it. Label and list all the major 

parts of the camera as described in this section. 

Remember that, although all cameras have very 

similar devices, they are not always in the same place. 

Some cameras have additional features and, if this 

is the case with your camera, it is important that 

you understand what they are and how to use them 

correctly. If you are not sure about a particular part of 

your camera, look at the manual or ask someone to 

explain what it is and record it on your diagram.

2.  De� ne the following terms: camera obscura, 

35 mm SLR camera, SLR digital camera, 

and digital compact camera.

3.  Form small groups and, using a digital camera, take 

a series of photographs exploring the mode settings. 

Start with the most common basic modes � portrait, 

landscape, runner and close-up � and then use the 

unique aspects of your camera to explore others. 

These could be the creative zone modes on a digital 

SLR camera or the scene modes on a compact 

camera. Once you have completed the shoot, 

download the images onto a computer and print out 

a proof sheet for each member of the group. In your 

workbook or journal, analyse the results. Next to each 

image, write down the mode you used to take the 

photograph and discuss the results achieved.

4.  Answer the following questions in your workbook 

or journal.

a.  What do you think Joseph Ni�pce (who created 

the � rst photograph � see page 2) and other early 

photographers would have thought about digital 

photography?

b.  What do you think is better: traditional � lm 

photography or digital photography? Why?

activitieS
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 1.2  FoCus
The focus on a camera 

controls the clarity of the 

photographs that are taken. 

In order to gain a clear, 

sharp image, such as that 

in �gure 1.2A, it is very 

important to understand 

how the focus works on 

the camera being used. 

As with most things in 

photography, there are many 

different kinds of systems. 

To gain the best results, 

photographers must have a 

thorough understanding of 

their own camera�s focusing 

system and how it works.

Figure 1.2B  

Image demonstrating 

selective focus.  

Dandelion, 

Jacob de Weger,  

Year 10,  

digital photograph

Figure 1.2A A clear, sharp, focused 

image. Hope, Samantha Daou, 

Year 12, digital photograph
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Manual focus

Older style 35 mm SLR cameras are often fully manual, 

with no auto option, so the photographer must focus every 

photograph. Most contemporary 35 mm and digital SLR 

cameras tend to have both auto and manual focusing 

systems. With these types of cameras, the photographer 

needs to ensure that they have switched the camera onto  

the desired setting. The manual setting allows the 

photographer to have full control over the focusing of 

the image; however, they need to physically focus every 

photograph. Manual focusing is achieved by turning a 

focusing dial on the lens of the camera to achieve a sharp 

image.

Figure 1.2C  

An auto focus/manual focus switch  

as it may appear on a modern camera
AF MF
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Focusing ring

Figure 1.2D Focusing ring on a standard 35 mm SLR camera.  

The focusing ring on digital SLR cameras is located in the same position.

Many SLR cameras have what is known as a  

split focusing system, whereby a small dissected circle 

appears on the screen when looking through the lens.  

To achieve correct focus, the focusing dial needs to be 

turned until the image comes together within the circle  

(see �gure 1.2E (i)). Another system shows a central grid  

of miniature crystals on the screen. The crystals shimmer 

and appear unclear when the shot is out of focus. In order 

to achieve correct focus, the focus ring needs to be turned 

until the crystals appear clear and sharp (�gure 1.2E (ii)).

Focused imageOut of focus image Focused imageOut of focus image

i. Split focusing system ii. Crystal focusing system

Figure 1.2E Focusing systems

Focused imageOut of focus image Focused imageOut of focus image

i. Split focusing system ii. Crystal focusing system

Figure 1.2E Focusing systems

Auto focus

Modern SLR 35 mm, SLR digital and compact digital 

cameras have fully automatic focusing systems as well 

as a manual focus option. When the camera is set on 

a basic auto focus setting, it will assume that the most 

important part of an image is placed in the centre  

of the frame and will therefore focus on this zone.  

This focus zone is often indicated by two brackets. 

Many digital cameras also allow the photographer to 

set the camera on different modes, such as portrait, 

landscape or close-up (see symbols on pages 7 and 9), 

which further help with maximising the desired focus. 

More advanced cameras allow greater control over 

the focusing zones and provide the option of selecting 

which part of the image the photographer wants 

focused (see �gure 1.2F(ii)).

ii. Advanced auto focus zone.  

The camera automatically focuses  

by considering all the auto focus 

points, or the camera will allow  

you to manually select particular 

points for focusing. This is  

important if your main subject  

is not in the centre of the frame.

i. Basic auto focus zone. 

The camera automatically 

focuses on the closest 

object between the brackets.

Focusing
points

Figure 1.2F Auto focus zones

When using a basic auto focus zone, a problem can 

occur if the main subject is not exactly in the middle of 

the frame (see �gure 1.2G). Once the shutter release is 

pressed halfway down, the camera will lock in the focus 

on what appears between the two brackets. A small beep 

will generally sound to indicate this. If the main subject is 

not in the centre of the frame, the photographer needs to 

move the camera to place the main subject between the 

brackets, press the shutter release button halfway, listen 

for the beep (not on all cameras) and then reframe the 

shot before compressing the button the rest of the way  

to capture the image.
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Figure 1.2G Example of an auto focus photograph in which the major 

subject has been placed at the side of the frame and the camera has 

focused on the central object

Figure 1.2H Example of an auto focus photograph taken correctly

poiNtS to RememBeR

� If you are taking a portrait, it is a good idea to make sure that 

you focus on the eyes of the subject. This is because people 

who are viewing a portrait will generally look at the eyes � rst.

� The aperture setting has a direct effect on the depth of � eld in 

a photograph (see section 1.4, pages 16�19).

1.  Look closely at your camera and discover what kind of 

focusing system it has. Then record in your workbook 

or journal how to use it.

2.  Look through your own or another family member�s old 

photographs and try to � nd some photographs that 

have been accidentally taken out of focus. Photocopy 

them and glue them into your workbook or journal and 

explain what you think may have gone wrong. These 

examples could be black and white or colour.

3.  Look through some magazines or search the internet 

for photographs that you think have been deliberately 

taken out of focus. What do you think may have been 

the intention of the photographer or artist who took 

the photograph?

activitieS

 1.3  sHuTTER sPEED
The shutter on a camera is like a blind that is situated 

between the lens and the � lm. The shutter opens and 

closes to allow light to enter the camera and reach the 

� lm. The shutter speed is the amount of time that the 

shutter remains open. This time is normally indicated as a 

fraction of a second and can vary from as fast as  
1

8000 of a 

second to as slow as half a second or even a second (see 

� gure 1.3A). Some cameras also have a choice of �B� on 

the shutter speed dial. This allows the shutter to remain 

open for as long as the shutter release is pressed.

2
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Shutter speed dial

B
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i. Shutter speed dial on 

a standard 35mm SLR camera
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Mode dial can be set on TV shutter speed priority.

Dial can be moved to change

shutter speed.

ii. Shutter speed indicator 

on an SLR digital camera

Figure 1.3A Shutter speed dials
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On some SLR 35 mm cameras, the shutter  

speed setting can be viewed when looking through  

the view�nder. It will often appear at the bottom of  

the view frame (see �gure 1.5F, page 22). On most 

digital SLR and compact cameras the shutter speed 

setting is indicated on the LCD screen on the back  

or the LCD panel on top of the camera (see  

�gure 1.3A(ii)).

The shutter speed on SLR cameras and some 

compact cameras can be adjusted to suit a variety 

of lighting conditions and to capture different kinds 

of movement shots. The length of time the shutter 

remains open has a direct bearing on the amount 

of light that reaches the �lm or digital sensor. If the 

shutter remains open for too long, too much light  

will enter the camera. If the shutter is not open  

for long enough, insuf�cient light will enter the 

camera.

What shutter speed to use

Shutter speed on manual  

SLR 35 mm cameras
On older 35 mm SLR cameras, the shutter speed  

may need to be set manually (see �gure 1.3A(i)).  

A standard shutter speed to use is 
1

125
 or 

1

250
 of a 

second. These speeds are appropriate for a normally 

lit outdoor shot using 125 ISO �lm (see page 20). If 

photographs are being taken in bright, sunny conditions 

where there is excessive light, a faster speed, such 

as 
1

500
, may be needed. This prevents too much 

light entering the camera and overexposing the �lm. 

Alternatively, a smaller aperture could be used, which 

may also prevent excessive light entering the camera 

(see section 1.4, pages 16�19).

If it is overcast or late in the afternoon, a slower 

speed, such as 
1

60
, may be needed to ensure that 

enough light reaches the �lm. It is always desirable 

to look at the light meter to guarantee the correct 

exposure (see section 1.5, pages 20�26).

The aperture also has a direct bearing on the  

amount of light that enters the camera, so it is 

very important that the shutter speed and aperture 

work together in order to create a correctly exposed 

photograph (see section 1.4, pages 16�19).

A shutter speed slower than 
1

60
 of a second should, 

as a general rule, only be used in conjunction with a 

tripod. This is because at slow shutter speeds the �lm 

will generally record the effect of camera shake caused 

by hand movements.

When using a �ash it is important to set the shutter 

speed on the appropriate setting. This is generally 
1

60
 

and it is indicated by a star or lightning bolt next to the 

shutter speed number on the dial.

SLR 35 mm camera

1.  Open the back of your camera and place the shutter 

speed dial on a variety of slow speeds (for example, 

B, 1,  
1

2
). Look through the back of the camera towards 

the lens, press the shutter release and take note of what 

happens and record it in your workbook or journal.

2.  Repeat activity 1, but this time change the shutter 

speed dial to 
1

500
 or 

1

1000
 of a second. Once again, 

note what happens when you press the shutter 

release. (You may need to wind the transport lever 

every time you press the shutter release.)

3.  Experiment with different shutter speeds and note the 

different lengths of time the shutter remains open. 

Record your observations in your workbook or journal.

4.  Write your own de�nition of shutter speed.

activitieS

Shutter speed on digital cameras
On digital cameras the shutter speed can be set on auto 

for taking general photographs or it can be automatically 

adjusted by the camera to suit the various mode 

and scene settings (see symbols on pages 7 and 9). 

Alternatively, most digital SLR cameras provide a shutter 

speed priority setting, often indicated by the abbreviation 

TV or S on the mode dial (see �gure 1.1H, page 6). This 

option allows the selection of a desired shutter speed and 

automatically adjusts the aperture to ensure the correct 

exposure. If the aperture setting starts to �ash, this tends 

to indicate that the correct exposure can not be achieved 

under the current lighting conditions.

the shutter speed controlling movement
The shutter speed controls the exact amount of time 

that a subject is exposed to the �lm or imaging sensor. 

Photographers can choose how they wish to capture a 

moving subject � in frozen motion, blurred motion, or 

frozen subject with blurred background. If the subject is 

moving, it is important to select the appropriate shutter 

speed to capture the image. If the subject is moving 

quickly, a fast speed (
1

500
 or 

1

1000
 or 

1

3000
) can be used to 

capture the image frozen in motion. Alternatively, a slow 

speed can be selected so the subject moves through the 

frame to capture blurred motion.

�RO�E� MOTIO�

By using a very fast shutter speed (
1

3000
 to 

1

500
 of a 

second), the camera can capture a fast-moving subject and 

freeze it (see �gure 1.3B). The shutter works so quickly 

that the subject barely moves while the shutter opens and 

shuts. Frozen motion photographs are normally taken of 

subjects in midair (such as a high jumper going over the 

bar) or a split second of an event (such as a close race 

�nish or a swimmer mid-stroke).
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Figure 1.3B Example of a frozen motion photograph. Joy, Anthea 

Sidiropoulos and Jessica Calvert, Year 11, digital photograph

�L�RRED MOTIO�

By using a slower shutter speed (
1

60
 or 

1

30
 or slower) and 

a tripod, a camera can create the illusion of movement by 

capturing a sharp background and a blurred moving subject 

(see �gure 1.3C). The tripod will hold the background still 

as the shutter opens, and the moving subject is captured 

before it closes again. Blurred motion photographs 

are often used to convey the impression of speed (a 

racing bike) or movement (a hand waving). Sometimes 

photographers use this technique at night to record a city 

scene with car lights moving through it (see �gure 1.3D).

Figure 1.3C Example of a blurred motion photograph. BMX, Sandra Purssey, 

digital photograph

Figure 1.3D Example of a blurred motion photograph taken at night using  

a tripod. Lost, Bianca Koffman, Year 12, digital photograph

At night, with limited light, the camera can be set 

on shutter speed B. A tripod can be used to prevent 

camera movement, and the image is exposed to the 

�lm or imaging sensor for approximately �ve seconds by 

keeping a �nger on the shutter release. This creates very 

interesting and exciting night-time photographs.

�RO�E� S���E�T �IT� �L�RRED S�RRO��D

By selecting a slow shutter speed (
1

30
 or 

1

60
) and panning 

(moving) the camera with the moving subject, the 

photographer can capture a frozen subject with what  

can appear to be a moving (blurred) background (see  

�gure 1.3E). By moving the camera at the same speed 

as the subject, and allowing the shutter to open and shut 

slowly while the camera is moving, the �lm or imaging 

sensor will freeze the moving subject and the background 

image will be blurred. These types of photographs are 

often taken to create the impression of movement and, 

in particular, speed. For example, a racing car might be 

shown driving past a blurred crowd in the background.

Figure 1.3E Example of a photograph of a frozen subject with blurred 

surrounds. Lynne Beck, gelatin silver photograph
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1.  Experiment with movement by taking a series 

of photographs in which you:

a.  take photographs of the same fast-moving subject 

using the three different movement techniques 

(record your shutter speed and apertures for each 

shot on a copy of the proforma on page 30)

b.  take photographs of different moving subjects, 

aiming to capture the best qualities of each 

technique (keep a log of shutter speed and 

apertures used)

c.  develop the � lm or download your images and print 

a proof sheet. Paste it into your workbook or journal 

and comment on the outcome of your shots.

d.  select the three best photographs that 

demonstrate movement (preferably demonstrating 

each technique), and then print them and submit 

them as part of your folio.

2.  De� ne each of the techniques available to record 

movement in photography.

3.  Make a list of all the important things to remember 

when selecting your shutter speed (include at least 

three).

4.  Look through some magazines and search 

the internet to � nd good examples of photographs 

that demonstrate frozen motion, blurred subject 

and blurred background. Photocopy or print and paste 

these examples into your workbook or journal, and 

comment on how you think the shots were taken. 

Write a short review of each, explaining what 

features you like and dislike, and why.

activitieS

 1.4  APERTuRE
The aperture is a small hole in the lens through which 

light travels into the camera and onto the � lm or imaging 

sensor. The aperture controls the amount of light 

that enters the camera and the depth of � eld in your 

photograph (see � gures 1.4A, and 1.4F, page 18). The hole 

size is indicated by what is known as an f-stop number. 

These numbers indicate a fraction of the hole�s size in 

relation to the focal length of the lens. Some or all of the 

following f-stop numbers may appear on the aperture: 

2, 2.8, 4, 5.6, 8, 11, 16, 22, 25, 29, 32 and 36 (see 

� gures 1.4A, 1.4B and 1.4C). Each f-stop number allows 

half as much light as the f-stop number before it. For 

example, f.4 allows half as much light to enter the camera 

as f.2.8. In other words, f.2.8 allows twice as much light 

to enter the camera as f.4. Note that the larger the f-stop 

number, the smaller the hole in the lens.

The size of the hole can be altered by turning a narrow 

ring on the lens of a 35 mm SLR camera. On digital 

cameras the aperture can be set on auto when taking 

general photographs or it can be automatically adjusted 

by the camera to suit the various mode and scene 

settings (see symbols on pages 7 and 9). Alternatively, 

most digital SLR cameras provide an aperture priority 

setting often indicated by the abbreviations AV or A. This 

option allows the selection of a desired aperture and 

automatically adjusts the shutter speed to ensure the 

correct exposure. If the shutter speed setting starts to 

� ash, this tends to indicate that the correct exposure 

cannot be achieved under the current lighting conditions.
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Figure 1.4A Aperture ring on a 35 mm SLR camera
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Dial can be moved to change aperture.

Figure 1.4B Aperture indicator on an SLR digital camera
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On some SLR cameras the aperture setting (f-stop)  

can be viewed when looking though the view�nder.  

It will often appear at the bottom of the viewing frame 

(see �gure 1.5F, page 22). On most digital SLR and 

compact cameras the aperture setting (f-stop) is 

indicated on the LCD screen on the back or the LCD 

panel on top of the camera (see �gure 1.4B).

f.2.8

f.8

f.4

f.11

f.5.6

f.16

Figure 1.4C Aperture settings

1.  List the f-stop numbers that appear on your camera. 

Then, using �gures 1.4E, 1.4F, 1.4G and 1.4H  

to assist you, discuss the f-stop settings that  

you could use to achieve a small and large  

depth of �eld.

2.  Using a 35 mm SLR camera with a detachable  

lens, take the lens off the camera body. Hold  

the lens towards a light and, looking through the 

back of the lens, rotate the aperture ring through 

the range of f-stop numbers. Take note of what 

happens and record this information in your 

workbook or journal.

activitieS

What aperture to use
A standard aperture is around f.8 or f.11. This should 

give a reasonable depth of �eld and an adequate shutter 

speed (
1

125
 or 

1

250
) under normal outdoor lighting conditions. 

However, it is important to check the light meter to 

determine the correct setting.

controlling focus � depth of �eld
The size of the aperture has a direct effect on the 

distance of focus within a photograph. This zone of focus 

is commonly called the depth of �eld. In most cases, by 

selecting the appropriate aperture, a totally focused shot 

should be achieved; that is, everything in the photograph 

should be clear and sharp. This is called a large depth of 

�eld. Selecting another aperture enables you to choose to 

have only a small part of the photograph in focus; that is, 

only the main subject is clear and sharp, with everything 

in front and behind it out of focus. This is called a small 

depth of �eld.

Think of depth of �eld as selective focusing. By 

understanding its possibilities you will have another tool 

at your disposal for creating interesting and imaginative 

photographs.

�O�TROLLI�� T�E �O�E O� �O��S

The easiest way to understand how to control the zone of 

focus in a photograph is to remember the following:

� large f-stop number (for example, f.22) =  

large depth of �eld

� small f-stop number (for example, f.4) =  

small depth of �eld.

DEPT� O� �IELD S�ALE

A variety of levels of focus are at your �ngertips. Every 

f-stop number will give you a different depth of �eld.

Manual 35 mm SLR cameras have a depth of �eld scale 

next to the focusing ring that allow you to read what your 

depth of �eld is (see �gure 1.4D). This is indicated by the 

f-stop number appearing twice on the scale. By drawing  

an imaginary line through the depth of �eld scale from 

where the selected f-stop appears, you should be able 

to see the distance your photograph will start and �nish 

being in focus.

Figures 1.4E, 1.4F, 1.4G and 1.4H further illustrate the 

concept of depth of �eld and the use of apertures and 

depth of �eld scale.

Depth of field scale4 4

30
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Figure 1.4D Depth of �eld scale on a 35 mm SLR camera

The distance between the subject and the lens also 

affects the depth of �eld. It is much easier to produce 

a clear, sharp picture when everything that is being 
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i. In this photograph of three girls, the photographer has focused on the 

�rst girl at a distance of two metres and has used an aperture of f.22. 

This photograph is an example of a large depth of �eld.

Depth of �eld  

approximately 5.25 metres

Depth of �eld scale

ii. This shows the aperture at f.22. If you look at the depth of �eld  

scale, you will see that 22 appears twice. By drawing an imaginary line  

up from both numbers (22) through the focusing scale, the depth  

of �eld is shown by reading the distance on the focusing scale 

from the �rst imaginary line through to the second. In the case  

of f.22, when focused on a subject two metres away, the depth  

of �eld will be from approximately 1.25 metres to 6.5 metres,  

making a total of 5.25 metres.

Figure 1.4E Example of large depth of �eld

i. A photograph of three girls, using the same setting as �gure 1.4E.  

The photographer has once again focused on the �rst girl at a distance 

of two metres, but this time has used an aperture of f.2.8.  

This photograph is an example of a small depth of �eld.

The depth of �eld is minimal.  

Only what was focused on will be clear and sharp.

Depth of �eld scale

ii. This shows the aperture at f.2. If you look at the depth of �eld scale,  

the lowest number you will see is 4, which again appears twice. If you draw 

two imaginary lines up through the focusing scale, and read the distance of 

focus from the �rst 4 to the second 4, it will indicate that the depth of �eld 

is approximately 0.25 m. In the case of f.2, it is correct to assume that the 

depth of �eld is so small that it does not appear on the scale. If you were 

to focus on an object two metres away, only the image that you focused on 

would be in focus.

Figure 1.4F Example of small depth of �eld
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photographed is a long way from the lens. If all the objects 

being photographed are close to the lens it is a lot more 

dif�cult to focus all parts of the composition.

Figure 1.4H Depth 
of �eld can be used 
to create interesting 
and imaginative 
photographs. In this 
example, a small 
depth of �eld has 
been selected to 
enhance the quality 
of the image. 
Hitching, Andr� 
DiMingo, gelatin 
silver photograph

Digital SLR cameras work on the same principle as 

35 mm SLR cameras. Many have a depth of �eld preview 

button that when pressed will adjust the diaphragm of the 

lens to match the chosen aperture setting, allowing you  

to see the current depth of �eld range through the lens 

(see �gure 1.1G, point 7, Depth of �eld/preview button, 

page 6).

1.  Take a series of photographs, experimenting with 

aperture use and depth of �eld. Always remember to 

ensure correct exposure. Be prepared to adjust the 

shutter speed if necessary.

a.  Set up a shot (you may like to use a tripod) that has 

a number of objects scattered from the foreground 

to the background. Focus on an object in the middle 

ground and take a number of photographs using a 

variety of f-stops (for example, f.2, f.4, f.11, f.22). 

Ensure that you record the f-stop and shutter speed of 

each shot (use the proforma on page 30).

b.  Take a number of shots that you feel would be 

enhanced by having a small depth of �eld (for 

example, portraits or a group of people with one 

person highlighted).

c.  Take a number of shots that you feel would be 

enhanced by having a large depth of �eld (for 

example, landscapes, still life, a group of people).

2.  Develop your �lm or download your images and produce 

a proof sheet. Glue the proof sheet into your workbook 

or journal and record the outcome of your photographs 

by commenting on both the successful and unsuccessful 

elements of the shots.

3.  Select the best two shots depicting a small and large 

depth of �eld. Print these as photographs and present 

them in your folio.

4.  Make a list of all the important things to remember  

when you are selecting your aperture and f-stop.  

Include at least three points.

5.  Look through magazines and search the internet to �nd 

good examples of photographs that demonstrate a small 

depth of �eld and a large depth of �eld. Comment on 

these examples by discussing what you think was the 

possible intention of the photographer.

activitieS

Distance (m)
1 2

f.2

3 4 5 60

f.22

Figure 1.4G This photograph shows a side view of how the three girls 
in �gures 1.4E and 1.4F were placed in front of the camera, which was 
positioned on a tripod. The scale below the photograph indicates the 
approximate depth of �eld at the two different aperture settings.
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 1.5  LIGHT
Light is the most important element in any photograph. 

It is more important than most people think. In order for 

you to become a successful photographer, it is important 

to develop a comprehensive understanding of light and 

how it affects your photographs. Too often, people take 

photographs without considering how light affects the images 

that they are taking (see � gures 1.5A and 1.5B). Before you 

take a photograph, it is wise to:

� work out where the main light source is coming from

� look at how it is affecting your subject

� check for any strong shadows that may distract from the 

subject or affect the look of the subject

� consider how the whole photograph will be lit

� work out how to judge the correct exposure settings for 

the camera.

A photographer must learn to see light and to judge how 

it is going to affect their photographs. The secret is to be 

aware of light. With time and practice you should be able 

to master its use.

It is important to be aware not only of how light is 

affecting your subject, but also of how it is affecting your 

Figure 1.5A This photograph has captured harsh, distracting shadows on 

the face.

Figure 1.5B This photograph enhances the qualities of the face through 

correct use of light.

Figure 1.5A This photograph has captured harsh, distracting shadows on 

the face.

Figure 1.5B This photograph enhances the qualities of the face through 

correct use of light.

� lm or imaging sensor. The amount of light that enters 

your camera and acts on your � lm or imaging sensor is 

called exposure. The way, and the degree to which, light 

exposes the image is governed by three things:

1.  The shutter speed: how long the shutter remains open.

2.  The aperture: the size of the hole through which light 

enters the camera.

3.  The ISO: the sensitivity of the � lm or imaging sensor to 

light. The ISO can vary considerably and, as a result, 

can have a direct impact on exposure. It is possible to 

purchase � lms with different ISOs that provide a range 

of sensitivities to light. The ISO is often referred to as 

� lm speed. The faster the � lm speed, the higher the 

sensitivity of the � lm to light. On most digital compact 

cameras, the ISO is set automatically, while on SLR 

digital cameras it is generally possible to manually 

selected your ISO.

The ISO is normally indicated by a number, such as 

125 or 400. The higher the number, the higher the 

degree of sensitivity. Higher numbered ISO settings 

and � lm are best used when there is poor lighting 

available � for example, when taking photographs 

indoors without a � ash.
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Make and type

ISOSize Number of exposuresExpiry date

‘Best kept below’ temperature

i. Decoding the �lm box

Barcode

ii. Standard 35 mm �lm with barcode

Figure 1.5C

Figure 1.5D The ISO window on the shutter speed dial of a 35 mm  

SLR camera

ISO on 35 mm cameras
When using a 35 mm SLR camera, you need to ensure that 

the camera is set up for the ISO you are using in order 

to gain the correct exposure. The �lm speed is normally 

indicated by the number that appears on the �lm and on 

the �lm box (see �gure 1.5C). When using an older style 

35 mm SLR camera, you need to manually set the ISO, 

generally on the shutter speed dial (see �gure 1.5D).  

On some automatic and modern SLR 35 mm cameras, the 

�lm speed is automatically set by the camera. The camera 

scans a barcode on the �lm and sets the ISO accordingly.

Sensitivity

Auto

200

400

800

1600

3200

Figure 1.5E ISO options as they may appear on the LCD screen  

of a digital camera

ISO on digital cameras
When using a digital SLR or compact camera, you can 

generally select your ISO through the menu or function 

setting on your LCD screen or possibly by the settings on 

your LCD panel.

On automatic zone and program settings, digital cameras 

mechanically set a standard ISO for the camera and then 

adjust the shutter speed and aperture to provide a correct 

exposure reading. This also occurs if you select your own 

ISO setting � the camera adjusts itself to provide an 

accurate exposure reading on all auto, basic and creative 

zone settings. On a manual setting it is necessary to use 

a light meter to ensure correct exposure.

Light meters
Light meters measure light and enable photographers to 

achieve the correct exposure for their photographs.  

A correctly exposed image will have a good range of tones, 

with the main subject matter appearing neither too dark 

nor too light.

When using a manual camera or a manual exposure 

setting, you need to have access to a light meter to 

ensure the correct exposure for every shot. The two main 

types of light meters are built in or hand held. Most 

modern cameras, including digital, have built-in meters. 

Built-in meters are by far the most convenient and, if 

used correctly, can achieve ef�cient readings. Most 

contemporary built-in meters are called coupled meters or 

through the lens (TTL) meters. With these types of meters 

you can gain the correct setting by looking through the 

view�nder and adjusting your aperture or shutter speed 

until the correct exposure is indicated. This is shown in 

various ways on different types of cameras. Sometimes an 

indication of correct exposure is achieved when a lever on 

the right-hand side of the view�nder frame is positioned 

between a - sign and + sign, or by a green light or 

numerical display (see �gure 1.5F).
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Figure 1.5F Common types of light meter as seen through a view�nder

It is important to understand that different cameras take 

their readings from different parts of the frame. As a result, 

it is important to consider what part of the frame your 

camera is taking its reading from. It is a common mistake 

to take the reading from the wrong section of the frame, 

making the chosen subject incorrectly exposed. This often 

occurs when the subject is small and does not �ll the frame, 

or is positioned to the side of the frame, or when there is a 

bright light behind the subject. Always ensure that you are 

taking the reading from your main subject (see �gure 1.5H). 

Some digital cameras provide a range of options on where 

the light reading is taken from (see �gure 1.5G).

i. Average metering: takes readings from the entire 

image and calculates an average; commonly used 

in 35mm SLR and compact cameras.

iv. Evaluative metering: the most high-end and complicated 

of all the systems. It takes readings from a number of different 

points throughout the frame and then compensates for darker 

or lighter elements to gain a global exposure reading.

ii. Centre weighted average metering: similar to 

average metering yet pays more attention to 

what is in the centre of the frame.

iii. Spot metering: takes a reading 

from a small circular area in the 

centre of the frame.

Figure 1.5G Standard metering modes

Older style 35 mm cameras are fully manual and require 

the use of a built-in light meter to gain the correct exposure 

for every shot. These cameras will generally have average 

metering systems (see �gure 1.5G (i)), taking the light 

reading from the entire frame. This is a problem if the 

subject is not taking up the entire frame and light is coming 

in from behind the subject. In order to rectify this problem, 

point the camera directly towards the main subject when 

taking the reading. If the subject is small and does not 

take up the entire frame you may need to move in until the 

subject �lls the frame, take the reading then move back 

before taking the shot. By doing this, you will gain a correct 

reading from the subject. However, make sure that you 

are not creating a shadow by blocking any light that would 

otherwise be shining on the subject (see �gure 1.5H).

Figure 1.5H It is very common for beginners to forget to take the light 

reading directly off the subject. In this photograph the reading was taken 

from the sun in the background.

Figure 1.5I Silhouettes can be easily created during a sunset, when all 

the light is coming from behind the subject. The light reading is taken from 

the sky and not the �gure, resulting in the �gure turning black. Sunset Joy, 

Anthea Sidiropoulos, Year 11, digital photograph

Grey cards
Light meters are built to read all subjects as grey. 

Therefore, if you are photographing something basically 

white (bright) or basically black (dark), the light meter will 

probably give you an incorrect reading. To ensure a correct 

reading, place a grey card (which re�ects 18 per cent of 

light) in front of the subject before taking your reading. You 

can purchase these from photographic shops or you can 

improvise with some normal grey card.
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alternative combinations of aperture 

and shutter speed setting
When you have worked out the correct exposure reading 

using the light meter, you can then decide what aperture 

and shutter speed options you have. In most cases 

you should have a choice of settings, with different 

combinations of shutter speed and apertures equalling 

the same exposure. Decide what is your priority � the 

aperture size or shutter speed � and select your setting 

accordingly. For example:

f.5.6 (aperture size) by 
1

250
 (shutter speed) = correct 

exposure

f.8 (aperture size) by 
1

125
 (shutter speed) = same correct 

exposure

f.11 (aperture size) by 
1

60
 (shutter speed) = same correct 

exposure.

Automatic cameras tend to choose the best average 

aperture and shutter speed available. On some cameras 

these settings will appear when you look through the 

view� nder, either at the side or bottom of the viewing 

frame (see � gure 1.5F). In most cases you have some 

control over these settings; for instance, if you want a 

faster shutter speed, you can move the aperture to a 

smaller f-stop number. Alternatively, if you want a larger 

f-stop number, you can slow down the shutter speed.

Hand-held light meters
Many professionals use hand-held light meters to gain 

correct exposure readings. They � nd these easier to use 

because they tend to be more accurate and are more 

convenient for taking a reading directly from the subject, 

particularly if they are using a tripod. Having taken the 

reading, a hand-held light meter will give a full range of 

possible aperture and shutter speed settings appropriate 

to the lighting conditions and the ISO.

Power

Select mode

Mode setting

Aperture 

f-stop setting

Select ISO

Set light 

meter

for reading

Select

shutter

speed

and ISO

Shutter

speed

setting

Figure 1.5J Hand-held light meter

Bracketing
If you are ever in doubt about your reading, you should 

�bracket�. Bracketing is taking the same photograph three 

times: once using the recommended aperture setting, once 

using the f-stop below the recommended aperture setting, 

and once using the f-stop above the recommended aperture 

setting (for example, f.5.6, f.8 and f.11). This should 

guarantee at least one shot will be correctly exposed. 

(See � gure 1.5K for an example of three photographs of the 

same subject, each taken with a different exposure.)

Some digital cameras have a bracketing setting, which 

sets the camera to automatically bracket each shot for you, 

i. Underexposed ii. Correct exposure iii. Overexposed

Figure 1.5K Three photographs of the same subject taken with different exposures
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ensuring that at least one correct exposure will be 

achieved from the three images taken (see �gure 1.5L).

Figure 1.5L Example of a bracketing symbol  

on a digital camera

White balance

The colour and tone of objects and their surroundings 

are affected by the light source that illuminates them, yet 

the human eye often does not see these effects. When 

we look at something under everyday household electric 

lights (tungsten globes rather than �uorescent), things do 

not appear with an orange tinge. However, if you have ever 

taken a photograph indoors without a �ash and the tones 

have turned out orange, this is because of the tungsten 

light. The effective elements of a light source are referred 

to as the colour temperature and different lights have 

different temperatures. The white balance system has 

been put into digital cameras to correct this imbalance in 

light temperature. Most digital cameras will be set on AWB 

(auto white balance), with many providing the option to 

select from a menu of different light conditions. If you �nd 

that your photographs are maintaining correct colour, you 

do not need to change to a select setting � this is only 

necessary if the colours of your photographs are turning 

out unnatural or arti�cial.

AWB i. Auto white balance

ii. Daylight

iii. Shade

iv. Overcast, early morning or late afternoon

v. Tungsten light

vi. White/�uorescent light

 vii. Flash

Figure 1.5M Common white balance settings

i. An image taken inside under tungsten light without a WB setting

Figure 1.5N

ii. The same subject taken on a tungsten WB setting
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1.  Study your camera and, if possible, its manual 

to work out how the camera�s light meter works. 

In your workbook or journal, write a brief outline 

in your own words of how to use your light meter 

correctly, including diagrams and illustrations 

as appropriate.

2.  Take a light reading of a chosen subject and record 

the recommended aperture and shutter speed. Using 

the same subject under the same lighting conditions, 

give three alternative combinations of aperture and 

shutter speeds that would allow you to achieve the 

same correct exposure.

3.  Record a light reading taken from a piece of white 

card, a piece of black card and a piece of grey card, 

all under the same lighting conditions. Outline the 

suggested settings and comment on the results.

Digital cameras only

4.  Outline the ISO options available on your camera 

and explain how you would go about selecting a 

particular setting.

5.  Using a digital camera, take a series of images 

exploring bracketing and white balance. Take the 

same subject matter in the same location but use 

three different exposure settings and at least three 

different white balance settings. Download the 

images and print a proof sheet of your results. 

Glue the proof sheet into your workbook or journal 

and analyse the various results achieved using 

different settings.

activitieS

Studio lighting
An exciting way to learn how light works and affects its 

subject matter is to take photographs under controlled 

lighting conditions. The easiest way to do this is by using 

a studio and studio lighting. If you do not have access to 

a studio or studio lighting, you can improvise by using any 

room in which the lighting can be controlled. However, the 

lights you use must be a lot stronger than standard globes.

By using studio lights, you have total control over how 

your subject is lit. You can experiment and be creative by 

lighting your subject from different angles, such as from 

one side only, from behind, from in front, from below or 

from above (see � gures 1.5P and 1.5Q). You can also 

create an evenly lit subject by placing your lights at angles, 

allowing the light to fall evenly onto the subject.

Direct light can be harsh, particularly in portraits, so 

specially designed equipment can be used to bounce and 

diffuse the light. A studio light can be � ltered and diffused 

through a partly transparent white silk or umbrella, for 

example. Alternatively, the light can be directed away from 

the subject and bounced back using a re� ecting surface.

i. A diffusing umbrella ii. A re� ecting umbrella

Figure 1.5O Lighting umbrellas

 Fill light
Key light

Back light

Figure 1.5P A three-point lighting system

The three-point lighting system is one of the most 

popular studio lighting setups. It consists of a key light, 

a � ll light and a back light. The key light is the main light 

source and is usually positioned at a 
3

4
 angle to the left of 

the subject. It is pointed directly at the subject and often 

� ltered through a diffuser. The � ll light is the secondary 

light source and is used to � ll in the shadows created by 

the key light. It is generally positioned at a 
3

4
 angle to the 

right of the subject. This light is generally softer and can 

be diffused in a soft box (see � gure 1.5P). Alternatively, 

a re� ecting umbrella can be used (see � gure 1.5O) or a 

bounce board. The back light tends to be quite bright and 

is placed behind the subject to create a rim of light around 

its exterior.

It is possible to use many different lights within a studio 

setting. One direct light source can produce dramatic 

effects; two lights over the subject can produce a balanced 

light source; and a third light source behind the subject can 

further illuminate it. You may also want to consider using 

different strengths of light on your subject, particularly when 

using two or three lights, as indicated above. This will create 

a range of tones over your subject matter.
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Figure 1.5Q This photograph was taken using studio lighting. Distress, 

James Ballarin, Year 12, gelatin silver photograph

Figure 1.5R This photograph was taken using available light. Silence, 

Johanna McCubbin, gelatin silver photograph

1.  Take a series of portrait photographs using a studio 

and studio lighting. Be as creative and imaginative 

as you can with the way you light the subject. Try a 

number of different types of lighting setups. You may 

also use some props, such as musical instruments, 

sporting equipment, hats and sunglasses.

2.  Develop the roll of � lm or download the images and 

print a proof sheet. Glue the proof sheet into your 

workbook or journal and comment on the outcome 

of the photographs.

3.  Select your best two shots, print them and submit 

them as part of your folio.

4.  Make a series of comments on what you have learnt 

from the experience.

activitieS

 1.6  TAKING 

PHoToGRAPHs
Taking photographs can be an enormously exciting and 

rewarding experience. Most of us at some stage have had 

the opportunity to take photographs, whether of family 

and friends at Christmas or of holiday scenes. Usually, 

our primary aim in taking these kinds of photographs 

is to capture and record a moment. In these situations 

we rarely consider using photography to be creative, to 

express ourselves or to re� ect our views of society 

Figure 1.6A Loading � lm into 

a traditional 35 mm SLR camera. 

Most modern 35 mm SLR cameras 

have automatic � lm loading systems.
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and the world around us. However, photography can  

be all these things and more.

Once you have mastered the art of taking photographs, 

you are free to take a photograph of your friend�s birthday 

party or a personal interpretation of a chosen subject or 

theme. You can develop your photographic skills to express 

ideas and feelings about things that are of interest or 

concern to you. The possibilities are endless.

When you have developed a good understanding  

of how your camera works, you should be ready to take 

your �rst roll of �lm or take your �rst digital shoot as  

a serious photographer. To do this successfully, apply  

the following procedure.

Steps in taking photographs
� Step 1:

� All cameras. Ensure that your camera lens is clean 

(wipe over the lens with a soft, dust-free cloth) and 

that the battery in the camera is charged.

� Step 2:

� 35 mm SLR. If using a manual camera, make sure that 

you have checked the �lm�s ISO and have adjusted 

the �lm speed dial accordingly. On older SLR cameras 

you will need to do this manually; modern automatic 

cameras read the �lm speed (ISO) directly from the 

barcode on the �lm cassette (see �gure 1.5C (ii),  

page 21), so there is no need to set the �lm-speed dial.

� Digital SLR and compact cameras. Press the �info� 

button on the back of the camera (see �gure 1.1I,  

page 7) or check your LCD for all your settings. Ensure 

that your image size, AF, ISO, AWB, battery level, and 

remaining shot space settings are all appropriate.

� Older style 35 mm SLR cameras. Load the �lm into the 

camera (see �gure 1.6A). If you are using a manual 

35 mm camera, in most cases you will need to pull up 

the rewind lever in order to open it. Some cameras 

have an opening switch on the side of the camera�s 

body. Once the camera is open, place the �lm in the 

space provided on the left. Then pull a small section 

of �lm from the cassette and place it in the slot on 

the �lm take-up spool at the right of the camera. 

When you thread the �lm, ensure that you keep it tight 

and thread it back towards the �lm cassette. Using 

the transport lever, wind the �lm on to ensure that 

it has gripped onto the sprockets and is therefore 

loaded correctly. Close the back of the camera and 

then take two shots to clear the exposed �lm and give 

you an unexposed frame to commence taking your 

photographs. Use the �lm rewind lever to check that 

the �lm is loaded correctly. Once the �lm is loaded, 

wind back the �lm just enough to make it taut. When 

the frame is advanced, the rewind lever should turn 

against the direction of the arrow. If it does, the �lm  

is loaded correctly.

� Modern 35 mm SLR cameras. On most modern 

cameras, loading your �lm tends to be quite easy. All 

you normally need to do is open the camera back, 

place the �lm in the slot on the left, pull the �lm over 

until it sits evenly on the sprockets, then close the 

camera. The camera should then automatically wind 

the �lm on two frames to remove the exposed �lm 

and set it up for your �rst shot.

� Step 3:

� All cameras. Select your subject and think of how 

it would be best placed within the camera�s frame. 

Try to be creative. You may wish to photograph your 

subject from an imaginative viewpoint, such as above 

the subject so you can look down on it, or below the 

subject so you can look up at it. Do not restrict your 

awareness to the main subject; everything else in 

the frame is important too. The way you compose 

the objects and elements within your photograph is 

called composition (see section 8.1, pages 142�7). 

Figures 1.6B and 1.6C are examples of good and bad 

composition. Also remember that you have a choice 

about the way you hold the camera (see �gure 1.6F).

  Timing is often a very important element in capturing 

the perfect image. Be patient and prepare yourself for 

the right moment to press the shutter release.

Figure 1.6B A portrait demonstrating bad composition

Figure 1.6C A portrait 

demonstrating good 

composition
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� Step 4:

� All cameras. While structuring the composition of your 

photograph, you will need to check how the subject is 

lit; that is, where the light is coming from and how it 

will affect your photograph.

� Step 5:

� 35 mm SLR camera. When you have decided on 

composition, you can take a light reading and set your 

aperture and shutter speed accordingly. Remember 

to take the reading from the subject and not the 

background (refer again to �gure 1.5H, page 22).

� Digital cameras. At this point you may consider 

switching your camera to a creative or basic zone 

setting (see symbols on pages 7 and 9) or possibly 

 a scene setting (see symbols on page 9) if your 

camera has this option.

� Step 6:

� All cameras. Focus the image. Ensure that your main 

subject is in focus and that you are aware of the 

depth of �eld.

� Step 7:

� All cameras. Hold the camera steady and take 

the photograph. It is important to always hold the 

camera with two hands and to ensure that nothing 

is obstructing the lens (such as hair, a �nger or a 

camera strap). Figure 1.6F demonstrates ways to  

hold the camera.

� Step 8:

� Digital cameras. To ensure correct focus, composition  

and exposure, play back the image once it has been 

taken. You may also want to check that you have 

not taken a photograph of a person in the middle of 

blinking and that no other unforeseen element has 

affected the quality of your shot.

� Step 9:

� All cameras. Repeat the process described in steps 4  

to 8 until you �nish your shoot.

� Step 10:

� Older style 35 mm SLR cameras. When you come to 

the end of the �lm, never force the transport lever. If it 

becomes dif�cult to wind on, you may be at the end of 

the �lm. Although some �lms indicate that they have a 

certain number of exposures (for example, 12 or 24), 

you may get an extra one or two exposures if you load 

the �lm carefully. Press in the sprocket release and 

rewind the �lm. You will know that you have all the 

�lm back in the cassette when the �lm loosens and 

becomes very easy to wind. You can also hear a click 

as it releases from the �lm take-up spool.

� Modern 35 mm cameras. These will automatically rewind 

the �lm back into its cassette at the end of the �lm.

� Digital cameras. Depending on the size of the memory 

card in your digital camera and the �le size of the 

images you are shooting, you may be able to shoot 

hundreds of images. When the memory card is full, 

you will be unable to take any more photographs 

unless you delete some or all of the shots.  

Ensure that you download and save any desired 

images before deleting them from the camera.

� Step 11:

� Older style 35 mm cameras. At this stage, open your 

camera and take out your �lm. It is now ready for 

processing. Keep your �lm in a cool, dry, dark place 

until it is processed.

� Digital cameras. Download your images onto a 

computer and review the outcome of your shoot.

� Step 12:

� All cameras. When you are developing skills in 

taking photographs, it is a good idea to record the 

subject, f-stop and shutter speed that you use for 

each shot. This information will be helpful when you 

have developed the �lm or downloaded the images, 

because you can then use it to interpret the outcome 

of each photograph (see �gure 1.6G, page 30).

35 mm SLR checklist compLeteD

  1. Check the lens is clean and 

 the battery is charged.

  2. Check that the ISO is set 

correctly.

  3. Load the �lm and check that 

you have done it correctly.

  4. Select your subject matter, 

composition and viewpoint. 

(Consider moving in closer to 

your subject, creating a tighter 

composition.)

  5. Take a light reading from the 

subject and ensure correct 

exposure by setting your 

aperture and shutter speed 

accordingly.

  6. Focus the subject.

  7. Hold camera steady and take 

the photograph.

  8. Record subject, f-stop and 

shutter speed.

  9. Repeat steps 4 to 8 until the 

�lm is �nished.

10. Older 35 mm SLRs will require 

you to press in the sprocket 

release button before you 

manually rewind the �lm. 

Modern 35 mm SLR cameras 

will automatically rewind the 

�lm when it is �nished.

Figure 1.6D Checklist for taking photographs using a 35 mm SLR camera
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Digital SLR checklist compLeteD

  1. Check the lens is clean and 

the battery is charged.

  2. Press the info button on the 

back of the camera to check 

your AF, ISO, WB, shot space 

and image quality settings.

  3. Select your subject matter, 

composition and view point. 

(Consider moving in closer 

to your subject, creating a 

tighter composition.)

  4. Consider selecting an 

appropriate mode or setting 

on the camera to enhance 

the quality of your photograph 

(e.g. portrait setting if you are 

taking a portrait).

  5. Examine how your subject is 

lit and where the camera is 

taking the light reading from.

  6. Check the aperture and 

shutter speed settings.

  7. Focus the subject.

  8. Hold camera steady and take 

the photograph.

  9. Record subject, f-stop and 

shutter speed.

10. Play back the image to 

ensure it has been taken 

correctly.

11. If you need to, reshoot the 

image; if not, consider other 

angles, viewpoints and 

compositions for the same 

subject matter � these may 

add interest and creativity to 

the photograph.

12. Repeat steps 4 to 11 until 

you have explored all options 

for the subject matter that 

you had intended to explore.

Figure 1.6E Checklist for taking photographs using a digital camera Figure 1.6F Ways you should hold a camera
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Assignment:        

Camera used:        

Film, memory card used:       

Date:    Lens:   

Frame 

number f-stop

Shutter 

speed Subject Notes

  1

  2

  3

  4

  5

  6

  7

  8

  9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

Figure 1.6G Proforma to use when taking photographs for different assignments and tasks
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activitieS

In pairs or in small group, complete the following tasks.

1.  You must follow the directions carefully to complete this 

task successfully. Always remember to focus every shot, 

check your light meter, and be aware of the aperture, shutter 

speed and composition. Record your settings on a copy of 

the proforma at �gure 1.6G. Using a roll of �lm or a digital 

camera, take two shots of each of the following subjects:

a.  a close-up of a face (approximately one metre away)

b.  a close-up of another object

c.  a subject at medium range (two to three metres)

d.  a landscape

e.  looking up at a subject

f.  looking down at a subject

g.  from imaginative and interesting angles

h.  a moving subject � use a shutter speed of 
1

30
 of a 

second (remember to check your light meter)

i.  a moving subject � use a shutter speed of 
1

1000
 of a 

second

j.  a moving subject � use a shutter speed of 
1

3
 of a 

second. Move the camera with your subject as you take 

the shot to blur the background.

 In addition, take two shots demonstrating:

k.  a small depth of �eld, using an aperture  

of f.2 or f.4

l.  a large depth of �eld, using an aperture  

of f.18 or f.22.

2.  Develop the �lm or download the images and print a proof 

sheet for every member of the group.

3.  Paste the proof sheet into your workbook or journal and 

comment on the outcome of the photographs. Also comment 

on any problems you had when taking the shots and how 

you might avoid these problems in the future.

4.  Select the best image that you shot and print it as a 

photograph. Present it as part of your folio.

5.  Present your most successful photograph to the class  

and evaluate it. You need to comment on what you think  

are the most successful qualities of your image. Then ask 

other students to comment on what they think of your 

photograph. Each member of the class should take it in  

turn to evaluate their photograph.



Darkroom processes and 
procedures

2.

 2.1  DARKROOM SAFETY
The information presented in this section is general 

advice on ways to improve health and safety in your 

classroom. However, it is important for your teacher 

to contact the local education authority for detailed 

information on health and safety regulations regarding 

photography and the darkroom.

Developing and processing your own black and 

white photographs can be perfectly safe if you use the 

equipment and materials correctly. Commonsense prevails 

in most situations and it is therefore rational to commence 

by setting up your darkroom in a way that minimises the 

possibility of hazardous situations occurring. It is also 

important to be aware of the possible dangers and how to 

deal with them in a safe and healthy way.

The following darkroom rules take into consideration 

health and safety issues:

� no eating or drinking

� no smoking

� no running or playing

� treat all chemicals with respect

� wash your hands at the end of each session.

Setting up the darkroom
The design of your darkroom should be carefully 

considered. It should maximise the working space and 

take into consideration health and safety issues.

All darkrooms, large or small, should have separate wet 

and dry areas. The dry area must provide enough space to 

house the enlarger, negatives and photographic paper. It 

should also allow for a clear, clean and dry working space, 

as well as an electrical outlet for the enlarger. The wet 

area is where the chemicals, trays and sink will generally 

be located.

It is important that proper ventilation is installed near 

and preferably behind the chemical trays, to extract the 

chemical fumes directly from the trays. The fumes are 

not considered to be toxic but can irritate and cause 

headaches and dizziness if not properly extracted. Should 

this occur, the students affected must be removed from 

the contaminated area as quickly as possible.

As you will be working mostly in � ltered lighting, it is very 

important that nothing is left on the � oor or on benches 

that you could bump into or trip over. All parts of the 

darkroom, including chemicals and trays, should be clearly 

labelled to prevent confusion. It is also important to be 

aware that the top part of the enlarger becomes very hot if 

it is left on for an extended period of time. This can cause 

burning if it comes in contact with skin.

Figure 2.1A Ensure that you label the trays.
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spills
If any spills occur you should clean them up immediately 

to prevent yourself and other students from slipping or 

inhaling fumes. Chemical spills are best cleaned with 

an absorbent such as sand, cleared away, and the area 

washed with plenty of water.

Chemicals spilled on clothing can cause permanent 

stains, therefore it is wise to wear protective clothing.

disposal
Schools and colleges must obtain a waste discharge 

permit from the local Water Board or Sewerage Authority. 

This will allow them to dispose of small amounts of 

chemicals through normal domestic and industrial outlets. 

The suspended silver in exhausted � xer is of value to 

some companies and may be sold in bulk (from 25 litres 

upwards). Your teacher should contact the nearest 

photographic supplier to � nd out more details.

using the chemicals
It is wise to be both sensible and careful when using 

photographic chemicals. Although they are not considered 

to be highly dangerous, improper use can be harmful.

The main problems that can occur are generally 

a result of accidents. If the chemicals are splashed 

into eyes or swallowed, it is important to be aware of 

what to do. Always carefully read the manufacturers� 

instructions and warnings, then adhere to their 

advice and recommendations.

First-aid advice
This � rst-aid advice is given for basic black and white Ilford 

photographic chemicals, including developer, stop bath and 

� xer. If other chemicals are being used it is important that 

you check the � rst aid advice from the Safety Standards 

Association (SSA). In an emergency, contact the Poisons 

Information Centre in your capital city.

Swallowed: Do not induce vomiting. Give the person a 

glass of water and seek medical advice.

Eyes: Hold eyes open and � ood with water for at least 

15 minutes. See a doctor.

Skin: Remove contaminated clothing and wash skin 

thoroughly.

First-aid facilities: An eye-wash facility is strongly 

recommended.

In some cases a student may be allergic, or build up an 

allergy, to the chemicals. A cut on a hand placed in the 

chemicals may result in stinging. If you have chemicals on 

your hands and you then place them in your mouth, this 

can be harmful. For all these reasons it is a good idea to 

use tongs whenever possible and keep your hands out of 

the chemical trays. After each session in the darkroom 

wash your hands thoroughly with hot soapy water.

Figure 2.1B Always wash your hands thoroughly after working 

with chemicals.

personal protection
There are a great many precautions that you can take 

while working in the darkroom. Some listed below may 

seem a little extreme; however, it is important for you to 

consider personal protection.

Eyes: wear safety goggles.

Hands: wear rubber (PVC) gloves.

Clothing: wear a rubber (PVC) apron.

Respiratory: where ventilation is inadequate, you could 

wear an SSA approved air purifying respirator.

1. In your class, discuss all relevant health and safety 

issues. Consider ways that you could improve 

the health and safety environment within 

your darkroom.

2. If the chemicals you are using are not Ilford 

developer, stop bath and � xer, contact the Safety 

Standards Association and � nd out the correct 

� rst-aid advice for your brand of chemicals.

3. Make a poster that advertises some aspect of 

health and safety in the darkroom. Once completed, 

display the posters around the darkroom and 

classroom to remind people of the importance of 

health and safety. 

activities
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 2.2  DEVELOPING FILM 

INTO NEGATIVES
It is always a very exciting time when you � rst start to 

develop your own rolls of � lm into ���������. The 

process is not dif� cult but each stage is essential to 

achieve a successful outcome. Each step must be 

completed as stated.

equipment and materials

You will need the following equipment and materials 

to develop your � lm into negatives: cassette cap 

remover; measuring container; 

thermometer; scissors; 

exposed � lm; darkroom or 

black bag; developing tank, 

lid, centre support, 

reel and cap; 

� lm developer; 

stop bath; 

� lm � xer; wetting 

agent (optional); 

negative � le.

Figure 2.2A 

The parts of a standard developing tank

procedure

step 1: loading the FilM

1. Collect all of the equipment and materials and place 

them on a bench in the darkroom. Ensure that you have 

all parts of the tank, cassette opener, reel, a pair of 

scissors and exposed � lm. Make sure that you are 

comfortable and know where everything is, then turn 

out the light so that you are in complete darkness. If 

you do not have access to a darkroom, you can use a 

����� ��� or a very dark cupboard.

2. In complete darkness, pick up the � lm and � lm 

cassette opener. Using the opener, pry open one end 

of the � lm cassette (see � gure 2.2D).

3. Take the � lm out of the cassette and hold 

onto it tightly with one hand. 

With the other hand 

pick up the reel 

and � nd the 

two lugs which 

indicate the 

entry to 

the reel.

Figure 2.2B Ensure 

that you have all of the 

equipment you will need 

for developing the � lm.

eveloping tank

Figure 2.2C A black bag 

may be used if you do not 

have access to a darkroom.

Figure 2.2D Opening the � lm cassette

Figure 2.2E The � lm reel

4. Carefully pull the start of the � lm through the opening 

of the reel. Continue pulling it through until it is about 

halfway around the reel (see � gure 2.2F).

5. You may now let go of the � lm. Place a hand on either 

side of the reel and rotate your hands back and forth 

about three to � ve centimetres at a time. This will 

wind the � lm onto the reel. Placing your thumbs on the 

lugs of the reel will help keep the � lm on track (see 

� gure 2.2G).

6. When all of the � lm is on the reel you will feel the end 

of the � lm, which is attached to a small plastic spool. 

Using scissors, cut off the spool and wind on the 

remaining small section of � lm.

7. Place the loaded reel onto the centre support and 

into the tank, ensuring that the lid is secure (see 

� gure 2.2I). You may now turn on the lights.
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Figure 2.2F 

Pulling the start of the � lm 

through the reel

Figure 2.2G 

Winding the � lm onto the reel

Figure 2.2H 

Cutting off the � lm 

at the end of the reel

Figure 2.2I 

Placing the loaded 

� lm in the tank

points to remember

� Ensure that the reel is in working order. Most reels come apart 

and are sometimes put back together incorrectly.

� If your reel is damp you will � nd it very dif� cult to load the 

� lm. Always tap the reel very lightly against a bench to check 

that it is dry before use.

step 2: the cheMical process

1. Set up all the chemicals, materials and equipment that 

you will need. There are a variety of brand names and 

different types of chemicals available. It is important for 

you to know which kind and type of chemical you are 

using, in particular:

� the water-to-chemical ratio required

� the correct temperature for use of the chemicals 

(almost all chemicals operate best at 20 degrees 

Celsius)

� the amount of time you need to use the chemical for 

it to be effective.

Write this information in your workbook or journal so 

you will have it on hand at all times.you will have it on hand at all times.

Figure 2.2J The processing equipment and materials you will need to 

develop the � lm

2. Film developer. The role of the developer is to develop 

the negative image onto the � lm.

The type of � lm you use, particularly the brand and 

ISO, has a direct in� uence on the required developing 

time. Developing time can change quite dramatically from 

one type of � lm to the next, therefore it is important to 

use the correct developing time for your � lm type and 

ISO. Write the following information in your workbook or 

journal so you will have it on hand at all times.

Film brand  

Film�s ISO  

Brand of developer  

Water-to-chemical ratio  

Temperature  

Time  
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If you are required to mix the chemical with water, 

always ensure that the water is the correct temperature 

before pouring in the chemical.

When you have mixed the developer and ensured it is 

the correct temperature, pour it into the tank, place the 

cap on the lid and agitate it (gently rock the 

tank upside down 

and back again) 

for about � ve 

seconds, every 

30 seconds. 

When the 

developer has 

been in the tank 

for the required 

amount of time, 

take off the cap 

and pour it out.

Figure 2.2K Agitating the developer 

in the tank

3. Stop bath. The role of the stop bath is to stop the 

action of the developer and neutralise 

the � lm in readiness for the third chemical, the � xer. 

The stop bath also prolongs the life of the � xer.

Write the following information in your workbook or 

journal so you will have it on hand at all times.

Brand of stop bath  

Water-to-chemical ratio  

Temperature  

Time  

When you have ensured 

that the stop bath is 

correctly mixed, 

pour it into the 

tank, put the cap 

on and agitate 

constantly for the 

required time. 

Then take off the 

cap and pour it 

into the tank.

Figure 2.2L Pouring the stop bath 

into the tank

4. Film fi xer. The � xer works to make the negative image 

permanent.

Write the following information in your workbook or 

journal so you will have it on hand at all times.

Brand of � xer  

Water-to-chemical ratio  

Temperature  

Time  

When you have mixed the � xer and ensured that it is 

at the correct temperature, pour it into the developing 

tank. Place the cap on and agitate it for � ve seconds 

every 30 seconds, for the 

time required. Then 

take off the cap and 

pour out the � xer. 

Some � xers can 

be re-used, so 

check to see if 

you can pour the 

� xer back into a 

bottle and not 

down the sink.

Figure 2.2M Pouring the � xer

5. Water/wash. On completing the chemical process use 

water to wash any remaining chemical from the � lm. 

You may do this by placing the tank under running water 

for � ve minutes, or you may use the following method 

which uses less water:

a. Fill the tank with water, secure the cap and shake it 

for one minute, then tip out the water.

b. Fill the tank with water, 

replace the cap and 

shake it for 

30 seconds, 

then tip out 

the water.

c. Fill the tank 

with water, 

replace the 

cap and shake 

it for 15 seconds, 

then tip out the 

water. This method 

should clean the � lm 

adequately.

Figure 2.2N Water washing the � lm

points to remember

� During the � nal rinse you may wish to add a small amount of 

wetting agent to help ensure the � lm is clean.

� Ensure that the lid of the developing tank has been put on 

properly. If the lid comes off accidentally before the � lm is 

� xed, your � lm will be exposed to light and may be ruined.

� Make sure that you follow the chemical times, temperatures and 

water-to-chemical ratios exactly as stated. It is not dif� cult to get 

the chemicals in the wrong order or to lose track of timing.

� If you want your negatives to turn out correctly you must be 

vigilant during the chemical process.

� Agitating the chemicals is a very important part of the chemical 

process. You can overagitate and underagitate the chemicals.
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step 3: drYing process

Take the lid off the developing tank and retrieve the � lm 

reel. Very carefully pull the exposed edge of the � lm away 

from the reel. Be careful not to put your � ngers anywhere 

except on the edges of the � lm.

Excess water can be 

removed with a squeegee. 

Hang the � lm in a 

clean, dust-free 

environment to dry.

When the � lm 

is dry, cut it into 

strips of about � ve 

or six negatives and 

put them in a plastic 

negative � le.

Figure 2.2O Hanging the � lm using tongs

common faults in negatives

overeXposed negatives

o���������� negatives occur when you allow too much 

light onto the � lm when you are taking a photograph. To 

prevent this you should ensure that you check your light 

meter before taking each shot.

undereXposed negatives

u����������� negatives occur when you do not let enough 

light onto the � lm when you are taking a photograph. To 

prevent this ensure that you check your light meter before 

taking each shot.

overdeveloped negatives

Overdeveloped negatives occur when one or more of the 

following has happened:

� the developer was left in the tank for too long

� the temperature of the developer was too warm

� too much developer was used.

To prevent the above occurring, you must ensure that 

you mix the developer correctly, and the time and chemical 

temperature used is correct.

underdeveloped negatives

Underdeveloped negatives occur when one or more of the 

following happens:

� the developer was not left in the tank long enough

� not enough developer was used

� the temperature was too cold

� old developer was used.

To prevent the above occurring, you must ensure that 

you mix the developer properly, the time used is correct 

and that you check the expiry date of the chemical.

Figure 2.2P Common faults in negatives

Overexposed Underexposed Overdeveloped Underdeveloped Black Clear
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blacK negatives

If all of your � lm turns out black it means that it has been 

exposed to light.

clear negatives

If all of your negatives are clear it means that your � lm 

may not have been exposed to light. This means you 

either did not load the � lm properly, you did not take any 

photographs, or you put the � xer in before the developer.

Good quality negatives
A successful negative will have the following qualities:

� a clear sharp image

� a variety of tones from very light to very dark

� be clean and free from dust marks and � ngerprints

� be evenly developed.

Figure 2.2Q Good quality negatives

1. After taking a roll of � lm, develop the � lm into 

negatives and place them in a negative � le.

2. In your workbook or journal, complete a 

comprehensive report on the process and procedures 

you undertook to develop the � lm into negatives. 

Include any speci� c equipment and materials that 

you used as well as any problems that you faced.

3. Write a detailed description on the outcome of 

your negatives in your workbook or journal. Include 

comments on both the good and bad aspects of 

your results.

activities

 2.3  PRINTING 

NEGATIVES INTO 

PHOTOGRAPHS
Having developed your negatives, you are now ready 

to start printing photographs. A straightforward 

procedure that must be followed precisely is used.

Developing photographs is really a case of �practice 

makes perfect�. The more experience you have, the 

better you will become at it. In many cases you will 

start processing your negatives by printing a proof 

sheet. The proof sheet will enable you to see all of 

your negatives as positive images. This will make it 

easy for you to select the negatives you would like to 

print (see section 2.4, pages 45�46, which explains 

how to print a proof sheet).

The darkroom

A darkroom is basically a light-tight room: when you turn 

off the light no other light should be seen. The darkroom 

must have:

� a dry bench space for exposing the negative onto 

photographic paper

� a wet bench space for processing the photograph

� easy access to running water

� good ventilation

� a � ltered ���������

� access to electrical outlets.
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Figure 2.3A A basic darkroom set up
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procedure

step 1: setting up

Ensure that the darkroom 

is completely set 

up. Collect all the 

equipment and 

materials that will 

be required. Set up 

the three processing 

trays as indicated in 

� gure 2.3D.

Just as there 

are different types 

of chemicals for 

developing negatives, 

there are also different types for printing photographs. 

In your workbook or journal, write the following 

information about the chemicals that you are using.

Tray one: paper developer

Brand of developer  

Water-to-chemical ratio  

Temperature  

Time  

Tray two: stop bath

Brand of stop bath  

Water-to-chemical ratio  

Temperature  

Time  

Tray three: paper fi xer

Brand of � xer  

Water-to-chemical ratio  

Temperature  

Time  

Figure 2.3D 

How to set up the three processing trays

Developer Stop bath Fixer

Figure 2.3D 

How to set up the three processing trays

Developer Stop bath FixerDeveloper Stop bath Fixer

Figure 2.3E Always check the temperature of 

the chemicals before processing.

Figure 2.3E Always check the temperature of 

the chemicals before processing.

equipment and materials

The following equipment and materials are essential in 

the darkroom: photographic enlarger; three processing 

trays; baseboard; � ltered safelight; tongs; scissors; timer 

(optional); focus magni� er; paper developer; stop bath; 

paper � xer; running water; photographic paper; 

� lters (optional).

Filter holder

Baseboard

Easel

Lens

Negative

holder

Bellows

Filter drawer

Lamp

Condenser

lens

Enlarger

dial

Focus

Figure 2.3B Standard black and white enlarger
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Figure 2.3C Basic photographic 

developing equipment

MMEE

F

11
ME

21
ME

112

3
4

567
8

9
10

11
2

Three trays Graduate

Timer Thermometer

Processing chemicals

F
C

Rubber gloves Tongs

Figure 2.3C Basic photographic 

developing equipment
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step 2: selecting a negative

It is always important to remember that it is very 

dif� cult to achieve a good quality photograph from a 

poor quality negative. When you � rst start to develop 

photographs it is wise to select the best quality 

negatives to print and not necessarily your favourite 

picture. This will produce successful photographs with a 

minimum of fuss. As you become more experienced and 

develop your skills in printing and processing, you can 

attempt the more dif� cult negatives.

When you have selected your negative you must 

ensure that it is clean and completely free from 

dust. Any marks on the negative will appear on your 

photograph so it is vital that you treat negatives with 

the utmost care. If your negatives have any kind of 

mark on them, you must clean them before processing. 

Use a blower brush or rewash your negatives to remove 

dirt, marks or dust.

step 3: using the enlarger

1. Pull the negative carrier out of the enlarger. 

Place your chosen negative into 

the carrier shiny side up 

and upside down, so 

the negative 

numbers face 

towards the 

back of the 

enlarger. Slide 

the negative 

carrier back into 

the enlarger 

(see � gure 2.3F).

Figure 2.3F The negative in the carrier 

of the enlarger

2. Turn the � ltered safelight on and the white room light off.

3. Switch on the enlarger and adjust the projected image 

to the required size.

4. With the aperture fully open, adjust the focus until you 

achieve a sharp image. If you photographed the image 

out of focus you will not be able to achieve a sharp 

image. You may choose to use a focus � nder to help 

you focus (see � gure 2.3G).

 Focusing can alter 

the size of your image, 

so this may need 

to be readjusted.

Figure 2.3G Using a 

focus � nder to focus on 

the image

5. Turn the lens aperture from full to f.8 to increase the 

edge sharpness and give more even illumination. 

Count the number of clicks so you can do it without 

looking at the lens. The actual aperture can vary, 

but should give you an exposure time of about 

10 seconds. For overexposed (dark) negatives you 

may select a 

smaller-number 

aperture, just as 

you may select 

a larger-number 

aperture for 

underexposed 

(pale) negatives.

Figure 2.3H Setting the 

aperture at f.8

step 4: printing a test strip

1. The negative acts like a � lter to the white light 

being projected on to the photographic paper. 

When a negative is dark, light struggles to get 

through. When a negative is pale, light travels 

through fairly easily. Photographic paper will react 

and become darkened by white light when it has 

been placed into the photographic chemicals 

(such as developer).

With this step you must � nd out how long you 

will need to expose light through your negative onto 

the photographic paper in order to give a correctly 

exposed print.

a. Cover the white light from your enlarger with a 

red safelight � lter, or turn it off.

b. Cut a medium size piece of photographic paper from 

your packet.

c. Place the piece of paper, shiny side up if you are 

using glossy photographic paper, onto the baseboard 

below the enlarger. If you are not using glossy paper, 

make sure the emulsion side of the paper faces 

up. The emulsion side 

re� ects the 

safelight 

differently to 

the reverse 

side of the 

paper and 

tends to be 

a lot 

smoother 

to touch.

Figure 2.3I Exposing the photographic paper
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d. Expose the whole of the paper to the enlarger 

light for two seconds. Cover a quarter of the paper 

with an opaque card and expose the rest for two 

seconds. Now cover half the paper with the card 

and expose it for a further two 

seconds. Finally, cover 

three-quarters of the 

paper with the card 

and expose 

it for two 

seconds. 

You should 

now have one 

piece of 

photographic 

paper with 

exposures of 

two seconds, 

four seconds, 

six seconds 

and eight 

seconds in 

each quarter.

2. Check the temperature in the developing tray to ensure 

that it is correct. Slide your ���� ����� smoothly and 

quickly into the developer, ensuring that it is totally 

immersed.

Rock the developing tray backwards and forwards for 

the appropriate time (approximately one minute). Using 

tongs (to prevent the chemicals getting on your hands) 

lift the paper out of the developer and allow to drain for 

about 10 seconds.

3. Slide the test strip of 

paper into the stop 

bath, ensuring that 

it is fully immersed. 

Rock the tray 

gently for the 

appropriate time 

(normally about 

15 seconds). 

Using a second pair 

of tongs, lift the strip 

out of the stop 

bath and drain 

for 10 seconds.

4. Slide the test strip into the tray of � xer and rock the 

tray to get a good � ow of chemicals over the surface 

of the print. Fixing generally takes approximately two 

minutes in fresh solution (check the requirements for 

the chemicals that you are using). It normally does not 

matter if the � xing time is exceeded, but you should 

not leave a print in the � xer for more than about 

10 minutes.

Figure 2.3J Using tongs to lift the paper 

out of the developer

Figure 2.3J Using tongs to lift the paper 

out of the developer

Figure 2.3K Sliding the test strip of paper

into the stop bath

Figure 2.3K Sliding the test strip of paper

into the stop bath

Figure 2.3L The test strip of paper in the � xer

5. Rinse the test strip under water and examine it under 

a bright light (daylight or room light). It will show four 

different exposure times ranging from light to dark. The 

lightest received only a two second exposure; the next, 

four seconds; the third received six; and the darkest 

strip received eight seconds. Write these times and the 

aperture you used on the test strip for future reference.

From the test, estimate the correct exposure for the 

� nal print. One exposure section should be about right, 

but if one strip is too dark and the next too light, the 

right exposure will be somewhere in between. If all 

the exposure sections are too light, open the aperture 

one stop (for example from f.8 to f.5.6) and repeat the 

test. If they are all too dark, close it by one stop (for 

example from f.8 to f.11) and repeat the test. When 

you have worked out the correct exposure you should 

be ready to print. Although exposure times are normally 

between 5 and 20 seconds they can vary from one 

second to more than � ve minutes, depending on the 

negative and the ����������� size.

Figure 2.3M Example of a test strip

You may decide to use graded � lters or graded paper 

to help improve the ��������� in your photograph. The 

higher the grade of � lter or paper the more contrast it will 

give your photograph (refer to section 2.4, pages 46�47). 

If you intend to use a � lter or graded paper it is always 

wise to start with a standard grade, such as grade 2. If 

you are using a strong � lter (such as grade 4) you may 

need to complete another test strip to ensure the correct 

exposure.
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Figure 2.3N Placing a graded � lter in the enlarger

step 5: printing a photograph

1. Switch the white light off and safelight on. Position 

the photographic paper under the enlarger. Expose 

the image onto the paper for the amount of time 

determined by the test print.

Test the temperature 

of the developer 

again and check 

the developing 

time. Repeat 

the chemical 

processes 

exactly as 

before.

Figure 2.3O The paper 

in the developer

2. Wash the print for � ve minutes in a good � ow of water 

which should be approximately 20 degrees Celsius. 

If you use photographic paper 

other than the plastic-coated 

paper (that is, RC paper) 

your wash time will be 

longer. Consult the 

directions supplied 

with your 

photographic 

paper. RC papers 

are recommended 

for � rst-time users 

because they are 

easy to handle.

Figure 2.3P Washing the print

After the wash, drain the print and use a squeegee or 

soft clean sponge to remove any excess water. Attach a 

wooden or plastic clip to one corner and hang the print 

over a drip tray to dry.

Drying can be speeded 

up by using a hair dryer 

on a low setting. 

Keep the dryer 

moving about 

30 centimetres 

away from the print. 

There are also 

commercial 

photographic 

dryers available.

Figure 2.3Q Drying the print

3. Examine the � nal print in bright natural light. The picture 

should contain a full range of tones from small areas 

of pure white (as white as the paper), to small areas 

of intense black, with a good range of grey in between. 

If this is not the case, check that you followed the 

instructions accurately.

Figure 2.3R A correctly developed photograph

4. Now that you have made a superb print, why not mount 

it for display? Mounting a photograph can � nish it off 

and give it a professional appearance (see section 6.1, 

pages 122�7).

Figure 2.3S A mounted photograph

common mistakes made when printing 

photographs

� You should test the exposure for every negative that you 

intend to print. Most beginners waste a great deal of paper 

because they become lazy and do not do test strips.

� Make sure that you follow the chemical procedure 

exactly. Many beginners become excited and do not leave 

their photographs in the chemicals for long enough. 
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The images may look fully developed; however, if they 

have not been left in the �xer for long enough the image 

will eventually discolour (discolouration may commence 

approximately one or two weeks later). This can also 

happen if the photograph has not been washed for long 

enough.

� Photographic chemicals can be badly affected by air 

and age. It is always wise to check the expiry date and 

replace the lid on the chemicals promptly after use.

� It is very important that you keep your hands clean and 

dry. It is very easy to mark your photographic paper with 

chemicals and stains.

� Ensure that you don�t move the paper or enlarger during 

exposure, otherwise your photograph will blur.

Figure 2.3T An unevenly developed photograph. Ensure that you place all 

of the print under the developing chemical for the same amount of time.

Figure 2.3U A print showing �ngerprint marks

Figure 2.3V A print blurred due to movement during exposure

Figure 2.3W Paper fogged while in the developer

Figure 2.3X The �lter used for this photograph was too strong and there is 

too much contrast in the print.

Complete the following in your workbook or journal.

1. Draw a diagram of your darkroom. Include the developing 

trays, chemicals, enlargers, safelights and white light. This 

should enable you to know where everything is placed inside 

your darkroom.

2. Draw a diagram of the enlarger you will be using. Label the 

focus, enlarger dial, lens, negative carrier, aperture, lamp  

and baseboard.

3. Record your experiences of printing your �rst few 

photographs. Glue in all your test strips, trial prints  

and �nal prints, then comment on their outcomes.  

Record the aperture, �lter or paper grade and exposure 

time for each print.

4. Outline any problems that you faced while printing your 

�rst few photographs.

activities
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 2.4  DARKROOM 

TECHNIQUES

Photograms
Photograms allow you to produce creative and imaginative 

images in the darkroom without having taken a 

photograph.

By now you know that photography paper reacts to light 

� the longer you leave the paper exposed, the darker it 

will become once placed in the developer. If you place an 

opaque object directly onto the paper and then expose 

it to light, you prevent light from reaching the paper 

where the object is. This technique allows you to create 

outlines and shapes of objects on photographic paper 

(see �gure 2.4A).

Figure 2.4A A photograph showing objects found at school. Some objects 

have been moved for a second after the initial exposure time of 10 seconds. 

This creates some grey tones in the image.

equipment and materials

You will need the following equipment and materials 

to produce photograms: enlarger; thermometer; three 

processing trays; timer (optional); tongs; dryer or 

pegs; paper developer; stop bath; �xer; photographic 

paper; interesting and imaginative objects to use in the 

photogram (for example, keys, string, wire, lace, pens).

procedure

1. Set up the darkroom in the usual way, including 

safelight, chemicals and enlarger.

2. Manipulate the enlarger so that the light rays will cover 

the size of paper that you will be using.

3. Turn the aperture on the enlarger to f.8.

4. Switch the safelight on and the white light off.

5. Place the light �lter over the enlarger and place a fresh 

piece of photographic paper under it.

6. Place your collected objects in an imaginative way on 

top of the photographic paper (see �gure 2.4B).

7. Expose the paper to the enlarger light for 10 seconds, 

then move or remove some of the objects (this will 

produce a grey tone where these objects have been). 

Expose the paper for a further one second.

8. Process the photographic paper using the chemical 

procedure and assess your results.

This is a creative exercise and you can explore and 

experiment with it to achieve whatever effect you wish.  

Try exposing the piece of photographic paper for a number 

of different times while moving the objects slightly (for 

example, one, two, four and six seconds). If you do this 

you will produce a number of different grey tones. However, 

it is always a good idea to leave one major object still, so 

an area will be left white.

The most common mistake that students make is to 

expose the photographic paper for too long. If you are 

having problems reduce the exposure time and/or use a 

larger �-���� number (for example, f.11 or f.16).

Figure 2.4B Setting up the enlarger to print a photogram
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Proof sheets and contact prints
Printing a proof sheet of your negatives will allow you to see 

all of your negatives as positive images. This will enable you 

to make a valid judgement about which negatives are worth 

printing as photographs. It is bene� cial to get into the habit 

of always printing a proof sheet of your negatives before you 

start printing them as photographs as they are a complete 

record of your � lm shoot.

Figure 2.4C An example of a proof sheet

equipment and materials

You will need the following equipment and materials to print a 

proof sheet: proof printing frame (see � gure 2.4D) or a sheet 

of glass; enlarger; three processing trays; thermometer; 

tongs; timer (optional); print dryer or pegs; paper developer; 

stop bath; � xer; photographic paper; negative � le; negatives.

Figure 2.4D A proof printing frame

procedure

1. Set up the darkroom in the usual way, including 

safelight, chemicals and enlarger.

2. Using the proof printing frame:

Open the proof printing frame and place your 

negatives (shiny side towards the glass) in the 

small slits provided.

Take the proof printing frame into the 

darkroom. Ensure the safe light is on and the 

white light is off.

Check the enlarger to ensure that the lamp 

is high enough to beam rays of light over the 

entire proof printing frame.

Slide a small fresh piece of photographic paper 

(as a test) into the proof printer with the shiny 

side facing the glass. Close the printer (it may 

need to click shut).

Turn the aperture on the enlarger to f.8 and 

place a light � lter over the lens.

Place the proof printing frame under the 

enlarger and ensure that all of it will be 

exposed to the light rays from the enlarger.

a.

b.

c.

d.

e.

f.

Figure 2.4E A test strip for a proof sheet
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Expose the paper to the light for four seconds,  

then cover a small portion of the paper. Expose  

the paper for an additional two seconds, then  

cover a bit more of the paper. Expose the paper  

for a further two seconds and cover a little more 

of the paper, then expose the paper for a �nal two 

seconds. This will give you a test strip of four, six, 

eight and ten second exposures.

Place the test strip in the developer, stop bath and 

�xer for the correct times. When it has been in the 

�xer for about 30 seconds to a minute you can  

look at the test strip under normal light conditions.

Select the best exposure time and then place  

a fresh piece of photographic paper into the  

proof printer (shiny side up) to print a  

full-sized proof sheet.

3. Using glass

If you do not have access to a proof printing frame 

you can use a small piece of glass instead. Use a 

similar process to the one described for the proof 

printing frame, but instead of placing the negatives in 

the printer, place them under the glass. When you are 

setting your negatives up to print, put a fresh piece 

of paper (shiny side up) under the enlarger, place your 

negatives on top of the paper (shiny side up), then put 

the piece of glass over the top to hold it all in place. 

Then proceed as described in step 2.

Figure 2.4F Setting up the enlarger to print a proof sheet using glass

points to remember

� Always ensure that the glass is clean and free from dust.

� Always produce a test strip �rst to check exposure times.

� If the negatives that you are using have different exposures, 

you may need to expose some longer while covering the others 

with an opaque card.

g.

h.

i.

Filters and graded paper
An ideal photograph will generally have areas that are black, 

white and many grey tones. By using �lters or graded paper 

it is possible to alter a print�s contrast (strengths of blacks 

and whites) by changing the grade of the �lter or paper you 

are using. This means if you have a negative that has little 

contrast and is printing a very grey photograph, you can 

correct this by using a higher �lter number or higher grade 

of paper. This will increase the intensity between the black 

and white tones in your photograph.

Graded paper
In the past, the only method of changing contrast in a 

photograph was by using graded paper. This method is 

still used by some today and is a very straightforward 

process. The only disadvantage is that you will need a 

number of packets of different graded paper to use this 

method successfully. The grades are generally zero, one, 

two, three, four and �ve. The higher the number, the more 

contrast will appear in the image. So if your prints are 

very grey and you want to give them a lot more contrast 

you need to use a higher-number graded paper (for 

example, four or �ve). If you are after less contrast in your 

photograph use a lower-number graded paper.

Filters
Most major photographic companies now produce variable 

contrast paper such as Ilford�s Multigrade Paper. By using 

this paper combined with �lters, you can gain an array of 

different contrasts from the same negative using the same 

paper. There are up to 12 �lters in a set (including half 

grades), ranging from double zero to �ve.

Figure 2.4G Example of a 

negative, with prints made 

from it using a �lter zero and 

a �lter �ve. Evening Standard/

Associated News

Filter 0 Filter 5
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Procedure

� Your enlarger may have a �lter drawer in which you can 

place the �lters to change contrast. Alternatively, it may 

have a universal adaptor under the lens, into which you 

can slide mounted �lters. It is also possible for you to 

carefully hold the �lters under the enlarger lens during 

processing.

� It is important to be aware that using �lters can have an 

effect on the exposure times of a print. Filters 00 to 3.5 

generally require the same exposure time and �lters 4  

to 5 require double the normal exposure time.

� With practice you will quickly learn to judge the effects 

the different �lters have on your photographs. Using 

�lters and gaining correct exposure times will become 

second nature to you.

Point to remember

� It is always a good idea to use �lter two or grade two paper as 

a starting point when testing exposures.

   Filter 0 Filter 1 Filter 2 Filter 3 Filter 4 Filter 5

Figure 2.4I The effects different �lters have on the same print. Evening 

Standard/Associated News

Dodging and burning in
When you are printing a photograph you may �nd that a 

particular part of the photograph will appear too light or 

dark. By dodging and burning in your print during exposure 

it is possible to control the amount of light that reaches 

the different parts of your photograph.

Choose a

multigrade filter:

yellow for low

contrast, purple for

high contrast.

Frame up and focus your

negative, and test for

exposure.

Carry out

remaining

steps in

normal room

light.

Develop for a minute in

multigrade developer.

A few seconds in stop

bath halts development.

Fix in paper fixer for

half a minute.

Wash in running water

for two minutes.

Prints drip dry in

about 10 minutes

or use a hairdryer if

you’re in a hurry.

Light-brown safelight

Expose a sheet of

multigrade paper.

Figure 2.4H The procedure for printing a black and white photograph using graded �lters
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dodging
When you have printed your photograph you may � nd 

that the exposure is correct except for a small section 

that appears too dark. By allowing that section of the 

photograph to be exposed under the enlarger for less time, 

it is possible to achieve an evenly exposed photograph. 

This technique is called �dodging�. To do this you will need 

to use a dodging tool.

It is quite easy to make your own set of dodging tools 

out of a few pieces of opaque card, � ne wire and sticky 

tape. The size and shape of the tool should relate directly 

to the area that you want dodged. However, you can make 

the shadow you create smaller or larger by moving the tool 

further from or closer to the enlarger light. The amount of 

time that you use the dodging tool for will depend on the 

requirements of the print. It is wise to complete a test 

strip to work out the correct 

exposure times. With these 

times in mind, you are free to 

start exposing the print. The 

appropriate tool should be 

moved constantly over the 

darker section during the 

latter part of the exposure 

time (see � gure 2.4J).

Figure 2.4J Dodging tools and how 

they are used

burning in
If a section of your photograph appears too light, it is 

possible to make it darker. This is done by covering the 

remainder of the photograph with a piece of opaque card 

and allowing the lighter part to be exposed for longer. 

This is called �burning in� and it enables you to produce a 

photograph that is correctly exposed. The correct exposure 

time can be obtained by completing a test strip for the 

different areas of the print. After exposing all of the print 

for the general exposure time, select the appropriate tool 

and wave it constantly over the image. This allows extra 

light to fall on the lighter areas of the print, exposing these 

areas correctly (see � gure 2.4K).

When burning in, use tools made of opaque cards with 

holes about one centimetre to about 

� ve centimetres in diameter. 

You can make a range of 

these tools with various 

shapes (circles, triangles 

and squares) for shading, 

or keep some card on 

hand and make the tools 

as you need them.

Figure 2.4K Burning in tools 

and how they are used

points to remember

� When you are dodging or burning in, the masks must be kept 

moving slightly during the entire exposure time. This is done in 

order to avoid a hard-edged shadow and to create a smooth 

transition between the dodged or burned in areas and the rest 

of the picture.

� It is possible to use your hands as masks for some basic 

dodging and burning in.

� It would not be uncommon for a single print to need both 

burning in and dodging to achieve an acceptable print (see 

� gure 2.4L).

� With practice you will gain con� dence and you will soon 

� nd almost every print can be improved by a certain amount 

of burning in and dodging � but be careful not to 

overdo it.
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i. A single photograph may need 

a number of different exposure 

times. In this photograph three 

different exposure times have been 

used in order to gain an evenly 

exposed print.

ii. A photograph demonstrating 

correct exposure throughout. 

Alexandra Bostock, Year 12, 

gelatin silver photograph

Figure 2.4L

Spotting
Marks often appear on photographs during the printing 

process. These marks may be caused by dust and can be 

removed by rewashing the negative (using a wetting agent 

can help). However, some dust, small hairs and scratches 

cannot be removed from the negative and can leave white 

marks on your photograph. Spotting eliminates these 

marks (see � gures 2.40 (i) and (ii)).

equipment and materials

You will need the following equipment and materials for 

spotting: retouching kit; dyes and/or pigment; good quality 

sable brush; mixing tray; cotton balls.
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procedure

Spotting kits are available 

from most photographic 

suppliers and are 

generally easy to 

use. They are 

normally made 

from dyes and 

pigments and 

can be mixed to 

make a variety 

of tints intended 

to blend with the 

different tones that 

appear in black and  

white photographs.  

If your resources  

are limited, inks  

and watercolours 

can be used as a substitute when spotting. However, the 

colours tend to sit on the surface of the print and are 

therefore more obvious than dyes, which penetrate the 

emulsion layer.

Figure 2.4M The equipment  

and materials used for spotting

Figure 2.4M The equipment  

and materials used for spotting

Whether you are using dyes or pigment, the golden rule 

when spotting is to apply the colour in very small amounts, 

using an almost dry brush and build up the density 

gradually. You should always apply the colour with a good 

quality sable paintbrush which is about size 0. The colour 

should be placed on the photograph in tiny spots, using 

only the tip of the brush. Do not overload the brush with 

colour or you may lose control of the colour.

Figure 2.4N You may �nd that it takes several coats to build up the 

intensity of colour necessary to make the spot disappear. Have patience!

points to remember

� Build the colour up slowly.

� Do not use strong colour, as this will show as a dark spot.

� With large spots work from the centre outwards. This helps 

avoid a dark ring around the retouched area.

i. A photograph showing scratches and dust marks ii. The photograph after spotting

Figure 2.4O
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 2.5  SPECIAL EFFECTS 

IN BLACK AND WHITE 

PHOTOGRAPHY

Negative image
A negative image will give you a normal photograph that 

looks like a negative. All the tones will turn out back to 

front (see �gure 2.5B).

equipment and materials

You will need the following equipment and materials to 

produce a negative image print: enlarger; three processing 

trays; thermometer; tongs; timer (optional); print dryer 

or pegs; piece of glass approximately 40 × 50  cm; paper 

developer; stop bath; �xer; photographic paper;  

a photograph that you have already printed.

Glass

Original photograph 

face down

Photographic paper 

face up

Figure 2.5A Place the sheet of glass over the top of the paper and 

photograph to hold them in place.

procedure

 1. Set up the darkroom in the usual way, including 

safelight, chemicals and enlarger.

 2. Manipulate the enlarger so that the light from it will be big 

enough to cover the size of the photograph you are using.

 3. Place the aperture on f.8.

 4. Turn the safelight on and white light off.

 5. Place a light �lter over the enlarger.

 6. Put a fresh piece of photographic paper (the same 

size as the photograph you are using), shiny side up, 

under the enlarger.

 7. Place your printed photograph face down on top  

of the paper.

 8. Place the sheet of glass over the top of your 

paper and photograph to hold them in place (see 

�gure 2.5A).

 9. Expose the paper to the light from your enlarger for 

approximately one minute (you may need to test the 

exposure time).

10. Put the piece of photographic paper through the 

chemical process and assess your results.

points to remember

� Exposure times tend to be a lot longer for this process than 

for printing a positive photograph.

� It is possible to obtain negative images from a number of 

items other than photographs. Experiment using images from 

magazines, photocopies and drawing, using the procedure 

described above (see �gure 2.5C).

i. A normal photograph ii. A negative image

Figure 2.5B Andrea Ball, Year 11, gelatin silver photograph

 



51CHAPTER 2 Darkroom processes and procedures

Solarisation

By exposing your photograph to light during the developing 

process, you can achieve a partial reversal of the image. 

Although achieving a successful result can be �ddly, the 

�nal results are normally worth the effort.

equipment and materials

You will need the following equipment and materials to 

produce a solarised print: enlarger; three processing trays; 

thermometer; tongs; timer (optional); print dryer or pegs; 

paper developer; stop bath; �xer; photographic paper; 

good quality negative (better results are achieved with 

high-contrast negatives).

procedure

1. Set the darkroom up in the usual way, including 

safelight, chemicals and enlarger.

2. Place your negative in the enlarger and print a test strip 

of possible exposure times.

3. Study the test strip under normal light conditions. 

Select an exposure time that will allow your image to 

appear slightly underexposed. For example, if the correct 

exposure is 12 seconds, then select approximately  

nine seconds.

4. Print the image using the enlarger for the selected 

exposure time.

5. Place the photographic paper in the developer and stop 

bath for the appropriate time. Do not put it into the �xer.

6. Wash any remaining chemicals from the photographic 

paper.

i. A standard print

ii. A solarised print

Figure 2.5D

Figure 2.5C A negative  

image produced using  

a photocopied image.  

The negative has then been 

made back into a positive. 

Anthea Sidiropoulos, Year 12, 

gelatin silver photograph
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 7. Select the f.8 aperture on the enlarger. Make sure 

there is no negative in the carrier. Check that the light 

rays from the enlarger will cover the piece of exposed 

photographic paper.

 8. Place the exposed paper under the enlarger and 

expose it to light for approximately 10 seconds (this 

can vary; a test strip is advisable).

 9. Place the photographic paper back into the developer 

and follow the chemical process as normal. If your 

image appears to go black, do not panic; wait until you 

have seen the image under normal lighting conditions.

10. When the photographic paper has been in the �xer for 

about 30 seconds you can examine the print under 

normal lighting conditions. However, do not forget to 

return it to the �xer for the appropriate amount of time.

11. When you have examined your print you can decide 

what you may need to do to improve it. As stated 

earlier, solarisation can be a dif�cult technique to 

master and you might need to try two or three times 

before you get it exactly right.

An alternative method is to expose the image onto 

photographic paper and then place it into old, exhausted 

developer. When the image appears, turn on the white light 

in the darkroom to expose the photograph. If the developer 

is old enough you may be able to keep the light on and 

watch the image solarise before your eyes. Alternatively, 

it may react quickly and, if this is the case, promptly turn 

off the light and watch what happens. Once you are happy 

with the result, swiftly place it into the stop bath and then 

process normally.

points to remember

� Initially, the photograph must be underexposed.

� Be careful not to get wet �ngerprints on the photographic 

paper during the process.

Sepia toning
It is possible to change the tone of your prints from black 

and white to shades of brown. This is a relatively easy 

technique that you can use to make your prints look older 

or more earthy (see �gure 2.5E).

equipment and materials

You will need the following equipment and materials to 

produce sepia prints: two processing trays; tongs; dryer 

or pegs; measuring jug; sepia toner bleach solution; sepia 

toning solution; a photograph you have printed.

Figure 2.5E i. Trees, Vivienne Balm, Year 12 (taken with infra-red �lm) ii. Same image with sepia tone added
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procedure

This process has a tendency to make your print lighter so 

it is best to use a slightly overexposed print.

1. Set up the bleach and toning solution in each of the two 

processing trays. You will need to mix the chemicals with 

water. However, the chemical and water ratio varies with 

different brands of chemicals. You will therefore need to 

read the instructions on the chemicals carefully (write in 

the ratios and chemical times in your workbook or journal 

so you will always have them on hand).

Sepia bleach water-to-chemical ratio  

 Time  

Sepia toner water-to-chemical ratio  

 Time  

2. Select a print that you have already processed to sepia 

tone. The best prints to use have a strong range of 

tones including some black areas.

3. Place the print in the bleach solution. After one to two 

minutes you should notice the image fading. When only a 

pale yellow image remains, you are ready for the next step.

4. Using running water, wash the photograph thoroughly.

5. Place the photograph in the sepia toning solution. 

After two to three minutes you will notice the image 

reappearing in sepia tones.

6. When the photograph has been in the chemical for the 

required amount of time, take it out and once again 

thoroughly wash it in running water.

7. Dry the print and mount it for presentation.

selected sepia toning
Selected sepia ������ is also possible. To do this you can 

use a paintbrush to paint the chemicals onto selected 

areas of your photograph. However, do not forget to wash 

the print after each chemical.

points to remember

� Prints tend to go a little lighter once they have been sepia 

toned. It is therefore a good idea to print your photograph 

slightly overexposed if you intend to sepia tone it.

� The chemicals tend to be harmful, so always make sure that 

you use tongs and wash your hands afterwards.

Hand colouring
h��� ��������� black and white prints is a technique  

that has existed for almost as long as photography itself. 

Many professional photographers hand-coloured their 

prints before colour photography was available to give 

the appearance of a coloured print. In the 1930s and 

1940s nearly every photograph was hand-coloured. With 

advancements in colour photography, the appeal of hand 

colouring died down. However, modern photographers use 

hand colouring as a creative technique to help enhance 

and highlight different aspects of their photographs  

(see �gure 2.5F).

Figure 2.5F i. A standard print ii. A hand-coloured print
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equipment and materials

You will need the following equipment and materials to 

produce hand-coloured prints: artist-quality brushes; a 

small plate or mixing dish; cotton buds (tufts of cotton 

on a skewer are ideal � see � gure 2.5G); cotton balls; 

vaseline (if using oil paint); wetting agent (if using dyes or 

watercolours, as it will help improve coverage and get rid 

of �high spots�).

the colour MediuM

The most important material in hand colouring is the 

colour medium. Although it is possible to hand-colour 

prints with a number of different types of media (for 

example, permanent markers, paint), the quality of the 

result will vary greatly, depending on the media used.

Most good photographic shops sell hand-colouring kits, 

although they can be costly. Alternatives are watercolour 

sets, oil paints, artist-quality pencils and vegetable dyes.

the photographic paper

When hand colouring, it is important that the photographic 

paper you use has a matt or satin surface. This surface 

will allow the colour to adhere to the paper evenly and 

easily. If you don�t have access to matt paper, it is 

possible to spray your photograph with a matt or satin 

surface spray or treat the paper with a solution of mineral 

turpentine and linseed oil (diluted 1:1). Brush this solution 

over the surface and allow it to dry. These procedures tend 

to make the photographic paper equally receptive to the 

different media.

Figure 2.5G How to wrap a skewer

procedure

It is always tempting to overdo hand colouring on 

black and white photography. It is therefore important 

to plan from the start what kind of result you are after. 

Look at the print to be coloured and imagine how you 

want the � nished work to appear. Remember, this is a 

creative technique, so you do not have to be conventional 

� use your imagination and be creative!

coMMercial hand-colouring Kits

Hand-colouring kits are available from most photographic 

suppliers and come in a variety of sizes and media. The 

most common are hand-colouring pencils, pens and oil 

paints. These kits tend to give very good results as long 

as the manufacturer�s instructions are followed carefully.

watercolours and vegetable dYes

These media are diluted using a mixture of water and 

wetting agent. It is best to build the colour in the selected 

area gradually using a cotton bud. Apply one coat at a 

time, allowing each coat to dry before applying the next.

Colour can be removed by washing the print. It is 

important to be aware that vegetable dyes tend to fade 

easily.

oil paint

By diluting the oil paint with linseed oil the colour can 

become transparent. It is best to slowly build the colour 

in the selected area of the photograph with a good quality 

paintbrush or � ne cotton bud.

Oil colour can be removed with a small amount of 

vaseline on a cotton bud.

pencils

Artist-quality pencils can be used by themselves on matt 

paper. Pencil lines can be removed by gently rubbing the 

surface with a cotton bud.

toning

Large areas of colour can be applied by using a cotton ball 

dipped in colour and wiped in a circular motion over the 

print. It is important to build the colour up slowly and allow 

one coat to dry before applying the next. If you are using 

watercolours it is best to dampen the print � rst.

points to remember

� Always plan the look of your artwork before you start. 

Minimal colouring can sometimes be more effective 

than full colouring.

� Ensure that you have a matt or satin surface to work on.

� Take your time with this technique. It is important that 

you take care and build the colour up slowly. One of the 

biggest mistakes students make is to apply too much colour 

to begin with. Only put a small amount of colour on your 

brush or cotton skewer at any given time.
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Screening and texture
You can create the illusion of a textured print by placing 

a textured screen between the enlarger and photographic 

paper while exposing the negative.

equipment and materials

The following equipment and materials are needed to 

produce textured prints: enlarger; three processing trays; 

thermometer; tongs; timer (optional); baseboard; a sheet of 

glass; print dryer or pegs; paper developer; stop bath �xer; 

photographic paper; good quality negatives; different fabrics 

and textured surfaces (for example, lace, �ne cotton, calico, 

�ywire � it is best if the fabric is �ne and light in colour so 

that it allows light to travel easily through it).

procedure

1. Set the darkroom up as normal, including the safelight, 

chemicals and enlarger.

2. Select a negative that you feel would be enhanced with 

the appearance of texture and place it in the enlarger. 

Manoeuvre the enlarger to achieve the correct size and 

a focused image.

3. It is wise to produce a good quality standard print �rst; 

this is useful to compare with the textured print.

4. When you have produced the standard print you will 

need to retest the exposure time with the texture. Place 

a test strip under the enlarger with the texture (such as 

a piece of fabric) placed on top of it. Remember that 

your fabric will obscure some light from the paper, so 

the exposure time may need to be much greater than 

before. In most cases you will need to increase the 

exposure time between 50 and 100 per cent.

5. When you have determined the correct exposure time, 

place a fresh piece of photographic paper under the 

enlarger with the texture over it. It is generally a good 

idea to place a sheet of glass on top of the texture to 

hold it �at against the paper. Expose it and process as 

normal.

6. Compare the �nal textured print with the original print. 

You may �nd that more exposure time is required, or, if 

you are using �lters or graded paper, you may need to 

increase the contrast.

7. Different textures will create different effects, so it 

is worthwhile experimenting and trialling a variety of 

effects and surfaces.

point to remember

� It is also possible to photograph different textures and 

combine the developed negative with a standard negative in 

the enlarger and print them together (see �gure 2.5I). This 

process is similar to sandwiching negatives, which is outlined 

on page 56.

Figure 2.5H  i. A standard photograph ii.  The same photograph printed using a texture screen of calico
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Figure 2.5I An example of a photograph which combines a standard 

negative with a texture, gelatin silver photograph.

Superimposing images
It is possible to print two negatives onto the same piece 

of photographic paper, making it possible to combine two 

negatives to create one photograph. The most important 

element in obtaining success with this technique is to 

select two negatives that will work well together. The 

best results can be achieved if the negatives are similar 

in lighting, size and density. However, the possibilities 

with this technique are endless. Your only limits are your 

imagination and time.

EquipmEnt and matErial

For this technique you will need the following equipment 

and materials: enlarger (sometimes this technique 

is easier with two enlargers); three processing trays; 

thermometer; baseboard; tongs; timer (optional);  

print dryer or pegs; scissors; paper developer; stop bath; 

�xer; photographic paper; two good quality negatives that 

will work well when printed together; thick cardboard  

for masking.

procEdurE

There are two different ways of approaching this technique. 

The most straightforward technique is to sandwich the 

negatives. The other technique is known as double 

printing.

sandwiching negatives

Place two negatives in the enlarger at the same time and 

expose them to the photographic paper together.

This method can be very effective; however, it is not 

suitable for all types of negatives. In this procedure you 

need to have the subjects in both negatives the correct 

size and the images will have to be overlapped.

Figure 2.5J Two negatives sandwiched together to form one print, gelatin 

silver photograph

double printing

This technique involves exposing both negatives separately 

onto the same piece of photographic paper.

To double print, work through the following procedure:

  1. Set up the darkroom as usual.

  2.  Place the �rst negative in the enlarger. Adjust the 

enlarger so that the image is focused and the  

correct size.

  3.  Place a thick piece of card the same size as the 

photographic paper on the baseboard.

  4.  Trace around the projected image, marking the section 

of the negative you want to keep.

  5. Cut the cardboard where you have marked it  

to obtain two masks. The �rst mask shows what  

you want to keep from the �rst negative and the 

second mask shows what you want to keep from  

the second negative.
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 6. Using a second enlarger (if possible), place the other 

negative in the negative carrier and manoeuvre the 

enlarger to gain a correctly sized and focused image 

that will �t into the second mask.

 7. You now need to test exposure times for each 

negative. When you have the times, you are ready 

to print.

 8. Start by placing a fresh piece of photographic 

paper into the baseboard. Using the enlarger light 

�lter, ensure that you place the baseboard in the 

correct position.

 9. Place the mask over the area of the paper you do 

not want exposed (see �gure 2.5L). Expose the 

other side to the �rst negative for the amount of 

time you determined in step 7.

10. Change the negatives. Using the enlarger light 

�lter again, ensure that the baseboard is placed 

in the correct position for the second negative.

11. Place the other mask over the photographic 

paper you have already exposed (see �gure 2.5L). 

Expose the second negative for the time 

determined in step 7.

12. Process the photographic paper in the  

usual manner.

13. When the photographic paper has been in the 

�xer for 30 seconds you may turn on the light and 

evaluate the result.

Figure 2.5L Using a mask when superimposing negatives

points to remember

� Double printing requires a very methodical approach.  

You must be prepared to spend the time organising your 

masks and setting up the enlargers.

� When holding your masks during exposures, it is wise  

to move them back and forth slightly to prevent a harsh line 

developing between one image and the next.

ii. The two photographs 

combined to form one print

Figure 2.5K

Catherine Fonti, Year 12, 

gelatin silver photographi. Two separate photographs
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Figure 2.6A Plan for camera, lid and � ap

 2.6  PINHOLE CAMERAS
Simple pinhole cameras are relatively easy to make and 

provide an excellent opportunity for you to develop a 

solid understanding of the basic principles of the camera 

obscura and darkroom processes and procedures.

Making a pinhole camera

equipment and material

In order to construct your camera, you will need the 

following equipment and materials: cartridge paper, 

boxboard cardboard, black cover paper, black theatrical 

gaffer tape (black, opaque, cloth tape), masking tape, 

Blu Tack, rubber bands, solid aluminium foil (available from 

chemical supply companies), a Stanley knife, scissors, a 

metal ruler, a cutting mat and a standard sewing needle. 

procedure

1. Very carefully measure out a template for your camera, 

lid and � ap on a large piece of cartridge paper. Use the 

diagram below to assist you with your measurements and 

remember that all lines must be drawn parallel.

2. Once you have measured out the design, you may like 

to cut it out and try putting it together to check that all 

your measurements are accurate (see � gure 2.6B).

3. Once you are sure your measurements are accurate, 

you are ready to transfer the design onto boxboard 

cardboard. When this is completed, you carefully cut 

out your design using a metal ruler, cutting mat and 

Stanley knife. Also, carefully cut out the small hole in 

the front of the camera, as indicated on the plan (see 

� gure 2.6A).

4. Once the design has been cut out you may need to 

score the fold lines of the camera and lid with a Stanley 

knife to allow them to bend into shape easily and 

accurately.

5. Using the gaffer tape, stick all the sides of the box and 

lid together.

6. Line the interior of the camera and lid with black cover 

paper, this helps reduce unwanted light re� ections.

7. From the inside of the camera box, use gaffer tape to 

stick a piece of solid aluminium foil over the hole.

8. From the outside, use gaffer tape to stick the � ap 

over the hole (see � gure 2.6C). This card � ap acts as 

the �shutter� with a gaffer hinge and a gaffer 

�latch� to keep the � ap closed 

when not being 

used for taking 

photographs. 

Gaffer tape sticks 

to itself repeatedly 

without losing its 

adhesive quality.

ed

Figure 2.6B 

Mock-up of design



59CHAPTER 2 Darkroom processes and procedures

 9. Very carefully, using a standard sewing needle, 

place a small hole in the centre of the solid 

aluminium foil. Any jagged edges created in the foil 

can be pressed down with a straight metal edge 

(for example, a scissor blade).

10. Place four small pieces of Blu Tack onto the inside cover 

of the lid; this is where you will stick the photographic 

paper. Your camera should now be ready for use.

11. Large rubber bands can be placed around the lid and 

box to keep the lid on and to keep the light out. The 

elimination of unwanted light presents the greatest 

problem in getting good quality photos.

Creating photographs with 

a pinhole camera

equipment and material

Pinhole camera, darkroom, processing chemicals 

(developer, stop bath and � xer), small sheets of 

photographic paper (sheets of 5 × 7 inch, cut in 

half, are ideal), Blu Tack, two large rubber bands, 

stop watch, pencil and a copy of the proforma on 

page 30 to document each shot. 

procedure

1. Collect all your equipment and materials, and move 

into the darkroom. Ensure that your chemicals are 

set up correctly (see � gure 2.3D on page 39).

2. Turn on the (red/orange) � ltered light and get out 

a fresh piece of photographic paper. (If a number 

of people are working in the darkroom together it 

may be a good idea to write your name in pencil 

on the back of the photographic paper. This way 

you will be able to recognise your photographs 

at the end of the lesson.)

3. Use the Blu Tack to attach the photographic paper 

� rmly to the centre of the inside lid of the camera. 

The paper must be attached shiny side up.

4. Place the lid back on the camera and use the 

elastic bands to ensure that it is � rmly attached.

5. Move outside and � nd a suitable subject to 

record. Secure your camera in a stable position 

in front of the subject so that it will not move 

during exposure. Place the camera so that the 

� ap/shutter is able to drop (not be lifted as this 

may cause movement). Exposure times can vary 

considerably and are affected by the weather, 

lighting conditions, time of day and the size of the 

hole in the camera. Bright days need less time, 

dull days or photographing in the shade will need 

more time. Large holes will need less time, while 

small holes will need more. If you are taking your 

photograph on a bright day it is recommended that 

you start with an exposure time of between 30 

and 45 seconds.

6. Gently detach the � ap and allow it to drop. 

Use your stop watch to accurately record your 

exposure. The camera and subject matter should 

not move at all during exposure. If they do, the 

image will blur. Still life images are the most ideal 

subject matter for this process. When the time is 

up, gently place and adhere the � ap back over the 

pinhole and return to the darkroom. Record your 

exposure time, lighting condition (bright sunshine, 

overcast, shade) and subject matter on the 

proforma sheet.

Figure 2.6C Pinhole camera

i. Front of camera

ii. Side of camera

iii. Inside of camera
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Figure 2.6D Image captured with a pinhole camera (the image presents as 

a negative). Oriana Kinsey and Camilla Rogers, Year 9

Figure 2.6E A positive image created from the pinhole photograph above

7. In the darkroom, remove the photographic paper from 

the camera and place it in the developer. The image will 

appear as a negative. If the image is faint and mainly 

white you will need to re-shoot with a longer exposure 

time. If the image is dark with a lot of black you will 

need to re-shoot with a shorter exposure time. Pinhole 

cameras can vary greatly and you may need to take 

the same subject matter three or four times before 

you gain the correct exposure. The more images you 

take, the greater will be your understanding of how your 

camera reacts to different subjects and different lighting 

conditions.

8. Once you have achieved an accurate exposure and 

produced a good quality print, it is a straightforward 

process to turn your negative image into a positive 

one. You simply need to follow the procedure on how 

to produce a negative image on page 50 of this book. 

A good negative image will enable you to produce a 

positive photograph.

points to remember

� In order to achieve a correctly exposed photograph you 

need to keep photographing the same subject in the same 

conditions (lighting) until you get a successful print. Too 

many changes can obscure any problems that may affect the 

outcome � one change at a time.

� Ensure that the �ap completely covers the pinhole and the lid 

is secure before you leave the darkroom.

� It is worth considering completing this task in pairs.



Digital processes and 
procedures

3.

 3.1  Using digital 

imaging software

Introduction

The art of digital photography differs considerably from 

that of traditional �lm photography. The processes and 

techniques of digital photography, and the effects and 

aesthetics that can be created, are distinctly unlike those 

of traditional �lm. A colour �lm photograph may appear 

similar to a colour digital photograph, but the fundamental 

qualities of the images are different. A photograph made 

from �lm re�ects grain or dyes, and is processed through 

chemicals, while a digital photograph is made from pixels 

and is enhanced and printed through digital software. 

To excel in the production of quality digital photographs 

you need to develop an understanding of the unique and 

exclusive characteristics of this exciting medium.

For the best results it is important that you start with 

using your knowledge of your digital camera to take the 

best photograph you can when you are in front of your 

subject matter (see section 1.6, pages 26�31).

i. A photograph before it has been enhanced using  

digital imaging software

ii. The same photograph after it has been enhanced 

using digital imaging software 

Figure 3.1A
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Once you have taken your digital photographs, you can 

easily connect the camera or memory card to a printer and 

print the images out directly. Alternatively, it is possible 

to improve them considerably by using digital imaging 

software. It is also possible to manipulate the subject 

matter to create highly imaginative artwork.

Digital imaging software has two primary purposes.  

The �rst is to enhance the quality of an existing 

photographic image by improving the colour, tone, clarity, 

composition and overall appearance of the image (see 

�gure 3.1A). The second is to create a new image by 

manipulating photographs, combining, distorting, altering 

and/or blending them in a creative and innovative manner 

(see �gure 3.1B).

Different types of software
The digital age has enabled photographers to choose from 

an abundance of software, which is available from large or 

small companies, or individual developers.

There is software available:

� for cameras

� to download images

� to process raw �les

� to sharpen

� to reduce noise (unwanted speckles of colour)

� to print

� to scan

� for use in printers and scanners

i: a and b Two photographs taken by 

Valerie Sparks for her El dorado Springs 

digital photograph

a. b.

The same two photographs combined with others to create a section of Valerie Sparks�, El dorado Springs, 2007, digital photograph, 100 cm × 600 cm

Figure 3.1B ii.
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This chapter will cover some of the basic techniques of 

digital imaging software, with a focus on Photoshop CS3. 

Most software uses similar tools and techniques so, if you 

do not have access to this version of Photoshop, you will 

need to adapt this information to your particular software.

Picasa by Google, Photo Plus and In Full View are freely 

available on the internet. Of course, for this price they 

have limitations, but they do have some good features 

and are easy to use. All are Windows-based software. 

For Macs, the installed iPhoto is satisfactory for most 

people. The GIMP is another free program. It works on any 

platform but can be challenging to use.

If you are on a tight budget you could look at 

Photoshop Elements or Corel�s Paint Shop Pro. If you 

are buying software, make sure you check that it offers 

a student discount. Some discounts are very generous. 

Most software has a free trial period.

The main Photoshop  
window
In developing your knowledge of how to use Photoshop, it 

is important to understand the location of all its various 

components. These can be seen in the main window when 

you open the program.

� for use in computers to manage colour

� to evaluate images and other software

� to store images

� to do most of the above and for use through 

mega-programs such as Photoshop.

Some software costs thousands of dollars; some is 

shareware (free or at very low cost). Some is included with 

the purchase of hardware (cameras, computers, scanners 

and printers). Software is continually being updated.

Common programs
There are many different types of digital imaging software 

on the market and also a large number of free software 

programs available on the internet. Such software 

ranges from the provision of options to enhance straight 

photographs to the more creative manipulation, distortion 

and construction of photographic images and digital 

artworks. The most comprehensive photographic software 

on the market suitable for professionals, students and 

hobbyists is Adobe Photoshop. This industry-standard 

software has continued to improve over many years. 

There is other software that offers some of the functions 

available in Photoshop, but no other software covers the 

full range of functions offered by this program.  

Figure 3.1C Main Photoshop window

Tool options 

bar

Main toolbar

Drop-down menu Menu bar

Image Pop-up window

Palettes Reduce screen Close window
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Move tool

Hand tool

Switch foreground and 

background colours

Set background colour

Default colour settings

Set foreground colour

Edit in quickmask mode

Change screen mode

Figure 3.1D The main Photoshop window toolbox

Cropping tool

Zoom tool
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Common tools
Digital imaging software packages have a variety of tools 

for working with photographs. Some software has more 

tools than others, but the symbols for the various tools 

are usually the same or similar. The widest variety and 

the most common tools are those appearing in the main 

toolbox window for Photoshop.

Explanation of the 
most commonly used 
Photoshop tools
When you click on a tool from the main Photoshop toolbox, 

a tool option bar will appear at the top of the main window. 

This will offer you a variety of choices on how you may use 

the tool. Some tools are hidden under others. For example, 

if you click and hold your �nder down on the lasso tool, 

you will have access to the polygonal lasso tool and the 

magnetic lasso tool.

The move tool allows you to move sections and 

layers around your image or onto another image.

Selection tools allow you a variety of 

options to work, enhance and transport components of your 

image (see the section on selections, on the next page).

The crop tool allows you to recompose your image by 

cropping out (deleting) unwanted areas.

The brush and pencil tools allow you to draw and 

paint on top of an image. Once you have clicked onto 

these tools, the tool option bar at the top of the main 

window will allow you to select from various brush sizes, 

and choose the diameter, hardness, �ow and opacity of the 

colour to be applied.

The clone tool allows you to clone (copy) one area of 

an image over another. Hold down �Alt� (on the keyboard), 

then left-click the clone tool over the area that you want 

copied. You then take your �nger off Alt and click onto the 

area that you want to cover. The original part of the image 

will appear on the new area.

The eraser tool allows you to rub out unwanted areas 

of an image, selection or layer.

The gradient tool allows you to create a coloured, 

controlled blend from one colour or tone to another (for 

example, to fade or darken gradually over a distance).  

This can be applied to selections or backgrounds.

The paint bucket tool allows you to pour a colour into 

a selection or area of a particular colour or tone.

 The blur/smudge tools allow you to soften or 

smudge areas of your image.

The dodge tool allows you to lighten areas of  

your image.

The burn tool allows you to darken areas of  

your image.

The text tool allows you to add text to your image. 

You have a choice of font styles, colour and sizes, and can 

run the text either horizontally or vertically.

The eyedropper tool allows you to select any colour 

contained within your image by clicking the eyedropper tool 

onto that colour.

The hand tool allows you to move your zoomed 

image around by dragging the hand over the image to the 

area that you wish to look at or work on.

The zoom tool allows you to magnify your image  

(left-click to zoom in, hold down Alt, and left-click to zoom 

out).

When you click onto the foreground colour square, a 

pop-up palette of colours will appear. Select a foreground 

colour for use in your image. When you click onto the 

background colour square, a pop-up palette of colours will 

appear. Select a background colour to use in your image.

Used to switch foreground and background colours.

Default colour settings resets your colour settings to 

black and white.

Change screen mode allows you to control the way 

that images are displayed within your work space. You can 

move from a screen that contains all your tools and 

windows to a screen that is free from these distractions 

You can press Tab on your keyboard to remove all the 

windows and tools from your screen. This will allow you to 

view your image without distractions. Press Tab again to 

regain them.

point to remember

� If you are trying to work on a particular area of your 

image and none of the tools seem to be working, 

you may have selected another area accidentally. To 

check if this is the problem, go to Select > Deselect. 

It could also be because a path has been started 

accidentally. If this is the case, go to Windows > 

Show Path and drag the path into the trash.



PART 1 MAking: using skills, Techniques And PRocesses66

Selection

As noted earlier, there is a variety of selection tools. 

These tools allow you to select all or part of an image. 

Once you make your selection, you may choose to alter 

or adjust that section, or you may choose to copy and 

paste it somewhere else, perhaps on another image. 

There are a number of options for selecting an area of 

your photograph, and you will need to understand how 

each one works in order to be able to select the best tool 

for the required task. When the image is selected it will 

appear to have a black, broken line �ashing around the 

selection. This is often referred to as �marching ants�. 

When you see the marching ants, only that area is active. 

Any adjustments you make will only affect the selected 

area.

The rectangular and elliptical marquee tools 

allow you to select basic shapes. You do this by dragging 

your chosen marquee shape over the area that you want 

to select. This works well if the area you want is a basic 

circular, oval, square or rectangular shape. If you are 

�nding it hard to make your selection correctly, Photoshop 

will allow you to transform this selection by going to the 

menu bar and choosing Select > Transform Selection. You 

can then drag out, distort or change the size of your 

selected shape. Once you are happy with the selection, 

you need to click back on the marquee tool to transform 

your selection.

1. Exploring tools to create an image

� Open a new document in Photoshop, 21 cm � 29.7 cm 

(A4 size). Use this document to explore the various tools 

in the program.

� Start by exploring the paintbrush tools and foreground 

colour options. Click onto the foreground colour and 

select a colour from the pop-up palette window. Then 

explore the various paintbrush options.

� Use the square or circle marquee tools to select an area 

of your image. Now use the paint bucket or gradient tools 

to colour this selection.

� Explore the text tool to produce words on your image.  

Look at the fonts and text options to produce various 

effects.

� Open the layer window (Window > Show Layers) and 

look to see if you have produced any new layers. The text 

should appear on a different layer. If you want the font  

to be transparent, move the opacity slider at the top of 

this window.

� Explore moving from one layer to the next (see page 70 

for more information on layers).

� Explore the blur and smudge tools to experience their 

effects.

� Explore any additional tools to create a colourful and 

abstract design.

� Print out a copy of your exploration and glue it into your 

workbook or journal. Comment on the tools and effects 

that you have produced.

2. Exploring tools to enhance and manipulate  

a photograph

� Open up a digital photograph in Photoshop.

� Explore the tools that you have already discovered and try 

new ones to enhance this image creatively.

� Print out a copy of your exploration and glue it into your 

workbook or journal. Comment on the tools and effects 

that you produced.

3. Answer in your workbook or journal

a. What are the implications of manipulating the source 

image?

b. Why would it be bene�cial to make a copy of it?

activities

By dragging the  quick select tool over an area of an 

image, it will loosely select that area. Pressing Alt while 

using the quick select will allow you to deselect areas. The 

size of the tool brush area can be adjusted on the tool 

option bar.

Figure 3.1E A selection within a photographic image illustrating the 

marching ants around the selection

Marching ants
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The magic wand tool allows you to select a tone or 

colour. Using the magic wand tool, you can simply click on 

the tone or colour that you want. You can then hold down 

the Shift key and click the wand again to widen your 

selection or hold down Alt to reduce it. Photoshop also 

allows you to increase or decrease the tolerance (tonal 

and colour range) of your selection. This is normally 

situated on the tool option bar on the main Photoshop 

window.

The lasso tool allows you to drag your mouse around 

an area that you want selected (roping it in as such), 

starting at one point and then moving the mouse around 

to �nish at the same point. This tool tends to give a fast 

yet not very accurate selection. 

Photoshop also provides a  magnetic lasso tool.  

This tool provides a similar technique to the lasso tool,  

but if the mouse is moved slowly around the edge of an 

object, the selection will grip to the edge. This is �ddly, yet 

once mastered it can be a quick way of selecting an object 

or shape. It works best with strong edges.

A third option is the  polygonal lasso. Just click on 

one point of the image you want to select, then on the 

next until you have moved around the image and returned 

to where you started, to complete the selection. This 

works best with objects with straight edges.

The path or pen tool allows for a detailed and 

accurate selection of any shape or form. In order to 

create the selection, click on the path tool then move to 

the tool option bar at the top left-hand side of the main 

Photoshop window and click on �paths� (  ). Then use 

the path tool to click around the area of the image you 

want selected. If necessary, zoom into the image to 

ensure that the path that you are creating is accurate.  

To create the selection, you must start and �nish the 

path at the same point. Once the path is completed,  

go to the top of Photoshop�s main window, click onto 

Windows > Path. At the bottom of the path window you 

will see a circular marching ants icon. Click on this to get 

the ants marching around your selection. If you mess 

things up and want to start again, press Escape and/or 

delete the existing Path.

adding or subtracting from a selection
When you �nd you have selected too much, or too 

little, you can add or subtract from the selection with 

any of the selection tools. Often, the lasso is a good 

choice because you can draw any shape selection you 

require.

To add to a selection, hold down the Shift key and use 

your chosen tool to mark the area you want to add. To 

subtract, hold down the Alt key. To do this accurately, it is 

best to zoom to 100 per cent or more.

This procedure takes a lot of practice. If you make a 

mistake, you can go to Edit > Undo to erase the last step 

or click back one history state (Windows > History) at a 

time until the mistake is reversed.

Figure 3.1F A path window 

with an example of a path 

and showing where to press to 

achieve the marching ants

Path around image

Activate selection 

(create marching 

ants)
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i. The edge of an image that has not been feathered

ii. The edge of a image that has been feathered

Figure 3.1H

Feathering the edges
Feathering allows you to soften the edges of a selection 

quickly, to make it appear less cut-out and hard-edged. Go 

to Select > Modify > Feather and pick the number of pixels 

you want to grade at the edge of the selection (between 3 

and 6 is common).

i. Where to �nd the feather tool window

ii. A feather tool pop-up window

Figure 3.1G

re�ning your selection
A more advanced and better method of re�ning a selection 

is to use the quick mask. This is not a selection tool, but 

enables you to see which areas are selected and which 

are not. It also allows you to easily add to or reduce the 

selection.

� Make a selection with any appropriate tools.

� Press the Q on your key pad; this will paint a red mask 

over the non-selected areas.

� Examine the edges � you may want to zoom in to have 

a closer look. If you want to add to the selection, paint 

the area with a black brush. To subtract, use a white 

brush or eraser tool.

� When it looks okay, press Q again so that the red mask 

goes and the individual selection returns.

� Feather the edges (see above).
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saving a selection
Once you have made a selection, you need to save it by 

going to Select > Save Selection. The selection is saved 

in the Channels palette, which is found behind the Layers 

palette. If you can�t �nd it, go to Windows > Channels. 

Type in a name for the selection, click OK and you will see 

the named selection appear at the bottom of the Channels 

palette. If you click on it you will see the selection in black 

and white, or your image. To make it active again, go to 

Select > Load Selection and press OK. Then again, in the 

Channels palette, click on the top channel (at the top of 

the stack) that says �RGB� and the full image will come up 

again with the selection active.

You will need to work your way through this a few times 

to become pro�cient. It is much easier to do it than to 

read about it!

Transform

Once you have an area selected you may decide that you 

wish to transform that part of the image. This can be done 

by going to Edit > Transform (�Ctrl T� is a shortcut). This 

option will allow you to resize the scale of the selected 

area, rotate, distort or give it perspective. It will also allow 

you to �ip your image horizontally or vertically. This is 

a common option used by students to manipulate their 

images. If you are changing the size of the selected image 

you need to hold down the shift key and pull the image out 

or in by the corners so as not to distort the subject matter.

Figure 3.1J The location of the Edit > Transform option

Non selected area (in red)

Selected area (not in red)

i. Close-up view of a photograph with the red mask over the non-selected areas 

Paint brush tool re�ning selection

ii. How to re�ne the selection using a paint brush tool

iii. A photograph showing a re�ned selection

Figure 3.1I
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Figure 3.1L This image was created by selecting the face and then  

Edit > Transform > Rotate to 180�. Upside down, Georgina Dempsey,  

Year 12, digital photograph

Layers
In Photoshop you can enhance various components of  

your image and/or import new selections so as to build 

and construct your artwork.

Photoshop is set up to allow you to work in layers, 

where each new imported image and or enhancement 

can be placed on a separate layer. This is critical when 

you want to build up an image using several different 

photographs.

By placing each image on a different layer, Photoshop 

allows you to work on the different components of each 

image separately and then go back and move, enhance or 

adjust that layer without affecting the rest of the artwork.
Layers

Figure 3.1M This image shows a number of different layers combined to 

make up the artwork. Flowers in the city, Alice Halpin, Year 12,  

digital photograph

i. Scaled down ii. Rotated iii. Skewed

Figure 3.1K The subject being transformed
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side of the main Photoshop window, you can click 

on Windows > History. This window will show you 

the previous 25 steps (actions) that you have taken 

on an image. You can easily click back to the last 

action you want to accept and then continue to work 

on the remainder of the artwork.

Figure 3.1O A history window

It is possible to increase the number of history 

steps; this can be altered in Preferences (top-left 

screen) > Edit > Preferences > Performance > History 

states. Fifty is a better choice. Too many will slow 

you down. 

If you are going to do a lot of spotting or painting, 

and think you may exceed your allocated number of 

history states, you can record important states by 

taking a �snapshot� of them. Highlight a history state 

that you wish to preserve, go to the bottom of the 

history palette and click on the camera icon. This 

creates a permanent history state for you to return 

to at any time. Just click on it. Remember that if you 

do this and then make another move you lose all the 

changes after you � rst created that history state.

It is also possible for you to move your images or text 

on top of or behind other layers by simply dragging the 

layer into the appropriate order on the layer window 

(see � gure 3.1N). In order to � nd the Layers window you 

need to look to the top of your main Photoshop window 

and click onto Windows > Layers.

 Layers can be opaque or transparent, and may have 

effects applied to them.

Another important aspect of layering is to create new 

layers for the different adjustments that you make to 

an image (see section 3.4, page 84). This will allow 

you to easily delete a mistake and go back and re� ne 

improvements without affecting the whole image.

Layers

Adjustment

Layers

Figure 3.1N A number of different adjustment layers

History
In Photoshop, the history window allows you to monitor 

and undo the steps that you have carried out while 

working on your photograph. If you make a mistake 

and want to undo it easily, you can go to Edit > Undo, 

and that will enable you to instantly undo your last 

adjustment. But a problem arises when you want to undo 

your � fth-last action. By looking at the top right-hand 
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1. Using some of the techniques mentioned earlier, 

create an image of a city that is being invaded by 

some giant creatures. The creatures could be chickens, 

spiders, pigs, dogs or similar. Brainstorm some 

possible ideas in your workbook or journal.

2. Download a reasonably good quality image of a 

cityscape from the internet. Then use a search engine 

to �nd at least three good quality photographs of 

your chosen creature. Save all the images to a folder.

In Photoshop, open up the cityscape, to use as your 

background. Now open up each of your creature 

images. Use one or more of the selection tools 

to select the �rst creature. Once your selection is 

complete, copy the selection (Ctrl C) and paste it  

(Ctrl V) onto the cityscape. Use the transform option 

to resize, rotate, �ip or distort your creature. Add more 

images of the creature by pasting them (Ctrl V) onto 

the background. Repeat this process for the other two 

images. Each time you paste a new image, Photoshop 

will place it on a different layer. Switch between the 

layers to move the creatures to different locations to 

create an interesting and well balanced composition.

3. Record the process you used to create this image by 

printing �print screens� throughout its construction. 

Glue the print screens into your workbook or journal 

and comment on the process.

4. Print out the �nished image. 

5. Evaluate the �nished image.

6. Select a photograph from this book that has been 

digitally manipulated. Provide the title, date and 

media, and outline at least six steps that you think  

the artist may have used to make the work.

activities

 3.2  image qUality
When creating your digital photographs, it is important 

that you strive towards producing the best quality image 

possible. The quality of a digital photograph is determined 

by a number of factors. In particular, the type of camera you 

use, its lens, imaging sensor, pixel size and the settings 

you select in terms of resolution (image size, DPI), ISO 

(sensitivity), focus, exposure, aperture and shutter speed.

When you analyse the quality of your photographs, it is 

important for you to consider many things. In particular:

1. Content. Does the image say something differently?  

Is it worthwhile? Is it surprising? Is it effective (see 

chapters 4 and 5, pages 102 and 109)?

2. Structure. Is the image composed well? Do the 

elements contribute meaning and purpose to  

the image (see chapter 8, page 142)?

3. Craft. Is the photograph made skilfully (see chapters 1 

and 3)? 

It is important for you to take into consideration:

a. Resolution. Image resolution is determined by the 

number of pixels produced per inch (ppi). An image 

printed at a small size contains more ppi than the 

same image printed at a larger size. In order to gain 

a good quality print, the number of pixels per inch 

should not be less than 150 dots per inch (dpi) at 

the size you wish to print. If it is less than 150 dpi, 

then the clarity and sharpness of the image will be 

compromised and you may not be able to see all the 

�ne detail.

i. An image showing high resolution

ii. The same image showing low resolution

Figure 3.2A
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b. Tone. There should be a broad range of tones, from 

very dark to very light, with a large number of tones 

in between. Tones should be clearly distinguished 

from shadows to highlights. The darker areas of  

a photographic image are known as shadows, 

whether they are shadows or not. The light areas  

are called highlights and those in the middle are 

called mid-tones.

Figure 3.2B A photograph in which the shadows and highlights  

are indicated

c. Colour. Colour can be technically correct or it can be 

enhanced or altered to gain a particular effect. For 

correct colour, a grey piece of wood appears grey, 

�esh tones appear normal, a known colour such as 

a trade logo appears exactly right. Pleasing colour 

could mean red tones at sunset, warm tones on a 

portrait, or bluish tones for a night or snow scene.

d. Sharpness. Sometimes high sharpness is required to 

reveal detail; at other times you may want softness 

to obscure it. It is these qualities that we can 

control in digital photography and use to enhance 

our images.

e. Concept and design. Perhaps most important is the 

question, is the image interesting or important for 

some reason? If you take a boring image, poorly 

composed, at the wrong moment, and there is 

camera shake it is very unlikely anyone will accept  

it as a high quality image.

Controlling image quality
The quality of a digital photograph relies on a 

combination of many attributes, as discussed previously. 

Because people have a variety of quality concerns 

that may vary with different images, the answer is not 

simple.

In order to achieve a high quality print, you need 

to have an understanding of how to obtain the best 

results for each quality concern (colour, tone, detail and 

clarity) and then put into place an action plan to combat 

problems as they may arise.

This section will cover some of the factors that you  

need to consider when enhancing a digital photograph.

Colour and tone

For the content to be seen easily and effectively in your 

photographs, the tones and colours should be correct 

and chosen from the widest possible range. For instance, 

a face should appear to have correct �esh tones � not 

green (unless you want to make the person look sick!). 

Black should be as black as possible, white as light as 

possible. You should be able to see detail in dark shadows 

and in bright areas.

Tone can be controlled by using digital software to  

adjust the levels of your photograph (see pages 84�87 of 

this chapter).

Colours

Light is a form of energy that comes from the sun, light 

bulbs, candles or other sources. Light can alter the way 

that you see colours. It is possible to manipulate the 

colours in your photographs, but �rst you need to have  

a basic understanding of colour theory.

It has been know for a long time that if we mix red (R), 

green (G) and blue (B) we can make other colours.

R + B = Magenta

R + G = Yellow

B + G = Cyan

Red

OrangeRed-Magenta

Yellow

Yellow-GreenBlue-Magenta

Magenta

GreenBlue

Cyan-GreenCyan-Blue

Cyan

Figure 3.2C An RGB and CMYK colour wheel

Mid-tones

Mid-tones

Mid-tones

Highlights

Shadows

Shadows

Highlight
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Although we give names to many other colours, all 

the colours we recognise can be made with varying 

amounts of red, green and blue. These are called the 

primary colours of light. Cyan, magenta and yellow are 

called secondary colours.

Blue is the opposite of yellow; if you increase the 

amount of blue in your image you will reduce yellow. 

Similarly, increasing green reduces magenta and 

increasing red reduces cyan.

All individual colours are described by three factors:

1. Hue: the colour you see (for example, blue, cyan, red).

2. Saturation: how colourful it is. Does it appear pure or 

is it dark and mixed with black?

3. Lightness: how bright it is (that is, how much white is 

mixed with it).

Red hue

More
saturation

Less
saturation

Figure 3.2D A diagram demonstrating colour saturation

This seems complicated, but it is necessary to 

understand that when we are discussing digital images 

there are three basic colours (blue, green and red) 

and three colours produced by combining them (yellow, 

magenta and cyan). All variations can be produced 

by mixing the basic colours to produce other colours 

(hues) or mixing them with black (reducing their 

colourfulness or saturation) or white (making them 

lighter or darker).

Colour can be controlled by using digital software (see 

section 3.5, pages 88�90).

Detail and clarity
To create a photograph that contains detail and clarity, 

it is important to � rst consider the size of the sensor 

upon which the image is being recorded.

Many SLR cameras do not have full-frame sensors; 

instead they have smaller ones. As sensors become 

smaller there must be fewer pixels, or the pixels 

need to be smaller. Fewer pixels mean less detail, 

so manufacturers try to � t more pixels into smaller 

spaces. Smaller pixels require better lenses but, as 

smaller sensors are used on lower cost cameras, 

this is not usually the case. This is why mobile phone 

cameras are poorer quality than compact cameras, 

which are poorer than SLRs. Professional SLRs often 

have full-sized sensors.

Figure 3.2E Diagram demonstrating the variation in sizes of imaging 

sensors

In general, any SLR will have enough pixels of 

suf� cient size to produce high quality results for all 

but very demanding professional purposes. If you are 

planning on printing your images to a large format, you 

must ensure that you set your camera to a large image 

size (highest quality JPEG or RAW).

To control the detail and clarity of an image, it is also 

important to be aware of focus and depth of � eld. Refer 

to chapter 1 (page 2).

Image output
Most digital images are either printed or viewed on a 

computer screen. The requirements for each differ.

� Printed output. The output quality of the image will be 

determined by the size at which you wish to print and 

the resolution of the � le. This resolution is quoted in 

pixels per inch (ppi). Most prints require your image 

to be at least 150 ppi at your chosen size. If you are 

doing your own printing you should check your printer�s 

manual for the recommended ppi. If you are sending 

your � les to a lab, discuss the requirements with 

them. If you are unsure, or your work is going for offset 

printing, say in a book or magazine, 300 ppi is a safe 

guess. As well as ppi, you will often see the term �dpi�. 

This means �dots per inch� and refers to the output 

resolution of the printer. Newspapers and magazines 

have a resolution ranging between around 100 to 

300 dpi, using printing plates. Inkjet printers spray 
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ink in very �ne droplets, enabling resolutions up to 

2880 dpi and higher. You do not need �les of this high 

resolution to print from, as the printer imports a lower 

resolution and converts it to small dots. In summary, 

if you prepare your �les so that they are between 150 

and 300 ppi, at the size you wish to print, this will be 

satisfactory for most printing purposes, no matter what 

output dpi is quoted.

� Screen output. Computer screens differ in quality and, 

as a result, if you are using a high resolution image on 

a poor quality computer screen then the image will not 

appear true on the screen.

Mode and file types
modes: rGb, cmYK and greyscale
All colours in a digital image can be de�ned by systems 

that describe each colour with numbers. There are 

different systems, depending on the output. For instance, 

computer screens show red, green and blue (rg�) 

information; so, for screens, we need to describe colours 

in RGB numbers. Offset printing, such as for newspapers, 

magazines, books and brochures, uses yellow, magenta 

cyan and black (cmyk) inks, so colours for these 

processes are described in CMYK numbers. Most inkjet 

printers print in CMYK (and sometimes other colours) 

but accept the ����� information in RGB, so for these 

purposes we use RGB. The conversion from RGB to CMYK 

is performed by software built into the printer. In this book 

we will only consider RGB because this is the mode most 

used by photographers.

Colour images can also be converted to greyscale, 

deleting entirely the colour in an image, making the 

image appear in greys from black to white (see  

section 3.6, page 91).

JpeG, pDF and tiFF �les
If you are having dif�culties because the size of your �le is 

too large, it is possible to compress it to make it smaller 

and therefore more manageable. There are two main types 

of compression.

1. lossy compression

On �les that are compressed to become quite small, a 

certain amount of data is usually lost. The most common 

lossy compression �le type is JPEG. Most cameras output 

JPEG by default and this produces images satisfactory 

for most purposes. Problems arise if you open your JPEG 

and then save it as another JPEG. This means double 

compression. Once is okay, twice or more can destroy too 

much detail.

2. lossless compression

These are compressions with little or no loss of data. 

The �les will be bigger than JPEGs. There are two main 

lossless �le types: TIFFs and PSDs. TIFFs are suitable  

for most software from any manufacturer. PSD is a 

Photoshop �le useful for situations where you may be 

moving a �le from one Adobe application to another;  

for example, Photoshop to Illustrator or InDesign. JPEGs 

contain mostly image data. TIFFs and PSD �les can also 

store information that includes layers and selections with 

the �le for later use.

You may wish to do these activities as a class or 

individually in your workbook or journal.

1. Select two professionally taken photographs from this 

book and assess their quality out of 100. Mark them 

out of 20 for each of the points below.

assessment criteria mark

Content 

Does the image say something differently? 

Is it worthwhile; is it surprising? /20

Structure 

Is the image composed well?  

Do the elements of design contribute 

meaning and purpose to the image? /20

Craft 

Is the photograph made skilfully? /20

Colour and tone  

Are the colour and tone correct and are they 

effective? Is there a broad variety of tones 

ranging from very dark to very light? /20

Detail and clarity 

Does the image size, pixels and the use of 

focus add quality to the photograph? /20

final grade /100

 Comment on the �nal grade you gave each work and 

discuss the two main qualities of each image. You may 

also wish to consider an element of each image that 

lets it down in terms of quality.

2. Select two of your own images and use the above 

table to assess their quality. Comment on the �nal 

grade you gave the images and discuss the two main 

qualities of each. You may also wish to consider an 

element of each image that lets it down in terms  

of quality.

activities
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 3.3  downloading, 

filing and 

selecting images
With digital photography, you no longer have to worry 

about the cost of � lm, as people did in the past. You may 

take hundreds of spontaneous and creative photographs 

of your friends, family and events on a digital camera. In 

doing this, you may � nd that you don�t actually download 

and print all of your photographs. In the past, in order to 

see your image, you had to have the � lm processed. With 

digital photography, you can view your image instantly, 

and this may be the reason so many people put off 

downloading their photographs and then eventually forget 

about them. However, a problem will arise when new 

technology supersedes old, and new decoding software 

can no longer read old � les. If old images are not 

downloaded, stored correctly and/or printed, they could 

be lost forever. For this reason it is important to download 

and store your images correctly.

Downloading
On your camera is a digital output plug. The correct 

lead (usually supplied with your camera) will connect the 

camera to the computer. Plug your lead into the USB 

or Firewire connection on the computer and turn on the 

camera. The photos you have taken should appear as 

small images on the computer screen. These images are 

called �thumbnails�. The computer will ask if you want 

to download all or some of the images. To select those 

you want, click on them and hold the Command (Mac) or 

Control (Windows) key. If you want to download a series of 

images, click on the � rst one, then the last, with the �shift� 

key pressed. All the images you have chosen should light 

up. Then press �download�. Wait until all the images come 

up onto the screen.

Storing images into a folder
Downloaded images are normally stored in a folder named 

�My Pictures�. If you wish, you can create a folder for 

storing them. The �My Pictures� folder is normally found 

under Main Drive > Users > (Name) > Pictures in Macs or 

in �My Documents� on a PC.

Figure 3.3A A My Pictures folder

It is best to separate your images into separately named 

folders; for example, a landscape, a portrait and a still-life 

folder.

After downloading all your images into one folder:

� Create a separate folder for each shoot 

(File > New Folder). The names of your new folders will 

come up as Untitled 1, Untitled 2 and so on.

� Rename your folders by clicking on the name of each 

rekeying a new title; for example, Big hill sunset, Tan at 

beach, Red gum tree, Flowers.

� Move a copy of all photos from each shoot to the 

appropriately named folder. To do this, click on the � rst 

image, hold the Shift key and click on the last image. All 

the images will highlight. Then click on the highlighted 

group of images and drag it to the new folder, holding 

down the Alt key.

It is important to keep all of your photographs neatly 

labelled under clear, appropriate headings so that you can 

� nd them quickly.

Keeping your original 
camera files
When all your chosen images have been downloaded, it is 

a very good idea to save them on a �s� device or burn 

them onto a CD or DVD. If you make a mistake later; for 

example, by reducing your � le size to less than is required 

for a print, and you have not made a copy, you can then 

download your original � le from the disc or USB and start 

again.

Figure 3.3B CDs, a DVD and USBs
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Burning a CD or DVD
Most computers have disc-burning software. Common 

programs are Nero for Windows and Roxio Toast for 

Mac. A CD holds around 600 MB safely, and a DVD holds 

approximately 4 GB (4000 MB). Actually, they can hold 

more, but it is not a good idea to overload them. This 

can lead to � le damage. A � le from a 6-mega-pixel camera 

as a high quality JPEG is just less than 2 MB in size. This 

means you can � t 600/2 = 300 onto a CD or 4000/2 

= 2000 on to a DVD. It is recommended that you also 

burn your � nished � les onto a memory stick or disc. 

Finished � les are likely to be a lot larger. For instance, a 

2 MB JPEG converted to a TIFF or PSD � le may open up to 

nearly 20 MB. You could � t 600/20 = 30 of these images 

on to a CD. Put a new CD into the slot and press �burn�. 

You can also set burning instructions so that � les on 

disc can be read on either Mac or Windows computers, 

or both.

Print a proof sheet 
using Photoshop
� Save all the images you want to appear on the ����� 

����� (also known as a ������� �����) to a folder.

� Go to File > Automate > Contact Sheet II.

ii. Diagram of a Contact Sheet II window

Figure 3.3D An example of a proof sheet

i. Diagram indicating the location of File > Automate > Contact Sheet II

Figure 3.3C

Select folder

Columns

Rows
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Figure 3.3E A student examining images on the computer screen

Note the numbers of the images that you have selected 

and save them (File > Save As) in a new folder named 

�Selected Images� in the Shoot Folder.

If they are in JPEG form, save them as TIFFs or PSD �les 

to prevent further compression and the additional loss of 

information.

The only time you should save any �le as a JPEG is 

for emailing or web use. Always keep an uncompressed 

version of the �le.

In the dialogue box:

� Source images � �nd where you have stored the folder 

with the images in it and highlight it.

� Document � set the page size for printing the proof 

sheet.

 For A4, width = 20, height = 29 is �ne.

� Resolution � 150 pixels/cm is okay.

� Thumbnails � note that the more columns and rows  

you have, the smaller the thumbnails. For 12 images 

on an A4 sheet, set columns to three, rows to four. A 

window will come up to show you how the proof sheet 

will look.

� Press OK.

� The proof sheet will appear on the screen after a few 

seconds.

� Press Print (see section 3.7, pages 98 and 99).

Examining and selecting 
images
Open into Photoshop all the images you are considering 

using. If you have more than 20 images, bring them in one 

group at a time. Go to the appropriate folder, click the �rst 

and last images, and highlight them by holding down the 

Shift key. Then click on the whole group and drag them to 

the Photoshop icon. All the images will open, one on top  

of the other.

View the images on the screen and close down any that 

you may not want to use. Look at the rest for appropriate 

exposure, colour, ��������, expression and composition. 

Remember, you can still straighten, crop and edit for tone 

and colour. Look for the best images; then zoom in on 

them  for closer inspection, especially for sharpness 

(at 100 per cent is best).

activities

1. Using a series of photographs that you have taken, use 

the process indicated above to print out a proof sheet. 

When you are developing your skills as a photographer, one 

of the most signi�cant things that you can do is analyse 

the images that you take. There is no greater lesson than 

learning from your own mistakes. Every time you complete a 

photographic shoot you need to print out a proof sheet, glue 

it in your workbook or journal and comment on the results. 

It is recommended that you also record in your workbook or 

journal the following information about the shoot:

� the date it took place

� the location

� the subject matter

� your intention in taking the photographs.

2. Looking at your proof sheet, circle and comment on the 

images that you think are the most successful. Discuss what 

you think are the qualities that make an image work (for 

example, composition, light, motion, colour, tone, pattern). 

Select three or four of the images that didn�t work well, 

circle them with another colour and discuss why you think 

they were unsuccessful.

3. Why do you think that so many people do not get around to 

printing their photographs? Provide at least three possible 

reasons.



79chAPTeR 3 digital processes and procedures

(continued)

Figure 3.3F An example of a student�s workbook/journal showing the analysis of a proof sheet
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You are now ready to edit your selected images to 

make them ready for printing. You might like to save your 

selected images into another folder. Many professionals 

call these images their �Hero� images.

1. When you �nish choosing your images, make another 

proof sheet of them to glue into your workbook or 

journal. Comment on the most successful qualities of 

the images and what needs to be done to adjust and 

enhance them in Photoshop.

2. Compare your proof sheet with that of another student 

in your class. Suggest how you feel the images could 

be improved and give reasons for your suggestions.

activities

 3.4  editing the image
It is possible for you to use digital imaging software such 

as Photoshop to edit a photograph. The editing process 

will allow you to apply corrections to enhance the quality 

of your image. These alterations can include correcting 

mistakes made when taking the photograph. (Warning: It 

is always best to take the �nest image possible. The best 

software cannot correct many major mistakes!)

Editing can correct colour and tone. In addition, editing 

can add or subtract parts of the image, make light areas 

darker or dark areas brighter. Image editing programs like 

Adobe Photoshop can be very complex and it is easy to 

get lost or to overcorrect and damage the image.

The best solution is always the simplest, so in this 

section we will look at the editing procedures that are 

most important for obtaining good quality photographs  

for print or screen.

Managing images  
on the screen
When you open several images at the one time, the 

images are on top of each another. To bring a covered 

image to the top, click on the horizontal bar on top  

of the image. To move an image around the screen, click 

and drag the horizontal bar to where you want the image 

and release the mouse to drop it (see �gure 3.4A).

Zooming
When working on an image, you may want it bigger to 

see if it is sharp, check details or manipulate a small 

selection. You may want it smaller so you can see the 

whole image, or even smaller again to move and compare 

it to another image. If you have several images open at 

once, you may want to arrange them on the screen or 

place them out of the way for later use.

To change the viewing size of an image you can use the 

zoom tool  . Activate the zoom tool by clicking on the 

magnifying glass on the main toolbar or by just clicking 

�Z� on the keyboard. For example:

� Click Z to activate the zoom tool. The zoom tool�s default 

is magni�cation and the cursor changes to a plus (+) 

sign.

� Click repeatedly on the image until it is the size you 

need. The magni�cation percentage will appear next to 

the image. When making �ne selections, you may need 

to go 200 or even 300 per cent. At these magni�cations 

you will see the individual pixels. To reduce the image 

size, hold down Alt on the key board and the + will turn 

 to a minus sign (-)  or right-click and go to �zoom 

out�.

Figure 3.4A A screen with several images opened on top of each other

Navigating
When you have a greatly magni�ed image it is easy to 

become lost. If you click on the navigator palette (Windows 

> Navigator), the active image will appear in a small 

window on the screen, with a little red square showing you 

where you are.

To move around an image that is zoomed-in so much 

that it does not all �t onto the screen, click and drag the 

bars on the left or lower sides of the screen image. An 

easy way to do this is to hold down the space bar on the 

keyboard. The cursor changes to a hand and, while holding 

down the space bar, you can left-click onto the mouse key 

and drag the image. Try it, it�s fun! Alternatively, you can 

just click on and use the hand tool from the Photoshop 

tool bar   .
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Straightening the image
When you take a photograph, you tend to look at 

the subject close to you. Often, the background 

may not be straight. If you don�t notice this, the 

image may have a tilt. Of course, sometimes you 

may deliberately angle the camera for a special 

effect. Usually, it is best to have horizontal lines 

without tilts. Such tilts can be corrected. There will 

be some loss at the frame edges after correction 

when you crop to get a square or rectangular frame.

There are a number of ways to straighten 

images, depending on circumstances and  

software options.

Using the transform option to 

straighten images

� Place a grid over your image by going to  

View > Show > Grid.

� Now, pick a line that should be horizontal, 

like the horizon, or vertical, like the side of a 

building.

� Use the marquee tool to select the entire  

image or click Select > All.

� Go to Edit > Transform > Rotate.

� Click on a corner and drag the image around 

until the crooked line lines up with the  

straight line on the grid.

� Click Enter/Return.

� You may need to crop the image to give it  

a square or rectangular frame (see next page).

� Pressing D on your keyboard will deselect  

the image.

Figure 3.4B An example of a navigator palette

Slider will allow you to slide in or out

Highlights the section of the image currently  

on the screen

i. Photograph showing a tilted horizon line

ii. The same photograph showing the horizon line straightened

Figure 3.4C
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Cropping

You may need to ���� an image when you straighten 

it, as described previously, or re�ne its composition.

� Click the crop tool on the toolbar, or press C.

� Click and drag the rectangle to obtain the crop  

you want.

� Press Enter.

i. A photograph before cropping

ii. The same photograph after cropping

Figure 3.4D

Retouching
If you obtained a digital �le by scanning �lm or  

re�ection copy (such as objects or paper on a �atbed 

scanner) or if you took digital photographs with dust  

on the sensor, you may have spots you want to remove.  

This ���������� is done with clone, heal or patch tools. 

You may also want to get rid of pimples or wrinkles from 

your portraits.

i. A photograph showing lots of dust spots

ii. The same photograph showing no dust spots

Figure 3.4E

Using the clone tool
The clone tool allows you to select a circular area and 

place a duplicate (clone) of it on top of another area; for 

example, a spot you wish to remove. This is most useful 

when the background has no texture. You can clone a 

whole face in if you choose!

� Select the clone tool . It has an icon that looks 

like a rubber stamp. The quick select method is S on  

the keyboard: S for stamp.

� Choose a brush size just bigger than the area you  

want hidden. A right-click can bring up the brush 

dialogue, otherwise click the arrow in the brush box on 

the tool options bar. This window will show two sliders, 
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one called �master diameter� and the other �hardness�. 

You usually want a soft edge to the clone stamp brush, 

so slide the hardness to 30 per cent. Master diameter 

sets the width measurement of the pixels of the clone 

stamp. You can also pick a brush from the selection that 

opens at the lower part of the brush drop-down window.

� Place the cursor on an area you want to copy. Hold down 

Alt then left-click.

� Take your �nger off the Alt key and move your cursor 

over the area you want to cover, and left-click. The 

selected part of the image will appear on the new area.

Using the healing brush tool

The healing brush tool is a bit like the clone tool but 

works well for textured areas. It places a selected textures 

area over the portion you want to mask but takes into 

account the surrounding area to blend in with surroundings. 

There are two variations of the healing brush.

Use this the same way as the clone tool, but now you 

can match texture from one area into another.

In later versions of Photoshop there is a �spot healing 

brush�. When you use this, you don�t have to select the 

area, just click on the spot and Photoshop automatically 

masks it, taking into account the surroundings.

Using the patch tool

The patch tool is ideal for replacing one area of an 

image with another. For example, replacing the dark circles 

under someone�s eyes with the skin from another area of 

the face. In order for this to work effectively the foreground 

and background colours need to be set to black and white 

(  ).

To use the patch tool, �rst select the area that you want 

covered. You can do this by holding down the Alt key and 

dragging the patch tool around the area to be selected or by 

using any other selection tool. 

Once the area is selected, click on the patch tool and 

ensure that the source option is selected on the tool 

option bar at the top of the Photoshop window.

Using the patch tool, click onto the selection and drag 

it on to the area that you want to replace your original 

selected area with. When you take your �nger off the mouse 

the new area will appear merged into the original area.

This is a popular portrait technique as it makes people 

look younger. Fashion photographers often remove every 

wrinkle or defect and their models then look like dolls (see 

�gure 3.6R on page 97).

Using the red-eye tool

The red-eye tool can correct the fault of red eyes 

caused by a camera�s �ashlight (see chapter 1, page 10).

Just click on the red part of the eye with the tool and it 

should automatically correct the problem.

i. Photograph before cloning

ii. The same photograph after it has been cloned

Figure 3.4F
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Adjustment layers
It is best to edit and enhance your images on separate 

adjustment layers. By producing individual adjustment 

layers when modifying the levels, curves, colour balance 

and hue saturation (for example) of your image, you will 

then be able to go back at any time to readjust these 

amendments without altering or damaging the other 

components of the image.

Adjustment layers are instructions for image editing that 

appear on the screen as a stack of horizontal book spines 

in the �Layers� window (see �gure 3.1O, page 71). They 

can be added to, swapped around or removed. Instruction 

layers, called �adjustment layers�, don�t block the layers 

underneath, although image layers do. To see through a 

layer to the layer underneath, we can make all or part of 

it transparent. This is done by lowering its �opacity�, by 

moving the slider that appears underneath the opacity sign 

at the upper right of the layers palette. One hundred per 

cent opacity means the layer blocks or acts completely. At 

50 per cent opacity it only works at half strength.

An advantage of adjustment layers is that you can  

re-adjust them by clicking on the black and white circle of 

the layer and the dialogue box re-opens to enable you to 

shift the sliders and readjust.

Figure 3.4G Diagram showing a number of different layer options

Adjusting tones
As discussed in section 3.2 (page 73) �tones� refers to 

the darkness or lightness of an image. Dark tones are 

called �shadows� (even if they are not shadows) and light 

tones are called �highlights�. Black is the darkest possible 

shadow tone, and white is the lightest possible highlight. 

Tones in the middle are called �mid-tones�.

Sometimes you may �nd that your image is too light or 

too dark. That is when tonal correction is required.

If the image is muddy, it may well be all mid-tones, with 

no black or white. Unless it is a picture of a foggy day, you 

may want more impact and need to get deeper shadows 

and brighter highlights.

i. Photograph demonstrating muddy tone

ii. The same photograph where tones have been enhanced

Figure 3.4H

Using levels to correct tones
In Photoshop, the simplest way to adjust the tone is to 

adjust �levels�.

This is done by going to Image > Adjustments at the top 

of the screen and selecting �Levels� from the drop-down 

menu. You could begin by clicking onto Auto Levels to see 

if this gives you the required result, if not, you will need to 

undo the adjustment and correct the levels manually.

In Photoshop, make a levels adjustment layer: Layer > 

New Adjustment Layer > Levels.
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Sliders

Gamma slider

DARK LIGHT

Figure 3.4I Diagram of a histogram

When you select �levels� you are helped by the 

histogram that comes up in the dialogue box. 

The left-hand end of the histogram is the dark-tone area 

and the right-hand end the light-tone area. The dark area 

on the graph that looks like a mountain range represents 

the number of pixels of the tone on the base line. If there 

is a mountain of pixels at the dark end (left), the picture 

is dark. We call that low key. If there is a mountain at the 

light end (right), the picture is mainly light. This is a high 

key image.

If the histogram does not reach the base at either or 

both ends but ends part-way up the sides of the box, 

we have clipping, which means that shadow or highlight 

details will be lost in those tonal areas. With most 

pictures, we aim to have a black, a white and tones in 

between, without clipping at either end.

If there is clipping, the tonal range usually cannot be 

corrected because tones have been �chopped off� and 

cannot be regained. This is especially true if the original 

image is a JPEG.

If there is no clipping and the mountain of pixels drops 

to zero inside the ends of the box, the tonal range is 

short; that is, at the dark end, tones may stop before 

they reach black and, at the light end, before they reach 

white.

This can be corrected by moving the sliders underneath 

the histogram until they just reach the start of the 

mountain range.

� The left and right sliders should be positioned where 

they just reach the start and end of the mountain range. 

This allows the dark-end tones of the image to reach 

black, and the light-end tones to reach white.

� The middle gamma slider can be moved to the left to 

make the whole image lighter or to the right to make  

it darker.

The middle gamma slider 

can be moved to the left 

to make the whole image 

lighter or to the right to 

make it darker.

The left and right sliders should be 

positioned where they just reach the 

start and end of the mountain range. 

This will allow the dark tones of the 

image to reach black, and the light 

end to reach white.

Figure 3.4J How to move the sliders into place. Photograph by Andrea 

Innocent

Correcting colour
From section 3.2, chapter 3 (pages 73 and 74), you 

should be aware that what you see on your screen is not 

always what you will see on a print-out. It is often best to 

do as much automatic colour correction as you can. If you 

keep twiddling with blue, green and red controls until the 

image looks right, the print may still turn out badly.

auto colour adjust
In Photoshop, go to Image > Adjustments > Auto colour.

This is a simple method that often works.

Figure 3.4K The location of the auto colour



PART 1 MAking: using skills, Techniques And PRocesses86

As mentioned previously, it is best to make any 

adjustment to your image in an adjustment layer (in this 

case, create a duplicate layer to use for your adjustments. 

This is done by clicking onto the duplicate layer icon found 

on the layers drop-down menu � or use the shortcut J).

Figure 3.4L How to make a duplicate layer of an image

Using curves to adjust colour
In Photoshop, make a curves adjustment layer: Layer > 

New Adjustment Layer > Curves.

There are three eyedroppers in the curves dialogue box.

One is black. This is the black�s eyedropper. The white 

eyedropper is for the white point and the centre eyedropper 

is for creating neutral grey. If you can make black and 

white without any colour left, the colour is often corrected 

throughout the tone range.

Black 

dropper

Grey 

dropper

White 

dropper

Figure 3.4M Diagram of the curves dialogue box

� If there is bright white, click on the white eyedropper, 

then on the white in the image.

� To use the black eyedropper, � nd a very deep shadow. 

You may need to do this a few times to � nd the 

darkest tone.

� For the grey eyedropper, look for something like 

weathered wood or concrete.

Brightness and contrast
Brightness depends upon how much white is in an image. 

More brightness means a lighter image, less means a 

darker image. The basic control for brightness is exposure. 

More exposure gives a brighter image, less makes an 

image darker. You need to aim for your camera exposure to 

produce the correct brightness. Usually, the auto exposure 

controls in the camera automatically give correct exposure 

and brightness.

adjusting brightness and contrast
Go to Image > Adjustment > Brightness and Contrast 

and move the slides until your image looks okay. Make 

sure you can see the histogram (View > Histogram) to 

ensure that none of the mountains of pixels fall off the 

cliffs at either end!

Contrast is how quickly dark areas change to light. If 

an image has only black and white parts, it has very high 

contrast. If it only has a few tones of grey, with no blacks or 

whites, it is of low contrast. The aim of most photographs is 

to have a contrast between these extremes.

i. A photograph with 

correct brightness and 

contrast

ii. The same photograph 

with too much 

contrast

iii. The same photograph 

with too much 

brightness

Figure 3.4N

Figure 3.4O Diagram of the brightness and contrast dialogue box
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Using curves to adjust brightness  

and contrast
Go to Layer > Adjustment layer > Curves. A boxed grid 

comes up with a diagonal line. Any point on the line can 

be clicked on and the line raised or lowered by dragging.

The line represents tones in the image as follows:

If the angle of the line is made steeper, the contrast 

increases.

The line is moved to 

make it more vertical

i. The curves line has been moved to make it more vertical. This has 

increased the contrast.

The line is moved to 

make it more horizontal

ii. The curves line has been moved so that it becomes more horizontal. This 

has reduced the contrast.

If the angle is lessened the contrast lowers (becomes 

�atter).

Refer to the diagram and see that both blacks and 

whites have become greys. If we take the centre of the line 

(graph) and drag it up, the image becomes lighter; down, it 

becomes darker.

The line is moved up towards the left, creating a brighter image

iii. The curves line has been moved up and towards the top-left corner, 

creating a brighter image.

The line is moved down towards the right, creating a darker image

iv. The curves line has been moved down and towards the bottom right-hand 

corner, creating a darker image.

Figure 3.4P

Burning and dodging

Photoshop has burning and dodging tools to 

make areas darker or lighter, just like the traditional 

darkroom technique (see chapter 2, page 32). Click on the 

tool and pick a brush at about 30 per cent opacity, and 

paint the area you want to burn (make darker) or dodge 

(make lighter).
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If you want small changes, this is acceptable, but 

burning and dodging damages pixels, so be careful.  

Don�t overdo it. A better method is to create a new empty 

layer and paint black or white to darken (burn), or lighten 

(dodge). To make this work, you must know a special trick.

This is how you do it:

1. Add a new, empty, layer to the layer stack by clicking on 

the new layer icon at the bottom of the layers palette.

2. Then the trick. At the top of the layers palette you will 

see �normal�. This is called a blending mode. Click on 

the double-headed arrow to the right of it. From the 

drop-down menu, select �soft light�.

3. Now make sure the foreground and background colours 

(the overlapping squares in the tools palette) are black 

and white. If they are not, click the little black and white 

squares above the foreground/background squares.

4. To burn, make the foreground (top) square black. If it is 

white, just click the little bent double-headed arrow over 

the squares.

5. Select a brush, keep the opacity low, say 30 per cent, 

and �burn in� with the brush on the parts of the image 

you wish to darken.

6. To dodge, make the foreground white and brush as for 

burning, above.

 3.5  scanners
You have probably used a �at-bed ������� to make a copy 

of an existing two-dimensional image or text. Have you 

ever considered using the scanner to create photographs 

of three-dimensional objects? Well you can � this section 

of the book will show you how.

1. Select two successful photographs that you have 

taken and work through the process from this 

section of the book (section 3.4) to enhance 

the quality of both images. Use �print screens� 

to record any adjustments that you make and 

document the process in your workbook or 

journal. Provide a before and after print of each 

image and comment on the �nal outcome.

2. Explain how effective your adjustments have 

been.

activities

i. A photograph before dodging and burning has taken place ii. The same photograph after burning and dodging

Figure 3.4Q

Dodged 

in to 

make 

this area 

lighter

Burned 

to make 

this area 

darker
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Types of scanner
Scanners produce digital � les from either:

1. Re� ection art � photographs, drawings, writing on 

paper or even objects, or

2. Film � negatives or transparencies.

There are specialised scanners for re� ection art and 

others for � lm or slides, but most re� ection scanners can 

also scan � lm and slides reasonably well.

The purpose of a scanner is to take a hard copy 

(re� ection art � lm or slide) and produce a digital � le 

able to be edited for screen or print directly or combined 

with other images. For instance, you may wish to scan a 

document, perhaps a handwritten letter, with a photograph.

Most scanners have their own software and this may 

need to be modi� ed if they are to be used properly under 

different circumstances.

Reflection/flat-bed scanners
To import a scanner into Photoshop go to Edit > Import 

and select the scanner software. The scanner must be 

connected and switched on.

Figure 3.5A An example of a � at-bed scanner

When activated, the scanner software interface comes 

up. The layout will vary from one scanner to another but 

the general principals are the same.

You will have to choose:

� What sort of original you have; that is, re� ection (for 

example, a print) or transmission (for example, a 

negative or slide).

� What resolution you wish to scan at (see �Scan 

resolution�, next).

� The bit depth (8 or 12 bits/channel; that is, in RGB total 

of 24 or 48 bits).

� Exposure � try auto � rst. If the resultant � le histogram 

shows highlight clipping, reduce the exposure, if the 

shadows clip, increase the exposure.

� The output size.

� On the panel or in scanner preferences, choose where 

you want the scanned image to go; for example, to a 

folder or to open up in Photoshop, or both.

� A �������� function.

� A selection of preview or scan.

Preview

Option

settings

Scan

Figure 3.5B An example of a software interface for a � at-bed scanner

scan resolution

� First decide on the output resolution. For print, this may 

be 360 dpi. You may want a � le for screen that requires 

lower resolution, but it�s better if you choose a print 

resolution. This will give you the option of either printing 

or downsizing later for screen.

� Colour references � the scanner default is usually okay.

bit depth
For an image not likely to require much editing, 8-bit 

is okay. If you intend to do a lot of Photoshop editing, 

especially levels or curves, choose 16-bit. This will help 

prevent banding in shadows. If you choose 16-bit, the � le 

will be twice as large.

preview and crop
If your original to be scanned is smaller than the scanning 

glass, you don�t need to scan the lot. If you do, the � le will 

be big and take unnecessary time to scan when you only 

want part of it. This is where preview comes in.

1. Set up the scan details, as above.

2. Place the item to be scanned in the centre of the 

scanning plate. This is called the �sweet spot�, as the 

detail is better towards the centre.

3. Press Preview.

4. When the scanner plate appears, crop the area 

you want scanned. The crop tool will probably look 

the same as the one in Photoshop. You may wish 

to straighten the original if it is a bit crooked and 

repeat Preview. You don�t have to get it exactly right, 

� nal trimming and straightening can be done in 

Photoshop.

5. When you�re satis� ed with the original, press Scan. 

Scanning may take a little while if the � le is large. If the 

� le is too large for the scanner you may have to reduce 

the resolution.



PART 1 MAking: using skills, Techniques And PRocesses90

Film scanners
You may have a dedicated � lm and slide scanner. The 

principles are similar to those for a � at-bed scanner but 

you can only scan � lm and slides. There are usually two 

holders: one for � lm strips � usually six frames long, and 

one that holds a single mounted slide.

1. Insert the right holder in the scanner. If you are 

scanning a mounted slide, place it in the holder before 

inserting. If scanning a � lm strip, insert the holder and 

slowly insert the � lm. The scanner should grip it, pull it 

in and position it.

2. With a mounted slide you can now proceed as 

described earlier for a � at-bed scanner.

3. With a � lm strip, the scanner software usually previews 

all the photos and presents them as thumbnails on the 

screen. Click on the one you want to scan to activate it 

and proceed as usual.

Figure 3.5C A photograph of a � lm scanner and a slideholder

Eject 

� lm

Auto

focus

Prescan Select

neg

Crop

Figure 3.5D An example of a software interface for a negative scanner

Scanning objects
Flat-bed scanners are able to be used as cameras. After 

all, when you scan a photograph you are really taking a 

photo of that photograph. Instead of placing a photo or 

drawing on the scanner plate, try placing some objects. 

You may have to lift the scanner cover to accommodate 

the thickness of your objects, so cover them with a dark 

cloth and do not look into the light during scanning, as it 

could damage your eyes.

The depth of focus of a scanner is limited, so only the 

parts in contact or very near the plate will be sharp. Try 

a � at object such as a moth. A high resolution scan of 

a deceased moth, butter� y or � ower, when printed large, 

looks fantastic!

Figure 3.5E An image of a shell and a piece of crumpled up paper, 

produced on a � at-bed scanner

Figure 3.5F An image of a moth, produced using a � at-bed scanner
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activities

1. Self-portrait

 Produce an image using a �at-bed scanner based around 

the theme of self-portraiture. Bring together a variety of 

objects that re�ect who you are. This might include a 

necklace or piece of clothing that you often wear, your 

phone, your travel card, a picture of a band that you like,  

or a photo of your family.

  Place all the objects on a �at-bed scanner and  

create an image that can be seen as a personal  

re�ection of you. On completion, print out a copy for 

assessment, glue an additional copy of the image into  

your workbook or journal and evaluate it using the proforma 

on page 257. Explain what you have learnt from this  

process.

2. Objects in nature

 Search for a variety of objects from nature. Consider the 

textures, colours and pattern of the objects. Explore scanning 

them with a �at-bed scanner to create interesting effects. 

Possible objects could include shells, autumn leaves, �owers, 

insects and plants.

  Record your investigation in your workbook or journal and 

print out your best image for assessment.

3. Extended task

 Explore manipulating and enhancing your images from 

activities 1 and 2 using Photoshop tools and techniques 

(see sections 3.1, 3.4 and 3.6, pages 61, 80 and 91). 

Document the process in your workbook or journal and print 

out your best image for assessment.

 3.6  Special effectS in 

digital photography
Computer software provides you with the opportunity to 

manipulate, enhance and distort your photographs in just 

about any way that you can imagine. After you develop 

knowledge of how to create special effects, the only thing 

holding you back will be your imagination.

Converting colour to black  
and white
Like most things in image processing, there are many ways 

to produce a black and white image using Photoshop, as 

well as other software. Some are better than others.

Using Photoshop, your options are as listed below.

Desaturate the image
This means all colours are converted to their minimum 

colourfulness; that is, grey.

Go to Image > Adjustments > Desaturate.

This would be wonderful if we saw all colours of the 

same brightness as equal tones, but we don�t. We see 

yellow and green as brighter than reds and blues, even 

when they re�ect the same amount of light.

A desaturated image can look very muddy; if is this 

the case, contrast can be added by going to Image > 

Adjustments > Brightness and Contrast.

convert to greyscale
The colours are converted according to a formula that 

approximates the way we see them.

Go to Image > Mode > Greyscale.

This is much better, especially if you then adjust 

levels.

Figure 3.6A Diagram of the location of the desaturate option

Figure 3.6B  

Diagram of the 

location of the 

greyscale option
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Go to Image > Adjustments > Levels and bring  

the sliders to the edged of the histogram. If the image 

looks a little dark or light, move the centre pointer, the 

gamma slider, until the image looks good (see pages 84 

and 85).

Use the channel mixer

People who use black and white �lm to produce black 

and white images often use �lters to improve an 

image. To make tones natural they use a yellow�green 

�lter. To make skies dramatic they use an orange or 

a red �lter, which darkens blues, giving a dark sky. A 

red �lter helps to lighten reds, so faces become pale. 

This is a trick of fashion photographers. We can do the 

same with digital, but we don�t need to put �lters over 

the lens.

Go to Image > Adjustments > Channel Mixer.

At the bottom left of the screen is a box called 

�Monochrome�. Click on it.

Figure 3.6C Diagram of the channel mixer window

Now you have three source channel slides.

A red channel set at +100 per cent, and a green and  

a blue set at zero.

You can alter these to act as �lters; that is, for a 

dramatic sky or light skin tone, increase red. If you do 

so, reduce green and blue because the total should add 

to 100 per cent; that is, if red goes to 150 per cent you 

could take both green and blue to -25 per cent:

+150 - 25 - 25 = 100.

For a yellow�green �lter, try Red = 0, Green = +150, 

Blue = -50 (blue is the opposite of yellow). The total 

150 - 50 still equals 100.

When you have a combination you are satis�ed with, �x 

the levels as before and save.

i. A photograph before it has been enhanced using the channel mixer

ii. The same photograph after it has been enhanced using the channel mixer. 

Photograph by Tim Cushan � Elephant refuge, Thailand, 2007

Figure 3.6D

Toning
In analogue (�lm) photography, special chemicals are 

available to make black and white images warmer (more 

reddish or yellowish) or cooler (more bluish). Special 

processes can make light areas (highlights) one colour 

and dark areas (shadows) another. All this and more is 

available with digital processing.

partial desaturation

The desaturate technique does not work very well for a 

conversion to black and white. Rather than completely 

desaturating the image, you need to stop just short. 

Colours will remain, but in a very weak form. This can look 

as though a pale watercolour wash has been applied to 

the black and white image.

If you print on a matt paper, it can look very painterly.
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i. A photograph with normal colour

ii. The same photograph after it has been altered using partial desaturation

Figure 3.6E

Hand colouring

� Start with a black and white image produced as 

described in the previous section.

� Now, to make colours possible, check that your image  

is set to RGB � go to Image > Mode > RGB.

� To add colour, create an empty layer by clicking on the 

little icon that looks like a page with a bent corner 

(appears next to the trash icon at the bottom of the 

layers window). To see the image beneath the colour you 

are going to use, go to the top of the layers palette and 

change �normal� to �colour�. This allows you to see the 

tones underneath.

� To choose your paint colour, go to the main toolbar box 

running down the left-hand side of the screen. Near the 

bottom are two squares, one over the other. Click on the 

top square (foreground).  

Now a colour picker palette opens up. From the rainbow 

of colours, click on the colour you want to use. This 

colour then comes graded in light, dark, colourful and 

less colourful variations. Click on the colour you want.

� Now move up the main toolbar on the left-hand of the 

screen and click on the icon with the brush.

Figure 3.6F Diagram showing colour picker palette

Figure 3.6G Hand-coloured photograph. The streets are our home, Veronica 

Waite, Year 11, digital photograph
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� Right-click to choose the size of brush and the softness 

or hardness of edge. You can also do this for the brush 

options at the top-left of the screen. 

� Paint on the area you want to colour. This takes a lot of 

practice. If the colour is too dense you can reduce the 

opacity of the brush or the layer. If you make a mistake 

you can drag the layer to the layers� trash icon (bottom 

left) and start again, or you can click on the previous 

history state in the history window ( just prior to your 

mistake).

� When you have completed this colour area, add a 

new layer with a new colour. Remember to choose the 

�colour� blending option.

� It is a good idea to name each layer. To do this, double-

click on the layer title and type in your own; for example, 

�red �owers�.

� Keep going until you have completed colouring all the 

areas you wished to colour.

This sounds much more complicated than it is. Once you 

have practised and found that you understand the idea, 

you will enjoy this technique.

colour toning
What you need to attempt here is not to colour the 

different details of the image but to apply a colour tone  

to the overall image.

i. A black and white image

ii. A black and white image that has had tone added

Figure 3.6H

You can make a warm or cool tone, or any colour you 

like. Usually, we want this sort of toning to be quite light 

and very subtle. You can experiment with stronger colours 

if you like. As a beginning, let us suppose that you want 

a subtle warming or cooling of the neutral black and white 

image.

� As before, convert a colour image to a black and white 

image by: Image > Mode > Greyscale. Now to allow 

colour to be added to the image you must convert it 

back to RGB colour. Go to Image > Mode > RGB.

� Go to Layer > New �ll layer > Solid colour. 

� A pop-up palette window will appear. Select a colour 

from the range provided to tone your image.

� The colour will then appear opaque over your image. 

Reduce the opacity of the layer to approximately  

25 per cent, using the opacity slider at the top of the 

layers window.

� You may �nd that the image has lost some of its 

contrast. To �x this you will need to adjust the levels 

(see pages 84 and 85).

� If it is the wrong colour, trash the layer and start again. 

Alternatively, with a black and white image set on RGB 

mode, go to Image > Adjustments > Variations and click 

on the colour you want to add to your image.

toning highlights one colour and  

shadows another

i. A photograph with normal colour

ii. The same photograph where the highlights are toned red and the shadows 

blue

Figure 3.6I
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Figure 3.6K Diagram of the �lters drop-down menu

i. No �lter ii. Cut out �lter iii. Plastic wrap �lter

iv. Accented edges �lter v. Pinch �lter vi. Twirl �lter

vii. Stamp �lter viii. Tile �lter ix. Emboss �lter

x. Glowing edges �lter xi. Solarise �lter xii. Stained glass �lter

Figure 3.6L Examples of some of the most popular �lters used  

by students

There are a number of ways of doing this.

Following is an ideal technique to get you started:

� Convert the image to greyscale and then to RGB  

as before.

� Go to Layer > New Adjustment Layer > Colour Balance.

� Click Highlights.

� With the colour sliders, adjust the highlight colour.

� Click Shadows.

� Adjust the shadow colours.

� If you so desire, you can colour mid-tones in a similar way.

Using filters
The �lter options in Photoshop provide you with a vast 

array of opportunities to easily transform an image. They 

can be fun to play with because you can achieve an 

instant result, but be aware that if you convert a whole 

picture with one of these effects it can tend to look very 

gimmicky. Many of the �lters attempt to make photographs 

look like paintings or drawings, while others distort colours 

and tones. At times, the effects can work, often as 

backgrounds with �������� of sections with undistorted 

images over them. One of the highlights of these �lters 

is that most will allow you to control the degree of the 

�lter effect created on your image. You may also consider 

selecting an area of your photograph and just applying the 

�lter to that selection. There are far too many different 

types of �lter to mention, but some of the popular ones 

are shown in the series of images at right.

It is recommended that you experiment with the artistic 

and other �lters on duplicates of your original �les. Don�t 

practise on originals, as you may accidentally save your 

changes and permanently damage your originals.

Figure 3.6J An image created using the plastic wrap �lter. doll face, Felicity 

McGlinn, Year 11, digital photograph
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Combining images
Previously, you may have cut up photos and pasted them 

together to obtain a �������. You can do this with much 

more precision and control in Photoshop.

To do this, you must know how to select parts of an 

image. There are different tools for this, depending on your 

purpose.

The selection tools are found at the top of the toolbar  

at the left-hand side of the main Photoshop window and 

are discussed in detail in section 3.1 (see pages 66�9).

Figure 3.6M Diagram of the 

marquee, magic wand, lasso, 

pen and move tool

Move Tool

The top tool on the right of the Photoshop tools  

window is the move tool. It is not a selection tool but it 

enables you to move one image over another. You might 

Figure 3.6O Two photographs 

overlapping each other, with the 

top image appearing transparent. 

Liliana Meloni, Realms 4, digital 

photograph

try this to combine two images so the one underneath is 

partially visible.

An important point to consider in combining two 

different photographs or selected aspects of different 

photographs is the size and resolution of the different 

images. They really need to be the same or very similar  

to each other, or you may �nd the quality of the �nal 

image is compromised.

combining two images
Open up two images. Select the image that you want 

to appear on top and copy it (Ctrl C), then activate the 

second image and paste the �rst on top (Ctrl V). If you 

need to alter the size of the image you can do so by 

going to Edit > Transform > Scale. By holding down the 

Shift key and altering the image by its corners you can 

enlarge or reduce the image size easily. If you want the 

images to overlap exactly, they must be the same size and 

resolution.

To see the bottom image, reduce the ������� of the 

top layer. This can be done by moving the opacity slider, 

which can be found at the top right-hand side of the 

layers window.

Adjust the opacity until you get the effect you want.

Figure 3.6N  

Diagram showing 

the location of 

the opacity slider 

at the top of the 

layers window

Opacity slider
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This technique often works well to combine writing,  

say scanned type or handwriting, with an image. 

Note: if a selection is active you can move the image 

with the move tool active. Just click on the selection, then 

drag and drop it.

compositing selections
There are at least two ways of moving a selected part of 

an image onto another image.

method  1

� With the selection active and feathered (see page 68), 

go to Edit > Copy (or press Ctrl C).

� Click on the image you want the selection to be 

superimposed on and click Edit > Paste (or press  

Ctrl V).

� Activate the move tool in the toolbar or press V and 

hold the left side of your mouse key down and move the 

selection where you want it.

� Scale the selection to size by going to Edit >  

Transform > Scale.

Figure 3.6P Photographs demonstrating a selection that has been copied 

and pasted onto another image and then scaled to �t the new image  

(Edit > Transform > Scale)

method  2

This is a very direct and simple method.

� With selection open, activate the move tool (see above).

� With two images open, click and drag on the selection, 

moving it to where you want it on the other image. For 

example, you could select a person�s face and move it 

onto the face of another person (see �gure 3.6Q).

i. Diagram of two photographs open and a selection from one image being 

dragged onto the top of another

ii. A photograph created by placing someone�s face on top of another 

person�s face. The colour has been matched by using Image > Hue/

Saturation.

Figure 3.6Q

Figure 3.6R  

Before and after, 

Diarne Petras, 

year 12, digital 

photograph

Figure 3.6R has been enhanced through cloning 

and painting the skin smooth, erasing blemishes and 

compositing selections of facial features onto the original 

image.
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 3.7  Setting 

the print 

dialogue 

boxeS
To print an image using Photoshop SC3 

(this process may vary if you are using 

different versions of Photoshop and 

other software programs; however, the 

main settings should be the same; they 

just may appear in different locations):

� Make sure the printer is connected 

to the computer, turned on and the 

paper is loaded correctly. As all 

printers differ somewhat, you may 

need your teacher�s help.

� Open the image to be printed in 

Photoshop.

� Make a copy of the image. Go to 

Image > Duplicate.

� Adjust the size of the duplicated 

image to the size you want to print it. 

Go to Image > Image Size.

� Go to File > Print (for earlier visions 

of Photoshop go to Print options).

� Select the printer to be used.

� Set the number of copies you want 

printed.

� Click on the page setup option.

A dialogue box will appear to coincide 

with the printer you have selected. 

Different printers will have different 

dialogue boxes.

This window will allow you a number 

of options and the options available will 

depend on the type of printer you have 

selected.

These options could include:

� Select your paper size (for example, 

A4, A3).

� Select your paper orientation (portrait 

or landscape).

� Set media type � to the paper you 

are using (for example, photo glossy 

paper, matt, plain paper, thick card).  

If you fail to do this the quality of your 

print will be jeopardised.

� Select Colour or Greyscale (Black). 

If all the options do not appear, they 

will become available in preferences  

a few steps further on.

� Click OK and move back to the Main 

Print window.

activities

For each of these activities it would be expected that you record and 

document the exploration and process of producing your artwork in your 

workbook or journal. Printing out a number of �print screens� during the process 

of constructing your image is an ideal way to do this. You will also be expected 

to print out your most successful images for assessment.

1. Landscape

 Using a landscape photograph that you have taken, explore the effects that 

can be created by using the black and white, colour, and toning options 

presented in the chapter.

2. Portraiture

 Using a portrait photograph that you have taken, explore a range of the 

creative possibilities available using �lters.

3. Create a face

 Create a new face by using the features of at least three different 

members of your class. Select one student�s eyes, another�s nose and 

another�s mouth. Consider whose initial face shape you will use, as well 

as whose hair and ears your face will have. You may even choose to 

distort the features by using the Edit > Transform option.

4. Self-portrait

 Create a photograph of yourself and use the images from �gure 3.6R 

as inspiration to enhance the quality of your appearance by means of 

Photoshop tools and techniques. The process of retouching photographs is 

common practice in magazines, so your task is to �go over the top� to create 

a stereotypical �ideal� face. You may choose to superimpose someone else�s 

eyes or mouth from your class, a magazine or the Internet onto your own; 

the options are open to your own interpretation of the task.

5. Humour

 Create a humorous image by combining a number of different  

photographs. This is a fairly open topic and therefore demands a lot of 

creative thought. Begin by working through the design process (refer to 

chapter 8, pages 148�56) to generate an idea. Document the process in 

your workbook or journal. Once you have the idea, you will need to take  

the photographs for the artwork and then work out the best method to 

combine the images (see above).

6. Research

 This activity could be done as a class or individually in your workbook or 

journal.

a. Search through books and on the internet to �nd three digital highly 

manipulated images. Create copies of the images and glue them into 

your workbook or journal.

b. Using the knowledge you have gained from this section and section 3.1 

(page 61), outline how your think the artist has created the work.  

Discuss any skills, techniques or processes you feel the artist may have 

used.

c. Discuss what you think of the image � is it successful? Why or why  

not?

d. Refer to the assessment criteria table on page 75 of this chapter. On 

which criteria have you judged your image?
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Paper sizes

ISO A Series

A0 841 mm r 1189 mm

A1 594 mm r 841 mm

A2 420 mm r 594 mm

A3 297 mm r 420 mm

A4 210 mm r 297 mm

A5 148 mm r 210 mm

A6 105 mm r 148 mm

A7 74 mm r 105 mm

A1

A2A3

A5 A4

A6A7

Figure 3.7A Standard printing sizes

Image preview Select printer Select number  

of copies

Page setup Colour  

management

Colour  

handling

Option for selecting  

paper orientation Position box Scaled print size box Rendering intent Print

Figure 3.7B The main print window

Figure 3.7C Sample of a type of page setup window 

� In the Position box, leave the �Centre image� ticked 

unless you want to change the size of the borders for 

your image. The image preview (to the left) shows you 

how the image will look on the page. If you want to 

change the size of your borders, click off the tick in the 

�Centre image� box and adjust Top and Left distances.

� In the Scale print size box, type in the height and width 

you want to print the image. Alternatively, if you want the 

image to �ll the print sheet, tick �Scale to �t media�.

� Under Colour Management, select Document.

� For Colour handling, select Printer manages colours 

unless your teacher advises you otherwise.

� For Rendering Intent, select Perceptual.

� Click Print.

� The �nal print window should appear.

Figure 3.7D Final print window
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� Check that the correct printer is selected (again!).

� Check that the number of copies you want to print is 

correct.

� Clicking on Preferences will allow you to check and 

make additional choices relating directly to your printer 

including:

� Set media type � to the paper you are using (photo 

glossy paper, matt, plain paper, thick card). If you fail 

to do this, the quality of your print will be jeopardised.

� Select Colour or Greyscale.

� Mode � check with your teacher. Auto may be OK, 

but special settings may be better. Usually for Epson 

printers you choose Advanced/ 1440 dpi/High Speed.

� Set Print settings choice to �Printer colour 

management�.

� Select �Colour sync� unless otherwise advised.

� Click on OK and be directed back to the �nal print 

window.

� Hit Print.
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Developing and  
re�ning ideas

4.

 4.1  CREATING AN IDEA 

FOR A PHOTOGRAPH
If you intend to create a photograph that is to be 

considered an artwork, then you must think of it as a  

work of art. Art relies on the creation and development 

of ideas. Throughout history artists have been inspired, 

motivated and in�uenced to create artworks that 

re�ect personal views, attitudes and responses to their 

world. Artists are constantly introducing new ideas and 

approaches to creating art.

Many people argue that the most dif�cult part of 

creating an artwork such as a photograph is to come up 

with the initial idea of what to make. Where do these  

ideas come from and how do artists develop them?

You can be taught the necessary skills and techniques 

required to create an artwork, but the idea has to come 

from within you. You must decide what kind of artwork  

you wish to produce and what idea you intend to explore 

and present.

Brainstorming
As the name suggests, brainstorming is storming or 

thinking of all the ideas and facets of a theme, concept or 

subject.

Brainstorming is often used as a starting point to the 

initiation and collection of different ideas. It helps you 

think through all the possibilities that come to mind, then 

record, develop and re�ne your ideas.

Use the following procedure to help you come up  

with ideas.

1. Select a new page in your workbook or journal to 

brainstorm the following questions. Do not feel 

inhibited or worry about what people will think. 

Record whatever comes to mind: open your mind and 

let the ideas �ow.

� What do I like?

� What am I concerned about?

� What experiences do I remember?

� What things in�uence me?

2. Re�ect on what you have written and circle what you 

consider to be the most promising comments or 

words (see �gure 4.1A).

3. Select one key word or comment, then write down 

everything you can about it and what it means  

to you.

For example, consider the topic of �family�. 

Everyone has a family and every family is individual 

and has its own identity. There are many ways you 

could approach this topic.

To develop your ideas further you could think  

of some questions to ask yourself which relate  

to this topic, such as:

� Who is in my family?

� What role does each person play in my family?

� How many generations exist in my family?

� How does each generation interact with each 

other?

� What kind of relationship do I have with my family?

� What makes my family unique?

Think of a number of questions that relate to your 

topic. Record these questions and your responses to 

them in your workbook or journal.
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4. When you have brainstormed your initial idea, you need 

to analyse your thoughts and eliminate anything that 

may be dif� cult to do (for example, photographing family 

members who are overseas), weak in content or that 

you are not personally interested in. Once again, circle 

the ideas that are of most interest to you.

5. Organise the ideas you have circled, from strongest to 

weakest, or from most inspiring to least interesting. 

This process may rely on:

� subject matter � how much interest or scope does 

this idea have?

� practicality � how easy is the idea to work with?

� knowledge � how familiar are you with the idea, 

subject matter or the needs of the task?

6. Select the � nal idea to be used in creating your 

artwork. This idea should give you a strong direction 

and focus; however, it will still need to be re� ned and 

developed further.

searching for motivation and inspiration
Once you have an idea in mind it is extremely bene� cial 

to look at ways other artists have dealt with similar 

themes and approaches in producing their art. The best 

way to do this is to look up an internet search engine 

(for example, Google) and search through art books and 

magazines. You could also � nd inspiration in � lms, music 

and through reading.

Collect and photocopy images and ideas you � nd 

interesting and inspirational (see � gure 4.1B). Glue these 

images into your workbook or journal and comment on 

what you � nd interesting about each. Consider the style, 

techniques and approaches artists use in recording their 

ideas. By doing this you will become aware of what you 

like, as well as alternatives that you may not already have 

thought about. It is considered appropriate to be inspired 

by other people�s ideas as long as you translate the ideas 

into something of your own, develop the ideas further and 

include something of yourself in them.

Following are possible approaches, styles, methods of 

presentation and techniques that may inspire or motivate 

your artwork.

aPPROaCHeS (SUBJeCtIVe)

Art as the communication of feelings; art that tells a story 

(narrative); art as a political or social statement; art as the 

expression of values; art as fantasy; art as decoration; art 

as education; art as part of culture.

StYLe

Representational; non-representational; narrative; ��������; 

high art; abstract; naturalism; pictorialism; impressionism; 

realism; ����������; expressionism; symbolism; hard edge; 

pop art.

metHOdS OF PReSentatIOn

Single photograph; series of photographs; collage or 

photomontage; series of images on one mount; large 

format; small format; repetitive images; a book.

teCHnIQUeS (StRUCtURaL)

Traditional black and white photograph; sepia toning; hand 

colouring; solarisation; negative images; photograms; 

screening or textured photographs; dodging and burning 

in; computer-aided photography; superimposing digital 

photography, digitally constructing and enhancing an image, 

using � lters, creating an image using a scanner.

Figure 4.1A An example of brainstorming
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�� Great tight, close-up and cropped composition. ��� Fun and unusual way to position subjects. ���� Social documentary suggests a story. ��� Joyful 

image with an appealing, tight, cropped composition. �� Mother and child � a theme popular in art history. ��� Close-up of a family huddled together. 

���� Interesting and unusual angle � worm�s-eye view. Very effective. ����� A family doing things together.

Figure 4.1B A collection of images that may provide motivation and inspiration

� �� ���

��

� ��

��� ����
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 4.2  THE DESIGN 

PROCESS
The design process enables you to explore, develop and 

re�ne your initial ideas. By working through this process 

you should be able to make a �nal decision about the way 

you intend to approach your subject matter and how you 

will go about producing the artwork.

Developing an idea for an artwork is not just about 

�nding different ideas; rather, it involves taking one idea 

and exploring and developing it. Working through the 

design process allows you the opportunity to consider 

all your options, both conceptually and technically. It 

allows you to plan your proposed artwork and think 

through possible problems. It enables you to become 

aware of your constraints and limitations, whether they 

be the availability of your chosen subject matter, your 

own technical competence or the facilities that you have 

available to you. The design process is the ideal way  

to work through your initial idea and develop it into  

a �nished artwork.

Step 1: creating  
the idea for an artwork  
(conceptual)
This step involves coming up with the art idea that you 

plan to explore. It relies on your ability to brainstorm initial 

ideas or subject matter, then choose one idea. This step is 

covered in detail in section 4.1 (pages 102 and 103).

An art idea could be �I aim to capture the attitude and 

characters of people working in the city�.

t���� In your workbook or journal, outline the art idea that 

you wish to explore.

Step 2: investigation
Investigate your chosen idea or subject matter and explore 

all possible approaches to it. Look at the way other artists 

have dealt with ideas similar to your own. You do not 

necessarily have to rely solely on other photographers. 

Other media such as painting, drawing, printmaking and 

�lm are very useful resources. Investigating your idea also 

means researching it.

t�����

1. Go to the library and use the internet to research  

your selected topic. Compile your research and present 

it in your workbook or journal.

2. Look at and record the way other artists have 

approached your theme. Collect examples and print 

or photocopy these images and glue them into your 

workbook or journal. Comment on what you think 

of these images and how they may inspire the 

development of your own artwork.

Step 3: outline the design 
problem to be explored
This involves a detailed statement indicating what you 

propose to design and produce. It is an aid to record, 

identify and document your idea.

t���� Photocopy the work brief/production design plan 

on pages 106 and 107, complete it and glue it into your 

workbook or journal.

1. Work through the brainstorming process in your workbook  

or journal to establish a theme you are interested in 

exploring (see pages 102�3).

2. Search out your theme or subject on the Internet and  

through as many books and magazines as you can,  

searching for artistic photographic images that you like  

and admire. Collect copies and write comments relating  

to what it is about each image that you like or �nd  

inspirational.

3. Record an art idea relating to your theme that you would 

like to explore.

4. Select two photographers that inspire you. Choose an 

artwork by each artist to analyse. Photocopy these works 

and glue them into your workbook or journal, then answer 

the following questions about your selected photographs. 

You may like to read a little about the artists before 

answering the questions.

a. What is the photograph about?

b. Is the photograph trying to tell you something about  

the subject matter?

c. Can you feel any atmosphere in the photograph?  

If so, how has it been created?

d. Why do you particularly like this photograph?

e. Are there any obvious artistic elements evident?  

For example, has the photographer used an interesting 

or unusual composition or focused on a particular 

design element, such as line, shape, tone, texture or 

pattern strongly?

f. What techniques have been used to create the 

photograph?

activities
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work brief/production design plan

name   date  

� Your work brief / production design plan must 

clearly outline the design problem you intend to 

explore and resolve. This proforma should only 

be used as a starting point.

� You should discuss what you what to explore  

and not what you want to make.

� You may make changes to the work brief /  

production design plan as you progress through 

the development of the artwork.

 Outline your initial idea and/or theme for the artwork you intend to produce.

 What interests you about this idea/theme?

 Discuss the types of ideas/concepts you are considering in creating interesting, imaginative  

and innovative artwork relating to your theme.

 Outline the style of work you are interested in exploring. Are you being in�uenced by any other  

artist or style of art?

 What design features or elements are you considering using to enhance the look of your artwork?  

(For example, composition, light, movement, depth of �eld, line, shape, tone, texture, colour.)
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Step 4: developing and 
refining your idea
When you have outlined your idea in a work brief/

production design plan, you are ready to develop and 

re� ne it. In order to do this you need to think through, trial 

and record as many different ways of approaching and 

presenting your idea as you can. The best way to do this is 

to use a number of pages in your workbook or journal 

to investigate and experiment with all the different 

design possibilities.

Composition is one of the most important factors in the 

design of any artwork. Composition relates to how you 

position the different subjects and design elements within 

the frame of your artwork (see section 8.1, page 142). For 

example, if you are taking a portrait of someone standing 

next to a mountain range, there are a number of ways you 

could compose the shot (see � gure 4.2A).

t���� In your workbook or journal, list everything that 

you want to appear in your artwork. Then draw at least 

� ve possible composition options.

The elements of design are the main design ingredients 

available to artists creating artworks. In most cases 

artists rely on the strong use of at least two of these 

elements. However, artworks generally contain most of 

the elements of design to some degree.

The design elements are line, shape, tone, texture, 

pattern and colour. Artists must consider how they 

are going to approach the use of these elements 

in the production of any artwork (see section 8.2, 

pages 148�53). These design elements, along with 

composition, will determine the centre of interest in 

an artwork and how the viewer�s eye moves around it.

 Outline how you intend to approach the production of your artwork. Include areas 

such as techniques and processes.

 List the equipment and materials that you will require in order to complete this artwork. 

(For example, will you need any special chemicals, such as sepia tone, or will you need special lamps 

for a particular effect, or a speci� c software package?)

 Outline the proposed time line for completing this project. Include dates for completing the investigation, 

experimentation and re� ning of your idea, as well as a date for the production of your � nished artwork.

Figure 4.2A Different ways you 

could compose the same subject 

matter
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t���� In your workbook or journal, comment on possible 

ways you could use each of the design elements  

to enhance your artwork.

Style refers to the feeling and �avour that your  

artwork will generate. It�s about the look of your 

artwork, its appearance, characteristics and treatment  

of subject matter.

Task: Find an artist whose artwork may in�uence you in  

the development of your own style. Collect at least 

two photocopies of their work and glue them into your 

workbook or journal. Comment on what it is that you 

like about these artworks and what type of style you are 

considering for your own piece.

Dimension relates to the size of the artwork. 

Changing the size of your artwork may have different 

effects on how your subject matter is perceived.

Task: Consider the size and dimensions of your artwork.  

What size do you feel would best enhance your design 

idea and why?

Technique refers to the approaches you take  

in creating and constructing your artwork (see  

chapters 1�3, pages 2�100).

t����� 

1. List the techniques that are available to you.

2. Is there a technique that may complement  

your topic or design?

3. What techniques are you considering using in 

creating this artwork?

4. You may need to experiment with a number of 

different techniques before you decide on the most 

appropriate for this project. Include documentation 

of all your experimentation in this area in your 

workbook or journal.

At this point you may start taking photographs to 

help with your investigation. Remember, this is an 

experimental stage and you are not trying to achieve 

your �nal work, nor should you expect all your shots 

to be successful. Be brave and develop your idea from 

your mistakes; this is all part of the process.

Step 5: identifying constraints 
and limitations
When you have explored and identi�ed the most 

appropriate way to make your idea into an artwork,  

you should consider any constraints or limitations  

that may affect your �nished work.

t���� Ask yourself the following questions and record  

your responses in your workbook or journal:

1. Have I thought through my idea thoroughly?

2. Have I access to the facilities that I will need?

3. Is the subject matter accessible?

4. Have I given myself a realistic time frame  

to complete the artwork?

5. Can I afford the costs that may be involved?

6. What problems can I foresee and how will I deal  

with them?

Step 6: working drawings  
and models
Now that you have decided upon your idea or  

concept, you need to use your workbook or journal  

and develop a range of working drawings and plans.  

These drawings may vary from quick sketches of 

possible compositions through to detailed drawings 

where you add working notes.

t����� Complete the following in your workbook or journal.

1. Draw a detailed working drawing of how your �nished 

artwork will look. Include how you intend to mount and 

present the piece.

2. Work out an approximate cost for the artwork.

3. Make a �things to do� list of everything to be done.

4. Draw a detailed time line showing when you intend to 

get each thing done.

Step 7: producing the artwork
This is the stage that most students imagine to be 

the most important yet, unless the previous steps are 

thoroughly completed, this step can be dif�cult. If you 

have planned well it should be a relatively straightforward 

process.

Step 8: analysing your results
The �nal stage of the design process is to analyse your 

�nished artwork. Keeping records of your strengths and 

weaknesses in this medium allows you to pursue the 

necessary skills to develop your artwork in the future.

t����� When you have completed your artwork, record  

your response to the following questions in your workbook 

or journal (or refer to the self-evaluation proforma on  

page 258).

1. Have you achieved what you set out to do?  

Why or why not?

2. Are there weaknesses in the �nished artwork? If so, 

identify them and try to work out how they occurred.

3. What are the strengths of the artwork and how did you 

achieve them?

4. If you were to complete a similar artwork, how would 

you improve the process?

5. What have you learnt from the experience of creating 

this artwork?
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5.

 5.1  PERSONAL THEMES
When you �rst start taking photographs there is no better 

theme to work with than one that is personal to you. 

Taking photographs of things that are of interest to you will 

make you excited and motivated about the whole process 

of photography. Look around you, become aware of what 

is important to you, then start thinking about how you 

can present those �������� in photographs. It is always 

important for you to think beyond the obvious � look for 

creative and imaginative ways of presenting your images.

At home

One of the easiest places to �nd a subject of a personal 

nature is in your own home. At home you are surrounded 

by things that are special to you, such as your family, a toy, 

your house or a pet (see �gure 5.1A).

Figure 5.1A My cat, Jacob de Weger, Year 10, digital photograph

activitY

While you are at home, brainstorm and record in 

your workbook or journal a list of personal subjects 

found in your home (see section 4.1, pages 102  

and 103, about how to brainstorm ideas).

Select one or two subjects and think about 

imaginative and creative ways you could present  

these in a photograph.

Complete a shoot of approximately 24 shots based  

on a personal theme found at home.

Develop the �lm or download the images and print  

a proof sheet of the results.

From the proof sheet, select your best image  

and print it into a photograph.

Mount your photograph for presentation and 

assessment.

In your workbook or journal, record the procedure 

you went through to produce the artwork. Include  

a personal evaluation of your �nished photograph.

a.

b.

c.

d.

e.

f.

g.

assessment

� Finished photograph (artwork)

� Record of your ideas, procedure and evaluation  

in your workbook or journal.

Refer to assessment criteria, page 257.

At school

Students spend approximately �ve and a half hours per 

day, �ve days each week, for up to 12 years (less holidays) 
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at school. Therefore, students must have some kind of 

personal association with their schools. School means 

different things to different people � some students � nd 

the most ful� lling aspect is the challenge of learning math 

and science, while others believe they gain more from 

sport, music, art and/or friendships.

Think about the classrooms you work in, the buildings 

you walk through every day, your favourite sport or musical 

instrument and your relationship with your classmates 

and teachers.

activitY

Brainstorm and record in your workbook or journal 

what you believe to be the most important aspects 

of school to you. List as many things as you can.

Look through your list and select one or two aspects 

of school life that most appeal to you. Circle them, 

then consider possible ways you can capture these 

things in a photograph.

Complete a shoot of approximately 24 shots based 

on personal themes at school (see � gure 5.1B for 

an example).

Develop the � lm or download the images and print a 

proof sheet of the results.

From the proof sheet, select your best two images 

and print them as � nal photographs.

Consider using a special effects technique on 

your photographs (see sections 2.5, 3.5 and 3.6, 

pages 50�7 and 88�98).

Mount your � nal photographs for presentation 

and assessment.

In your workbook or journal, record the procedure 

you went through to produce the artwork. Include a 

personal evaluation of your � nished photographs.

a.

b.

c.

d.

e.

f.

g.

h.

Recording an event
We all experience important events throughout the 

year. Some of these events are more important than 

others; whatever the case, it is great to have these 

events recorded as photographs. In today�s society 

most people like to take snapshots of events that are 

of importance to them. In most cases these people are 

not interested in creating an artwork and do not put a 

great deal of thought into each shot. However, if you look 

through newspapers and magazines and take notice of 

how some photographers have recorded events, you can 

generally see a more creative and artistic approach.

Think about a coming event that is of importance to 

you. It may be a birthday party, sports carnival, school 

concert, netball or football match, wedding, christening 

or graduation (see � gure 5.1C for an example).

Figure 5.1C Final, Marina Savenkov, Year 12, digital photograph

assessment

� Finished 

photograph 

(artwork)

� Record of 

your ideas, 

procedure 

and evaluation 

in your workbook 

or journal.

Refer to 

assessment criteria, 

page 257.

Figure 5.1B Greyscale 

Blues, Jacob de Weger, 

Year 10, digital photograph
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activities

1. Look through a number of newspapers and 

magazines and collect at least four examples of 

ways photographers have recorded an event in an 

imaginative and creative way. Comment on how 

the photographs were taken, what makes them 

imaginative and what it is that you like about  

each of them.

2. Look through some old snapshots taken  

by you or a family member to record an event.  

If possible, photocopy them and/or glue them into 

your workbook or journal. Compare the way these 

photographs have been taken with those from the 

newspapers and magazines. Discuss the difference 

between a snapshot and a photograph.

a.  In your workbook or journal, make a list of all 

of any coming events you could photograph. 

You may like to contact your school�s magazine 

committee to see if there is something coming 

up that they would like you to photograph.

b. Select the event you intend to photograph. 

Your aim with this activity is to come up with 

a creative and imaginative artwork and not a 

snapshot, so think through possible ways you 

could present your selected event. If you intend 

to photograph a sporting event you may like to 

consider capturing a particular movement shot 

(see section 1.3, pages 13�16).

c. Complete a shoot of approximately 24 shots of 

your selected event

d. Develop the �lm or download the images and 

print a proof sheet of the results.

e. Select the best shots from the proof sheet and 

print them as a series of �nal photographs. To 

fully record the event you will need to produce a 

collection of at least three photographs.

f. Mount your �nal photographs for presentation 

and assessment. You may like to consider  

using a creative approach to mounting  

(see section 6.1, pages 122�7).

g. In your workbook or journal record the procedure 

you went through to produce the artwork and 

include a personal evaluation of your  

�nished photographs.

assessment

� Finished photograph (artwork)

� Record of your ideas, procedure and evaluation  

in your workbook or journal.

Refer to assessment criteria, page 257.

 5.2  COMMON THEMES
The portrait, landscape and still life are the most common 

themes used by both historical and ������������ artists 

in artworks. Artists are constantly looking for new, creative 

and imaginative ways to present these themes.

We interact with people daily, live in some kind of 

landscape and we are constantly surrounded by different 

groups of objects. We can certainly use these themes as  

a starting point to produce our own artworks.

Portraits

Taking a portrait of someone captures an everlasting 

image of them. We have all had our photographs taken at 

some stage of our lives and we all enjoy looking back at 

how we have changed as the years have passed. Taking a 

portrait photograph gives you the opportunity to capture an 

image of a person in a large variety of different ways. For 

example, you can:

� capture personality through the use of props

� use make-up and soft lighting to enhance the subject�s 

attractiveness

� record facial expressions to depict different moods

� photograph the subject in a strange environment

� dress the subject in a variety of costumes  

(see �gure 5.2A and section 13.1, pages 220�2).

Figure 5.2A Galadriel, Kylie Clark, Year 12, gelatin silver photograph
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assessment

� Experimental portrait shoot, including proof sheet  

and comments in your workbook or journal

� A �nished artwork (this could be one photograph  

or a series of photographs)

� The design process recorded in your workbook or journal.

Refer to assessment criteria, page 257.

Landscapes
As you walk in the country, look at the sea or wonder  

at city skyscrapers, you take in some kind of landscape.

Landscape photography enables you to select a small 

section of the world and create a picture from it. The 

landscape is always there and, as a photographer, you 

have an enormous choice about how you photograph 

it. You can photograph the landscape from a number of 

angles, such as looking up or down at it, or on a rainy, 

windy, overcast or sunny day. You can also photograph it at 

different times to create different effects (see �gure 5.2B 

and section 13.2, pages 223�4).

Perhaps one of the most important decisions you 

will need to make is how you will frame and compose 

the photograph: which section of the landscape you 

will keep and which section you will omit. Be aware of 

what your aim is in taking each photograph.

Figure 5.2B Windmills by lake, Geelong, Charles Ferry, Year 12, digital photograph

activities

1. Research the way two different photographers approach 

taking portraits. Collect examples of their work and 

comment on the similarities and differences between them. 

Discuss their approach to the subject matter, techniques, 

lighting, composition and artistic intention.

2. In small groups, explore the possibilities of portrait 

photographs. Each member of the group should take it in 

turns to act as model and photographer.

a. Select a suitable setting and complete a shoot of 

approximately 24 shots, experimenting with different 

lighting, angles, facial expressions, backgrounds and 

moods.

b. As a group, develop the �lm or download the images 

and print a proof sheet for each group member.

c. Glue a proof sheet into your workbook or journal and 

comment on the positive and negative aspects of each 

shot. You may like to discuss this with the rest of the group 

before making your �nal comments.

3. Produce an artwork based on a portrait theme.  

Decide what kind of portrait you are going to take and 

how you are going to be creative and imaginative in 

your approach. Choose a person you know well and 

who is readily available to photograph. It is important 

that you know and understand their personality. You 

may wish to ask a relative or a close friend who 

is willing to pose for you. Use one of the following 

ideas as a starting point or create one of your own: a 

self-portrait; my friend the sportsperson; the different 

emotions on a face; she looks so stressed; what an 

attitude; just thinking; a smiling face; my dad the cook; 

he collects insects; I�m shy; hot and bothered; looking 

sharp; best dressed.

 In your workbook or journal, proceed though the 

design process (see section 4.2, page 105) to develop 

and re�ne your idea. Include a personal evaluation of 

your �nal result.
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activities

1. Research landscape photographs from different 

countries, seasons or times of the day. Collect at 

least one example of a photograph from each of 

three photographers.

 In your workbook or journal, discuss  

the following:

a. the artist�s intention in creating the artwork

b. the qualities found in each landscape

c. from what viewpoint the landscape was taken

d. your personal reaction to each photograph.

2. Produce an artwork with a landscape theme.  

You are not restricted to a country setting � you 

may choose the city, a street, the bush or sea as 

the focal point for your artwork. You may decide to 

depict a landscape for its beauty or for some other 

reason; for example, it may mean something special 

to you.

 You can select one of the following ideas as a 

starting point or you may prefer to come up with 

one of your own (see section 4.1, pages 102�5, to 

help you come up with an idea): the street where  

I live; a beautiful place; where it all happened;  

a sunburnt country; textures of the bush; a land  

of all seasons; capturing the wind; the sand and the 

ocean; life�s a beach; the roar of the sea; the city I 

live in; shapes and lines in the city; lost in the city.

3. In your workbook or journal, proceed through the 

design process (see section 4.2, page 105) to 

develop and re�ne your idea. Remember that this 

is a creative process, so try to be as imaginative as 

you can.

4. Print and mount your �nished artwork for 

presentation and assessment.

5. Evaluate your �nished artwork in your workbook  

or journal.

assessment

� A �nished artwork (this could be more than one 

photograph; for example, a series of photographs)

� The design process recorded in your workbook or 

journal.

Refer to assessment criteria, page 257.

Still life

Everyday objects placed in an interesting way  

or photographed from an enticing viewpoint with 

stimulating lighting form the basis for a good still-life 

photograph (see �gure 5.2C).

Figure 5.2C Red shoes, Stephanie Pirrie, Year 12, taken with the aid of a 

mirror and enhanced using Photoshop

Still-life photography has been a popular theme since 

the invention of the camera. It initially followed in the 

footsteps of the other art media, including painting and 

drawing. However, still-life photography in today�s society 

is largely used to promote and advertise commercial 

products. If you look through any magazine you will see 

dozens of still-life photographs advertising everything from 

soap to jewellery to saucepans.

activities

1. Find and research an example of a still-life painting 

and an example of a still-life photograph. Write 

a brief description of the artworks, taking into 

consideration the composition, subject matter, 

lighting and techniques used. Also comment on why 

you selected each.

2. Find three examples of still-life photographs that 

have been used in advertising. Compare them to the 

examples you have selected above, discussing the 

similarities and differences.

3. Find at least two still-life images that have 

obviously been digitally manipulated and show the 

use of special photographic techniques such as 

superimposing, toning and hand-colouring.  

Outline how you think they were created.
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(continued)

4. Produce a still-life photograph that will form the basis 

for an imaginary advertising campaign. The photograph 

will be used in magazines and newspapers to help 

promote your product. You are required to come up 

with a product name and advertising slogan. This 

could be presented in your photograph.

 You may consider using one of these products in  

your advertising campaign: suntan lotion; sporting 

product; skin or hair care range; perfume; sunglasses; 

hats; fruit and vegetables; �orist; hardware store;  

sporting goods; musical instruments.

5. When you have selected your product, work through 

the design process to come up with the best way to 

present it (see section 4.2, page 105).

a. You must consider who you will be trying to sell 

the product to, the market and what kind of image 

you want the product to project. Record this in 

your workbook or journal.

b. Look through magazines and newspapers to see  

how other companies promote similar products.  

Copy these into your workbook or journal.

6. When you photograph your still life try a number of 

ways of arranging the objects. Also try shooting the still 

life from a number of angles.

 Composition is the most important design quality 

in a still life, so you will need to carefully consider 

where you position each object within the frame. The 

background will also play a major part, so make sure 

that you take it into consideration.

7. Print a proof sheet and select your best image. You may 

like to consider using a computer software package to 

add and arrange text onto the photograph. Consider 

the font type and size for the product�s name and 

slogan. Explore different placements for the text, making 

reference to existing advertisements for inspiration.

8. Mount the �nished artwork for presentation and 

assessment.

9. Evaluate your �nished artwork in your workbook or 

journal.

assessment

� A �nished artwork depicting an advertisement for a 

selected product

� The design process recorded in your workbook or journal.

Refer to assessment criteria, page 257.

 5.3  SOCIAL 

COMMENTARY
Artists often choose to comment on certain aspects of 

the society in which they live. They use their artwork as 

a means of communicating their attitudes, aspirations, 

concerns and feelings for the world around them.

Perhaps more than any other medium, photography can 

document and record the visual world in a very convincing 

way. Photography can record injustice and aid in rectifying 

it through documentary evidence. A photographer can 

capture images of war and starvation in faraway places 

that are so compelling they cause a major impact on the 

way we and our government respond to these crises. 

Photographers also respond to concerns closer to home 

� unemployment, racism, homeless youth and drug abuse 

are common issues tackled by photographers.

Photographers do not limit themselves to commenting 

only on the negative aspects of society. They also present 

their ideas on community spirit and positive aspects 

of life. There are several different levels on which an 

artist can comment, such as current issues relating to 

themselves, their community and world affairs.

Social commentary is perhaps the most dif�cult type 

of artwork to create. It tends to be a lot more demanding 

in its approach than other artworks. It is a challenge to 

communicate a personal view of an issue in an artwork or 

to sum up an opinion within a single image.

Community issues
Issues in the town, city, suburb or street where you live 

are often considered to be community-based. Even though 

these issues relate to every person who lives within the 

community, people respond to them differently because 

they see the issues differently. Figure 5.3A is an example 

of a personal response to a community issue.

Figure 5.3A Save Albert Park, Shemiah Faith Major, Year 13,  

hand�coloured gelatin silver photograph
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assessment

� Finished artwork which comments on an aspect  

of or issue in your community

� Workbook or journal containing a brief design process, 

record of your studio experience and comments relating 

to the group�s outcome of the project.

Refer to assessment criteria, page 257.

Current affairs

Issues that are currently in the news and are  

of concern to members of society are commonly used 

in art (see �gure 5.3B). Photographic journalists are 

always looking for images that re�ect current affairs 

issues. Each time you open a newspaper or magazine 

you can see examples of this.

Figure 5.3B What the recruiting of�cer never mentioned, William Swinson, Year 12, gelatin silver photograph

activities

1. As a class or small group, look at the community in which 

you live. You may consider your street, suburb, town or city 

to capture and record.

  Together, list and record all the issues that are  

important to the area. These issues can be both positive 

and negative.

2. Each member of the group should then decide what issue 

they would like to deal with and how they intend to record 

their ideas about it. Work through the design process and 

record your ideas in your workbook or journal. Negotiate 

roles for each member of the group, and delegate tasks.

 The main aim of this activity is to see how different 

people respond to recording a similar section of their 

community. It is interesting to see how each member of  

the group deals with a similar issue.

3. Make a photographic record of your idea. It would be ideal 

if the group or class could go on an excursion and take their 

photographs on the same day, as this would add to the 

challenge. However, if this is not possible, the project should 

be done over one or two weeks.

4. When the task is completed, each member of the group 

should print their photograph and mount it for presentation, 

evaluation and assessment.

5. The group or class should consider setting up a display or 

exhibition of their photographs (see section 6.2,  

pages 128�34).

6. In your workbook or journal, comment on the results 

achieved not only by yourself but also by the group. Discuss 

the similarities and differences in the way the various 

members of the group handle the project.
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assessment

� The � nished photograph presented as a magazine cover

� The design process recorded in your workbook or 

journal.

Refer to assessment criteria, page 257.

Personal issues

These issues relate directly to the artist and are 

normally the hardest felt. Society has an enormous 

impact on our lives and, to a large extent, we are 

activities

1. Imagine that you are a photographic journalist for a 

magazine like Time. Your task is to produce a photograph 

for the front cover of the next edition. You are required to 

produce a photograph commenting on a current affairs 

issue of your own choice.

2. Start your project by creating a list of all the current 

affairs issues you can think of. Select one and work out 

what kind of comment you want to make about it 

(see section 4.1, page 102).

3. It would be worthwhile collecting a number of Time 

magazine covers to gain some inspiration. (Use a 

search engine such as Google to � nd Time covers on 

the internet). Looking through newspapers, magazines 

and the internet may also give you some ideas. Collect 

at least three images.

4. Work through the design process (see section 4.2, 

page 105). Consider all the different options for taking 

this kind of photograph. For example, you could stage 

the photograph using actors and a set, or you could 

take a live action shot at a rally or demonstration. 

You may also consider digitally creating the image 

(see � gure 5.3C).

5. Produce the artwork and present it as a magazine cover.

6. Evaluate your � nal result in your workbook or journal.

Figure 5.3C Netball team of cloned students � prepare 

for a possible future!, Frances Anderson, Year 12, 

digital photograph

Figure 5.3D It is your 

loneliness that gives an 

edge to the shadows, 

William Swinson, Year 12, 

gelatin silver photograph
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controlled by the society in which we live. This is not 

necessarily a bad thing and, if you think about it, you 

will probably come up with a number of both good and 

bad personal social issues to explore.

activities

1. Produce an artwork that communicates a 

personal issue about society. Figure 5.3D is an 

example of such an artwork.

2. You need to think through all the things that  

you could comment about and select one (see 

section 4.1, pages 102�3). Some examples 

of topics are: the stress of school; your mind; 

relationships with your family; peer group pressure; 

the generation gap; the opposite sex; my choices, 

my future; being a teenager in this generation.

3. In your workbook or journal, work through the  

design process to develop and re�ne your idea  

(see section 4.2, page 105).

4. Consider using special effects and creative 

mounting in the presentation of your �nal idea.

5. Evaluate your �nished artwork in your workbook or 

journal.

assessment

� Major artwork commenting on a personal issue  

in society

� The design process recorded in your workbook or 

journal.

Refer to assessment criteria, page 257.

 5.4  CONTEMPORARY 

THEMES
Modern photographers search for new and alternative 

subject matter for their photographic artworks. Many 

photographic artists have moved away from photographing 

a naturalistic view of their surrounding world and have 

instead preferred to construct an image themselves using 

sets, props and actors, as well as digital manipulation and 

enhancement. These images tend to be a response to the 

artist�s world instead of an accurate record of it.

Surrealism

Surrealism as a theme has been popular since the 1930s. 

Innovators of this style include artists such as Salvador 

Dali and Rene Magritte, who explored this theme in 

paintings, and Man Ray and Dora Marr, who explored it 

through photography. This approach centres on the notion 

of creating images that are dream-like and can stem from 

the unconscious mind. The images generally depict scenes 

and subject matter that could only exist in the artist�s 

mind, not in the world as we know it. Surrealism as a 

theme has been rejuvenated through the introduction of 

digital photography and the contemporary artist�s ability to 

manipulate and construct a desired subject.

Figure 5.4A Holding, Georgina Dempsey, Year 12, digital photograph

Figure 5.4B Giracock, Georgina Dempsey, Year 12, digital photograph
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activities

1. Using a computer search engine or your school 

library, �nd a work by a traditional surrealist 

photographer (see Philippe Halsman, Dali atomicus 

�gure 10.2H, page 175) and a contemporary 

surrealist digital artist. Make copies of both 

artworks and then analyse them brie�y. Include an 

introduction to each work, a brief description of 

the subject matter and a comparison of the artists� 

working methods and artistic intention (refer to 

section 9.2, pages 159�62, for assistance).

2. Produce an artwork with a surrealistic theme. Browse 

through images on the internet to provide you with 

inspiration.

3. You could select one of the following ideas to use 

as a starting point or you may prefer to come up 

with one of your own (see section 4.1, page 102, for 

help): the face as you would never see it; what has 

happened to our school; sorry, teacher, I have shrunk 

my friends; I didn�t know that they could �y; I always 

new I had magical powers, I live in the ocean.

4. In your workbook or journal, proceed through the 

design process (see section 4.2, page 105) to 

develop and re�ne your idea. This is a creative 

process, so try to be as imaginative as you can.

5. Create your artwork (see section 2.5, page 50,  

and section 3.6, pages 91�8, for assistance).

  Print and mount your �nished artwork for 

presentation and assessment.

6. Evaluate your �nished artwork in your workbook or 

journal.

assessment

� A �nished artwork re�ecting the theme of surrealism

� The design processes recorded in your workbook or 

journal.

Refer to assessment criteria, page 257.

Photographic theatre
The notion of creating the subject matter for a photograph 

using actors, props and backdrops is often referred to 

as �photographic theatre�. This approach to photography 

has been popular since the postmodern period that 

commenced in the 1980s. Among the many artists who 

explore this method in their work are Australian Tracey 

Moffatt (see �gure 11.5A, page 186), Anne Zahalka  

(see �gure 12.5C, page 209), American Gregory Crewdson 

(see �gure 10.2O, page 179) and German Loretta Lux 

(see �gure 12.3B, page 200), who have all explored this 

method extensively. This approach to image making is not 

new � high art photography (see section 10.2, page 172)  

of the late 19th century explored this approach, as did 

many early Australian photographers working in the same 

period. These photographers chose to photograph their 

subjects in front of painted backdrops; they would direct 

them into place and would often use props. This was 

particularly the case with many of the early images of 

Aborigines, who were often depicted in a staged set with 

props that included dead kangaroos, spears and a painted 

landscape scene in the background (see �gure 5.4C).

Figure 5.4C Portrait of an Aboriginal man and woman, J.W. Lindt, c. 1874, 

albumen silver photograph

activities

1. Look closely at the Aboriginal image in �gure 5.4C 

and compare it to Tracey Moffatt�s image from her 

Something more series (see �gure 11.5A, page 186). 

Brie�y analyse boths artworks. Include an introduction 

to the work, a brief description of the subject matter 

and a comparison of the artist�s working method and 

artistic intention (use section 9.2, pages 159�62, to 

assist you).

2. Produce an artwork that has been entirely staged 

to communicate a creative idea. The idea may be 

developed from one of the following starting points  

or you may come up with your own. An updated 

version of a nursery rhyme or children�s story; a  

re-enactment of a scene from a famous movie; a 

scene depicting elements of your own life.
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(continued)

3. In your workbook or journal, proceed through the 

design process (see section 4.2, page 105) to 

develop and re�ne your idea. You will need to consider 

what actors you will require to play the various roles, 

what props and backdrops you will need to arrange. 

You will also need to consider lighting as it can play a 

major role in helping to set the mood of your artwork.

4. Print and mount your �nished artwork for presentation 

and assessment.

5. Evaluate your �nished artwork in your workbook or 

journal.

assessment

� A �nished artwork re�ecting the theme of  

photographic theatre

� The design processes recoded in your workbook or journal.

Refer to assessment criteria, page 257.

Figure 5.4D He doesn�t seem to understand, Lauren Benson, Year 12, 

digital photograph

Appropriation
The notion of ������������� is to use the subject of an 

existing artwork as the foundation for a new artwork. The 

fundamental element of this approach to making artwork 

is not to copy the work but to reinterpret it, giving it new 

meaning. There are many reasons an artist may choose 

to appropriate an artwork; it may be to honour the artist, 

question or challenge the meaning of the original work or 

to use it as a symbol to express views and opinions about 

the artist�s world. Appropriation is particularly relevant and 

of interest to postmodernists, as it provides them with 

the opportunity to question the signi�cance and value of 

artworks from the past.

Figure 5.4E Appropriation of American Gothic, Alice MacFarlan, Year 11, 

digital photograph

Figure 5.4F Appropriation of Da Vinci�s Mona Lisa, Felicity McGlinn, Year 11, 

digital photograph
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assessment

� A �nished artwork re�ecting the theme of appropriation

� The design processes recoded in your workbook or 

journal.

Refer to assessment criteria, page 257.

activities

1. Compare �gure 10.2N, Daughter of art history A (1989)  

by Yasumasa Morimura (page 178), with Manet�s (c. 1881) 

painting, The bar at the Folies-Berg�re (you could �nd a 

copy on the internet). Why do you think that Morimura 

decided to appropriate Manet�s famous painting? Discuss 

the similarities and differences between the two artworks.

2. As a class, discuss the legal (copyright � which, in Australia, 

generally exists for the life of the artist plus 70 years) and 

ethical considerations (moral rights of the artists and the 

honour of the artwork) that should be taken into account if 

an artist chooses to appropriate an artwork.

3. Produce a digital photographic artwork that appropriates 

an image of a famous artwork from the past. The challenge 

of this task is to re�ect elements of your school; perhaps 

its uniform, buildings, grounds or crest. As a starting point, 

consider the most famous artworks that you know. Works 

such as Leonardo Da Vinci�s Mona Lisa (1503), Edvard 

Munch�s The Scream (1893), or Andy Warhol�s Marilyn 

Monroe (c. 1964). How could you best adapt these images 

to re�ect an element of your school?

4. Brainstorm additional artworks that you could use as the 

basis for this work. Look through books or search the 

internet for famous artists and their works. Collect at least 

four possibilities. Consider the different ways that you could 

adapt each of the artworks to re�ect the task.

5. Select the artwork that you intend to use. You will need  

a relatively high-resolution digital copy of the image.  

Pose a fellow student in the same position as a �gure 

from the artwork and then take a digital photograph of that 

person. It should be a relatively straightforward process 

using digital software to dress the �gure from the painting 

in your school�s uniform (see section 3.6, pages 91�8), on 

superimposing). You could also consider including elements 

of your school in the background of the artwork.

6. Document the procedure of creating your artwork in your 

workbook or journal and evaluate the �nal result.

7. Print and mount your �nished artwork for presentation  

and assessment.
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Presenting photographs

6.

 6.1  MOUNTING
Most artworks are created for display, with the artist�s 

intention being to share their response to a subject with the 

audience. It is therefore important for artists to consider 

how to present their work. Mounting and framing are used 

to �nish an artwork and give it a professional edge.

The method that you use to mount your work will 

largely depend on what you intend to do with it when it is 

complete. You may primarily be concerned with presenting 

the artwork for assessment, or you may intend to give it 

to someone as a gift, exhibit it and/or sell it. Whatever 

the case, you need to consider how you will present the 

image. It is important to remember that a work is mounted 

to enhance its appearance and to do this properly you 

need to develop the necessary skills. A poorly mounted 

photograph can look shoddy and take the viewer�s 

attention away from the artwork itself.

There are a number of mounting options available. 

Before you begin, you will need to consider the effect that 

you want, the costs involved and the time available.

Edition numbers and  
artist�s signature
As with most types of traditional printing techniques, it has 

become fashionable in recent times for photographers to 

place edition numbers on their artworks. The artist indicates 

at the bottom left-hand corner of their work how many prints 

they have made of the work and which print this photograph 

is in that edition. For example, 12/15 means that particular 

artwork is the twelfth printed from a total of 15 prints.

It is appropriate for photographers to sign their artwork. 

The signature acknowledges the photographer as the artist, 

the photograph is viewed more positively as an artwork 

and it is also perceived to be more valuable to collectors. 

Titles provide a glimpse into the artist�s intention and help 

provide a focus for interpreting the artwork.

For maximum effect, the signature, edition numbers 

and title are written with a graphite pencil or Indian ink. 

Examples of an edition number and artist�s signature are 

shown in �gure 6.1A.

Figure 6.1A  

Artwork 

indicating the 

edition number 

of the work, 

the artist�s 

signature and 

the title of  

the work
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Artists are not always interested in creating artworks 

that will last forever. Some artists are concerned 

with capturing the moment. Installations, on-line and 

performance art often include photographs that are 

unmounted and that are presented in an unusual and 

often unconventional manner.

Figure 6.1B Carolyn Lewen�s and Neil Stanyer�s Blue-gold installation 

for the 2007 Castlemaine state festival. The work comprised approximately 

40 hangings accompanied by � oor text and a musical sound scape by 

Jeremy Collings. The images are photograms printed onto cotton fabric 

and were made using common reeds.

Standard mounting
The standard method used to mount a photograph 

is on white or black card. The type of card used will 

largely depend on what is available, with cover paper 

through to expensive acid-free matt board being adequate. 

Most art and framing suppliers have a wide variety of 

different paper and boards.

Photographs can either be mounted on the top 

of the mount or underneath it (window mounting). 

The photograph should be arranged on the mount board 

in one of two ways.

1. The lower border is slightly wider than the top, 

which in turn is slightly wider than the sides 

(see � gure 6.1C).

2. The sides and upper border are the same, 

with the lower border twice as wide as the other sides 

(see � gure 6.1D).

To correctly mount a photograph you must take the time 

to measure the borders surrounding it to ensure that they 

are the required dimensions.

Figure 6.1C Window mount, where the lower border is slightly wider 

than the top, which, in turn, is slightly wider than the sides

Figure 6.1D Window mount, where the sides and upper border are 

the same, with the lower border twice as wide as the other sides

eQUipMenT and MaTeriaLs

To mount your photograph, you will need the following 

equipment and materials: guillotine; steel ruler; sharp 

cutting knife; cutting board; soft pencil; cover paper or 

mount board; adhesive (for top mounting only); masking 

tape or tailored mounting corners (see section 7.1, 

page 137).
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Top mounting
This is the simplest form of mounting (see �gure 6.1E).  

It involves adhering the photograph directly to the board  

or paper.

poinTs To consider

� You may print your image with a white border around 

its edge and create a double-mounted effect. This is 

particularly suitable when mounting on black or coloured 

board or paper.

� Ensure that the edges of the photograph are straight, 

square and clear of any marks and uneven borders 

created during printing.

� Make sure the adhesive you are using will bond the 

photograph to the paper without causing it to buckle. 

Some heavy glues tend to affect thin boards and paper. 

Rubber cement or spray adhesive are the best  

adhesives to use.

� Take the time to measure the borders to ensure that you 

place the photograph in the correct spot within the mount 

(use a guide line when mounting).

Figure 6.1E Top-mounted photograph

Window mounting
This type of mounting involves cutting a hole in  

the card or paper the same shape as, but slightly 

smaller than, your photograph. The mount then sits 

on top of the artwork and creates a professional 

border (see �gure 6.1F). If you can gain access to a 

bevelled-edged matt cutter it will further enhance the 

professional look of your mount.

Figure 6.1F Window-mounted photograph

poinTs To consider

� It is always important to measure your photograph 

accurately and cut out your window mount slightly smaller 

than the photograph. It is wise to print the photograph with 

a thin white border to ensure that you are not covering too 

much of your photograph with the window mount.

� The colour or tone you select for your mount is very 

important. It should complement your print and not 

compete against it.

� By using an acid-free mount board, combined with acid-

free tape and other acid-free materials, you will help to 

conserve your photograph (see section 7.1, page 136).

� Use the guidelines on page 123 in the layout of your 

mount.

� Use tape to adhere your photograph to the window mount 

(see �gure 6.1G).

� For a major artwork you may consider double mounting the 

photograph. First window-mount the artwork in one colour 

or tone, then remount it with another colour or tone and 

allow some of the �rst mount to show under the other 

(see �gure 6.1H).

poinTs To consider

� It is always important to measure your photograph 

accurately and cut out your window mount slightly smaller 

than the photograph. It is wise to print the photograph with 

a thin white border to ensure that you are not covering too 

much of your photograph with the window mount.

� The colour or tone you select for your mount is very 

important. It should complement your print and not 

compete against it.

� By using an acid-free mount board, combined with acid-

free tape and other acid-free materials, you will help to 

conserve your photograph (see section 7.1, page 136).

� Use the guidelines on page 123 in the layout of your 

mount.

� Use tape to adhere your photograph to the window mount 

(see �gure 6.1G).

� For a major artwork you may consider double mounting the 

photograph. First window-mount the artwork in one colour 

or tone, then remount it with another colour or tone and 

allow some of the �rst mount to show under the other 

(see �gure 6.1H).
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Figure 6.1G The back of a window-mounted photograph. It is not necessary 

to use a lot of masking tape, as it is better to allow the paper to expand and 

contract in different weather conditions.

Figure 6.1H Double-mounted photograph

Creative mounting
Exploring the creative possibilities with mounting will  

allow you a further device to aid in the construction  

of your photographic artwork. As an artist, you have the 

opportunity to explore, trial and re�ne whatever approach 

you wish.

photomontage
Photomontage involves cutting out and mounting parts 

of one print onto another. This technique has enormous 

creative potential as it allows you to combine a number  

of different photographic images (see �gure 6.1I).

poinTs To consider

� It is important to make sure that the overlapping images blend 

with the background. The tones in the images should be similar.

� To aid in the combination of the two images, you could spray 

the completed image with a surface spray (use a matt or gloss 

pressure pack spray).

� To help add authenticity you can add shadows to the overlay 

images. These can easily be painted on with watercolours or 

with an air brush.

� It is important to use a good quality adhesive to ensure the 

overlaid print is attached correctly to the background.

Figure 6.1I An example of a photomontage. Meat market,  

Brett Seakins, Year 12, gelatin silver photograph
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cutting and pasting
The possibilities with cutting and pasting photographs 

are endless. By playing around with a pair of scissors 

or a guillotine, you can totally change the structure of 

your photograph and produce some really creative and 

imaginative images (see �gure 6.1J).

Print a number of copies of the same photograph 

and experiment with cutting it a variety of different 

ways. Always use a good quality glue to ensure that the 

various parts of your photographs adhere correctly.

printing and mounting  

reversed images
It is possible to achieve interesting results by 

combining a standard photograph with a reversed 

image of the same photograph. The reversed image 

can be made easily by simply printing the photograph 

with the negative upside down (matt-side up) in 

the enlarger. By combining a number of normal and 

reversed images you can create some amazing 

artworks (see �gure 6.1K).

Figure 6.1J  

An example of 

cutting and pasting. 

Youth on Chapel 

Street, Letitia 

Gamble, Year 12, 

collage, gelatin silver 

photographs, toner, 

digital photographs, 

polaroids and lith 

�lm

Figure 6.1K  

An artwork created 

using reversed images 

combined with  

normal prints
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Mounting several photographs 

on the same mount
There is no rule stating that you must have only one 

photograph on a mount. There are many possibilities that 

stem from the combination of many photographs on the 

same mount (see � gure 6.1L).

Figure 6.1L An example of many images presented together on the same 

mount. Letter boxes, Elise Nicholson, Year 12, digital photographs

Mounting photographs on 

non-traditional surfaces
Photographs do not have to be mounted on board or 

paper. As an artist you are free to select whatever surface 

you want. A mount can become part of the artwork and as 

important as the photograph itself (see � gures 6.1M (i), 

(ii) and (iii)).

i. Digital photographs 

mounted on perspex. 

Mind, body, spirit, soul, 

Melissa Amore, Year 12

ii. Photographs 

mounted on wooden 

boxes. Boxed in, 

Loretta Bourke, Year 12

iii. Digital 

photographs heat-

pressed onto a 

tablecloth. A family 

meal, Vanessa 

Blanco, Year 12

Figure 6.1M Examples of photographs mounted on non-traditional surfaces

Short-answer questions

Complete the following in your workbook or journal.

1. Why do we mount photographs?

2. What type of things do you need to consider when you are 

mounting your photographs?

3. What is an edition number?

4. Why do artists sign their work?

5. What are the two standard ways to mount a photograph?

6. What are the two standard ways to structure the size of 

the borders on a mount?

7. Make a list of all the creative ways you can think of to 

mount a photograph.

Practical tasks

1. Print two photographs. Top-mount one and window-mount 

the other.

2. Print another photograph and mount it in a creative manner.

3. Consider the three mounted images produced for tasks 1 

and 2. Which technique do you think enhances your 

photograph the most? Explain why.

4. Which of the mounted images from this chapter do you 

think is the most successful? Explain why.

acTiviTies
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 6.2  EXHIBITION SPACES
Despite our media-driven world, where thousands of 

images are displayed before us everyday in magazines, 

on billboards, television and the internet, and even on 

phones and iPods, the value of an artistic image is still 

truly appreciated. In fact, the notion of �ne art has become 

increasingly more accessible, relevant and of interest 

to the general public. Society has developed a better 

understanding of the importance of art and, in so doing, 

has supported the formation and development of exhibition 

spaces throughout the country. Whether you wish to view 

signi�cant artworks from ancient Egypt, the works of a 

great master like Picasso, view an emerging artist�s latest 

exhibition or attend a group show by artists from your local 

community, today we have a vast array of different types of 

exhibition spaces to cater for all types of art.

Public galleries
Public galleries are funded by taxpayers to provide 

cultural resources for the community. These galleries offer 

people the opportunity to view and learn about signi�cant 

artworks. Public galleries can vary considerably, depending 

on their purpose. Larger public galleries, such as the 

National Galleries of New South Wales, Queensland and 

Victoria, establish their own collections of traditional and 

contemporary artworks, and deal with all art media, from 

craft to �ne art. They are the focal point in making art 

accessible to the general public. Part of their role is to 

exhibit, conserve and preserve their own collections. They 

are also responsible for the acquisition of new artworks.

Figure 6.2B A public regional gallery in Benalla, Victoria

In addition to government funding, public galleries rely 

on the support of the community through donations and 

bequests. A signi�cant proportion of the artworks within 

public art collections have been donated or purchased 

with money provided by philanthropists, as well as other 

interested and supportive members of the public.

Public galleries often put together or borrow exhibitions 

using artworks from other national and international galleries, 

and private collections. These exhibitions bring together 

important artworks and provide a valuable opportunity for 

their audiences to see major artworks �rst-hand.

Public galleries have a responsibility to make their 

exhibitions accessible to all members of the public and to 

different audiences. They do this in a variety of ways:

� guided and audio tours

� tours for students, and the visually and hearing impaired

� the production of educational kits for students of all ages

� by opening the gallery early some mornings and late 

some nights for special out-of-hours viewing.

Figure 6.2A The National Gallery of New South Wales
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They take great care to provide uncomplicated 

information panels throughout the exhibitions. The aim is 

to develop a greater public audience that can appreciate 

and enjoy the artworks displayed in the gallery.

Public galleries do not generally charge a fee to view 

their own collections. On some occasions they may charge 

a fee to view major national and international exhibitions. 

These charges are only put in place to help cover the cost 

of the exhibition and not to generate pro� t.

There are many regional public galleries scattered 

throughout Australia. These galleries provide a smaller, yet 

similar, service to communities whose members may not 

be able to visit the major galleries in their capital cities.

Many local and city councils support the arts by 

providing funding for other, smaller, public galleries. These 

galleries tend not to have their own collections; they focus 

mainly on exhibiting travelling exhibitions, and displaying 

the work of artists who work in a particular style, media, 

theme or historical period. A public gallery that has been 

established to cater for a particular media is the Centre 

for Contemporary Photography in Victoria. This gallery�s 

main focus is to promote and exhibit present-day 

photographic artworks. Exhibitions that deal with a speci� c 

theme are often held in this type of gallery. Retrospectives, 

group, solo and salon shows are organised by a curator, 

who coordinates the exhibition schedule for the year. 

Refer to chapter 14, page 249, for the location of public 

galleries in your state.

Figure 6.2C Centre for Contemporary Photography, Victoria

Commercial galleries
Commercial galleries are generally privately owned and 

are established to display and sell artwork in order to 

make a pro� t.

Most commercial galleries represent a group of artists 

(often referred to as a �stable�) whose work they promote, 

market and regularly exhibit. It is in the business interests 

of a commercial gallery to ensure that their stable includes 

either established artists or highly talented emerging 

artists whose work re� ects a good investment option 

for the gallery�s discerning clients. It is a challenge for 

young, up-and-coming artists to be selected by commercial 

galleries. They generally have to submit a folio of their 

artwork to the gallery�s director and hope that that person 

sees a strong potential in their talent and their artwork. 

Some young artists try to establish a name for themselves 

in alternative art spaces prior to approaching a commercial 

gallery for representation.

Figure 6.2D Roslyn Oxley9 Gallery, New South Wales

The services that a commercial gallery might offer an 

artist from their stable include: an annual or bi-annual solo 

exhibition, involvement in group shows with other artists 

from the stable, promotion of their artwork on the gallery�s 

website, the marketing of their artwork to public and 

corporate investors, and publicity through the promotion of 

their artwork in newspaper and art magazine articles.

Major commercial galleries cover a proportion of the costs 

associated with the marketing of their artists. These could 

include set-up costs for an exhibition, invitations, mail-outs, 

advertising and opening night expenses. In return for such 
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services, the commercial gallery takes a commission from 

the sale of the artworks. The commission may range from 

around 33.3 per cent to 45 per cent.

Smaller commercial galleries may make other 

arrangements with their artists. Some may not cover all 

expenses while others may split particular costs with the 

artist. Refer to chapter 14, page 249, for examples of 

commercial galleries in your state.

Alternative art spaces
As most artists are not represented by commercial or 

public galleries, they need to look for alternative venues in 

which to exhibit their artworks.

Without going to great expense, many artists now create 

their own websites. This can be seen as an ideal avenue 

in which to expose their artwork to the world.

Some groups of artists combine and establish artists�-

run spaces. These spaces can apply for government 

funding and/or can generate income by hiring out the 

venue for some months of the year to other artists.

Increasingly, local and city councils are supporting the 

arts by assisting with a growing number of unconventional 

sites in which artists can display their works. In 

Melbourne, two laneways in the inner city (Hosier Lane 

� see �gure 6.2E � and Centre Place) have been set up 

with an array of light boxes, with the space suitably titled 

Bright lights. Artists can apply to exhibit their work on the 

boxes through a local administrative body.

Most cities have a number of gallery spaces that artists 

can rent. The artists pay a fee for the rental of the space 

and then hang, promote, market and sell their artwork 

themselves.

Restaurant and caf� proprietors regularly exhibit and 

promote artists� work, and many banks, hotels and of�ces 

allow and encourage artists to hold exhibitions in their 

premises. The next time you happen to be in a restaurant  

or caf�, take note of the artwork on the walls. Refer to 

Chapter 14 for examples of alternative art spaces in  

your state.

Roles of people working  
in a gallery
There are a number of different jobs for people to 

undertake in an art gallery. Larger galleries employ hundreds 

of people to ensure the smooth operation of the gallery, 

whereas smaller galleries may have only two or three staff.

Running an art gallery and putting on an exhibition 

requires the skills of a number of signi�cant people; in 

particular, the gallery director, curator, exhibition designer 

and publicity of�cer.

Figure 6.2E Bright lights, alternative art space in Hosier Lane, Melbourne
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The gallery director
The gallery director�s role is to oversee the smooth and 

successful running of an art gallery. In the case of a 

commercial galley, the director is generally the owner. In 

public galleries, the director is employed by a government 

body to administer all aspects of the gallery, including 

the �nancial, cultural, social and political components. 

The director is also ultimately responsible for supervising 

everything connected with the day-to-day running of the 

gallery, including the exhibition schedule, staf�ng, security, 

conservation and marketing.

The curator
The curator is responsible for the exhibitions presented in 

a gallery space. If the gallery has its own collection, then 

the curator is also responsible for the artworks housed 

within the collection. It is the role of the curator  

to advise and work with the gallery director to establish 

the exhibition schedule for the year. The curator will 

generally suggest possible exhibition ideas, including 

exhibitions made up of artworks from the gallery�s own 

collection (if they have one), thematic shows (based on a 

theme), movement shows (honouring a particular style or 

art period), retrospectives (celebrating the work of an artist 

over an extended period of time) and media-based shows 

(where the work of a particular studio form is exhibited;  

for example, photography).

Once an exhibition has been given the go-ahead, it is the 

role of the curator to oversee all aspects of the exhibition. 

This can include:

� Borrowing artworks from other galleries and private 

collections.

� Organising the transportation and insurance of borrowed 

artworks.

� Working in conjunction with the exhibition designer to 

organise the layout and look of the exhibition.

� Working with the publicity of�cer to organise marketing 

and promotion.

� Ensuring that the works are maintained and appropriate 

conservation procedures are followed.

� Researching the artworks that are to be presented in 

the exhibition and developing a sound understanding of 

their historical, cultural and social signi�cance.

� Providing education on the exhibition to the gallery staff, 

members and visitors.

� Writing up information for use in the exhibition 

catalogue, media releases and articles for newspapers 

and magazines.

Major public galleries, such as the national galleries in 

each state, employ a large number of specialist curators 

to look after the various aspects of their collection and 

exhibition program. For example, they would have a 

curator of photography as well as another for textiles, 

painting, ceramics and sculpture. These curators would 

also be responsible for advising the gallery director on the 

purchasing of new acquisitions. Commercial galleries do 

not generally employ a full-time curator. They may employ 

a freelance curator to coordinate an exhibition or, in most 

cases, the gallery�s director will take on the role.

Figure 6.2F Dr Isobel Crombie, Curator of Photography  

at the National Gallery of Victoria

exhibition designer
The role of the exhibition designer is to advise and work in 

conjunction with the curator to establish the look and style 

of an exhibition. The designer works towards presenting the 

artworks in a manner that will maximise their impact on an 

audience. In order to do this the designer may consider:

� The placement and arrangement of the artworks within 

the exhibition space, including the order in which 

the artworks are hung � perhaps chronologically 

(historically) or thematically.

� Ensuring that the artworks are presented in such a way 

that they complement one another. Consideration is 

given to the works hanging either side of an artwork, as 

well as those on surrounding walls.

� Painting the walls of the gallery space a colour that 

enhances the aesthetic qualities of the artwork, as well 

as the theme and subject matter of the exhibition.

� Arranging the lighting of the exhibition to create an 

enhanced atmosphere and mood.

� The framing and mounting of the artworks and the layout 

of their display. This would include the presentation 

height of the artworks (refer to page 134) and how they 

may be presented if they are three-dimensional; for 

example, in a cabinet or on a pedestal.

� The design of the information panels presented 

throughout the exhibition. The design of these would 

need to work in conjunction with the look and style of 

the remainder of the exhibition.

� Placing signage (perhaps the title of the exhibition) 

throughout the exhibition to further enhance the 

established style of the exhibition.
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Exhibition designers are also generally responsible for 

ensuring that the style and look of an exhibition is carried 

over to any publicity and advertising material.

publicity of�cer
It is the role of a publicity of�cer to promote and market 

the art gallery and its exhibition schedule, to make 

people aware of what is going on and to entice as many 

visitors as possible to the gallery. The publicity of�cer is 

responsible for all the advertising and promotion of an 

exhibition. Their role could include:

� Organising the opening night of an exhibition, including 

sending out invitations to signi�cant members of the 

public in addition to government dignitaries, gallery 

board members, sponsors and the media to preview the 

exhibition. For major exhibitions there may be a series of 

opening and preview nights organised.

� Sending out information on the exhibition to gallery 

members and other interested parties who appear on 

their mailing list.

� Creating a press release with detailed information on the 

exhibition and a collection of images for the media to use in 

articles that they may choose to publish on the exhibition.

� Sending out information on the exhibition to schools and 

other educational institutions.

� Being responsible for the advertising schedule for the 

exhibition. This would include working with a graphic 

artist (possibly the exhibition designer) to establish the 

advertisements for newspapers and magazines as well 

as television, radio and billboards.

� Working with the television and radio networks to 

encourage them to present a story on the exhibition.

� Writing articles about the exhibition for an in-house 

magazine or newsletter.

Figure 6.2G Exhibition designers at work

Figure 6.2H Publicity of�cers at work
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Putting on an exhibition
To place your artwork on display is to present your images 

and artistic ideas to an audience. It can be a time of 

excitement and anxiety. The feedback that you receive from 

the public�s viewing and response to your work will give you 

an insight into the qualities that your work contains.

There are no hard and fast rules for displaying and 

exhibiting artwork and the organisation of the display will 

depend on the type of images you are presenting.

A successful exhibition needs a lot of preparation and 

planning. If you intend holding an exhibition you should 

consider the following points.

� Who is involved? Is it a solo or group show?

� What brings the artists together? Is it a theme, style, 

common interest or medium?

� You must consider your audience. Who are you trying 

to reach? Is it your parents on open day, your peers, or 

your teachers and classmates?

� What is left out of an exhibition is just as important as 

what is put into it. Be ruthless in your decisions about 

which artworks will appear in the exhibition.

� The organisation of an exhibition must deal with a 

number of design problems, such as the different sizes 

and shapes of the photographs, the different tones in 

the works (from light to dark) and the hanging of the 

works (some may need to hang vertically while others 

hang horizontally).

� Draw a detailed plan of the exhibition. This may change 

as the exhibition is being hung; however, it is an 

important tool in the production of the show.

Conduct an investigation into how galleries exhibit photographic 

works to audiences in different ways.

Research report

Visit two galleries currently holding photographic exhibitions 

and use the questions from the proforma below to aid your 

investigation. Summarise your �ndings in a report, with a 

conclusion explaining how and why the practice of each of 

your chosen galleries is different. Do you think the galleries are 

catering for different audiences? Explain your answer.

Does the gallery have a website? What can be discovered 

before the visit?

The gallery

Name of gallery  __________________________________

Location of gallery  ________________________________

What type of gallery is this?

 Public gallery

 Commercial gallery

 Alternative art space

Who owns the gallery?  _____________________________

When did the gallery open?  _________________________

What is the main purpose of the gallery?  ________________

_______________________________________________

What type of artwork is exhibited in the gallery?  ___________

What is the criterion for the selection of artwork for 

exhibition?  ______________________________________

_______________________________________________

How would an artist approach the gallery in an attempt to have 

their artwork exhibited?  _____________________________

_______________________________________________

What does the physical space of the gallery look like? 

_______________________________________________

_______________________________________________

How is the gallery funded?  __________________________

The photographic exhibition

Title of exhibition  _________________________________

Name(s) of exhibiting artist(s)  ________________________

What are the main features of the exhibition?  ____________

_______________________________________________

_______________________________________________

Who is the curator of the exhibition?  ___________________

What is the curator�s main role in this exhibition? 

_______________________________________________

_______________________________________________

_______________________________________________

_______________________________________________

Has an exhibition designer been involved in this exhibition? 

_______________________________________________

_______________________________________________

If not, who has coordinated the hanging of the exhibition? 

_______________________________________________

How have the artworks been displayed to maximise their impact 

on their audience?  ________________________________

_______________________________________________

_______________________________________________

_______________________________________________

How is the artwork labelled?  _________________________

How has the exhibition been promoted and marketed? 

_______________________________________________

_______________________________________________

_______________________________________________

How has the exhibition been funded? (For example, government, 

sponsorship, through the sale of artwork) 

_______________________________________________

Does the exhibition have a sponsor?  ___________________

If so, who are they and how have they supported  the exhibition?

_______________________________________________

_______________________________________________

acTiviTies
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� Ensure all works are mounted appropriately (see section 6.1, 

pages 122�7).

� Many artists give their artworks a title. Will the intention of 

your artwork be clearer to the audience if it has a title?

� Artworks are generally classi�ed in exhibitions by placing 

a label next to them which states the name of the artist, 

the title, date and medium.

� Hanging an exhibition takes a lot of time and patience. 

You may like to change and adjust particular pieces as 

you see �t.

� There is a height standard for hanging artworks. This 

measurement is taken from the ground to the centre of the 

artwork. For small artworks, the measurement is 155 cm 

and for larger works it is 185 cm (see �gure 6.2I).

� Ideally, an invitation should be sent to your audience. 

The invitation should state relevant information about 

the show, such as the exhibiting artists, venue, date 

and times. The invitation may show an image or several 

images from the exhibition (see �gure 6.2J).

� The highlight of the exhibition is the opening. The school 

principal or local member of council may be interested in 

opening your exhibition. Contact you local paper for publicity.

� The utmost care must be taken of artworks on display. 

The exhibition should be continually monitored.

185 cm

155 cm

i. ii.

i. Small artworks are hung so that the centre of the artwork is 155 cm  

from the �oor.

ii. Large artworks are hung so that the centre of the artwork is 185 cm  

from the �oor.

Figure 6.2I The height standard for hanging artworks

1. At the end of the semester, organise for your class to 

put on an exhibition of the artworks that your have 

produced. Select a class member to take on the role 

of curator, and then appoint a team of exhibition 

designers and publicity of�cers. You will also need to 

appoint a number of students to mount and hang the 

show under the direction of the curator. You may also 

consider offering achievement awards and, if this is 

the case, a number of students could be responsible 

for organising them.

2. Organise a display of artwork for a particular audience. 

This may be for parents on parent�teacher nights, or for 

the general public on open day. Consider using the local 

bank or another public space to exhibit your artwork.

3. An exciting activity is to place your artworks in 

competitions and local and city fairs. Ilford Photographic 

Company holds a school competition every term; 

contact your local photographic supplier for details.

4. Discuss with your teacher the possibility of holding an 

annual school art show. This is an ideal place to present 

your artworks to the school and wider community.

acTiviTies

Figure 6.2J An example of an invitation to a school art show

Figure 6.2K An annual school exhibition



Preservation, conservation 
and restoration

7.

 7.1  PRESERVATION  

AND CONSERVATION
Artworks generally re�ect aspects of the time in which 

they were made and therefore can be seen as a creative 

record of an ever-changing world. When you walk through a 

gallery you are given the opportunity to view artworks from 

many cultures and civilisations. By looking at these works 

you can learn a little more about the way other people 

lived. It is satisfying to think that in hundreds and possibly 

thousands of years, people will be looking at our culture 

through the artworks that we have produced. However, if 

we do not consider the way we conserve and look after 

artworks, there is a good chance that many will not survive. 

The preservation and conservation of artwork centres around 

caring for the work and helping to prevent any foreseeable 

damage; that is, safeguarding the artwork for the future.

Over the past 40 years the importance of photographic 

preservation and conservation has been recognised. 

Photographers have become concerned with the use of 

processing techniques that will guarantee the maximum 

life for their images. Furthermore, photographers are now 

aware of the importance of proper display and storage 

to help prevent damage to artworks. In addition to most 

galleries, museums and collectors, artists are now able to 

clearly see the value and importance of looking after and 

maintaining photographs in prime condition.

One of the major concerns in photographic preservation 

and conservation is the make-up of photographic paper. 

The problem stems from the construction of the paper, 

which consists of a number of different layers of complex 

chemical materials. These layers can react to external 

factors differently and the layers can separate, damaging 

the photograph. It is important that the layers maintain a 

stable relationship if they are to be successfully conserved 

and preserved.

Digital photographic paper comes in a variety of different 

qualities for a diverse range of purposes. Thicker, high-

quality papers tend to be similar to the more traditional 

types of photographic paper that consist of several 

different layers. Thinner papers are exposed to different 

problems because of their delicate and fragile nature.

External dangers
The main external dangers facing photographs (and any 

artworks produced on paper) are light, temperature, 

humidity �uctuations, fungus, atmosphere pollution, acidity, 

insects and general handling.

Light
All light can cause problems to artwork produced on paper, 

particularly the ultraviolet (UV) and infra-red (IR) rays found 

mainly in natural and, particularly, in arti�cial light. Strong 

light can damage artworks by causing them to fade and/or 

discolour.

The safest lighting condition for any kind of artwork 

is total darkness. When photographs are displayed, it is 

important to keep the effects of light to a minimum. Some 

ways of doing this are:

� not hanging a photograph in direct sunlight

� photographs should be framed under ultraviolet-

absorbing glass or perspex

� light generated from a spotlight should not create 

additional heat on the photograph
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� the intensity of the light should be kept to a minimum. 

Photographs are exhibited at the National Gallery of 

Victoria under 50 lux of light intensity. Lux (or luxen) 

is the measurement of light energy. A bright sunny day 

measures 6000 to 10  000 lux. A rainforest measures 

about 2500 lux. Light levels are monitored for every 

exhibition with a special light meter.

� when a photograph is not being displayed it should be 

kept in a completely dark storage area.

The National Gallery of Victoria and the Art Gallery of 

New South Wales have a policy to display photographs on 

a ratio of 1:3 (that is, exhibit for one month, rest for three 

months) to conserve the photographs.

temperature and relative humidity
Temperature and relative humidity (the measurement 

of moisture in the air) are related; therefore, if the 

temperature in a room is constantly changing, so is the 

relative humidity. This can cause paper to expand and 

contract (the paper becomes brittle in a dry atmosphere, 

then becomes moist in conditions that are damp). The 

� uctuating and changing conditions of a room tend to 

stress and ultimately damage an artwork. State public 

galleries such as the National Gallery of Australia and 

the National Gallery of Victoria use building automated 

systems (BAS) to control and record temperature and 

relative humidity via computers and sensors in gallery 

spaces. In addition to the BAS, they sometimes still use 

portable data loggers to extract data via computer.

Figure 7.1A The building automated system at the National Gallery 

of Victoria

Older style hydrothermographs are still used in some 

galleries to monitor and record the temperature and 

relative humidity in a room (see � gure 7.1B).

Figure 7.1B 

A hydrothermograph

Of particular concern to photographers is how the 

different layers of photographic paper react with each 

other. If, in dry conditions, one layer shrinks more than 

the layers underneath, it could detach itself from the other 

layers. This can cause the emulsion to crack and � ake 

and, unfortunately, the damage tends to be irreversible.

If the relative humidity surrounding an artwork extends 

beyond 60 per cent, mould can begin to grow on and 

within an artwork. It is important to consider the following:

� photographs should be kept at a constant temperature 

and relative humidity (international exhibiting and 

storage conditions are between 18�20 degrees Celsius 

and at a humidity of 45�55 per cent)

� photographs should be checked occasionally for 

potential problems, such as mould spores and fungus, 

that could damage the artwork.

acidity
Many types of paper produced over the past few hundred 

years contain residual acid. If this acid is not neutralised it 

can ruin the paper. Artworks have been known to discolour 

and, ultimately, be burned by paper containing acid.

Nineteenth-century photographic paper contained acid. 

Since then manufacturers have realised the potential 

problems associated with acidity and used this information to 

enhance the production of their photographic paper. However, 

if photographs are mounted or displayed on paper that 

contains acid, the print can still be damaged or ultimately 

destroyed. Therefore, it is important that artworks are 

mounted and stored in an acid-free environment.

Ideally, photographs should be mounted under a 

window mount made from an acid-free matt board (see 

section 6.1, page 124). The photographs should be 

attached to the baseboard using acid-free mounting 

corners rather than hinges and glued with acid-free, 

water-based glue. These corners allow for easy removal 

from the mount if required. For the best protection, the 

window mount should be attached to the baseboard 

using gummed linen tape (see � gures 7.1C and 7.1D).
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An international standard for testing materials for their 

reactivity with photographs was developed by the Image 

Permanence Institute in America. This test is known as 

the photographic activity test, or PAT. Here, 

this test is performed at the 

National Archives of Australia. 

In their advertising, many 

companies mention that 

their produce has passed 

the PAT, meaning it is safe 

to use near or against 

photographs.

Figure 7.1D Ideal mounting system for a photograph

Photograph: Ansel Adams Photo booth self-portrait, 1936

Ansel Adams, photographer,

1 photographic print: silver gelatin; 08 × 07 cm.

Courtesy of the Katherine Kuh papers 1908�1994, 

Archives of American Art, Smithsonian Institution

insects
Artworks should be regularly checked for insect attack to 

prevent damage occurring.

Insects can in� ltrate an artwork and even breed within 

mounts and frames. Insects such as silver� sh have also 

been known to eat the surface of the paper. If insects are 

present they must be removed. However, be aware that 

most commercial insect spray repellents will stain artworks 

that are on paper. Most galleries use insect traps to 

manage the problem.

atmosphere pollution
Artworks should be displayed and stored in a pollution-

free environment. Cigarette smoke, car fumes and other 

air pollution can damage an artwork through constant 

exposure. Public state galleries have air � ltration systems 

that minimise the exposure of their artworks to pollution.

Handling
Photographs should be handled with the utmost care. The 

grit, grime, grease and oil on hands can damage the work. 

It is therefore important for people handling photographs 

to take protective measures. Wearing clean cotton gloves 

or using paper � ngers (a piece of acid-free paper folded in 

half � see � gure 7.1E) is often advisable when working 

with photographs. The handling of artwork should be kept 

to a minimum to prevent accidental mishandling.

Figure 7.1C 

Close-up view of a mounting corner

Figure 7.1E Using paper � ngers when handling photographs

storage
Photographs are generally stored by galleries, collectors 

and museums in solander boxes (� gure 7.1F). These 

boxes are lined with acid-free material and are light-tight, 

provide an environment of relatively stable humidity and 

temperature, and protect the artworks from atmospheric 

pollution and insects. Acid-free clear plastic is placed 

over photographs in storage. Students can use acid-free 

tissue paper.

Figure 7.1F A solander box
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 7.2  RESTORATION
�Photographic restoration� refers to bringing back or 

replacing what has been damaged, thereby restoring the 

photograph to the best condition possible.

Old photographs are no longer valued only for their 

documentary importance, they are also valued for their 

artistic merit. The recognition of the importance of 

photographic conservation is relatively new and we are 

now faced with the problem of the ongoing deterioration 

of many old photographs. The damage usually appears as 

faded and bleached images, purple and brown splotches, 

fungus, prints sticking together, physical damage (for 

example, rips and tears), insects eating the work and acid 

mounts burning the sides of the photographs. What can we 

do about this damage? Should we accept that, as these 

photographs are old, damage is part of their existence, or 

should we attempt to repair the damage caused by time 

and restore the photographs to peak condition?

It is generally accepted that photographs can and 

should be restored. However, the restoration should in 

no way create an artistic forgery or historical falsi�cation. 

The restorer needs to keep in mind that the photograph 

was created by an artist and should in no way attempt 

to re�ect any of the restorer�s own artistic ideas on the 

work, even if they believe they understand the artistic 

intention of the work. The restorer should also be careful 

not to remove elements of the work that provide evidence 

of its age. In most cases photographs are dated by the 

procedures and techniques used.

Conservators work under ethical guidelines that mean 

all changes and treatments made to an artwork should be 

reversible. They do not work towards changing the artwork 

permanently in any way.

There will always be an ethical debate over the extent 

to which an artwork should be restored. If an image has 

greatly deteriorated, should we attempt to reconstruct it?  

If we do that, are we re-making the work and, therefore,  

to be considered the artist of the work?

The restoration that takes place with a photograph will 

largely depend on what is appropriate. Restoration is a 

delicate procedure and should generally be handled only 

by a competent professional. Most processes used in 

the restoration of photographs are very delicate and the 

restorer should have a detailed scienti�c knowledge of the 

products being used. In particular, very old photographs 

(for example, daguerreotypes, see �gure 10.1D, page 168, 

and collodion images) need speci�c attention, and an 

Figure 7.2A A conservator restoring an old photograph at the National Gallery of Victoria
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inexperienced individual could cause greater damage than 

already existed by attempting to restore them.

When restoring a work it is desirable to restore 

the actual photograph; however, this may not always 

be possible. An alternative is to duplicate the image, 

creating a copy of the photograph. However, it is 

important to remember that original photographs 

have certain qualities that no copy can match. Colour 

photographs processed in the 1960s will lose their 

colour de�nition, with the greens and blues beginning 

to dominate. Many galleries collecting photographs are 

reprinting the photographs from the original negatives, 

even though this con�icts with most collection policies of 

purchasing mint photographs (photographs printed by the 

photographer and/or photographer�s assistant the year 

they were taken).

activities

Short-answer questions

Answer the following questions in your workbook or journal.

  1.  Why is the conservation and preservation of photographs 

so important?

  2.  List the main external dangers affecting the preservation 

and conservation of a photograph.

  3.  What measures can you take at home to ensure  

the safekeeping of your own photographs?

  4.  Why must historical requirements be taken into 

consideration when restoring photographs?

  5.  What are the main conservation concerns relating  

to mounting an artwork?

  6.  Explain the difference between conservation and 

restoration. Include a de�nition of each.

  7.  List the main forms of damage to photographs  

that require restoration.

  8.  Why do you think it is important to restore an original 

photographic artwork? Would it not be easer to scan  

the image and then enhance it in Photoshop?  

Explain your response.

  9.  If a photograph has deteriorated signi�cantly, should 

we attempt to reconstruct it? Do you agree or disagree 

with this question? If we do that, are we re-making the 

work and, therefore, to be considered the artists of the 

reconstructed work? Explain your response.

10.  With the increased use of the internet by photographers 

to display their artwork and the whole notion of a digital 

image that can be so easily reproduced and stored, do 

you think that in time we will no longer need photographic 

conservators? Explain your response.

Research report

Different galleries have different concerns in regards to the 

conservation, preservation and restoration of photography. 

Compare the concerns and actions taken to protect and restore 

photographs in a major public gallery with those taken by  

a commercial gallery.

 Use the questions in the following proforma to aid in your 

investigation of each gallery. Summarise your �ndings in  

a report, with a concluding paragraph noting the differences 

and similarities between the two.

Name of gallery ___________________________________

Location of the gallery ______________________________

Type of gallery: public, commercial, alternative art space

How are the works displayed?  ________________________

What type of lighting has been used?  __________________

How long does the exhibition run?  _____________________

What efforts are made by the gallery to control temperature  

and humidity? ____________________________________

What is the gallery�s policy on the storage and handling of 

photographic artworks? _____________________________

_______________________________________________

Does the gallery go to any measures to protect the 

photographic artwork from atmospheric pollution, insects and 

acid?  __________________________________________

_______________________________________________

If so, what measures are taken?  ______________________

_______________________________________________

Practical task

1.  Look through your parents� or grandparents� photographs. Find 

at least one that may need some kind of restoration. Make 

sure that you ask permission and take great care with the print.

 Scan the image (see page 89) and use a computer 

software package (such as Photoshop, see section 3.4, 

page 80) to enhance the image�s tone, colour, brightness 

and contrast. If the image has any marks or scratches you 

could hide them using a cloning tool. Consider anything 

else that may need to be restored, and possible techniques 

that you could use to further enhance the image. Print out a 

before and after version of the photograph for assessment. 

In your workbook or journal, document the procedure that 

you followed in restoring the photograph.

2.  Compare the original and restored versions of your 

photograph. Which image do you think holds more �value�? 

Consider sentimental value and historical value.
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i. Photograph before restoration

ii. Photograph after restoration

Figure 7.2B 
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Aesthetic elements in 
photography

8.

 8.1  COMPOSITION
�Composition� refers to the way various 

components within a frame are arranged. 

Anyone can point a camera at a subject 

and create a photographic image. 

However, the way you compose the 

subject within the picture frame � where 

you put it, how close you get to it, at 

what angle you photograph it, how you 

use perspective, and what is placed in 

front and behind it � will govern the 

success of the image. Composition 

allows you to capture your own creative 

and individual interpretation of a subject 

(see �gure 8.1A).

The difference between a  

snapshot and an artistic photograph 

depends greatly on composition.  

Good composition is vital to the 

production of a quality image.

Figure 8.1A A frame within a frame is a common method 

used to create interesting composition. Bums on seats, 

Annetta Brown-Shepard, Year 12, gelatin silver photograph
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points to remember

� Get close to your subject. One of the biggest mistakes made 

by the novice photographer is not getting close enough to the 

subject. The main subject of the photograph should generally 

take up most of the frame. Beginners often photograph mostly 

the background, making the main subject appear almost 

insigni�cant (see �gure 1.6B, page 27).

� Pay attention to the background. What appears in the 

background of a photograph generally has a direct in�uence 

on the subject. If you are photographing a portrait, make sure 

that there are no overpowering images in the background (for 

example, trees appearing to grow from the subject�s head � see 

�gures 8.1B(i) and (ii)). Whenever possible, the background 

should complement the major subject. For example, to enhance 

a portrait of a pilot, the background of the photograph could 

contain an aircraft or airport.

� Hold the camera level. A common mistake made by beginners 

is to photograph a landscape or subject with a tilted horizon 

line. Always ensure that you hold the camera level, ensuring 

the horizon lines runs horizontally across the photograph  

(see �gure 8.1C).

� Edit the image. It is up to you to select how you are going to 

approach a particular subject. Be creative and always think 

beyond the obvious � consider different angles, viewpoints 

and backgrounds (see �gure 8.1D). Only items that enhance 

the whole image should be in your photograph. Ensure that 

you eliminate anything that does not directly contribute to the 

total image. This may not be easy, but in most cases it will be 

possible with a little creative thought and planning.

i. A photograph with a tilted horizon line

ii. A photograph with a horizontal horizon line

Figure 8.1C

i. A photograph where the photographer has not paid attention to the 

background. The tree appears to be growing from the subject�s head.

ii. The same subject as (i). However, in this photograph the photographer has 

paid attention to the background.

Figure 8.1B
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i. Front view ii. Side view iii. Close-up view

Figure 8.1D Three photographs showing how the same subject can be photographed in a number of different ways

Figure 8.1E Newsstand, Jacob de Weger, Year 10, digital photograph
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Rules of composition
There are many rules or formulae for correct 

compositional structure. Traditionalists believe 

that photographers should follow these rules, 

whereas contemporary photographers use their own 

compositional formats.

When learning about composition it is wise to be 

aware of these rules, then you can decide whether your 

photograph would be enhanced by the use of them or 

not. You may decide to pay attention to some of the 

rules and ignore others. As the creator of the image, 

you have that freedom and choice.

1. A horizon line should never cut the photograph in 

half. Consider having a low or high horizon line.

2. If you are photographing a portrait and the subject 

is not looking into the camera but across the frame, 

more space should be given to the direction of their 

gaze (see �gure 8.1G).

Figure 8.1G A portrait where more space is given to the direction of the 

subject�s gaze. Dad, Nadine Newell, Year 11, gelatin silver photograph

3. If a subject is moving across the frame it should 

move from left to right.

4. The �golden section� (or golden mean) refers to  

the most common compositional structure of a 

picture. It basically means that the structure and 

positioning of images within a frame should have  

Cropping
Although cropping should be seen as a last resort,  

you can often improve the composition of a poor image 

by cropping it. Traditionalists argue that a photograph 

should be printed as it was shot. These photographers 

traditionally print the entire negative, with a thin black 

border around the frame to indicate that no cropping has 

occurred (see �gure 8.1E). However, when learning and 

developing skills in photography, cropping can greatly 

contribute to the success of some of your photographs,  

so it should be encouraged and used as required  

(see �gure 8.1F).

i. A photograph before cropping

ii. The same photograph as (i) after cropping

Figure 8.1F
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i. Horizon line

ii. Frame format

iii. Position of main subject
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Figure 8.1H Diagrams showing the �golden section�

an approximate ratio of 5:8. It is believed that at this 

ratio the composition has a better proportion, the 

location of the centre of interest can be found and a 

�xed position for a horizon line can be established  

(see �gure 8.1H).

5. The �rule of thirds� suggests that you divide your 

picture frame into thirds, both horizontally and 

vertically. The best location for the main subject of 

the photograph is at one of the points where the 

lines intersect (see �gures 8.1I and 8.1J).

Figure 8.1I According to the �rule of thirds�, the points where the lines 

intersect are the best places to position the main subject of the photograph. Figure 8.1J This photograph demonstrates the �rule of thirds� at work.
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i. Horizontal composition ii. Vertical composition iii. Open composition iv. Closed composition

v. Rule of thirds vi. Golden section vii. Simple composition viii. Tight

ix. One-point perspective x. Moving across the frame xi. Small depth of �eld xii. Panoramic

Figure 8.1K Examples of different types of compositional formats

activities

1. In your workbook or journal, de�ne �composition�.

2. List �ve things you should take into consideration  

when composing a photograph.

3. Collect three photographs that demonstrate good  

composition. Print or photocopy the photographs  

and stick them into your workbook or journal.  

Make comments under each, outlining the successful 

compositional elements used in each which demonstrate  

the rules and structures of composition.

4. a. Take a series of photographs demonstrating good 

composition. Try photographing the same image from  

a number of different angles, viewpoints and distances. 

Acknowledge the points made in this section and take 

them into consideration when you are taking each 

photograph. Possible subjects to photograph include a 

car, a statue, a portrait and a house.

b. Process your �lm or download your images and print a 

proof sheet of the results. Stick the proof sheet into your 

workbook or journal and comment on the images.

c. Print the best image and comment on the compositional 

qualities that it contains.
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 8.2  THE ELEMENTS  

OF DESIGN
The elements of design are the major features available 

to you when you create a photographic image. Your use of 

these elements will directly in�uence the aesthetic value  

of your image.

The elements of design are line, shape, tone, texture, 

pattern and colour. A photographer may concentrate on one 

design element or use a combination of different elements 

in their work. You can use these artistic elements to 

enhance the design qualities in your photographs.

Line
The use of line in a photograph has endless 

possibilities. Line can lead the viewer�s eye towards 

the focal point within a photograph, unify different 

sections of a picture by leading the eye from one area 

to another, create depth through linear perspective, 

create pattern through repetition, and divide the 

photograph into different sections of interest. Lines 

can be horizontal, vertical, thick, thin, straight, curved, 

strong, bold, transparent, repetitive, natural or created 

(see �gure 8.2A).

Figure 8.2A This photograph demonstrates good use of line. Shannon Henwood, Year 12, gelatin silver photograph
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Shape
Objects are often recognised by their 

shape. When creating photographs you 

can use shape to give structure, meaning 

and purpose to your picture. Shape may 

be de�ned as a line that joins itself at 

both ends, but shape can also be created 

through contrasting blocks of colour  

or tone.

Shapes are generally considered to be 

two-dimensional (for example, a circle, 

square or triangle). By adding tone to a 

shape you can convert that shape into 

a form, or three-dimensional image (for 

example, a ball, box or cone).

It is possible to enhance the main 

subject or features of a photograph by 

simplifying, removing or suppressing some 

of the surface detail and allowing the 

shapes to become more obvious. This can 

be particularly effective if the image is 

photographed against a plain background, 

such as the sky.

A variety of different shapes can appear 

in a photograph to make it interesting. 

Shapes can be natural, organic, hard-

edged, bold, subtle, common, unusual or 

silhouetted (see �gure 8.2B).

Tone
Most black and white photographs  

contain a variety of tonal gradations. 

Tone is very important in black and white 

photographs. A standard black and white 

photograph should contain an area that 

is black, another that is white and the 

remaining areas should have a variety 

of grey tones. A particular effect can 

be achieved by only using grey tones in 

the photograph. Alternatively, a highly 

contrasted image can be created through 

the use of black and white.

Tones can be soft, harsh, contrasting, 

complementary, subtle, subdued, limited 

or various (see �gure 8.2C).

Figure 8.2B This photograph demonstrates bold shapes produced by shadows. Hugh Laurence, 

Year 11, gelatin silver photograph

Figure 8.2C A photograph demonstrating good use of tone. 

Shannon Henwood, Year 12, gelatin silver photograph
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picture. Patterns have strong decorative qualities that can 

re�ect an aesthetically pleasing view of the world.

When photographing a pattern, consider the framing  

and viewpoint of the picture. A more powerful image can 

sometimes be created by taking a close-up view of  

the image.

Patterns can be decorative, repetitive, derived from 

nature or created (see �gure 8.2E).

Texture

�Texture� refers to the surface 

characteristic of a subject. Texture 

can add a tactile quality to shape, 

tone and form. It can give depth, 

character and realism to an image.  

A strong tonal range will help  

reveal the surface qualities of an 

image. The most effective means  

of controlling the textural appearance 

in a photograph is the direction  

of light.

The close-up lens or �lter can 

be used to exaggerate the surface 

texture of an object. Texture can 

reveal the nature of a surface, 

enhance the quality of an image 

or it can become an image itself. 

Textures can be rough, smooth, 

sharp, soft, furry, prickly, pitted,  

dull, shiny or grainy (see  

�gure 8.2D).
Figure 8.2E A photograph demonstrating good use of pattern. The screen, Eleanor Adams, Year 12,  

gelatin silver print

Figure 8.2D This photograph demonstrates good use of texture. Yosemite Valley, Charles Ferry, Year 12, digital photograph

Pattern

The element of pattern can be used effectively in a 

photograph to create rhythm, harmony and compositional 

structure. By repetitive use of line and/or shape, a pattern 

can be created. A pattern can be the main subject for a 

photograph or it can be used to aid in the design of a 
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Colour

When referring to the concept of recording a photographic 

image or digitally manipulating an image on a computer, 

we refer to colour in terms of the colour spectrum of light 

(RGB or CMYK, see � gure 3.2C, page 73). When analysing 

photographs and physically mixing colours in art, we refer 

to colours in terms of colour pigments. These colours are 

structured around a different colour wheel, with the primary 

colours consisting of red, yellow and blue.

In photography, colour can play a signi� cant role in the 

overall aesthetic quality of an image. Like tone, colour can 

give an object solidity and form, as well as enhancing the 

emotion, mood and atmosphere of a photograph.

It is important to understand the basic principles of 

colour, as they can greatly assist you in determining your 

approach to its use.

There are three basic categories of colour. The � rst 

group are called the primary colours (red, yellow and blue) 

and these form the basis of all other colours. The second 

group are called secondary colours. They are orange, green 

and purple, and are made by mixing two of the primary 

colours together. The third group of colours are called 

the tertiary colours, and they include khaki, burgundy and 

brown. They are made by mixing different amounts of the 

three primary colours together.

Secondary
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Figure 8.2F Colour pigment wheel: looking at a colour wheel helps you 

to understand how different colours work together.

Colours that appear opposite to each other on the colour 

wheel are called complementary colours. Because they are 

direct opposites they create a striking contrast when placed 

beside each other. Colours that appear next to each other 

on the colour wheel are called harmonious colours, as they 

match each other by appearing similar.

Certain colours can also appear warm, such as red, 

yellow and orange, or cool such as blue, green and purple.

i. Example of complementary colours: purple and yellow, blue and yellow

ii. Example of harmonious colours: orange and yellow, green and yellow

Figure 8.2G

Colour, although not necessarily an important design 

element in black and white photography, can be added to 

an image to give it a further dimension.

Colour can be added to black and white photography 

through toning and hand-colouring (see section 2.5, 

pages 50�7 and section 3.6, pages 93 and 94).

Figure 8.2H This photograph demonstrates good use of colour. 

Coloured face, Jessica Minear, Year 12, digital photograph
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Figure 8.2J This photograph demonstrates space created by looking through one object to 

view another. Observational Deck, Tokyo Tower, Charles Ferry, Year 12, digital photograph

Space
�Space� refers to the notion of depth within 

an image. Photographs are two-dimensional, 

�at pieces of paper. In order to create the 

impression of space within this picture  

plane, the image needs to rely on design 

elements such as tone, colour, line and 

shape. The design elements can work on 

their own or together to create the illusion  

of space. Space can be deep (you can  

see fair distance into the background, see 

�gure 8.2I), shallow (you can only see a 

small way into the image, see �gure 8.2H)  

or �at (there is no evidence of space).  

Space can be created through perspective, 

with objects becoming smaller as they move 

towards a vanishing point. Tone and colour 

allow objects to appear darker and more 

detailed in the foreground and lighter and 

less detailed in the background.

The visual awareness of space can also 

be created; when objects are overlapped, to 

produce the appearance that the object in 

front is closer than the one behind it; and, by 

looking through one object to view another, 

such as a window (see �gure 8.2J).

negative and positive space
�Space� can also refer to the area that the 

subject matter is taking up within the frame, 

this is called positive space. The remaining 

space within and around the subject is  

called negative space (refer to �gure 8.2E). 

In �gure 8.2K, the space the jelly �sh are 

in is the positive space and the black 

background is the negative space.

Figure 8.2I This photograph demonstrates deep space and an example of one-point perspective with all the lines leading to one point.  

Lorne, Charles Ferry, Year 12, digital photograph
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 8.3  THE PRINCIPLES 

OF DESIGN
The principles of design are used in artworks as a means 

of bringing order and balance to your photographic images. 

Awareness of design principles can aid you in the design and 

layout of your images. The design principles are devices that 

you can use to help make your artwork hold together and 

achieve a strong aesthetic quality. When you are looking at 

one of your photographs you may feel that it is not looking 

right, that it is not visually holding itself together. Through 

gaining an understanding of the design principles you can 

learn to identify the cause and the solution to this problem.

Unity
In order to create an image that is whole and united, it 

is necessary to consider the placement of the design 

elements within. Unity is achieved by creating an 

attachment between each of the elements, whether they 

are placed close to each other, touch, overlap or come 

together to form part of a sequence.

Unity is also created through compositional structure. 

An implied triangle is often used to create a sense of 

unity within a composition. By placing the elements and/or 

subject matter in the arrangement of a triangle or a series 

of triangles it is possible to make a united picture. The base 

of a triangle is solid and stable; therefore, it is an ideal 

structure to use in an effort to achieve wholeness within 

a composition.

Figure 8.2K This photograph demonstrates negative and positive space. Laura Petrucci, Year 12, digital photograph

activities

1. Examine the use of the design elements in each of the � gures 

in this section. Use the appropriate section of the proforma 

on analysing artwork on page 159 to come up with at least 

three words to describe the use of the most signi� cant design 

elements in each of the images.

2. Which of the � gures representing the design elements in this 

chapter do you think is the most successful? Explain why.

3. Complete a photograph shoot that explores the elements of 

design.

a. Take at least two photographs that concentrate on each 

design element. Then, take photographs that combine a 

number of design elements in the same photograph.

b. Process the � lm or download the images and print a 

proof sheet of the results. Glue the proof sheet into your 

workbook or journal and comment on your four most 

successful shots and explain why you think that they have 

been enhanced through the use of the design elements.

c. Print your most successful photograph and comment on the 

design qualities that you feel it contains.

Figure 8.3A 

Implied triangle 

used to create 

unity. Young woman, 

Eleanor Downie, 

Year 12, 

digital photograph
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Proportion
The relationship between the size of the various objects 

within an artwork and the size of the artwork itself has a 

direct bearing on how the work is seen and interpreted by 

the viewer.

When we look at an artwork we expect items to be in an 

acceptable proportion to one another. We are accustomed 

to viewing the outside world and, therefore, when we see 

objects represented in an artwork we have a natural desire 

to view them in the same proportion. Artists are generally 

aware of this and, as a result, can manipulate their 

images to create a particular reaction from the viewer. 

Proportion can help to imply emphasis; this is achieved 

by representing the most signi� cant subject of an image 

larger than all else. When manipulating proportion within 

an artwork it is necessary to compare the size of one 

object against another. We cannot see how large or small 

an object is unless we have compared it to another (see 

� gure 8.3B).

Emphasis
By allowing one area of an artwork to dominate, an artist is 

able to create a point of interest to attract the attention of 

the viewer. The emphasis of a particular part of an image 

often makes it the focal point. The focal point is achieved 

through a number of techniques. These include:

1. Placement: the subject is placed in or close to the 

centre of an artwork.

2. Scale: the subject is made larger than any other feature 

in the artwork.

3. Detail: the subject is given greater detail.

4. Isolation: the subject is placed on its own or away from 

other features.

5. Contrast: the subject looks different or opposite from 

the rest of the work.

6. Line: the use of line to lead the viewer�s eye towards 

the subject.

Repetition and rhythm
Through repetition of a similar design element throughout 

an artwork, the viewer�s eye can see continuity and order. 

By matching each element with its repeated counterpart, 

the eye is able to see the similarities within the image 

and is given direction to move easily and freely around 

the work. Whether it is a line, shape, texture or colour, 

the repeated element allows a pattern to be created and, 

as a result, a harmonious balance is often established 

within the work.

Figure 8.3C Photograph illustrating repetition. Dance, Madeline O�Bryan, 

Year 12, digital photograph

Rhythm is created within an artwork when there is 

ordered repetition, this often resembles the reoccurring 

beats in music. Just as music is made up of a 

Figure 8.3B The proportions of the various components of this image have been manipulated to create interest. 

The farm, Alice Halpin, Year 12, digital photograph
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combination of repeated beats, so too an artwork can 

create rhythm through a duplication of similar elements. 

For example, if a series of small, medium and large 

shapes recurred as a pattern throughout an artwork, they 

would create a rhythm (small, medium, large � small, 

medium, large � small, medium, large).

Figure 8.3D Photograph illustrating symmetrical balance. Tram tracks, Melbourne, Charles Ferry, Year 12, digital photograph

Balance

In order to achieve a composition that is visually pleasing, 

one that generates a feeling of equilibrium and order, it 

is necessary to structure an artwork so that it appears 

balanced. There are two different ways an artist can 

choose to balance a picture.

Figure 8.3E Photograph demonstrating asymmetrical balance. Cityscape (Yarra River), Melbourne, Charles Ferry, Year 12, digital photograph
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activities

1. Look through a number of books, magazines and the internet 

and �nd examples of artworks where each of the principles 

of design is evident. Make copies of these works and glue 

them into your workbook or journal. Under each example, 

provide a description of how the principle of design has 

assisted in creating harmony and order in the image.

2. Explain how symmetrical balance is achieved in �gure 8.3D 

and asymmetrical balance is achieved in �gure 8.3E.

3. Which of the �gures representing the design principles in this 

chapter do you think is the most successful? Explain why.

1. �Symmetrical balance� refers to offsetting the weight of 

the design elements on one side of a central axis by 

mirroring them on the other. If a large shape appears on 

one side of an artwork, then a shape of the same or a 

very similar-size would need to appear on the other.

2. Asymmetrical balance is achieved when opposing 

elements on different sides of a central axis are evenly 

weighted. They do not have to be the same shape or size 

or, for that matter, even be the same design element; 

however, they do have to have the same visual weight.



Discussing and analysing 
photography

9.

 9.1  THE PROCESS 

OF ANALYSING 

PHOTOGRAPHS
By looking at and studying the different ways artists 

approach photography, you can learn much that will 

aid you in your own photographic work. It is important 

to develop the ability to know what to look for and 

evaluate what you see. By studying and analysing 

photographs you can develop an understanding of how 

different photographers work, what their concerns are, 

their techniques and in�uences, as well as gaining an 

awareness of what makes a successful photograph.

Every day we are confronted with hundreds of  

photographic images in newspapers, magazines, books, 

the internet, television, or on billboards. We accept them 

as part of our daily lives and �ick past these images 

without even noticing them. However, if we want to 

develop a better understanding of the artistic approach 

to photography we must learn to look more closely at 

photographs. We need to establish a formula to help us  

to evaluate the photographic images we see. Following is  

a good procedure to use when analysing a photograph.

Procedure for analysing  
a photograph

Introduce the artwork
Provide the name of the artist, the title of the artwork,  

its date and media (for example, Lewis W. Hines,  

Breaker boys, c. 1910, gelatin silver photograph).

Describe the photograph
Your description should include a detailed outline of what 

is in the photograph, including the main subject matter 

and what is in the background and foreground. Describe 

the picture so that someone who has never seen the 

photograph can visualise what is in it by reading your 

description.

Analyse the techniques used
Discuss how the artwork was made, including the 

techniques, equipment and materials used. Has the image 

been manipulated? Was it photographed in a studio or 

outside? How has the photograph been lit? Was it created 

using �lm or is it a digital image? Has the image been 

manipulated? If so, how?

Analyse the design features
Discuss how the photographer has composed the image 

(refer to �gure 8.1J, page 146). What are the most 

signi�cant design elements evident within the image? 

Describe how they have been used (refer to section 8.2, 

page 148). Have any of the principles of design (refer to 

section 8.3, page 153) enhanced the aesthetic qualities of 

the image? If so, how?

The meaning and/or intention of the artwork
What was the photographer trying to achieve by producing 

this photograph? Was the artist trying to tell a story, or 

make a comment or judgement? Was the artist primarily 

concerned with capturing images in nature, or concerned 

with creating their own image?

Look for clues when analysing photographs. Everything 

from the title of the work to the subject matter, date and 

the way it has been photographed will give you some idea 

of what the artist was trying to achieve.
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Evaluate the artwork

What are the qualities of the photograph? What are the 

successful and unsuccessful elements in the photograph? 

Has the artist been in�uenced by photographic traditions? 

If so, how? Do you like the photograph? Is it considered an 

important photograph? Why/why not?

AcTIvITIEs

Analysing your own work

1. A good place to start when developing your skills and 

con�dence in talking and writing about photographs is with 

your own work.

a. Select a photograph you have taken and write a brief 

analysis of it. Use the format on page 159 to assist  

with your analysis.

b. Each member of your class is required to present a  

short analysis of one of their photographs to the rest 

of the class. This does not need to be formal and could 

involve the discussion taking place as the class sits in a 

circle on the �oor. Although this may seem intimidating 

at �rst, the more experience you have, the easier it will 

become. The following outline may assist you with your 

presentation.

 As you can see, my photograph is of a ________. 

I used ________ equipment, materials, procedure 

and techniques to produce this photograph. The main 

design elements and principles that I was interested in 

capturing and recording were ________. My main aim 

in taking this photograph was to ________. My personal 

assessment of the photograph is ________.

2. Look through a number of newspapers, photographic 

magazines and websites to �nd examples of how art critics 

review photographic exhibitions.

3. Visit a photographic exhibition and complete a detailed 

review of it. In your review, include at least two detailed 

analyses of photographs in the exhibition. Also include the 

location and name of the exhibition and a brief introduction 

to the artist(s) represented.

Figure 9.2A Lewis W. Hines, Breaker boys, c. 1910, gelatin silver photograph. Courtesy George Eastman House
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key words and noting important points that relate to the 

photograph being analysed. You can use these key words and 

terms as the basis for your written analysis. After completing 

this you should be able to write the information as a report.

You may need to photocopy this format each time you 

plan to use it to analyse a photograph.

After using the format a few times you will be able to 

analyse photographs without it, as you will have developed 

your skills and knowledge in discussing and analysing 

photographs.

FormAT For AnAlysIng A phoTogrAph

introduce the artwork

The artwork to be analysed is  (title of artwork)  

by  (name of artist).  

It is a  (gelatin silver photograph,  

type C colour print, digital photograph, photomontage, installation) and was created in  (date).

describe the photograph

 (title of artwork)

depicts

(Describe the subject matter of the image; for example: 

Breaker boys depicts a large crowd of young boys dressed in old and dirty overalls, jackets and caps. In the 

background, a group of older boys are gathered in the centre propped up on a ledge. The faces of the children 

seem grubby as if they have just �nished a long day of hard labour. They appear to be standing very still and 

stare expressionless towards the camera. A mood of quiet sadness is re�ected throughout the image.

Use as many descriptive words as you can. You must describe the image in a manner that will enable someone 

who has never seen it to be able to visualise it from your description.)

analyse working method

 (artist�s name) has created this work using  

 (traditional and/or contemporary) materials and techniques.

 (artist�s name) has photographed this image 

 
(co

n
tin

u
e
d
)

 9.2  FORMAT FOR 

ANALYSING 

PHOTOGRAPHS

Many students �nd it dif�cult to talk and write about 

artworks. This section provides a format to assist you to 

develop your con�dence and ability to analyse photographs. 

You are required to work through the format by ticking 

AcTIvITIEs

a�������� � ����������

1. Write a detailed analysis of the photograph on page 158  

by Lewis W. Hines. Photocopy and use the format in this 

section on pages 159�62, to assist you with your analysis.

 Lewis W. Hines was born and raised in America. He was one 

of the foremost photographers to concern himself with social 

issues. Hines photographed the underprivileged and outcast 

members of the community. In one series of work, Hines toured 

America attempting to capture and document the exploitation 

of child labour in factories, mills and mines. By recording these 

images, Hines attempted to draw people�s attention to the 

appalling conditions by presenting photographic documentary 

proof that could not be disputed. Hines�s photographs helped 

prompt the government to improve the working conditions of 

children.

2. Select a photograph that you like and/or are inspired by. 

Complete a detailed analysis of it, using the format given in 

this section.
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FormAT For AnAlysIng A phoTogrAph

(Discuss how the artwork has been made; for example:

� in a studio using traditional photography

� in a studio then manipulated and distorted it in the darkroom/or using Photoshop

� as he/she found it in nature and has used traditional photography, without any manipulation and/or distortion

� of an entirely constructed scene. He/she has created the scene using a set, actors and props.

� as it was found in his/her surrounding world and has captured it as a record of time to document an issue or 

idea. The image is naturalistic (true to life) and has not been manipulated or distorted.)

The image has been photographed  (inside, outside, in a studio) using  

 (dramatic, soft, even)  

(natural, arti�cial, studio, �ash) lighting.

The techniques that  (artist�s name) appears to have used in this work include 

.

� Traditional processes

� Digital enhancement

� Superimposing

� Solarisation

� Hand colouring

� Sepia toning

� Negative imaging

� Large or small depth of �eld

� Frozen motion � captured using a fast shutter speed

� Blurred motion � captured using a slow shutter speed

� Panned motion � captured while panning with the moving subject using a slow shutter

� Slow shutter. 

(You should go into some depth about the techniques used, explain how it was done.)

In order to produce this work  (artist�s name) would have needed 

to use the following materials:

� Black and white �lm

� Colour �lm

� Slide �lm

� Processing chemicals (black and white developer, stop bath and �xer)

� a stage/set constructed using fabric, paint, wood, props and costumes

� Photographic printing paper.

 (artist�s name) would have also needed the following equipment:

� Camera

� SLR 35 mm camera (If you are not sure, say �possibly�)

� SLR digital camera 

� Photoshop software

� Tripod

� Studio lighting

� Processing equipment (trays, developing tanks, enlarger)

� Flash

� Printer

� Other.

(If the artwork is contemporary and/or postmodern it may be relevant to include the following:  

In many contemporary works artists no longer see the need to take or process their own photographs.  

So there is a chance that  (artist�s name) may have directed 

a technician to photograph and/or process this work under his/her supervision.)

(continued)
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FormAT For AnAlysIng A phoTogrAph

analyse the style and design features

The style that  (artist�s name) has chosen for the work re�ects elements of  

 

(traditional pure straight photography, pictorialism, photo secessionalism, modernism, postmodernism,  

photographic theatre, surrealist, narrative, naturalism, documentary and/or photographic journalism  

(see section 10.2, pages 172�80)), in that  

.

(You need to explain how the image re�ects the style you have mentioned.)

The artwork contains a  

(closed, open, tight, traditional, unusual, vertical, horizontal � see �gure 8.1J, page 147) compositional format.

The image has been taken at  

(eye level, worm�s-eye view, bird�s eye view, a low/high, highly unusual) angle.

The most signi�cant design elements that  (artist�s name) 

has chosen for this work include (see section 8.2, page 148):

� Tone (highly contrasted, large variety of tone, limited tone, high key)

� Use of colour (soft, subdued, bright, dull, dramatic, strong, contrasting, harmonious, primary, secondary, tertiary, 

warm, cool, dark, high key)

� Texture (for example, vast array of different textures, strong solid rough textures, soft subtle textures,  

other words, smooth, shiny, sharp, furry, prickly, natural forming textures)

� Shape (for example, common bold shapes, uncommon natural forming shapes, other words, soft-edged,  

hard-edged, geometrical, organic)

� Line (for example, straight, curved, fuzzy, vertical, horizontal, diagonal, thick, thin)

� Focus (large or small depth of �eld, clear sharp image, a soft-focused image)

� Space (deep, �at, shallow).

Order and harmony have been created in the image through the use of  

 (unity, proportion, repetition, rhythm and/or emphasis (see section 8.3, page 153)). 

This is a result of 

 . (You need to discuss how this has been achieved.)

The artwork is  (asymmetrical, symmetrical, a bit asymmetrical, see  

page 155) balanced. 

Balance has been created through  

(placement of subject matter, repetition, colour, line, use of implied triangles).

discuss the meaning and/or intention of the artwork

In creating  (title of work)  (artist�s name) has approached the 

subject matter of a  (outline the basic subject matter of the work;  

for example, a portrait of a woman) in a  

(traditional/contemporary/innovative/sensitive/thought-provoking) manner.

I feel that  (artist�s name) has captured his/her image in this way in order 

to  . (Make a statement about an issue, re�ect on 

something about the time in which it was created, capture the true essence of the photographic medium, explore 

new and innovative image making, explore the aesthetic elements of the subject matter, record an event, zcapture 

the beauty of nature, re�ect an artistic idea, suggest a narrative, create a false reality.)

The title suggests .

(Does the title assist in the interpretation of the work? If so, what does it tell us?)

The main features about this work that re�ect this intention are 

 .

(You need to mention the main qualities in the work that re�ect the artist�s intention; for example,  

choice of subject matter, placement of subject matter, composition, techniques.)

 
(co
n
tin
u
e
d
)
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 9.3  HOw TO wRITE A 

COMPARATIvE ESSAY
Comparative essays form the basic structure for most art 

appreciation writing. They provide you with the opportunity to 

investigate the various in�uences, approaches and interests 

of artists and, in doing so, compare their similarities and 

differences. Artists often have their own personal creative 

aims and working methods that they use for making art. By 

making comparisons between the artistic aims of one artist 

or movement with those from another, you are given the 

opportunity to make clear contrasts between the two. This also 

provides you with the chance to illustrate an argument relating 

to how one artist or movement may differ from another.

Process

1. Research the topic, making notes and recording sources 

of information for your bibliography. Remember, if you  

are quoting directly from a text, you must use footnotes. 

The more reading that you do on a topic, the greater your 

understanding of it will be; therefore, the easier it will be 

to put the information into your own words.

2. Select examples of an artwork from both of the artists 

or movements that you are studying. Make sure that 

the artworks you select clearly illustrate the points that 

you intend to make. When comparing artworks it is also 

easier to do so if they have something in common (for 

example, both are portraits).

3. Use the �Format for analysing a photograph� on pages 

159�62, to assist you when discussing and analysing 

artwork.

4. Within your notes make a list of the similarities and 

differences between the two artists or movements 

(photocopy the table opposite to assist you with your 

note-taking).

5. Format your essay using the essay plan on the next page.

6. Construct your bibliography at the end of the essay.

poInTs To rEmEmbEr

� Once you have introduced the artist using their �rst name and 

surname, you then need to only mention the artist by surname. 

Do not discuss the artist by using only their �rst name.

� Select the most obvious and relevant artwork to analyse. 

Ensure that the work re�ects everything that you will or have 

been discussing about the artist�s work.

� Whenever you discuss an artwork you must always provide the 

title, date and media. You should then go on to discuss why it is 

a good example of the topic being discussed.

� Younger year levels may consider discussing only one 

artwork by each artist. If this is the case, they should be 

completed at the end of the essay and the analysis format 

on pages 159�62 could be used to assist.

� Include copies of all the artworks being analysed in your 

assignment.

� Use art words and correct technical terms whenever possible.

FormAT For AnAlysIng A phoTogrAph

The historical and/or cultural context in which it was made suggests that .

(You need to mention if the time and/or place in which the artist worked may give an insight when trying to 

interpret its meaning.)

evaluate the artwork (not required for every analysis)

I believe that  (name of artist) has taken a  

 (creative, imaginative, innovative, expressive, highly signi�cant, clever,  

well-documented) approach to the subject matter. His/her use of technique is  

(highly skilled, innovative, traditional, conservative, outlandish). What I like most about the work is the 

 

(choice of subject matter, technique, design, idea behind it, other).

Art historians/critics  (note author and source) suggest 

 (title of artwork) is  

 

(refer to commentaries on the artwork).

I agree/disagree with these statements because 

.

(continued)
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Essay plan for comparing  

two artists
You could adapt this essay plan to compare two art 

movements.

1. Introduction
Introduce the topic.

2. Introduce the artists
Introduce the artists that you will be discussing and mention 

why you think they are good examples for the topic. Outline 

the time and place in which they worked as well as any 

other directly relevant information. This introduction should 

be no longer than a couple of paragraphs.

3. In�uences
Discuss the in�uencing factors on your �rst artist and how 

these affected the development of their artwork � include 

historical, cultural and artistic in�uences. In contrast, 

discuss your second artist and the in�uencing factors 

that affected the development of their artwork � include 

historical, cultural and artistic in�uences.

4. Working method
Discuss the working method of your �rst artist. Include 

their use of materials, techniques and processes. Discuss 

the process they used toward the creation of their work.

Provide an example of their artwork to present evidence 

about their working method. You could use the working 

method section form the analysis format proforma to 

assist you (see pages 159 and 160).

Now, discuss the working method of your second artist. 

Include their use of materials, techniques and processes. 

Provide an example of their artwork to present evidence 

about their working method. You could use the working 

method section from the analysis format proforma to 

assist you (see pages 159 and 160).

5. style and approach to subject matter
Discuss your �rst artist in terms of style and approach 

to subject matter. What are the distinguishing stylistic 

features evident in their work? Include an example of their 

artwork to provide evidence of their style. You could use 

the style section from the analysis format proforma to 

assist you (see page 161).

Now, discuss the style and approach to subject matter 

of your second artist. What are the distinguishing stylistic 

features evident in their work? Include an example of their 

artwork to provide evidence of their style. You could use 

the style section from the analysis format proforma to 

assist you (see page 161).

6. communication of ideas and meaning
Discuss the artistic intention of your �rst artist. What  

did they attempt to communicate in their work? What 

is the meaning behind their work? Provide an example 

of their artwork to present evidence about their artistic 

intention. You could use the meaning and/or intention 

FIrsT ArTIsT  
or movEmEnT

sEconD ArTIsT  
or movEmEnT

Similarities

� In�uences

� Artistic aims

� Stylistic features

� Subject matter

� Techniques used

� Use of design elements and principles

� Meaning and or intention

� Artistic qualities

Differences

� In�uences

� Artistic aims

� Stylistic features

� Subject matter

� Techniques used

� Use of design elements and principles

� Meaning and or intention

� Artistic qualities
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Write a comparative essay on the following topic:

 How does the time and place in which artists work impact on their approach to art making? Discuss with reference to two artists 

and their artworks from chapter 12, pages 190�218.

activitY

section from the analysis format proforma to assist you 

(see pages 161�2).

Now, discuss the artistic intention of your second artist. 

What did they attempt to communicate in their work? What 

is the meaning behind their work? Provide an example 

of their artwork to present evidence about their artistic 

intention. You could use the meaning and/or intention 

section from the analysis format proforma to assist you 

(see page 161).

7. conclusion
In conclusion, refer back to the topic and discuss how you 

have addressed it in your response.

8. Bibliography

Figure 9.3A Students using a variety of resources to complete a research assignment on a photographic artist
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History of photography

10.

 10.1  technical 

developments

Exploring the possibilities  

of photography
In ancient times, stories were told of a contraption 

that could permanently record images seen through a 

mirror. Inventors, scientists and artists are known to 

have considered the principles of photography for many 

hundreds of years. However, it was not until early in the 

19th century that they had any real success.

In order to produce a photographic image, two things 

were required � a mechanism to project an image onto 

a surface and a surface that could capture the image 

permanently through exposure to light.

How to project an image onto a surface has been  

known since ancient times. By placing an object in front of 

a small hole (later a lens) outside a darkened room with 

no windows, light rays would re�ect off the object through 

the hole and create a reversed image on the opposite 

wall (see �gure 10.1A). Artists traced the projected image 

from the opposite wall, creating an exact likeness of the 

subject (�gure 10.1B). This device was known as a camera 

obscura (Latin for �dark chamber�) and was the forerunner 

of the modern camera.

Figure 10.1A  

Example of  

how a camera 

obscura works
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Figure 10.1B Camera obscura being used as an aid in drawing

Throughout history people have known that light can 

chemically change a surface by either darkening or 

lightening it. This is seen in the way that the sun�s rays 

darken the colour of our skin and light fades fabric. In 

1725, a German professor, Johann Schulze, discovered that 

light darkened a solution of chalk mixed with silver salt. 

Schulze created the �rst photographic images when he 

placed a chalk and silver salt solution in a glass container 

covered with opaque paper. He cut letters and shapes 

out of the paper and exposed it to sunlight. The solution 

became dark purple in the places where the light reached 

it. The rest of the solution remained white. However, when 

Schulze removed the paper from the container the rest of 

the solution also went dark, so the recorded image was 

lost. The problem remained of how to �x the image.

In the late 18th century, Thomas Wedgwood, the son of 

the famous English potter Josiah Wedgwood, explored how 

to permanently record images. Wedgwood used his father�s 

camera obscura to experiment with capturing images on 

paper and leather coated with a silver nitrate solution. 

Although he was successful in recording images of objects 

such as leaves and lace placed directly on the surface of 

the paper or leather, he failed in his attempts to make the 

images permanent. He also failed to successfully capture 

an image created by a camera obscura, as the image was 

far too faint.

The first photograph
In the early years of the 19th century a Frenchman, Joseph 

Ni�pce, also attempted to capture images from the camera 

obscura. He also sensitised paper with silver salt and 

was able to capture faint images, but was unable to make 

them permanent. After further experimentation, Ni�pce 

found that by applying a light-sensitive varnish containing 

bitumen of Judea (a kind of asphalt) to a metal plate, 

exposing the image, then dissolving the unexposed parts 

of the plate in an oil of lavender solution, a permanent 

image was created. This process worked on the principle 

that the bitumen solution hardened instead of turning 

black when exposed to light, leaving the unexposed part 

soft and therefore easy to remove.

Between 1826 and 1827, Ni�pce recorded what is 

believed to be the �rst permanent photographic image 

using this process. He called the images �heliographs� 

or sun drawings. The heliographs were captured using a 

camera obscura made by combining a microscope lens 

with a small wooden box. The image took an exposure 

time of eight hours to record and depicted a view from 

an attic window of his house (see �gure 10.1C). Although 

effective, this process was not really practical because of 

the long exposure time required.

Figure 10.1C The �rst recorded photograph � the view from his window at 
Gras, 1826�27, by Joseph Ni�pce

The daguerreotype
A painter working in Paris, Louis-Jacques-Mand� Daguerre, 

became interested in Ni�pce�s work and persuaded him to 

go into partnership in 1829. When Ni�pce died four years 

later, Daguerre continued Ni�pce�s work with Ni�pce�s 

son Isadore. In 1835, Daguerre developed a new method 

of preserving the image using a silver plate. The plate 

was sensitised with fumes of iodide, placed in a camera 

obscura, exposed to light, then to a mercury vapour and 

�nally ��xed� with a salt solution, resulting in the creation 

of a visible permanent image. The process, called the 

daguerreotype, produced a much clearer photograph and 

the exposure times were substantially reduced from eight 

hours to around 30 seconds. As Daguerre perfected the 

technique, the exposure time was further reduced, allowing 

portrait images to be captured. However, the exposure 

times are long when compared to today and the sitter had 

to remain perfectly motionless. If the subject moved the 

image would blur, which made it dif�cult to photograph 

children. Adults often took on stiff poses and sometimes 

had their head and hands braced into position.
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After details of the process were published in 1839, 

the procedure became increasingly popular and was 

eventually used all over the world. A daguerreotype was 

taken in Australia only two years after it �rst appeared in 

Paris. Because the image was captured directly onto the 

silver plate, no negative was produced and as a result no 

copies could be made of the image. Another disadvantage 

was that the images could be viewed only from certain 

angles because they were produced on a shining polished-

metal surface. Daguerreotype images were often stored in 

specially designed wooden cases lined with velvet which 

sometimes had glass covering the photograph. As a result 

of their durability and these specially designed cases, 

many daguerreotypes have survived (see �gure 10.1D).

Figure 10.1D A daguerreotype portrait

Fox Talbot�s collotype
At the same time, in England, William Henry Fox Talbot was 

working on a method to permanently preserve the image 

created by the camera obscura using a chemical process. 

Scientists knew the effect light had on silver nitrate and 

Talbot decided to experiment with this. Talbot discovered 

that by coating paper with salt and silver compound, he 

was able to produce a negative image. He also discovered 

that he could �x this image with a strong solution of salt 

water. Talbot then placed the negative image over a sheet 

of prepared paper and exposed it to light, producing a 

positive image on the second sheet. This process, the 

collotype (Greek for ��ne image�), meant multiple copies of 

the image could be produced. However, the image was not 

as clear as the daguerreotype.

The collodion wet plate
In 1851, another Englishman, Frederick Scott Acher, 

introduced a process where glass plates, not paper, 

were covered with a light-sensitive solution. While they 

were still damp, the plates were put into the camera 

and exposed to the subject, then developed before they 

had dried. This process was known as the �collodion 

wet-plate process� and produced high-quality images 

through a glass negative. Initially, a black backing was 

placed behind the glass to produce a positive image. 

These early collodion images were called �ambrotypes�. 

However, as time progressed the images were printed 

from the glass negative onto tin (known as the tinotype) 

and eventually onto paper. This allowed photographers 

to print multiple copies of the same image.

Although extremely effective, this process also had 

disadvantages. The photographer needed a darkroom 

close by in order to prepare the glass plates prior to 

exposure and to immediately develop them. As a result, 

photographers often improvised and created mobile 

darkrooms on the back of horse-drawn carts and in 

tents (see �gure 10.1E).

Photography became increasingly popular with many 

wealthy people, who enjoyed recording images as well 

as having their portraits taken.

Figure 10.1E A portable darkroom.  

When packed up, this darkroom would �t  

into a suitcase. This type of darkroom was commonly used by travelling 

photographers around 1862 for the collodion wet-plate process.

Another popular innovation was a process known as 

stereo-photography. This process involved the photographer 
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taking two photographs of the same subject at the same 

time. The photographs were placed in a stereoscope and, 

when viewed, the images merged to form one three-

dimensional image (see �gure 10.1F).

Figure 10.1F Stereoscope equipment and photographic images

The dry plate negative
In the latter part of the 19th century Richard Kennett 

devised a dry plate negative that did not need immediate 

development. This meant the photographer could do 

away with the tedious procedure of Archer�s wet-plate 

process. No longer was it necessary to have a darkroom 

on hand. This technique accelerated the development of 

photography.

With this new technology came much faster exposure 

times, which freed the camera from the tripod. As a result, 

many small hand-held cameras were developed. These 

enabled people to take instant snapshots and led to the 

beginning of the modern era of photography.

Photography for everyone
An American, George Eastman, started a company which 

aimed to bring photography within everyone�s reach. He 

chose the name Kodak because it was a nonsense word 

that sounded snappy and could be pronounced in nearly 

every language. Eastman explored the possibilities of 

producing a roll of �lm which would allow a photographer 

to take numerous photographs without reloading their 

camera. By 1890, Eastman had developed the �rst 

Kodak camera. Although very basic, it was easy to use 

and contained a �lm with enough exposures to take one 

hundred photographs. When the �lm was completed 

the camera was returned to Eastman�s company, where 

the photographs were processed. The camera was then 

reloaded with another roll of �lm and returned to its owner. 

Eastman�s Kodak camera, the Box Brownie, was easy 

to use, affordable, produced good results and became 

popular all over the world.

In 1925, a miniature camera known as the Leica was 

developed by Dr Oscar Barnack in Germany. This camera 

was the �rst to use 35  mm �lm and was much more 

sophisticated than the earlier Kodak camera. The Leica�s 

popularity con�rmed the position of amateur photography 

as an international pastime.

Throughout the 20th century, �lm, cameras, lenses and 

photographic paper continued to improve. Photography 

became increasingly popular and an integral part of our 

society. The technology available allowed photographers to 

photograph the depths of the ocean, distant planets and 

inside the human body. It also gives us the opportunity to 

capture the memories of a family, the horrors of war and 

the beauty of our world, as well as providing us with a 

vehicle for self-expression.

The development of colour 
photography
Ever since the early development of photography, the 

search to create coloured images has been underway. 

Early daguerreotype photographs were often hand-painted 

by artists in an attempt to bring colour to the image. This 

practice continued into the early 20th century, with no 

other creditable and affordable alternative available to 

those desiring colour.

The foundations for colour photography were  

established in 1859 by the Scottish scientist James Clerk 

Maxwell. Maxwell established that all colours were made 

from combinations of the three primary colours of light.  

In 1861 he took three black and white photographs 

through red, blue and green �lters, then projected them 

as slides together, in line with the same coloured �lter 

(see �gure 10.1G). Maxwell created what is believed to be 

the �rst colour photograph. His method is referred to as 

�colour separation�.

Figure 10.1G James Clerk Maxwell�s �rst colour photograph of a tartan 

ribbon, 1861, taken and projected separately through red, blue and  

green �lters

By the early 20th century two French brothers, Auguste 

and Louis Lumi�re, used this knowledge and coated 

plates with tiny grains of red, blue and green starch dyes. 

The dyes acted as �lters over a silver bromide emulsion. 

With reversal processing, a light shone through the plate, 

showing the original colours. This process was called 

Autochrome and, although considered groundbreaking, 

the colours produced were soft pastel shades that often 

appeared dark.
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Figure 10.1H A selection of digital cameras, mobile phone cameras and a printer
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activities

1. Draw a diagram showing the principles of the camera 

obscura.

2. What was the major � aw with the technique developed 

by Thomas Wedgwood?

3. Discuss the positive and negative aspects of the 

daguerreotype and Fox Talbot�s processes.

4. What was the major restriction of the collodion 

wet-plate process?

5. Why was the photographic technique developed by 

Richard Kennett so signi� cant?

6. Explain the principles of the � rst Kodak camera.

7. Using a diagram, brie� y describe the basic principles 

of colour photography.

8. What are the major differences between � lm 

and digital photography?

Written report

9. Interview your parents, guardian or grandparents about their 

memories of taking and processing their family photographs 

at least 20 or more years ago. Produce a report that 

includes the following information:

� Documentation about the people you are interviewing 

and the historical period they are recalling

� The types of camera they used

� An explanation of how they went about getting 

their photographs developed

� Details about the quality of their photographs and, 

if possible, a copy of one picture

� Discussion of how the process of creating family 

photographs has changed. Record the type of camera 

you and/or your family are currently using.

� Consideration of the quality of the images produced 

today and the options presently available for processing 

and printing your photographs

� As a result of your investigation, outline what you 

think have been the most signi� cant developments in 

family snapshot photography over the past 20 or 

more years.

Comparative task

10. Compare a portrait taken in the 1800s to another taken in 

the 2000s. Discuss how each image was made, including 

the techniques, processes, equipment and materials used. 

Consider the quality of each image (use the proforma on 

analysing an artwork on page 159 to assist you).
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 10.2  the development 

of photography  

as an art form

High art photography
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Figure 10.2A

H. P. Robinson

Fading away, 1858

Albumen toned print from �ve separate wet-collodion negatives

The Royal Photographic Society, Bath, RPS 9997

Figure 10.2B

Peter Emerson

Gathering waterlilies  

c. 1886

Plate IX from  

Life and Landscape  

on the Norfolk Broads

Platinum print

The Royal Photographic 

Society, Bath, RPS 10213
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The early pictorialists
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Figure 10.2C

Clarence H. White

The ring toss, before 1903

Photogravure

The Royal Photographic Society, Bath

The photo-secessionists
����������������������������������������������������������

�����������������������������������������������������������

������������������������������������������������������������

�����������������������������������������������������������

�����������������������������������������������������

����������������������������������������������������������

���������������������������������������������������������

����������������������������������������������������

����������������������������������������������������������

���������conventions���������������������������������

���������������������������������������������������������

�����������������������������������������������������������

������������������������������������������������������������

��������������������������������������������������������

�����straight��������������������������������������������

����������������������������������������������������������

��������������������������������������������������������

�������������������������������������������������������������

����������������������������������������������������

��������������

Figure 10.2D

Alfred Steiglitz

Sun rays, Paula, Berlin, 1889

Gelatin silver print 

22.0 × 16.2 cm

© George Eastman House
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Figure 10.2E

Edvard Munch

Portrait of Charlotte Dornberger, 1889

Oil on canvas

47.5 × 35.3 cm

Private collection

Munch Museum/

Munch Ellingsen Group/

BONO 2008

© Munch Museum 
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Figure 10.2F

Carte-de-viste photograph 

of Charlotte (Meisse) 

Dornberger, c. 1880 Figure 10.2G Man Ray, Le violon d�Ingres, 1924, gelatin silver photograph
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Figure 10.2H Philippe Halsman, Dali atomicus, c. 1948,  

gelatin silver photograph. Photograph by Phillipe Halsman  

© Halsman Estate. Courtesy George Eastman House

Figure 10.2I John Heart�eld, Adolf the superman: 

swallows gold and spouts junk, 1932, photomontage
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Figure 10.2J  Abstraction, porch shadows,  

Connecticut, 1915, Paul Strand, 

Copyright © Arpeture Foundation Inc., Paul Strand Archive
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Figure 10.2K Nude, 1936 

Photograph by Edward Weston 

Collection Center for Creative Photography 

© 1981 Arizona Board of Regents
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Figure 10.2L David Hockney 

Mother 1, Yorkshire Moors, August 1985  

Photographic collage 

181/2  × 13'' 

© David Hockney
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Figure 10.2M Cindy Sherman, Untitled #397, 2000, colour photograph. 

Photograph courtesy of Cindy Sherman and Metro Pictures Gallery
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Figure 10.2N Yasumasa Morimura, Daughter of art history (theater A), 1990. Coloured photograph, transparent medium, 180 × 246 cm. © The artist. 

Collection private collection in Japan. Private collection in US. Photograph courtesy of the artist and Luhring Augustine, New York.
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Figure 10.2O  

Gregory Crewdson 

American born 1962 

Untitled 1999 

Type C photograph 

121.9 × 152.4 cm image 

National Gallery of Victoria, Melbourne 

Kaiser Bequest, 2000

Figure 10.2P New York City, Monument to smile (05/31/07 � 06/09/07). 

Agnes Winter exhibits Monument to smile, a massive, 50-storey projection  

of over 250 photographs of smiling New Yorkers that brings public art to  

the walls of the Rockefeller Center. Transmitted by 12 large projectors. 

© Agnes Winter 

May 31st � June 9th 2008 

Rockefeller Center � New York
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activities

Group task

1. In small groups, create a photographic timeline (this could 

be done as a poster to be displayed around the classroom). 

The timeline must contain the following information:

� an outline of major technological developments in 

photography

� an outline of major artistic movements in photography

� an outline of major historical and social events.

 Where possible, include photographs to highlight the 

information presented.

2. Once your timeline is complete, as a group, discuss the 

following questions and record your answers.

� What do you think is the most signi�cant development in 

the history of photography? Give reasons for your response.

� What is your favourite photographic movement or artist? 

Give reasons for your response.

� What impact do you think photography has had on 

society? Discuss with particular reference to the late 

1800s and today.

� Considering the developments in photography over the 

past 10 years, what developments can you imagine might 

take place, both technologically and creatively, in the  

next 10 years?

Short responses

3. Discuss the approach taken by Munch in adapting the 

photograph of Charlotte (Meisse) Dornberger into a 

painted image (see page 174). Discuss the similarities and 

differences between the photograph and the painted image. 

What do you think that Munch was trying to achieve by 

altering this image?

4. Compare H. P. Robinson (1858), Fading away (see  

page 172) with Gregory Crewdson�s Untitled (sod man), 

1999 (see page 179). What similarities can you see in 

the artist�s working method (action) and artistic intention 

(ideas)?

5. What do you think John Heart�eld was trying to 

communicate about his world in his Adolf the superman: 

swallows gold and spouts junk (1932), photomontage (see 

�gure 10.2I, page 175)?

6. How has Paul Strand used composition and the design 

elements to enhance the quality of his 1915 photograph,

 Abstraction, porch shadows, Connecticut (see �gure 10.2J, 

page 176)?

 7. Why do you think Cindy Sherman is such a popular and 

successful artist? What is it about her work that people 

respond so positively to?

 8. What aspects of Yasumasa Morimura�s photographs re�ect 

elements of postmodernism?

 9. Look closely at Gregory Crewdson, Untitled (sod man),  

see �gure 10.2O, page 179. Create your own story relating 

to the image about what has just happened and what is  

going to happen next.

10. What impact do you think Monument to smile (�gure 10.2P, 

page 179) would have had on the people of New York and 

its visitors? Explain your response.

Extended responses

11. Research and write a response to the following statement: 

�Photographic artworks are a true re�ection of the world in 

which they were created.� Do you agree? Provide reasons  

for your argument and refer to speci�c artworks to  

support points made.

Or

 Select three photographs from this chapter. Record the 

artist, title, date and media of each work, then identify the 

features that distinguish each work as being part of  

a particular style, time and place (world).

Research assignment

Select a photographer from this chapter that you admire. 

Research this person, using the following points as an outline 

for your written assignment of approximately 1000 words. Use 

diagrams and reproductions as appropriate.

� Background of the artist

� Style and in�uences

� Techniques and processes/working method (actions)

� Artistic aims and intentions (ideas)

� Unique qualities of the artwork.

 Select and analyse an artwork (see chapter 9, Analysing a 

photograph, page 157).

 Your class may decide to present each report as a class 

talk or PowerPoint presentation. This would allow the class 

to develop an awareness and understanding of a number of 

different photographers.



History of Australian 
photography

11.

 11.1  THE EARLY YEARS
In the past, most art forms in Australia were governed to 

a large extent by overseas trends and traditions. What 

was fashionable in Europe soon became fashionable in 

Australia. This was the case with photography. Overseas 

travel, combined with immigration and imported literature, 

enabled Australians to become aware of, and keep 

relatively up to date with, the technical and artistic 

advances in photography.

Photography in Australia was initially used largely to 

record the unique aspects of the land, its fauna, � ora and 

people (see � gure 11.1A). It was also used to document 

the development of the colony, which included the growth of 

railways, buildings and townships. These images were often 

sent back to Europe as a way to inform and advise people 

of developments in the settlement of Australia. However, the 

most popular use of photography was to create miniature 

portraits that captured personal records of the settlers.

On 12 December 1842, George Goodman opened what 

is thought to be the � rst portrait studio in Australia. This 

popular studio was set on the roof of Sydney�s Royal 

Hotel and Goodman used the daguerreotype process (see 

section 10.1, page 167) to create a likeness of many 

Sydney citizens. 

In 1850 Fox Talbot�s collotype was introduced, but it 

was soon superseded by the collodion wet-plate process 

(see section 10.1, page 168). The population of the colony 

trebled during the gold rush of the 1850s and 1860s. The 

number of photographic studios increased dramatically 

and many photographers, both professional and amateur, 

began to explore this new medium.

During the 1880s dry-plate negatives and small 

hand-held cameras became available. These innovations 

put photography within the reach of many Australians. 

As a result, amateur photography became increasingly 

popular throughout most major towns and cities. By the 

late 19th century, photography in Australia was well 

established � with many professionals making a living from 

photography, and amateurs enjoying the thrill of capturing 

and recording images.

Figure 11.1A

Freeman Brothers, Sydney

1854�1900

William Freeman, born England 1809, arrived Australia (early 1850s), died 1895

James Freeman, born England 1814, arrived Australia (early 1850s), died 1890

Walter Davis (c. 1860)

Ambrotype, colour dyes, wood, leather, velvet, glass and gilt metal (case)

9.1 × 6.8 cm irreg. (10.2 × 8.2 cm (case) (closed))

National Gallery of Victoria, Melbourne

Gift of Warwick Reeder, 1991



Around this time many photographers made a conscious 

decision to use photography more creatively. Images could 

be copyrighted by Australian photographers. A debate over 

the legitimacy of photography as an art form was initiated. 

As the dispute ripened in Europe, the controversy spread to 

Australian shores. Some believed that photography was a 

threat to painting because the camera could create a more 

exact likeness of a subject. Some Australian photographers 

were happy not to be called artists, recording their portraits 

and images in a very methodical way. However, another 

group was determined to gain the acknowledgement of 

photography as a respected art medium.

Figure 11.1B Advertisement for George Goodman, Australian,  

9 December 1842

 11.2  THE AUSTRALIAN 

PICTORIALISTS
With the adoption of European ideas, in particular those of 

the pictorialists (see section 10.2, page 173), a group of 

Australian photographers attempted to justify the artistic 

merit of photography by capturing images in a similar way 

to accepted painting styles. They often tried to reproduce 

the ideas, painterly qualities and subject matter of the 

popular artists of the time (see �gures 11.2A and 11.2B).

Figure 11.2A

Tom Roberts

Born Great Britain 1856, arrived in Australia, 1869, died 1931

Shearing the rams, 1888�90

Oil on canvas on composition board, 122.4 × 183.3 cm 

Felton Bequest, 1932

National Gallery of Victoria, Melbourne

Figure 11.2B

© Alfred Wilkinson

Australia, 1869�1940 

Shearing, c. 1900�27 Poltalloch, South Australia 

Carbon photograph 

35.3 × 26.0 cm (image) 

Gift of Mr Keith D Bowman 1927

Art Gallery of South Australia

By the end of the 19th century works by French 

impressionist painters such as Renoir and Monet were 

in�uencing Australian artists in their approach to technique 

and subject matter. This in�uence can be seen in the 
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Figure 11.2D

PRG 737/3 The spirit of endurance,  

c. 1936 by Harold Cazneaux ©

Photograph courtesy of the State Library of South Australia

Figure 11.2C
Henri Mallard

Nearing their journey�s end, 1920s

Gelatin silver photograph, 14.6 × 24.1 cm 

Gift of Paul Mallard 1978

Collection: Art Gallery of New South Wales

Photograph: Mim Stirling

works of the Heidelberg school and the Australian 

impressionists such as Frederick McCubbin and 

Tom Roberts.

The early Australian pictorialists used soft 

focus and diffused outlines to record romantic, 

picturesque and sentimental visions of nature, 

showing a similar approach to their subjects as 

the Australian impressionists did in their paintings 

(see �gure 11.2C). They turned their lens on the 

real world, rather than studio-created scenes, 

to capture subtle and subdued interpretations 

of the Australian landscape, the character of 

the Australian people and nationalistic ideas. 

These images were seen more as personal 

interpretations of subjects rather than merely 

records of them.

In 1916 a group of Australian photographers 

formed a distinctive Australian school of 

pictorialism. They called themselves the Sydney 

Camera Circle and attempted to establish 

photography as an art form separate from painting. 

They aimed to rid photography of painterly qualities 

and traditional subject matter. This group of 

photographers, which included Henri Mallard  

(�gure 11.2C), William Stewart White, Harold 

Cazneaux (�gure 11.2D), Cecil Bostock and James 

Sterning, gained respect for Australian pictorialism 

through their work, which was displayed nationally 

and internationally.
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 11.3  THE AUSTRALIAN 

MODERNISTS
In the early 1930s a small group of Sydney-based 

photographers set out to explore the artistic potential of 

photography in the mechanical age. This group, led by Max 

Dupain, included the young David Moore and Wolfgang 

Sievers, a newly arrived immigrant from Germany. These 

men were to change the face of Australian photography. 

Strongly in�uenced by American and European modernist 

art styles, particularly the Art Deco and German Bauhaus 

movements, the group developed a modernistic approach to 

photographing their subject matter. They further developed 

the ideas of the Sydney Camera Circle and searched for 

images containing bold content, abstract beauty, geometric 

shapes and clean crisp lines. Dupain, Moore and Sievers 

demonstrated the essence of pure or straight photography 

by capturing images that previously may have been seen as 

uninteresting and dull. Making a living through government 

commissions, commercial photography and photographic 

journalism, they used their free time to photograph images 

of personal concern and interest.

Max Dupain demonstrated his passion for the 

beach and the idealistic post�World War 1 vision of 

the Australian way of life through a series of works 

photographed at beaches around Sydney Harbour. This 

ideal is epitomised in the 1937 photograph Sunbaker, 

which has come to symbolise the Australian lifestyle 

(see �gure 11.3A).

David Moore trained as a photographer under 

Max Dupain in a Sydney advertising agency. Moore 

rejected the arti�cial nature of the subjects in his 

commercial photographs and attempted to photograph 

and document the realities of the human condition. 

He spent many weekends photographing the poverty-

stricken and depressed areas of Sydney. Redfern 

interior (1949) captures the essence of Moore�s 

concerns (see �gure 11.3B). The photograph depicts an 

emotional moment in the life of an ordinary household.

Figure 11.3A
Max Dupain

Sunbaker, 1937

Gelatin silver photograph

46 × 41 cm

© Max Dupain Exhibition Negative Archive
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Figure 11.3B

David Moore, 1927�2003

Redfern interior, 1949

Gelatin silver photograph  

38 × 27 cm or smaller

© Queensland Art Gallery

Wolfgang Sievers obtained a great deal of work as 

an industrial photographer. He combined the elements 

of German art school design with dramatic lighting to 

create an artistic interpretation of man and the machine. 

This is clearly revealed in his work Gears for mining 

industry (1967), which re�ects an ideal vision of man and 

machine working together (�gure 11.3C).

Figure 11.3C

Wolfgang Sievers

Gears for mining industry, 1967

Gelatin silver photograph

© Queensland Art Gallery

 11.4  PHOTOGRAPHY  

AS ART
In the early 1970s in Australia, photography as art 

gained major acceptance and widespread support. 

Its endorsement by state and commercial galleries, 

educational institutions, business and private collections 

brought about a renewed respect for the medium. In 1972 

the National Gallery of Victoria appointed a Curator of 

Photography. This was a signi�cant step, as the curator�s 

role was to develop Australia�s �rst major collection of 

national and international photography. Other states 

soon followed Victoria�s lead and established their own 

photographic collections.

The introduction of courses in the art of photography 

by universities and colleges of advanced education 

encouraged the development of new styles and forms of 

creative expression in the medium. The Prahran College 

of Advanced Education in Victoria introduced the �rst 

creative photography course in the late 1960s. Until then, 

photographers had either been self-taught or trained 

as technicians, gaining skills primarily by photographing 

images for the commercial market. As a result of tertiary 

inclusion, by the mid 1970s a new generation of Australian 

photographers was emerging from art colleges. They were 

willing to explore fresh and varied avenues of individuality 

and developed their own style and personal response to 

the medium of photography.

Until the mid 1970s photography in Australia was 

generally black and white, and featured images of natural 

themes such as these shown in �gures 11.2B, 11.2C, 

11.2D and 11.3A. However, by the late 1970s the diversity 

in photographic artistry was evident, as was the move 

away from black and white to colour photography.

Technological advancement in colour processing,  

in particular, C-type colour processing, brought new 

aesthetic qualities to Australian photography.

 11.5  POSTMODERNISM 

IN AUSTRALIAN 

PHOTOGRAPHY

Australian photographers
Tracey Moffatt explores the use of bright, vibrant colour 

in her 1989 series Something more. Moffatt�s works 

borrow the stylistic features of 1950s B-grade movies and 

attempt to challenge viewers� perceptions of the dreams 

and desires of the disadvantaged members of society. 

Something more presents a series of moving, theatrical 

photographs that tell the story of an Aboriginal woman 
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(played by Tracey Moffatt) leaving a country town in search 

of a new and better life in the city (see �gure 11.5A). 

Moffatt has re�ected and created a response to issues 

concerning her own Aboriginal heritage.

The approach Moffatt has taken in recording these 

images can be described as �photographic theatre�. The 

photographer creates a setting, then positions subjects 

within the setting. The photographer acts as a director, 

producing and controlling the images being photographed. 

This approach to picture taking was very popular during the 

1980s and can be seen in the work of Robyn Stacey, Rose 

Farrel and George Parkin, Anne Zahalka and Anne Ferran, 

as well other Australian photographers.

Appropriating or borrowing images from famous artworks 

is a common practice in contemporary Australian art. 

Artists who appropriate artworks provide themselves 

with the challenge of reinterpreting the work to give new 

meaning to the image and perhaps question aspects of 

the original artwork.

In the series, Bondi: playground of the Paci�c, Anne 

Zahalka attempts to recreate well-known images from 

Australian paintings and photographs of the 1930s and 

1940s. Through these images she rejects the idealistic 

visions of Australians presented in these earlier works  

and chooses to create an updated, postmodern (and 

perhaps more realistic) vision of the people of Australia.  

In her photograph, The sunbather, #2, 1989  

(�gure 11.5B), Zahalka colourfully reconstructs Max 

Dupain�s Sunbaker image (�gure 11.3, page 184). However, 

instead of selecting a strong, clean-cut masculine �gure, 

she has presented a slim, long-haired, redheaded �gure 

whose gender is not speci�c. Zahalka is suggesting that 

Dupain�s Sunbaker is an unrealistic representation of a 

picture of a typical Australian male of the 1930s. The 

artist states that The sunbather #2 is an attempt to 

rewrite this history by replacing the stereotype with those 

�gures not generally represented.

Many contemporary artists explore a variety of media 

in their art making and do not submit themselves to 

a signature style. They often choose to reinterpret 

themselves with each new series of images. They also 

tend to create artwork in series and not as a single image 

produced in isolation.

Sydney-based artist Julie Rrap works not only in the 

photographic media but also in painting, sculpture and 

performance art. Her style and subject matter can vary 

considerably from one series of work to the next. She 

has been interested in appropriation as well as the 

representation of the human form in art. Rrap is also 

known to use herself to play the central character in  

her artwork (see Sherman and Morimura in chapter 10, 

pages 177 and 178 and Moffat in �gure 11.5A).  

Figure 11.5A  

Tracey Moffatt 

Something  

more #1, 1989 

Series of 9 

images 

Cibachrome 

98 × 127 cm 

Edition of 30 

Roslyn Oxley9
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Her 2002 series of digitally-created, morphed �gures in land 

and seascapes, entitled Fleshstone, brings into question the 

notion of truth in contemporary photography. Photography 

was once considered as an authentic and truthful 

representation of the world; this is no longer the case. As 

a result, viewers of contemporary photography will question 

Figure 11.5B  

Anne Zahalka (Australia, b. 1957) 

The sunbather #2, 1989, from the series  

Bondi: playground of the Paci�c 

Type C photograph on paper 

Roslyn Oxley9 Gallery

Figure 11.5C  

Julie Rrap 

Pearl John, 2003  

Digital print 

126 × 218 cm 

Edition of 9 

Fleshstones 

Roslyn Oxley9 Gallery

the honesty of the images as they are presented. More 

often than not, they will �nd them to be fabricated pictures, 

created from the mind of the artist. In this series of works, 

Rrap also brings into question any preserved ideas that art 

needs to be aesthetically beautiful by presenting us with 

grotesque interpretations of the human form.
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as graphic designers they have developed an interest in 

exploring issues relating to the media, popular culture, 

gender roles, stereotypes and advertising. They are 

interested in the way we live our lives and the in� uencing 

factors that control our desires. Their digital compositions 

are generally constructed from numerous photographs 

combined and manipulated together to form large detailed 

prints (see � gure 11.5E). Their narratives can be light-

hearted at times, poking fun at past cultural stereotypes 

and domestic roles. At other times, their work can appear 

to have a more serious side, exploring the impulses 

of human behaviour and our need to conform to social 

expectations.

The future of photography 
in Australia
The scope for the future of photography in Australia is 

virtually limitless. Australian photography has come of age, 

with many photographers working, studying and exhibiting 

overseas, and gaining recognition at an international 

level. By seeking inspiration from within Australia and 

overseas, Australian photographers have gained respect 

and recognition, forging their own identity in the artistic 

medium of photography.

Bill Henson (see � gure 11.5D) is a contemporary 

Melbourne-based photographic artist who adapts many of 

the traditions of the past to create his photographic works. 

He is a highly trained craftsman and takes pride in his skill 

and knowledge of the camera, in addition to established 

darkroom processes and procedures. Much of Henson�s 

work explores the concept of transition and, in particular, 

the moments between night and day, and childhood and 

adulthood. His photographs have a transient quality and 

rely on dramatic lighting to create compelling moods and 

atmospheres within his scenes. His images of young 

teenagers are staged to capture powerful emotions on the 

faces of the models, often suggesting something is about 

to happen or something has just happened. He explores 

the notion of a � eeting moment which, once passed, is 

gone forever. Some art critics argue that Henson is more 

of a traditionalist than a postmodernist. Whatever the 

case, he creates aesthetically enchanting images that deal 

with contemporary themes in a thought-provoking manner.

Fine art digital photography has become increasingly 

fashionable at tertiary institutions throughout Australia, 

such institutions now honour more graduates in this 

form of image-making. Just as, in the past, many 

institutions struggled to accept straight photography as an 

independent art movement, digital image-making has had 

its own battles to � nd its place alongside more traditional 

art media.

Design school graduates Charmaine Hardy and 

Simon Strong are part of a new breed of contemporary 

digital photographers. Through their commercial work 

Figure 11.5D 

Bill Henson

Untitled #20, 

Type C, Colour 

Photograph

2000/2003

Roslyn Oxley9 

Gallery
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Figure 11.5E  

Charmaine Hardy and  

Simon Strong  

The mower, 2000,  

Digital inkjet print 

156 × 205.9 cm 

© Hardy & Strong

activities

Extended responses

1. You are a 19th-century newspaper reporter sent to 

Goodman�s studio to write a story about the new 

photographic process. Imagine that you have seen the 

process of photography for the �rst time. Write an article 

about your experience.

2. Look closely at Max Dupain�s 1937 Sunbaker (page 184), 

Anne Zahalka�s 1989, The sunbather #2 (page 187) and 

Julie Rrap�s 2003, Pearl John (page 187) and then answer 

the following questions:

a. What characteristics of the artist�s world (time and place 

in which they lived) do you think are re�ected in each of 

these works?

b. How do you think audiences would react to these 

photographs? Which image do you think would be the 

most popular? Explain your response.

c. Explain how you think each artwork was made.

d. What do you think was the idea (artistic intention) 

behind each of the works?

e. Discuss the compositions and use of design elements 

and principles in each of the works (see page 159 for 

assistance).

3. Research assignment

 Select two artists from this chapter and complete a 

research assignment that compares their artistic 

approaches to photography. 

 Use section 9.3, How to write a comparative essay 

(page 162), to assist you with your essay plan. Analyse an 

artwork by both artists to provide evidence of points you 

made in your essay (see section 9.2, Format for analysing 

photographs, page 159).

4. Practical assignment

 Create a photographic image that shows a signi�cant 

in�uence from one of the photographers mentioned in this 

chapter. Your work should re�ect a similar choice of subject 

matter, composition, use of lighting and techniques as your 

artist. (Look at the student work by Clair Weller, �gure 13.5B  

(page 230), and compare it to Gregory Crewdson�s  

�gure 10.2O (page 179), as an example of the task.)

5. Complete the following in your workbook or journal:

a. Brainstorm possible artists.

b. Select an artist and outline their choice of subject 

matter, style and working method (action).

c. Collect a number of images by your artist to use as 

inspiration.

d. Brainstorm possible approaches that you could take to 

emulate your selected artist�s work.

e. Plan the production of the work, making an outline of 

everything that needs to be done.

f. Produce the work.

g. Evaluate your �nished artwork (see page 258).

h. Present your �nished artwork and workbook or journal  

for assessment.



A close-up look at 
signi�cant photographers

12.

 12.1  Ansel AdAms

Artist and world �  

structural/cultural
Ansel Adams is one of America�s most respected and  

well-known photographers, revered for his breathtaking 

black-and-white landscapes of the American West. 

Throughout his 70-year career he produced a proli�c 

body of work, was awarded three Guggenheim fellowships 

and published a large number of technical and artistic 

photographic books. He taught, reviewed and wrote 

articles about photography. His images were included in 

over 500 exhibitions in his lifetime, and he was integral 

to photography�s acceptance as a �ne art. He was also 

instrumental in establishing photographic departments in a 

number of museums, including the Museum of Modern Art 

(MoMA) in New York, the �rst museum to have a dedicated 

�ne art photographic department (established in 1940).

Adams was an only child, born in 1902 in San Francisco. 

In 1914 he taught himself to play the piano and was 

exceptionally talented. His love of the arts continued to 

grow, fuelled by regular visits in 1915 to the Panama 

Paci�c International Exposition (a world fair held in his 

home town for a year), where he learned to use a number 

of scienti�c and musical instruments, and viewed famous 

artworks from all over the world.

In 1916, after learning about Yosemite National Park, he 

convinced his parents to holiday there, and made his �rst 

photographs with a Box Brownie camera. Developing a love 

of nature and the wilderness, he continued to photograph 

the American West for the rest of his life, promoting 

preservation of the environment.

In 1892, activist and conservationist John Muir  

founded the Sierra Club, America�s oldest ecological 

organisation, which was hugely in�uential in the beginning 

of the environmental movement. Adams became heavily 

involved with the Sierra Club from a young age. He wrote 

for the Sierra Club Bulletin, took club tours, held his �rst 

solo photography exhibition at the club in 1928 and was 

elected as a member of the board of directors in 1934, 

a role he maintained for 37 years. Muir�s writings and 

ideas in�uenced Adams, who published Sierra Nevada: the 

John Muir Trail in 1938. As a passionate environmentalist, 

Adams used his images to advocate preservation and 

conservation of wilderness areas and national parks, 

contacting various American presidents and urging them  

to consider the environment.

Figure 12.1A  

Ansel Adams 

Photo booth  

self-portrait, 1936 

Ansel Adams, 

photographer, 

1 photographic 

print: silver gelatin; 

08 × 07 cm. 

Courtesy of the 

Katherine Kuh 

papers 1908�

1994, Archives 

of American Art, 

Smithsonian 

Institution
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After Adams died in 1984, an area of more than 

200  000 acres of wilderness between Yosemite National 

Park and the John Muir Wilderness Area was named after 

him and, on the �rst anniversary of his death, Mount Ansel 

Adams was of�cially named, on the southeast boundary of 

Yosemite National Park.

Practice

In�uences

� Nineteenth-century landscape photographers  

of the American West, such as Timothy O�Sullivan, 

Carleton Watkins and Eadweard Muybridge

� The history and science of photography

� The wilderness of the American West

� John Muir (1838�1914), a conservationist  

and nature writer

� Music � he was a talented, trained classical pianist  

(his photographs have been described as �symphonic�)

� Photographer Alfred Steiglitz and other contemporaries, 

including Paul Strand, Edward Weston, Imogen Cunningham 

and Dorothea Lange (see section 10.2, pages 173�76)

Style

� Sharp and even focus

� Extensive tonal range

� Clarity of detail

� Straight or pure photography (unmanipulated images)

� Close-up images or expansive sweeping landscapes

� Majestic, heroic images, full of national pride

Themes and interest

� The Earth, natural formations, mountainous landscapes 

and wildernesses

� The changing environment

� A personal, physical and psychological connection with 

nature, revealing spirituality and meaning through images

� Technical perfection, �awless prints and the potential  

of photography

� Portraits

� Modernism (see page 176)

Ideas/artistic intention

� �Pure� photography

� To depict the beauty of the great American landscape

� To convey metaphysical meaning in an object or scene

� To provide a glimpse of the world in a new and more 

spiritual way

� To campaign for the preservation and conservation of 

the natural world and its resources

Actions/working method

� He primarily used an 8 × 10-inch view camera �  

a large-format camera, with each frame developed 

separately. He experimented, however, with  

different cameras.

� He used a very scienti�c approach � experimenting with 

exposure, developing negatives and making prints.

� Working in natural light, he would sometimes wait hours, 

days or entire seasons for the right light.

� Using a very small aperture, he would make long, slow 

exposures to maximise depth of �eld and detail, so 

that everything in the image would be in focus, from the 

objects closest to him to the point furthest away.

� Knowing his subject intimately � he photographed the 

same scenes for decades.

� Pre-visualising a scene in black and white prior to 

releasing the shutter on his camera.

� Using the �zone system� to more accurately measure 

exposures and extend tonal range. The zone system is 

structured to achieve the fullest possible tonal range, 

with detail in both light and dark areas of a scene.

Artwork

Mountainous terrains, huge skies, dramatic clouds, 

dark shadows and luminous rays of light � Adams 

photographed the expansive landscapes of America�s West 

as idyllic, serene and transcendent. He was interested in 

natural beauty and the spiritual quality in nature, whether it 

was vast or minuscule it was beautiful and meaningful. He 

was in awe of nature and photographed it with respect and 

discipline. His pictures were of places Americans wanted 

to see, as they wanted to see them � untouched. His 

heroic landscapes expressed an American national identity.

After meeting Paul Strand in 1930, Adams decided to 

forgo a promising career as a concert pianist and dedicate 

his life to photography. Seeing Strand�s superb negatives 

and witnessing his devotion to the medium inspired Adams. 

Although Adams� initial approach stemmed from  

19th-century pictorialists who had photographed the land 

before him (for example, Timothy O�Sullivan, Carleton 

Watkins and Eadweard Muybridge), he soon abandoned this 

romantic, soft-focus style, which attempted to resemble 

painting, believing photography was an art form in and of 

itself and should not be used to imitate other art forms.

Adams was a founding member of Group f.64  

(which included photographers Edward Weston and  

Imogen Cunningham � see page 176), a photographic 

collective named after the smallest possible aperture. 

Requiring long exposures, this aperture setting resulted 

in the greatest possible depth of �eld and a very sharp 

focus. The group delighted in the camera�s potential to 

record things as they were. Adams worked alongside his 

contemporaries, discussing photography constantly. He 

was an admirer of in�uential American photographer Alfred 

Stieglitz and was honoured to exhibit solo in his New York 

gallery, An American Place, in 1936.

Adams was a very sociable person and had many 

friends. His photographs of people, although less known 

than his landscapes and nature images, are wonderful. 
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His photograph of his friend, the artist Georgia 

O�Keeffe, is full of expression, mischief and mystery 

(�gure 12.1B). It displays the signature Adams clarity, 

magni�cent tonal range and contrast, as well as the 

sense of drama found in his landscapes.

During the Great Depression, American photographic 

artists began to turn their cameras to social and 

political issues in an attempt to bring about justice and 

social change. At this time Adams was being criticised 

for photographing �socially insigni�cant� rocks and plants 

when people were in need. He was a close friend of 

Dorothea Lange, who had embraced the documentary 

movement, and was photographing the poor and 

deprived. Although Adams initially resisted social 

documentary photography, he admired her work and they 

collaborated and assisted each other at various times. 

By the early 1940s Adams was inspired to campaign for 

the rights of the Japanese�Americans who were interned 

in the Manzanar War Relocation Center in California, 

during World War 2. Depicting their loyalty, strength 

and courage, he published Born free and equal, which 

included text he had written regarding this injustice.

Photographs of nature, however, remained Adams� 

primary focus � sweeping landscapes and tiny details. 

His macro images of leaves, ferns, underground  

rock formations or cacti reveal intricate patterns and 

details. Rocks, ravines and trees close up become 

almost abstract shapes. He uncovered the essence  

of his subjects and their �eeting forms in changing  

light conditions.

In 1941, with Fred Archer, Adams developed the  

�zone system� for correct exposure and negative 

development. To achieve the fullest possible tonal 

range, with detail in both light and dark areas of a 

scene, the �nal print is pre-visualised (in black and 

white) prior to releasing the shutter. Zones are assigned 

to parts of a scene, where 0 is pure black and 10 is 

pure white, with nine varied shades of grey in between. 

Light readings are taken from these zones, and the 

exposure adjusted accordingly. Adams primarily used a 

view camera, taking individual negatives, developed  

separately, to achieve the desired results. Tonal range  

varies with the development time of the negative.  

A shorter development decreases contrast while a 

longer development increases it.

The Tetons and the Snake River, 1942 (�gure 12.1C) 

illustrates Adams� technical skill and precision, as  

well as his love of the wilderness. Intense and heroic,  

Figure 12.1B Ansel Adams, Georgia O�Keeffe and Orville Cox, Canyon de Chelly National Monument, Arizona, 1937, gelatin silver photograph
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the expansive landscape appears to be timeless.  

This image is typical of Adams� work, with a large depth 

of �eld that ensures every point is in sharp focus. The 

s-shaped river leads the viewer�s eye through each part 

of the photograph. The dark, dramatic sky and billowing 

clouds sweep across the rugged, snow-capped mountain 

ranges, and the winding river is framed by bush and land, 

balancing the image. The atmosphere is awe-inspiring 

and powerful but also quiet and spiritual. This image was 

included in 1977 on the Voyager spacecraft, sent to convey 

information about the world to a possible alien civilisation. 

Initially, Adams made photographs for their aesthetic value; 

later, however, he used images to evoke a response. He 

wanted the public to be aware of environmental issues 

and to want to preserve wilderness areas. His images 

re�ect the passion he had for the American West. By the 

1940s he had developed his distinct style and many of 

the images he made at that time are his most famous. 

With clarity, precision and accuracy he recorded things as 

they appeared, photographing the same wilderness areas 

repeatedly over many decades and coming to know the 

land intimately. These majestic scenes are heavy with 

admiration. Adams became respected both for his artistic 

vision and disciplined technical pro�ciency.

Adams had a modernist approach, placing emphasis 

on line, shape, surface and texture. The science of 

photography was also very important to him: the way 

the image was made, as well as its visual and aesthetic 

values. Sometimes he would wait hours, days or seasons 

for just the right light, or for a storm. He often released 

the shutter just as the light was about to fade into night, 

with only a few seconds in which the light was exactly right 

for his pre-visualised perfect picture. The quality of light 

was vital to his images, he used light to reveal surface, 

texture and shape in rocks, trees, mountains and skies. 

Images such as Moon and half dome, Yosemite National 

Park (1960) focus on solid blocks of shape, using light and 

shade to bring the forms to life.

For Adams, nature and wilderness were places of 

pure beauty; they were symbols of national identity 

Figure 12.1C Ansel Adams, The Tetons and the Snake River, 1942, gelatin silver photograph
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and pride. He united the environmental movement, 

nationalism and a fascination with nature to promote 

conservation. He felt that the intimate connection 

humankind has with nature is spiritual, material and 

very meaningful. His images sought to draw out this 

meaning and, in revealing it, inspire people to respect 

and conserve the natural world.

In 1980 he was awarded the Medal of Freedom by 

President Carter, for being �visionary in his efforts to 

preserve the country�s wild and scenic areas, both on  

�lm and on Earth�.

 12.2  HirosHi sugimoto

Artist and world �  
subjective/postmodern
Hiroshi Sugimoto is one of Japan�s most renowned 

contemporary artists. He has exhibited widely both 

in Japan and internationally, and has won numerous 

prestigious awards and grants. Based in New York, 

Sugimoto also spends a lot of time in Japan and travels 

frequently to work on projects.

Sugimoto was born in Tokyo in 1948, where he was 

raised and educated. In the 2005 catalogue for his  

Figure 12.1D Ansel Adams, Moon and half dome, Yosemite National Park, 

1960, gelatin silver photograph

activities

1. What aspects of Ansel Adams� world inspired  

the development of his photography?

2. How do you think Ansel Adams� landscapes could have 

assisted the environmentalist movement in America?

3. Paul Strand and Edward Weston in�uenced the development 

of Ansel Adams� approach to photography. Use the internet 

to �nd a photograph by either artist that demonstrates this 

in�uence. Include a copy of the work alongside a copy of 

one of Adams� photographs. Outline at least three similarities 

between the two images.

4. Imagine you are Ansel Adams and you are staying at 

Yosemite National Park for a few days to take a series of 

photographs. Complete an imaginary diary insert of your �rst 

day�s events. Include what you set out to do in the morning, 

what equipment and materials you used, how the day�s shoot 

went and a comment on the results you achieved.

5. Using the internet, �nd an early pictorialist landscape 

photograph by Carleton Watkins and compare it with one of 

Ansel Adams� photographs from this text. Include copies of 

both works and discuss their similarities and differences.

6. Outline how the fundamental principles of Group f.64 are 

revealed in Ansel Adams� The Tetons and the Snake River, 

1942 (see �gure 12.1C).

 7. What do you think alien civilisations who intercepted the 

Voyager spacecraft would have learnt about our world from 

Ansel Adams� photograph, The Tetons and the Snake River, 

1942 (see �gure 12.1C)?

 8. Search the internet to �nd a photograph by Ansel  

Adams of Japanese�Americans who were interned in the 

Manzanar War Relocation Center in the 1940s. Include a 

copy of this photograph and outline what you think Adams 

was trying to achieve by photographing this type of subject 

matter.

 9. Why do you think audiences over time have responded so 

positively towards Ansel Adams� photographic work?

10. Ansel Adams is motivated by the aesthetic beauty of 

the natural world in which he lives. The structure of his 

photographs, their composition and use of light, as well  

as the design elements form the fundamental quality of  

each image. Select an artwork by Adams that re�ects  

his structural (modernist) approach to image making. 

Analyse the artwork (use the proforma on page 159 to 

assist you) to provide evidence of his approach.

  Where possible, use the internet to research and view 

additional photographs by Ansel Adams.
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mid-career retrospective exhibition, he talks candidly 

about his childhood and �rst encounters with photography. 

He was intensely interested in science, and when his 

primary school teacher invited the children to bring small 

objects from home for an experiment with sunlight, he 

was captivated as he watched his bottle opener, comb 

and a cicada wing form silhouettes on the light blue 

photosensitised paper in the sunlight. Later, he joined the 

model train club (for which he needed accurate pictures 

of real trains to work from) and, with his Mamiya camera, 

he traversed the city, photographing trains. In high school 

he joined the photography club and his passion for 

photography grew. However, he studied economics, not art, 

at Saint Paul�s University in Tokyo. But, in 1970 when he 

graduated, he moved to Los Angeles in America to pursue 

his passion for art. There, he attended the Art Center 

College of Design, and then, in 1974, he moved to New 

York. In his early days in America he developed an eye for 

antiques, and earned his living with a successful antique 

business; a practice he continues.

Practice

In�uences

� Minimalism � an art movement that started  

in the 1960s, usually characterised by simplicity  

and basic abstract or geometric shapes;  

often associated with repetition

� Conceptualism � an art movement in which the idea 

is more important than any other aspect of the work, 

particularly the craftwork and aesthetic appeal

� French-born American artist Marcel Duchamp 

(1887�1968), who is credited for his integral role in 

conceptualism and known for his involvement in the 

surrealist and dada movements

� Renaissance painting � a European art movement of 

the late 15th and 16th centuries

� Modernism and postmodernism (see  pages  176  and  177)

Style

� Conceptual

� Almost always black and white

� Technically impeccable prints

� Considered composition

� Frozen, still imagery

� Images are often not what they appear to be  

at �rst glance

Themes and interest

� The nature of photography and its function in our 

perception of the world around us

� The notion of �truth� or �reality� in photography

� Culture � Eastern and Western cultural in�uences, from 

his experience of living in both Japan and America

� History

� Time

� Light

� Space

Ideas/artistic intention

� His work undermines the idea of a photographic �truth�.

� He sets out to investigate intangible concepts like time, 

light and space.

� Through series, he explores relationships between 

inherently different things: past and present,  

East and West, natural and arti�cial, reality and fantasy, 

art and science, traditional and contemporary,  

action and stillness, life and death.

� Sugimoto challenges viewers to reconsider the way they 

think about particular subjects by showing them from a 

different perspective, or revealing the arti�ce, rather than 

presenting reality.

Figure 12.2A  

Art:21 � Art in the twenty-�rst 

century, production still 2005.  

Hiroshi Sugimoto, Season 3. 

Episode: �Memory�  

© Art21, Inc. 2005
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Actions/working method

� He works in series, photographing many various �types� 

of the same thing.

� His series usually span several years, sometimes decades.

� Sugimoto starts with an idea or concept, and explores it 

through repetition in a series.

� Using a large-format camera he usually makes black and 

white images; with long exposures he increases visible 

detail, capturing the gradually changing light re�ecting on 

or projecting from his subjects.

� He photographs existing objects or found sets.

Artwork

Hiroshi Sugimoto arrived in America in 1970, when 

photography was beginning to make an impact on the  

art world. The medium was changing shape, progressing,  

and becoming acknowledged and established as a �ne  

art form. In the 1960s, photographers had begun to  

move away from the craft of photography. Striving to  

achieve technical perfection was no longer necessary;  

of importance was the meaning or message in the image, 

and photographers chose instead to shoot quickly and 

spontaneously rather than spend hours setting up and 

composing an image. The everyday and social commentary 

in snapshot style was popular, and photography�s 

accessibility and function were celebrated. By the 1970s, 

avant-garde photographers were also experimenting with 

colour photography.

Sugimoto worked against the trend of the time, with 

heavy 19th-century style equipment. Using a large-format 

camera and a tripod he photographed in black and white, 

making long exposures and usually using only available 

light. In�uenced by minimalism and conceptualism (leading 

artistic movements in America in the 1970s) his work is 

heavily ideas based, employing simple repetition. Without 

directing or staging his subjects, he photographs series 

of what he considers to be found objects or sets. The 

in�uence of Marcel Duchamp (the father of conceptualism 

who, in the 1920s, turned found objects into �art�, and 

made multiples) is evident in Sugimoto�s work. Some of 

Sugimoto�s photographs are directly inspired by Duchamp.

Figure 12.2B Hiroshi Sugimoto, Radio City Music Hall, New York, 1978, gelatin silver photograph
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In 1972 Sugimoto made a series of photographs of 

an electric clock � time was to become central to his 

practice. Not only does his work invite re�ection on the 

concept of time but most of his series also take a very 

long time to make, usually many years. He therefore works 

concurrently on several projects.

Begun in 1975, Theatres is a collection of photographs 

of wonderful Art Deco cinema interiors and drive-in movie 

theatres. With vast tonal range and details that you 

can study for hours, these spaces are very engaging. 

Sugimoto, however, was concentrating on the movie that 

was playing. With an exposure time the exact duration of 

the given screening, he literately photographed the entire 

feature �lm. Here, he returns the moving image (a series 

of still images presented at a very fast speed) to a single 

image. Recording an entire �lm in this way, however, results 

in a bright, white rectangle without any detail: pure light 

� the essence of photography. In capturing elapsed time 

in this way, he loses the content of the �lm, and the old 

entertainment venues (that reference another era) hang 

heavy with silence. The viewer is left to their imagination, 

projecting their own stories onto a blank, white rectangle. 

In his images of drive-ins, elapsed time is also expressed 

in the slow movement of the stars that leave white lines 

through the image as they move across the sky.

He also commenced his Dioramas project in 1975, 

continuing this series for over 20 years. Including 

photographs of animals, birds, life under the sea and 

scenes of early humans, most of these images look like 

standard wildlife photography. At �rst glance the subjects 

appear real, but there is something odd about them, they 

appear too frozen, too composed and too detailed. The 

images are so clean, clear and crisp, that the actual clarity 

of the photograph infers the photographer has been close 

up, and used a large-format camera and long exposure time 

(and thus photographed very still subjects). There is no blur 

at all, something we are accustomed to seeing in images 

of wild animals. Images of Neanderthals con�rm that these 

photographs have been made in a natural history museum. 

It is what we know about photography and about the world 

that indicates the deception. Sugimoto, however, does 

not want to trick his audience; he highlights photography�s 

role in classifying things in the world, putting them into 

categories and labelling them; altering our perception. 

Imitating documentary photography, he makes a copy (the 

photograph) of a copy (the diorama) of life.

His series Portraits (1999) operates in a similar way, 

Sugimoto made these images of famous historical �gures 

in wax museums. Many of the historical �gures have  

been constructed from paintings made by Renaissance 

artists. Sugimoto studied the lighting techniques used by  

16th-century painters from which the wax �gures were 

modelled. Placing himself in the position of the painter, he 

then adds another layer to his reproduction. He makes a 

replica (photograph) of a replica (wax model) of a replica 

(original painting) of the subject. His work traces a course 

of time across several layers of history, capturing images 

of people who lived before �lm was invented.

He creates a likeness of our �idea� of the �gure, as we 

imagine it to be, rather than a portrait of the person. In 

light of her tragic death, his image of Princess Diana (one 

of the most idealised �gures of our time) is both haunting 

and compelling. Chased by paparazzi at the time, it has 

been suggested that our obsession with her (and thirst 

for images of her) contributed to her death. Although his 

images look real, and the prints are life-size, Sugimoto�s 

photographs refute the modernist idea that the camera 

records a picture of something exactly as it is.

Figure 12.2C Hiroshi Sugimoto, Diana, Princess of Wales,   

1999, gelatin silver photograph

In 2005, in an interview with Hino Naohiko, published 

in the magazine Art iT (vol. 3, no. 4), Sugimoto talks of 

how ideas for his work usually evolve from a question 

he poses. Seascapes developed from the question: �Is 

it possible to recreate today the ocean as it was when 

the ancients saw it?� he explains. Sugimoto travels the 

world, recording the union of sea and sky for this ongoing 

project, begun in 1980. His representations are either 

divided in two at the horizon, forming two neat rectangles, 

or presented as one hazy block, when the sea and sky 

merge as one in a mist. Each picture is de�ned by the way 

the light falls on the water, or is re�ected from it. Only the 

titles reveal that the images have been made at different 

ends of the globe. The serenity, water and sky remain 

constant and perhaps have always looked the same 

through all time.

In 1997 he started to make images of iconic  

20th-century buildings from all over the world.  
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Entitled, Architecture (1997�2002), this series of 

modernist constructions is photographed in an anti-

modernist way. Reversing his usual sharp-focus style, 

these images have short exposure times and are pushed 

out of focus. Real buildings appear unreal; they look like 

photographs of models or toy buildings. Bold blocks of 

shape with clean, straight lines and hard edges (modernist 

constructions) are rendered soft and fuzzy by Sugimoto�s 

camera.

Figure 12.2D Hiroshi Sugimoto, S.C. Johnson Building, 2001, gelatin silver 

photograph

The images suggest an idea of a building; an architect�s 

vision before the building is built, or the memory of a 

building after it is destroyed. This feeling is particularly 

evident in Sugimoto�s image of the Twin Towers of the 

World Trade Center, in the United States.

Sugimoto documents people who are not there, he 

makes impressive buildings look like toys and photographs 

�lms that vanish. He explores the very idea of reality, and 

the ability that photography has to manipulate the way we 

perceive it.

More recently, his art practice has diversi�ed, and he 

has worked across a range of media and disciplines. For 

example, in 2002 he designed and built a Shinto shrine 

(a traditional Japanese place of worship and a dwelling 

for gods). In Colors of shadow (2004�05) he made colour 

photographs of interiors that have virtually no colour. And, 

for an exhibition in 2007, he photographed contemporary 

Japanese fashion reminiscent of sculpture, with its unique 

shape and form.

activities

1. Discuss how Hiroshi Sugimoto went about creating Radio 

City Music Hall, New York, 1978 (see �gure 12.2B).

2. Use the internet to �nd a photograph from Hiroshi 

Sugimoto�s Dioramas project. Compare the work with 

Anne Zahalka�s diorama photograph Alpine scene, 

2006 (see �gure 12.5E, page 211). Discuss the 

similarities and differences.

3. Why do you think Hiroshi Sugimoto took a photograph 

of a wax statue of the Princess of Wales and not one 

of her in real life, in his photograph Diana, Princess of 

Wales, 1999 (see �gure 12.2C)?

4. Search the internet to �nd at least two examples of 

Hiroshi Sugimoto�s Seascapes. Discuss what you think 

Sugimoto was trying to communicate about his world 

in these photographs.

5. What elements of minimalism and conceptualism are 

evident in Hiroshi Sugimoto�s S.C. Johnson Building, 

2001 (see �gure 12.2D)?

6. Compare Ansel Adams� photograph Moon and half 

dome, Yosemite National Park, 1960 (see �gure 12.1D, 

page 194) with Hiroshi Sugimoto�s S.C. Johnson 

Building, 2001 (see �gure 12.2D). Discuss the 

similarities and differences in the ideas explored and 

both artists� approach to image making.

7. Hiroshi Sugimoto sets out to show us the world through 

a different perspective. His photographs express his 

imaginative and thoughtful response to experiences he 

has had and witnessed. Select an artwork by Sugimoto 

that demonstrates his personalised approach to image 

making. Analyse the artwork (use the proforma on  

page 159 to assist you) to provide evidence of his 

subjective (personal) approach.

Where possible, use the internet to look up and view 

additional photographs by Hiroshi Sugimoto.

 12.3  Loretta Lux

Artist and world �  
cultural/subjective
Loretta Lux was born in 1969 in Dresden and grew up 

in Soviet-occupied East Germany. This was a communist 

society, monitored by the Stasi (secret police). In 1989, 

a few months before the Berlin Wall came down (allowing 

East and West Germans to unite), Lux moved to Munich. 

From 1990 to 1996, she studied painting at the Academy 

of Visual Arts, but did not start experimenting with photo-

based art until 1999. Her �rst photo works were self-

portraits, which look remarkably like grown-up versions of 

the images of children she began making soon after.
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In The hush (1999), Lux presents herself immaculately 

groomed in front of a wall of old-fashioned children�s 

illustrations. With a �nger to her lips she silences the 

audience, indicating the secrecy of the world she inhabits, 

into which she will allow the viewer a glimpse. She is 

secretive about her personal identity and life, as well 

as her practice. In 2000, on the eve of her �rst show in 

Germany, she changed her name to Loretta Lux. She does 

not like to tell an audience how to read her work, nor 

does she disclose the techniques she uses to create the 

resulting surreal images of the secret worlds of children.

In 2004, Lux had her �rst solo show in America, 

represented by the Yossi Milo Gallery in New York. The widely 

acclaimed exhibition was a huge success, with her works 

selling at very high prices for an emerging photographic 

artist. In 2005 she won the In�nity Award for Art from the 

International Center for Photography in New York.

Practice

In�uences

� As a child she lived with her grandparents, who took 

her to museums and art galleries where she �rst saw 

the works of old masters (European painters who 

worked before and up to the early 1800s). Some of 

these became very in�uential on her practice including: 

Pinturicchio (1454�1513, Italian), Agnolo Bronzino 

(1503�72, Italian), Diego Vel�zquez (1599�1660, 

Spanish), Francisco Jos� de Goya y Lucientes (1746 

�1828, Spanish), Caspar David Friedrich (1774�1840, 

German) and Philipp Otto Runge (1777�1810, German).

� Her training as a painter has also been an in�uence on 

her photo-based practice.

Style

� Colour photographs (usually in soft pastel tones)

� Hyperreal and slightly surreal

� Unusual lighting, without shadows in the image

� Her images are composed and enhanced on  

the computer using digital manipulation software  

such as Photoshop.

� The images have a particular strangeness.  

The children in her images seem to be trans�xed on 

something just beyond the viewer�s vision. They are  

lost in their own world; a world to which the audience 

has no access.

� Often, the size of the head or facial features of the 

children are ever so slightly out of proportion with the 

rest of the body.

Themes and interest

� Photographs children almost exclusively

� The innocence and secret world of a child

� The �idea� of childhood (something everyone will 

experience, then lose as they grow up)

Ideas/artistic intention

� She creates a vision of childhood for the viewer to 

project onto and re�ect on their childhood.

� She presents the world of a child as a magical, 

mysterious and sometimes scary place. She intentionally 

creates very ambiguous images, enticing viewers to use 

their imagination.

Figure 12.3A  

Loretta Lux  

The hush, 1999  

Ilfochrome print  

© Loretta Lux  

Courtesy Yossi Milo  

Gallery, New York 

and Torch Gallery, 

Amsterdam
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� Lux invites re�ection on what it means to be a child, as 

well as adult nostalgia for times past. Childhood, for 

Lux, is a symbol for paradise lost. Something we have 

all experienced, but only for a short time before that 

innocence is gone and there is no way of getting it back.

� Her images also have a strong psychological effect on an 

audience: while they compel viewers to study the details 

of a picture, the current climate and debate around 

images of children questions this inquisitive response. 

The images can make viewers feel uneasy and invite 

contemplation about contemporary fascination with youth.

Actions/working method

� Carefully selecting her tiny models, props and retro 

clothing, Lux photographs the children of friends  

against a plain white wall in her studio. She then  

scans the images and reworks them on the computer. 

Using software programs, she places the children  

in scenes from other photographs or her paintings.

� Lux controls every single aspect of the picture. 

Everything is completely staged, directed, manipulated, 

retouched and enhanced.

� She makes very few images each year, as her images 

take several months to complete.

� In a similar way to a painting on a canvas, her images 

are created with Photoshop �tools� and �brushes�  

on a computer.

� Her �nal images are presented as small Ilfochrome prints 

in limited-edition sizes (from one digital �le she makes 

only a small, speci�ed number of prints).

Artwork

Loretta Lux photographs the sons and daughters of friends 

and, although she says the children are recognisable, the 

images are not meant to be portraits. They reveal nothing 

about the individuals; instead, they represent the idea of 

childhood in general. The images draw both on classical 

painting and contemporary studio portraiture of children, 

as well as the latest digital technology processes in 

photography. The children seem both na�ve and mature, 

they appear odd but it is hard to detect in what way. They 

are photographed in a studio against a white backdrop, 

the scanned images are then manipulated using computer 

programs. The proportions of the children are ever so 

slightly altered, reworked and enhanced, then digitally 

inserted into various settings (photographs Lux has made 

on her travels, or her own paintings). The clothes are not 

the children�s own, instead they are carefully selected from 

remnants of Lux�s own childhood or secondhand stores; 

they are often slightly too big or a little small and mostly 

reminiscent of another era. Although some of them look  

distinctly 1960s or 1970s in style, because retro clothing 

is constantly coming back into fashion it is dif�cult to 

place these children in a particular 

era. They seem timeless, so 

incredibly real, and at the same 

time slightly surreal. Bathed in 

light, they cast no shadows, and 

never do they smile or laugh. 

Stark backgrounds, empty rooms 

and barren landscapes place 

these children in a time warp. The 

children in Lux�s images disregard 

the viewer, lost in thought, occupied 

with something the audience can�t 

grasp or see � a child�s world that 

adults have no access to.

In the corner of an empty room, 

with wooden �oorboards and dirty 

walls, a small girl with her hair tied 

into two, tight, neat, blonde buns, 

stands with one hand clutching 

her shoulder (see �gure 12.3B). 

She looks worried or upset, staring 

intently at something beyond the 

Figure 12.3B  

Loretta Lux  

Hidden rooms 2, 2001  

Ilfochrome print  

© Loretta Lux, Courtesy Yossi Milo Gallery,  

New York and Torch Gallery, Amsterdam
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viewer�s vision. She is dressed in a neat dress of  

aqua, orange and white checks that could possibly be  

a school uniform. Around each of her ankles are the 

impressions of tight bands, a sign that she has just 

taken off her shoes and socks. Menacingly, shattered 

glass is strewn across the �oor behind her and one 

cannot help wondering if she has just broken something 

and is expecting to be scolded, or if she is the child of 

neglectful parents. Like an illustration from the scary 

fairy tales of the Brothers Grimm, perhaps this little 

girl has been locked in a room by a nasty stepmother 

or witch. A story starts to unfold in the mind of the 

viewer: why is she holding her shoulder, and how was 

the glass broken? Perhaps Lux imagined these images 

when she was read stories as a young child, or they 

could be autobiographical, representing events that she 

remembers from her own childhood.

The walk (2004) features two Asian girls, obviously 

sisters, with matching hairstyles and buttoned-up coats. 

They walk along a country path in perfectly coordinated 

steps, with buckled-up shoes that seem too big for them. 

Their heads also appear large on their small bodies 

and they seem to carry the weight of the world on their 

shoulders, with their serious expressions and mature 

faces. They might be sad or perhaps just contemplative; 

they do not allow the viewer to read their minds or 

enter their world � they have each other. The younger 

sister�s pastel-blue coat is stained and dirty, indicating 

that perhaps times have been tough. Perhaps, like the 

storybook characters Hansel and Gretel, their parents have 

abandoned them and they are following a path to try to get 

home, or maybe they have run away. One of them carries a 

white handkerchief, but we do not know if it is to dry tears, 

or is a sign of surrender.

These perfectly composed, mysterious and surreal 

scenes, in soft pastel tones, are instantly compelling, 

occasionally sinister and often perplexing. Lux chooses 

titles that do not reveal too much and she refuses to give 

Figure 12.3C  

Loretta Lux  

The walk, 2004  

Ilfochrome print  

© Loretta Lux, Courtesy Yossi Milo Gallery, New York  

and Torch Gallery, Amsterdam
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away information about the images. Nevertheless, events 

begin to unfold, as you look at the details. Lux wants 

her audience to read their own version of the scenario 

into each picture. Later images such as The green room 

(2005), Hugo and Dylan 2 (2006) and The dove (2006) 

have even more of a narrative sway, as Lux includes more 

elements and props suggesting interaction and events for 

the viewer to speculate on.

Unlike most of the other children in her photographs, the 

child in The drummer (2004) stares de�antly at the viewer, 

arms raised, drumsticks clenched tightly in �sts about to 

break the silence with a beat. This is probably Lux�s most 

well-known image. It has graced the covers of several 

magazines and the National Gallery of Victoria purchased 

it for their collection in 2006.

The child has been referred to as a �drummer boy� 

(�gure 12.3D), but also looks remarkably like an older 

version of Lux�s Study 

of a girl 1 and 2 

(2002). It is dif�cult 

to determine the sex 

of this child, with 

its cherub-like face, 

piercing blue eyes and 

�awless, porcelain 

skin. It is somehow 

strange, and yet the 

stereotype of a perfect 

child. One thing is 

certain though, this astonishingly beautiful child, with its 

angelic appearance, will grow up and be forced to take 

on the responsibilities of the adult world and learn of 

its atrocities and hardships. The simplicity of the child�s 

current existence, seated at a well-loved table, in a room 

with softly striped wallpaper will come to an end; it is as 

if the drum roll we anticipate signals the next chapter in 

life. Lux�s images invite re�ection on Western society�s 

obsession with youth, attracting both critics and admirers. 

Her aesthetically appealing images are intriguing. The 

child�s world that she invites the viewer to see, but forbids 

them to enter, is a nostalgic reminder of a lost past. A 

clever combination of considered composition, graphic 

design, classical painting and photography, all seamlessly 

stitched together digitally, has earned Lux not only a fortune 

for her sell-out shows, but also, in a short timeframe, a 

rapid rise to stardom in the competitive art world.

Figure 12.3D  

Loretta Lux  

The drummer, 2004  

Ilfochrome print  

© Loretta Lux, Courtesy  

Yossi Milo Gallery, New York 

and Torch Gallery, Amsterdam
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1. What do you think Loretta Lux is attempting to 

communicate about her own childhood in her 

photographic self-portrait The hush, 1999  

(see �gure 12.3A, page 199)?

2. Outline how Loretta Lux went about creating Hidden 

rooms 2, 2001 (see �gure 12.3B, page 200). 

Discuss how she may have accessed, dressed and 

photographed her model, where the background of the 

image came from, and the materials and techniques 

she may have used.

3. Loretta Lux�s artworks are open to interpretation. It is 

up to the viewer to construct their own meaning. Using 

all the clues provided, create your own interpretation 

of Hidden rooms 2, 2001 (see �gure 12.3B,  

page 259). Once complete, compare your 

interpretation with those of other class members.

4. Outline the symbols used by Loretta Lux to assist her 

audience in interpreting her photographic artwork The 

walk, 2004 (see �gure 12.3C).

5. Discuss how Loretta Lux has used composition and 

design elements to help establish atmosphere and 

mood within her photographs of children. Use the 

proforma on page 259 to assist you.

6. What do you think Loretta Lux is attempting to 

communicate about her world in her photographic 

images of children?

7. Why do you think audiences respond so well to Loretta 

Lux�s images of children?

8. It is our culture to celebrate youth and, through her 

artworks, Loretta Lux acts as a social agent, bringing 

into question adult nostalgia for times past. Her 

photographs ignite our memories and allow us to 

re�ect on our own childhood experiences. Select 

an artwork by Lux to analyse (use the proforma on 

page 159 to assist you) and use your analysis to 

provide evidence that her work is a re�ection of the 

culture in which it was made.

Where possible, use the internet to look up and view 

additional photographs by Loretta Lux. Login to 

www.jacplus.com.au to locate the weblinks for this chapter.

activities

 12.4  Max Dupain

Artist and world �  

structural/cultural
Max Dupain was born in Sydney in 1911 and lived there  

his entire life, photographing the city from the late 

1920s until just before his death in 1992. He is one of 

the country�s most revered photographers. Technically 

and critically acclaimed, his images are included in the 

collections of most major state and public galleries in 

Australia. Dupain was given his �rst Box Brownie camera 

in 1924 when he was 13; four years later he won the 

Carter memorial prize for �productive use of spare time�. 

He attended Sydney Grammar School, then trained brie�y 

at Julian Ashton Art School and East Sydney Technical 

College, and also joined the Photographic Society of New 

South Wales. After studying, he worked for Cecil Bostock 

at a leading commercial photography studio in Sydney, 

learning studio-lighting skills, large-format camera usage 

and the technical skills required for developing negatives 

and making prints. At that time photographers could not 

afford to specialise in a particular area of photography, 

it was essential to photograph everything with expertise. 

Assignments ranged from product photography to high-end 

fashion, and Dupain gained a versatile approach to his 

practice.

In 1934, Dupain opened his own photographic studio. 

Olive Cotton, who had shared an interest in photography 

with him since their teens, joined him there as an 

assistant. They married in 1939, and although they 

divorced not long after, they continued to operate the 

studio together. During World War 2, Dupain served in  

the Royal Australian Air Force (RAAF) and Cotton managed 

the studio during his absence. Cotton became a  

well-known Australian photographer in her own right. 

Dupain re-married and had a daughter, Danina, and  

a son, Rex, who followed in his father�s footsteps, 

establishing a successful photographic career.

Figure 12.4A  

Olive Cotton 

Portrait of Max Dupain, 1938 

Gelatin silver photograph 

gelatin silver matt; image 25.2 × 20.2 cm on sheet 29.2 × 24.8 cm 

© Josef Lebovic Gallery 
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� He aimed to make provocative images that were 

re�ective of the modern age of machines and industry, 

and the changing face of Australian society and culture.

� Rejecting staged or directed photography to capture 

spontaneous moments, he photographed people 

absorbed in ordinary activities, and everyday objects.

� He loved the �Australian way of life� and made heroic, 

nationalistic images promoting an Australian identity.

� He aimed to stimulate thought with his photography 

rather than merely entertain or amuse.

Actions/working method

� Constantly working throughout his life, Dupain made a 

proli�c number of images.

� Working almost exclusively in black and white,  

he considered colour photography to be restrictive, 

providing too much information and leaving little room 

for interpretation.

� He was interested in the potential of photography and 

experimented with many varied technical applications 

(for example, incorporating several images to make 

a single print, montage, solarisation and negative 

manipulation). The entire process was important, from 

Practice

In�uences
� George Dupain (1881�1959), Max�s father,  

who was dedicated to physical education, �tness,  

diet, health and wellbeing

� World War 2

� The industrial age

� Modernism (see page 176)

� Surrealism, and particularly the artist Man Ray

� The Bauhaus movement, promoting rational  

and functional design

� The �Neue Sachlichkeit� (new objectivity) movement, 

promoting realist art

� The photographic revolution in Europe and America, 

discovered through books and journals, as well as 

established European photographers who migrated  

to Australia (for example, Wolfgang Sievers)

Style
� Dramatic light

� Sharp focus

� Capturing spontaneous moments  

(glimpses of daily life)

� Unusual angles

� Heroic imagery

� Simple modernist form  

and light

� Emphasis on geometric shapes, 

patterns and design

Themes and interest
� Australia and Australians

� Sydney

� Landscapes, streetscapes  

and cityscapes

� Beach culture

� Portraits

� Nudes

� Still life

� Architecture

Ideas/artistic intention
� His early work was a reaction  

against the pictorial tradition  

(a soft-focus, picturesque 

photographic style that attempted 

to look like painting). Dupain 

promoted �new photography�, which 

had developed from other visual 

movements following World War 1.

Figure 12.4B  

Max Dupain 

Bondi, 1939  

Gelatin silver photograph 

30.4 × 29.6 cm 

© The Max Dupain Exhibition Negative Archive
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the moment of releasing the shutter, to the craft involved 

in developing the �lm and printing the photograph.

� He used dramatic, harsh lighting � often bright,  

natural sunlight.

� Versatility was one of his best attributes; he was trained 

to photograph a vast array of subject matter.

Artwork

Max Dupain photographed the Australian environment  

and its social and cultural content. His practice 

encompassed almost all photographic genres, including 

portraiture, the nude, still life, architecture, landscape 

(streetscape, cityscape) and documentary. He is most 

famous for his personal work celebrating Australian 

identity, particularly beach culture, including iconic images 

such as Sunbaker, 1937 (see �gure 11.3A, page 184), 

Bondi, 1939 (see �gure 12.4B) and At Newport (1952).

Bondi is taken from below (a worm�s-eye view),  

a perspective which raises the �gures to heroic 

proportions. The viewer looks up at them; two, bronzed, 

monumental �Aussies� drenched in light, the sunshine 

literally glowing on their tanned skin. They look out  

to sea, ready to �battle� the surf. The image is livened 

with humour, as Dupain records the split-second (now 

immortalised) when the woman adjusts her bathing-

costume around her bottom.

Dupain rejected soft-focus, pictorialist photography 

(popular in the early part of the 1900s) as too  

picturesque and nostalgic to capture the modern pace of 

life. Incorporating European formalism and innovation with 

Australian culture, he pioneered the �new photography� 

movement in Australia (characterised by clean lines,  

sharp focus and extreme perspectives such as close-ups 

and worm�s-eye or bird�s-eye views) that stemmed from the 

in�uence of international developments in the visual arts 

following World War 1. By 1935 Dupain was recognised  

as Australia�s leading modern photographer.

Dupain was an avid reader and he learned about 

surrealism and European photography through  

international publications. He was particularly in�uenced 

by the work of Man Ray, an American-born (often 

French-based) surrealist photographer, whose style and 

techniques were fashionable. Adopting the expressiveness 

of the surrealists, Dupain experimented with combining 

unrelated objects to achieve poetic or theatrical effects. 

The formal aspects of the Bauhaus movement  

(promoting simpli�ed rational and functional forms)  

also impressed Dupain, and both movements in�uenced  

his aesthetic.

Impassioned clay (1936) uses montage to bring together 

an eroded shell, and a female �gure. The soft curves of the 

shell blend into the woman�s body, her perfect, pale skin 

becomes one with the curved, white surface of the shell. 

In the 1930s, full photographic nudes were uncommon 

in Australia. Dupain photographed both male and female 

nudes; he was one of the �rst Australian photographers to 

work with �gure studies and nudes as a serious genre. He 

was fascinated with the human form, its vigour and vitality, 

and often depicted the ideal body. His interest in physicality 

probably stemmed from his father, who was devoted to 

physical education, diet, �tness and health.

Dupain�s most famous body, Sunbaker (see �gure 11.3A, 

page 184), was made in 1937, but it was not until the 

1970s that the image gained attention. It was included 

in a retrospective of Dupain�s work in 1975 at the 

Australian Centre for Photography (ACP) in Sydney and 

then purchased by the National Gallery of Australia (NGA). 

Close up, and taken from a worm�s-eye view, Sunbaker 

was photographed at Culburra Beach near Jervis Bay. 

The foreground of the image is �lled with sand, while the 

monumental, heroic, bronzed man is centred, basking in 

the sun. Still dripping with water from �riding� the waves, 

he dominates his environment, the huge sky above and the 

warm sand below. His athletic frame is foreshortened and 

presented as a solid shape.

Figure 12.4C  

Max Dupain 

Impassioned clay, 1936  

Gelatin silver photograph, 46.1 × 32.6 cm 

Purchased 1976 

Collection: Art Gallery of New South Wales
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Throughout his career Dupain worked primarily as a 

commercial photographer for advertising and industrial 

organisations. Using simple, clean lines, patterns and 

geometric shapes he introduced a modernist aesthetic 

to middle-class Australians through his editorial work for 

mainstream print media. His photographic assignments 

and commissions were a major part of his practice from 

1930 to 1970 and re�ect his artistic aesthetic and ideas. 

A number of images from his commercial engagements 

have since been purchased for state art collections; for 

example, Advertisement for Hoover (1937), owned by the 

National Gallery of Australia in Canberra.

Figure 12.4D  

Plate 7 

Max Dupain, 1911�1992, Australia 

Advertisement for Hoover, 1937 

Gelatin silver photograph 

35 × 25 cm 

© The Max Dupain Exhibition Negative Archive

During the war Dupain served with the Royal Australian 

Air Force (RAAF), working in a camou�age unit in Darwin 

and Papua New Guinea (one of his few departures from 

Australia) until he was transferred to the Department of 

Information (1945�1947). Documentary photography had 

sparked Dupain�s interest, and the opportunity to explore 

its philosophy (that art should inspire social awareness) 

arrived with this transfer. He was required to travel the 

country taking photographs to promote Australian life at 

the climax of the war. Assignments ranged from �women at 

work� to �queuing for rations�.

Compressed into a shallow space, a line of sullen 

�gures, almost all dressed in black, extends through 

Dupain�s photograph Meat queue (1946). Two women 

at each edge of the photograph, who look out from the 

queue, frame the image. It is perfectly balanced by a 

central �gure in a lighter-coloured coat disturbing the 

queue and seemingly upsetting the woman in front. The 

sign above their heads, reading �Meat coupon scale�, 

indicates their objective � food rations. The women 

appear in place of the carcasses that ought to be dangling 

from the meat hooks above their heads. The expressions 

on their faces convey the hardships of post-war Australia.

Inspired by the philosophies of John Grierson, who 

had recently coined the term �documentary�, as well as 

American photographers who were depicting the Great 

Depression, Dupain advocated the documentary movement 

in Australia. A book of documentary work by Dupain, entitled 

Photographs, was published in 1948, in which Dupain 

states:

modern photography must do more than entertain,  

it must incite thought and, by its clear statements  

of actuality, cultivate a sympathetic understanding  

of men and women and the life they create and live.

After World War 2, Dupain became intensely interested 

in architecture, and started photographing the works of 

in�uential architects. Although new consumerism in the 

1950s caused a demand for advertising and promotional 

photography, truth was now integral to Dupain�s 

practice and emphasis was placed on spontaneous 

personal recordings. In response to the in�uence of the 

documentary movement, he began to move away from 

super�cial commercial work, accepting industrial and 

architectural commissions. He photographed modern 

architecture and everyday objects, accurately recording 

detail with a simple matter-of-factness.

With strong lines, geometrical shapes and a re�ection 

on technology and the machine age, the realist aspects of 

the Neue Sachlichkeit (new objectivity) movement and the 

simple rationality of the Bauhaus style are evident in a great 

deal of his architectural and industrial photography. At the 

crossroads of science and art, the camera was recognised 

as an ideal tool for the machine age, capturing modern 

life and industry. In harsh Australian sunlight, Dupain 

photographed built constructions. Throughout his career, 

light was a crucial tool for Dupain, its strength and position 

critical to each image. Light and shade portrayed form and 

movement; dramatic light emphasised shape and structure, 

created drama, revealed surface and texture, and gave 

warmth to an image.

Construction of architect J�rn Utzon�s famous Sydney 

Opera House began in 1959, and Dupain dedicated 

himself to documenting the process for well over a decade. 

In 1978, he left Australia again, and spent three weeks 
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in Paris photographing the Australian Embassy designed 

by architect Harry Seidler. Dupain�s architectural work 

enhanced and promoted the built form, often with the 

added documentary appeal of the construction process 

and building workers. In later years, however, his images 

gradually became devoid of people and even more formal.

Figure 12.4E  

Max Dupain 

Meat queue,  

1946, Sydney 

Gelatin silver photograph 

46.0 × 65.5 cm  

(image & sheet) 

© The Max Dupain Exhibition 

Negative Archive

activities

1. What do Max Dupain�s images tell us about the world in 

which he lived?

2. Find a piece of Australian music or poetry from the 1930s or 

1940s that re�ects an equivalent view of the Australian way 

of life as Dupain�s photographs. Discuss the similarities.

3. What do you think post-war European migrants would 

have learnt about Australia by looking at Max Dupain�s 

photographs? Provide examples to help clarify points made.

4. What materials and techniques do you think Dupain has 

used in creating Impassioned clay, 1936? (See �gure 12.4C 

and refer to section 2.5 (pages 50�7) to assist you.)

5. Discuss Dupain�s use of composition and the design 

elements in his 1939 photograph, Bondi (see �gure 12.4B). 

Use the proforma on page 259 to assist you.

6. Compare Advertisement for Hoover (1937) by Dupain  

(see �gure 12.4D) with a contemporary photograph 

advertising a domestic product (include copies of both 

images). Discuss the similarities and differences in style  

and artistic intention (ideas).

 7. Look closely at Dupain�s Meat queue, 1946  

(see �gure 12.4E) and discuss how this image captures  

the change in Australian identity after World War 2.

 8. Search the internet for an example of Max Dupain�s 

architectural photographs (for example, the Sydney Opera 

House under construction). Select one image and discuss 

how Dupain has used light, composition and design 

elements to enhance the quality of the photograph. Use the 

proforma on page 259 to assist you.

 9. Why do you think Max Dupain is considered such an 

important Australian photographer?

10. Max Dupain�s photographs are considered to be a true 

re�ection of the Australian way of life in the 1930s and 

1940s. Select an artwork by Dupain to analyse (use the 

proforma on page 159 to assist you) and use your analysis 

to provide evidence that his work is a consequence of the 

culture in which he lived and worked.

Where possible, use the internet to look up and view additional 

photographs by Max Dupain.

Dupain was awarded an Order of the British Empire 

(OBE) in 1982, and from 1984 to 1988 he reviewed 

photography for the Sydney Morning Herald. He continued 

making photographs until just before his death, and is 

today celebrated for pioneering an Australian photographic 

style that in�uenced and inspired many of his successors.
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 12.5  Anne ZAhAlkA

Artist and world �  

cultural/postmodern
Anne Zahalka is one of Australia�s most highly 

regarded artists in photo-media. She has exhibited 

extensively both nationally and internationally, and 

has produced many iconic images. Born in 1957  

to a Jewish Viennese mother and a Catholic 

Czech father, who migrated to Sydney; identity, 

multiculturalism and representation were to become 

important themes in her practice. She commenced 

studying art in 1976, and completed her Master 

of Fine Arts at the University of New South Wales, 

College of Fine Arts, in 1994.

Figure 12.5A  

Anne Zahalka 

Artist #33 (Anne Zahalka), 1990 

Type C photograph 87.0 × 85.0 cm  

Roslyn Oxley9 Gallery

Zahalka started making photographs and 

participating in exhibitions in the 1970s. It was an 

exciting time to embark on a future in photo-media, 

as photography was �nally gaining status in Australia 

as a legitimate art form. Diverse work by talented 

Australian photographers was being produced, 

achieving international recognition for Australian 

photography. The 1960s had been a transitional 

period, as photography of a more everyday, personal 

nature gradually emerged � previously photography 

had been used mostly for commercial ventures, such 

as advertising, high fashion and photojournalism.

Practice

In�uences
� Jewish Viennese and Catholic Czech cultural heritage

� Growing up in Australia at a time when immigration  

was expanding and including many new and diverse 

cultural groups

� The question of Australian identity post 1980

� Changing attitudes to cultural and gender stereotypes

� The postmodernist movement and the shift towards 

encouraging a more creative, personal and innovative 

use of photo-media (see page 177)

� Art styles of the past; in particular, 17th-century  

Dutch painting

Style
� Artworks re�ect a variety of styles and aesthetics

� Experimenting with a range of techniques and 

approaches and reinventing her style

� Interested in photographic theatre and appropriation,  

as well as documentary photography

Themes and interest
� Identity and representation

� Gender and stereotypes

� Photographic postmodernism/appropriation

� Suburbia and interiors

� Multiculturalism

� The deception of appearances

Ideas/artistic intention
� Working in the 1980s, Zahalka, like many other 

photographic artists, was not interested in �capturing 

the decisive moment�. She moved her camera from the 

street into the studio and �directed� her subjects.

� Zahalka aims to challenge and undermine accepted 

ideas. Applying principles from art history, and using 

recognised signs, symbols and imagery, she often 

appropriates or re-stages existing artworks so her 

audience will recognise the work, but see it in a new light.

� Zahalka uses irony and humour to expose contradictions 

and show how the way the image is presented can 

dictate what the audience should think or feel.

� Her constructed scenes are presented as fa�ades and 

are not meant to appear real. They invite the viewer to 

re�ect on and question what images (and media) tell us 

about ourselves and the world we live in.

� For her documentary work, Zahalka�s choice of subject 

matter is primarily the many and varied leisure 

activities Australians enjoy. Exploring the multi-million 

dollar industry leisure has become, she highlights the 

environmental impact that the way we live our lives 

might have on our world.

Actions/working method
� Initially working with medium-format colour positive �lm 

and experimenting with camera and darkroom trickery, 
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Zahalka printed her early images as large Cibachrome photographs 

(high-gloss paper). Later, she created digitally manipulated 

photographic artworks, enhancing colours and including objects that 

could not co-exist logically in an environment.

� Works are often staged and constructed. She uses friends, family 

and acquaintances to pose for her artworks.

� Photographic works are created in series rather than as individual 

isolated images.

� Her process starts with the conceptual idea, using the photographic 

medium to create an image to communicate her message.

Artwork

Zahalka�s �rst major body of work evolved in 1986, when she was 

awarded a residency in Berlin, Germany. A number of residencies have 

been very important to Zahalka�s practice, especially this one, which 

was a turning point in her career and provided a platform for research 

and development as an artist. She initiated new ideas and methods of 

working that resulted in a series that would later be exhibited in several 

de�ning Australian photographic surveys, and purchased by many of the 

state galleries. Resemblance (1987) is a direct homage to 17th-century 

Dutch painting, evoking the style and conventions of genre paintings by  

Jan (or Johannes) Vermeer, in particular, but others also. Zahalka 

enlists the active participation of viewers to decode the meanings 

Figure 12.5C  

Anne Zahalka 

The cleaner (Marianne Redpath/

performance artist), 1987 

Cibachrome photograph 

80 × 80 cm 

Edition of 20 

Roslyn Oxley9 Gallery

Figure 12.5B Johannes Vermeer  

Woman writing a letter, with her maid, c. 1670 

Courtesy of the National Gallery of Ireland 

Photo © National Gallery of Ireland
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and messages of her photographic replicas which, like 

their predecessors, are rich in symbolism and detail. 

Seventeenth-century Dutch painting has been a major 

in�uence on Zahalka�s photographic practice. Vermeer is 

thought to have used some kind of primitive camera to 

achieve an almost photographic accuracy in his painting. He 

probably used a camera obscura that projected or re�ected 

an image onto a two-dimensional surface. Vermeer rendered 

paintings like photographs.

These three months in Europe offered Zahalka the 

opportunity to see some of the paintings she had 

previously admired only in reproduction. The �ea markets 

in Germany provided the props, and she constantly 

rearranged her new studio, making photographs that 

resembled these paintings.

Zahalka drew on the aesthetic conventions of these 

paintings, creating interiors that utilised light, colour and 

space in a similar way. The viewer often looks into a 

room though an open door, or thick curtain pulled back to 

reveal the private world of the sitter amidst the equipment 

of their trade. In some images, a fake black and white 

tiled �oor (as appears in many of Vermeer�s works) was 

installed over wooden �oorboards, and still lifes (bowls 

laden with fruit and vegetables and/or �sh and bread) 

were arranged on tables. Several of Zahalka�s photographs 

include 17th-century Dutch paintings hung on a wall. 

Everything is carefully arranged, the pictorial space is  

a theatre in which the sitters play their part in a  

controlled environment.

Friends posed as her subjects, and each image is 

laden with symbolism and meaning. Some symbols are 

common to those in the original paintings; for example, 

a half-peeled lemon with the rind dangling in a spiral 

from a table is a popular still-life motif employed to 

indicate the deception of appearances (beautiful to 

look at, and yet sour to taste) � it can be found in a 

number of the images in the Resemblance series.

Zahalka includes elements in each image of her 

Resemblance series that on closer inspection expose 

the deception of the portraits. Upon initial viewing, 

The cleaner (Marianne Redpath/performance artist) 

(1987) appears to be from another era. On the table, 

next to the traditional still life (bowl of fruit), lies a 

plate of sliced kiwi fruit (Zahalka�s clue to identify the 

sitter�s origin � New Zealand), which would never have 

featured in a 17th-century Dutch painting. This cleaner 

also has a set of headphones resting around her neck, 

plugged into a walkman clipped on her hip. She is now 

clearly a 20th-century woman. In each of these images 

there is a contemporary element amid the period 

props. These incompatible inclusions are not intended 

as jokes; they de�ne the distance that separates past 

and present, and acknowledge the in�uence the former 

undoubtedly has on the latter.

Figure 12.5D  

Anne Zahalka 

The girls #2,  

Cronulla Beach, 2007  

Type C photograph  

74.0 × 90.0 cm 

Roslyn Oxley9 Gallery
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In 1989 Zahalka was awarded a residency at the Bondi 

Pavilion Community Centre to make photographs at one 

of Australia�s most celebrated and idealised sites � the 

beach. Bondi: playground of the Paci�c includes a number  

of images with generic titles: The bathers, The lifesavers,  

The surfers, The tourists, The girl, The sunbather #2 (see 

�gure 11.5B, page 187). With affection and humour, rather 

than mockery, each image pokes fun at a �type�. The 

lifesavers wear twee, striped swimming costumes, 1950s-

style; the surfers are not blond, bronzed Aussies, they are 

slightly uncomfortable Japanese males; and Zahalka did 

not photograph them on the beach. She lugged tonnes of 

sand just metres from it, built a set and photographed her 

subjects in front of an obviously painted backdrop of sky, 

sea and sand. These props demonstrate to her audience 

that she is working in the realm of ideas, not the real world. 

This series addresses Australian culture, cultural rituals 

and social constructs, highlighting the non-inclusive notion 

of an �Aussie� so actively promoted in the modernist era; 

she questions the �ideal� these popular historical images 

encourage. One image she created in this series has 

become so well recognised it rivals the popularity of  

the original image it mimics. The sunbather #2, 1989  

(see �gure 11.5B, page 187) is a re-staging of Max Dupain�s 

Sunbaker (1937), a nostalgic black and white photograph 

re�ecting a romantic view of the past (see �gure 11.3A, 

page 184).

Zahalka returned to the contested site of the Australian 

beach following the violence of the 2006 Cronulla riots 

to re-examine the dynamics of stereotypes, and the 

racism that existed there, and made a follow-up series, 

Scenes from the shire (2007). Soon after the riots, men 

and women from the Lebanese community were being 

recruited into the Cronulla lifesaving club; Zahalka seized 

the opportunity to make a new body of work. She was 

introduced to Aheda Zanetti, a young Muslim woman 

who had just launched a range of modest women�s 

swimwear. The burquini, a play on the words bikini and 

burqa (sometimes spelt �burka�), provides head-to-toe 

coverage. Made from Lycra, printed in bright colours and 

with motifs common on popular swimmers, they look very 

contemporary. The girls #2, Cronulla Beach, 2007 (see 

�gure 12.5D) depicts three young Muslim women, dressed 

in their burquinis staring directly at the viewer. Legs astride 

and arms crossed; shifting gender roles, they seem to 

parody the machoism associated with the stereotypical 

male lifesaver, as they guard their right to a place on the 

beach.

Wild life (2006) is the title of a series of Zahalka�s 

photographs of dioramas (life-size museum exhibits of 

animals or birds in natural surroundings with painted 

backgrounds). At �rst glance they appear to be authentic 

images (of animals living in the wild) that one might see 

in a holiday brochure advertising adventure and idealised 

wildlife. Faded, deteriorating painted backdrops, and 

stunned stares on the faces of stuffed animals soon 

expose the photographer�s location: a natural history 

museum. Zahalka provides other clues to reveal the 

deception; like her Resemblance series, these works 

all have odd elements included, disturbing the viewer�s 

�journey� into this serene and idyllic wilderness. By 

subtly inserting objects into the image that shouldn�t be 

there, Zahalka unsettles the audience bringing them to 

question what it is they are viewing. A replica of a replica, 

each image is a copy of an environment constructed to 

represent a �real� environment. Unrelenting consumerism 

demands the sacri�ce of the real experience for a 

simulated one. Zahalka thus highlights our complicity in 

the destruction of the natural environment.

Throughout her practice Zahalka has consistently 

explored the nature of image making, its relationship 

to the world around us, and the ability images have to 

command, distort or deny the truth. Using a vast range 

of popular imagery from both the past and the present, 

she explores identity, gender, ethnicity, representation, 

consumerism and the fabric of Australian culture. She 

frequently applies humour to demonstrate photography�s 

tendency to label and de�ne an individual, the world we 

live in and our relationship to it.

Figure 12.5E  

Anne Zahalka 

Alpine scene, 2006 

Type C print on Ilfa�ex paper 

80 × 80 cm 

Edition of 10 + 2 A/Ps 

Roslyn Oxley9 Gallery
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 12.6  Tracey MoffaTT

Artist and world � subjective/
cultural/postmodern
Tracey Moffatt is one of Australia�s most internationally 

successful contemporary artists. Based in New York,  

she works across both �lm and photography, experimenting 

heavily with various techniques, changing her style and 

approach with each series. Characterised by a �lmic 

quality (images that re�ect characteristics of �lms) 

and often with a loose narrative (the suggestion of a 

story), her work has been exhibited widely in Australia, 

Europe and America, and is held in many national and 

international collections. In 2007, the International Center 

for Photography in New York awarded her the prestigious 

In�nity Award for Art.

Figure 12.6A  

Tracey Moffatt 

Self portrait, 1999 

Hand-coloured photograph 

33.5 × 22 cm 

Edition of 10 

Roslyn Oxley9 Gallery

activities

1. Print out a copy of Anne Zahalka�s The cleaner  

(Marianne Redpath/performance artist), 1987 

(see �gure 12.5C). Use arrows and texts to point out 

the references that she has made to 17th-century 

Dutch painting. Use the internet to �nd another 

artwork from her Resemblance series and once again 

include a print-out of the artwork and highlight the 

references to 17th-century Dutch painting. Although 

these works appear to be from a bygone era, what 

clues does Zahalka give us to prove this wrong?

2. Outline how Zahalka went about creating the images 

for her Bondi: playground of the Paci�c series. 

Describe her working method, use of materials and 

techniques.

3. View Zahalka�s image The sunbather #2, 1989 

(�gure 11.5B, page 187) and go to the Roslyn 

Oxley9 Gallery website (login to www.jacplus. 

com.au to locate the weblinks for this chapter) and 

view the Bondi: playground of the Paci�c series. What 

do you think Anne Zahalka was trying to say about 

her world in producing this series of photographs? 

Where possible, use artworks from the series to 

provide evidence to support your comments.

4. Using the internet, look up Charles Meere�s painting, 

Australian beach pattern (1940). Then look up  

Anne Zahalka�s appropriation of this painting, entitled 

The bathers (1989). Print out a copy of both images  

and compare the similarities and differences in 

subject matter. By appropriating Meere�s artwork, 

what do you think Zahalka was trying to say about 

Australian culture and stereotypes?

5. How do you think an Australian audience would 

respond to Zahalka�s photograph, The girls #2, 

Cronulla Beach, 2007 (see �gure 12.5D,  

page 210)? Give reasons for your point of view.

6. What do you think Zahalka was trying to say about 

her world by creating a replica of a replica in her 

series Wild life (see �gure 12.5E)?

7. A postmodernist�s role is to question and challenge 

traditional art. They often use appropriation, parody, 

irony, alternative working methods and techniques 

to comment on and pose questions relating to the 

conventions of art. Select an artwork by Zahalka that 

re�ects her postmodern approach to image making. 

Analyse the artwork (use the proforma on page 159 

to assist you) to provide evidence of her postmodern 

approach.

Where possible, use the internet to look up and view 

additional photographs by Anne Zahalka (login to www.

jacplus.com.au to locate the weblinks for this chapter).
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Born in Brisbane in 1960, Moffatt is an  

Indigenous Australian who was raised by a white foster 

family in Mount Gravatt, a suburb of Brisbane. Through  

the 1960s and 1970s she immersed herself in television, 

magazines, comics, books and �lms, as an escape 

from her suburban life. She started photographing as a 

teenager, making her friends and siblings dress-up 

as she staged, directed and photographed them (in 1998 

she re-photographed some of these images for Backyard 

series). Moffatt studied visual communications at the 

Queensland College of Art, graduating in 1982. She 

then moved to Sydney, where she started exhibiting her 

images and making short �lms and videos. In 1989 she 

held her �rst solo exhibition at the Australian Centre for 

Photography in Sydney, with her series titled Something 

more (see �gure 11.5A, page 186) that was made during 

a residency at the Albury Regional Art Gallery. This 

series has become her most well-known work. Her �rst 

international success was also in 1989 when her short 

�lm Night cries: a rural tragedy (1989) was selected for 

of�cial competition in the 1990 Cannes Film Festival.

Practice

In�uences

� Popular culture and media

� Film and art history

� Painting and painters; for example,  

Francisco Jos� de Goya y Lucientes (1746�1828)

� Her childhood in Brisbane, and both her Aboriginal and 

white families, as well as her Indigenous heritage

� Postmodernism

� Feminism

Style

� Moffatt never ties herself to a signature style;  

instead, she experiments widely, using various 

techniques and media.

� Working in series, she explores ideas and  

concepts, often with a loose narrative that is open  

to interpretation.

� She has worked both in black and white, and colour 

photography, and has executed series in a wide range of 

media including: Cibachrome photographs, gelatin silver 

photographs, photogravures, photolithographs, screen 

prints and offset prints.

� Like many postmodern artists, Moffatt chooses to show 

the constructed nature of photography, using a kitsch 

style with obviously painted backdrops and arti�cial 

stage settings.

Themes and interest

� Race and gender relations

� Sexuality and eroticism

� Stereotypes and prejudices

� Power struggles

� Identity and representation

� Violence and cruelty

� The past and its impact on the present

Ideas/artistic intention

� Moffatt�s work challenges previous Indigenous 

representations in print, �lm and ethnographic 

photographic studies (see �gure 5.4C, page 118), 

undermining and challenging racial prejudices, 

stereotypes and misconceptions of �aboriginality�.

� Through her work she comments on society, culture and 

lifestyle, sometimes with a cynical approach and often 

using irony or humour.

� Her work explores gender relations, stereotypes and 

representations through power struggles, sexuality and 

the erotic, as well as cruelty and brutal behaviours.

� She does not attempt to capture �the real�; instead, 

she wants to create a new reality, raising questions and 

challenges for her audience to consider.

Actions/working method

� Prior to starting a project, Moffatt has a preconceived 

concept and visualises what her work will look like. 

She draws up elaborate plans and sketches, giving 

consideration to every detail: what the characters will be 

wearing, sets, props, backdrops and so on.

� She often spends a great deal of time looking for actors 

who �t her pre-visualised �characters� and has cast 

herself as various �gures within series.

� Her ideas are sometimes based on images or �lms she 

has seen, her past, memories or sometimes dreams  

she has had.

� While she directs the shoots and arranges every 

detail of the image-making process, she often employs 

technicians to perform the mechanical and manual 

tasks in her work, specialists to work with the images 

in Photoshop and expert printers to achieve the desired 

end result.

Artwork

Since the 1980s Moffatt has worked proli�cally, making 

photographs, documentaries, short �lms, experimental 

video, music clips and �lms. Her style has continually 

evolved and developed, from her early straight black and 

white images titled Some lads (1987), portraying male 

Aboriginal dancers (who she encouraged to play up to the 

camera, be proud and pose) in contrast to 19th-century 

ethnographic photos of Aboriginal people (see  

�gure 5.4C on page 118) through to her later, heavily 

computer-manipulated series, Under the sign of Scorpio 

(2005) and Portraits (2007). With a combination of both 

black and white, and vivid coloured photographs, the 

images in Moffatt�s series Something more (1989) have 

become iconic. Drawing on the aesthetic of 1950s B-grade 

movies, they are glossy, dramatic and exaggerated, with 
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overtly painted backdrops and staged props. The pictures 

tell the tale of a young woman�s search for something 

more from life. In the �rst image we see the face of the 

central character (Moffatt) who dreams of life in a big 

city, somewhere far from her current small town existence 

(see �gure 11.5A on page 186). In the eight images that 

follow we never see her face again, but a strange and 

surreal story of intimacy and violence unfolds through varied 

positions of her body, juxtaposed with other characters and 

props, presented like movie stills. Using unusual crops and 

compositions, Moffatt provides enough clues for viewers to 

infer that our heroine comes to a tragic end; but, between 

each image, her ambiguous depictions leave plenty of room 

for imaginations to run wild. Never realising her dreams, the 

�nal picture �nds the central character face down on the 

road, unkempt and still 300 miles from Brisbane.

Moffatt rarely delivers the resolved, happy ending 

that viewers anticipate. In Scarred for life (1994) and 

Scarred for life II (1999) she relays ordinary, yet tragic, 

occurrences. For those pictured, the in�uential years of 

childhood and adolescence are tarnished by scenarios 

and incidents that will last in the mind for a lifetime. 

Their stories are familiar and an audience can instantly 

sympathise. Parents scold and reprimand their children for 

not conforming to stereotypes, fearing what the neighbours 

will think, and problematic situations such as domestic 

violence, neglect, humiliation, cruelty and psychological, 

verbal and physical abuse are depicted. The images are 

presented like classic photojournalism, laid out on a page 

with captions in the style of a 1960s Life magazine. The 

text directs viewers� readings of each picture that might be 

interpreted quite differently without the caption.

Figure 12.6B  

Tracey Moffatt 

Useless, 1974, 1994 

Off set print 

80 × 60 cm 

Series of 9 images 

Edition of 50 

Roslyn Oxley9 Gallery
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Moffatt�s series Up in the sky (1997) explores themes 

of race, power and violence. Set in the dry, deserted 

Australian outback (that could almost be the American 

South) the images are cinematic and, once again, the 

audience is invited to � ll in the gaps of the disjointed 

narrative. Outcasts crawl the streets, nuns march in to 

steal an Aboriginal child, a cow hangs heavy on the branch 

of a tree, caught in the bright-headlights of a car, and 

men brawl on a dirt road; but all of these events look 

choreographed, rather than documented.

Appearing even more � lmic, Invocations (2000), 

meaning to summon for help (usually supernatural forces, 

like God or magical spirits), is a dream-like sequence 

of the supernatural, mystical fantasies and inexplicable 

drama. Unrelated stories of a young black girl and a black 

woman appear to run parallel, but perhaps they are woven 

together � the story of a girl who later becomes a woman. 

The events are open to interpretation, but the ending does 

not appear to be a happy one. Again, it could be set in 

Australia or the American South. Black magic, spirits 

and the mysterious reign; a child who appears to 

be abandoned in the eerie dark woods with witches, 

animated trees and wild dogs, wakes and happily skips 

along, while in other depictions the woman is attacked by 

ravens and overpowered by dominating men.

In� uenced by the art of Goya, as well as suburban, 

popular culture of the 1960s, Moffatt recreated the 

scenes from dreams she�d had four years prior to 

making this series. She drew up elaborate storyboards 

of her visions, carefully detailing sets, costumes and 

painterly backdrops. The photographs were then made 

on a specially constructed set in New York, with actors 

and animals. After the photographs were scanned and 

computer manipulated, a specialist screen printer then 

printed the 13 multicoloured screens by hand, each colour 

layered separately on top of the previous one, achieving 

the desired painterly effect. The � nal works are presented 

in round, oval and rectangular shapes, like the 1960s� Walt 

Disney animation classics that Moffatt regards so highly.

When Moffatt narrowly missed being selected as an 

of� cial photographer for the 2000 Sydney Olympics, she 

stayed at home and photographed the events on her 

television screen. Fourth (2001) portrays athletes who 

� nished fourth in their event, the signi� cance of their 

achievement virtually ignored as the � rst three place-winners 

were thrust into the limelight. Moffatt�s scenes are printed 

in mute colour with the athlete who came fourth highlighted.

In 2003, Moffatt returned to Brisbane for a residency at 

the Institute of Modern Art (IMA) and made her Adventure 

series (2004). These images were inspired by a comic 

Figure 12.6C 

Tracey Moffatt

Up in the 

sky #1, 1997

Off set print

61 × 76 cm

72 × 102 

paper size

Series of 

25 images

Edition of 60

Roslyn Oxley9 

Gallery
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strip that was run in a Brisbane newspaper when she 

was a child, about �ying doctors, as well as the 1970s� 

Australian sea-adventure television show The rovers. 

Moffatt recreates the thrill and escapism of these alluring 

action series, with eroticism, violence and power games all 

at play in her overtly constructed reality. Spending a long 

time searching for the right actors, live animals, costumes 

and props for this shoot, she again cast herself in one of 

the roles (see �gure 12.6E, top left-hand image). She hired 

a graphic artist in Brisbane to paint the backdrops and a 

stylist from Sydney for hair and make-up. The photo shoot 

was followed by extensive Photoshop manipulation of the 

images, which are placed together in groups of three to 

be read like a comic strip. Again, Moffatt is a storyteller, 

using a disjointed narrative. The images both celebrate 

and parody this type of action drama, and highlight the 

in�uence of mass media.

Moffatt has never settled into a rut; each new series 

she makes is very different in style and approach to 

the one that came before. Her proli�c career explores 

countless ways to communicate and convey her ideas and 

stories. The technical aspects and craft of her media are 

not important for her. While she directs and supervises 

the work, she employs technicians and specialists for 

each particular series to carry out various skilled tasks, 

providing her the freedom to render her visions in varied 

and diverse media.

Moffatt is a storyteller, examining contemporary issues 

and relevant concerns that are shared across diverse 

places and different cultures. Often referencing �lm or 

art history, her ambiguous tales explore complicated 

relationships and universal themes that go beyond any 

one race, culture, society or lifestyle. Her images are 

contemporary, cynical, humorous, sexy and compelling; 

Figure 12.6D  

Tracey Moffatt 

Invocations #5, 2000  

Photo silkscreen 

146 × 122 cm 

Series of 13 images 

Edition of 60 

Roslyn Oxley9 Gallery
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they are easy to empathise with and relate to because 

of their pop-culture style and kitsch, staged themes; but 

she never proscribes one single reading of her work; 

instead, she leaves space for contemplation, and for 

viewers to question and project their own thoughts and 

interpretations.

Figure 12.6E  

Tracey Moffatt 

Adventure series 2, 2004  

Colour print on Fuji�ex paper 

132 × 114 cm 

Edition of 60 

Roslyn Oxley9 Gallery
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activities

1. How do you think Moffatt�s childhood affected her life  

as an artist?

2. What do you think Moffatt was trying to communicate  

about her world in her 1989 series Something more  

(see �gure 11.5A on page 186)?

3. What is your own personal reaction to Moffatt�s image 

Useless, 1974 (see �gure 12.6B) from her Scarred for life 

(1994) series?

4. Go to the Roslyn Oxley9 Gallery website and view Moffatt�s 

Scarred for life (1994 and 1999) series. What do these 

images tell us about the world in which she lived?

5. Moffatt never proscribes one single reading of her work, 

she leaves them open to interpretation. With this in mind, 

look closely at Moffatt�s Up in the sky #1, 1997 (see 

�gure 12.6C) artwork and write your own personal, creative 

interpretation of this artwork. Once completed, compare it to 

the interpretations done by other members of the class.

6. Search the internet for an image by Francisco Goya that 

demonstrates a connection to Moffatt�s Invocations #5, 2000 

(see �gure 12.6D). Provide a copy of the artwork and discuss 

what elements of the image may have in�uenced Moffatt in 

the development of her work.

7. Outline how Moffatt approached producing her Adventure 

series, 2004 (see �gure 12.6E). Discuss her working  

method including materials and techniques used.

8. As in the Adventure series, 2004 (see �gure 12.6E), Moffatt 

often employs technicians to perform most of the technical 

aspects of her image making, including photographers, 

computer imaging (Photoshop) experts, graphic designers 

and specialist printers. This is a far cry from Ansel Adams, 

who believed that the taking and printing of a photograph 

was a signi�cant role of the artist and an essential aspect 

of the art making process. What do you think about Moffatt 

using technicians to assist her in creating her artworks?

9. Moffatt is motivated by her own life, her thoughts, 

imagination, opinions and beliefs. Her artwork is an 

emotional response to her world and experiences.  

Select an artwork by Moffatt that demonstrates her 

personalised approach to image making. Analyse the  

artwork (use the proforma on page 159 to assist you)  

to provide evidence of her subjective approach.

Where possible, use the internet to look up and view additional 

photographs by Tracey Moffatt (login to www.jacplus.com.au to 

locate the weblinks for this chapter).
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 13.1  Portraits

Figure 13.1A  

Butter�y scales,  

Jessica Minear, Year 12, 

digital photograph

This is a  

self-portrait, 

taken in the 

midday sun 

under tulle with 

makeup applied 

to the artist�s 

face.
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Figure 13.1B In my dreams I can �y, Veronica Waite, Year 11, digital photograph

This image was taken of the re�ection of a boy in the window of a high-rise apartment block in the city.
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Figure 13.1C Individuality, Rebecca Finney, Year 12, digital photograph

This is a series of three photographs taken in a studio using a tripod and arti�cial light.
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 13.2  LandscaPes

Figure 13.2A Phillip Island, Laura Petrucci, Year 12, digital photograph

This image was taken with a digital camera and then the colour was enhanced in Photoshop using image, adjust, equalise.

Figure 13.2B Seascape, Alice Halpin, Year 12, digital photograph

This image is a combination of numerous different photographs. The various components have been photographed 

separately, selected and imported into the composition using Photoshop.
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Figure 13.2C Southbank at night, Elizabeth Logan, Year 12, digital photograph

This photograph was taken at night using a tripod and a slow shutter speed.

Figure 13.2D Day and night, Marina Savenkov, Year 12, digital photograph

This image was constructed from 17 photographs of a cityscape scene, taken over a set period of time.  

A tripod was used to maintain the composition and a separate photograph was taken every half-hour. The various 

components were then placed together using Photoshop.
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 13.3  sHutter sPeed

Figure 13.3A 

It�s only a dream, 

Fiona Scott, Year 12, 

gelatin silver 

photograph

This photograph 

was taken on a 

tripod using a 

B shutter speed. 

The image was 

exposed for 

approximately 

5 seconds, 

with limited light. 

The model moved 

and then held 

position every 

second.

Figure 13.3B Skier sequence, Whistler, Canada, Charles Ferry, Year 12, digital photograph

This photograph was taken using a tripod, fast shutter speed and a high-speed continuous shooting mode. The six 

photographs were opened in Photoshop and the moving � gures were selected and layered on top of the background image 

to form the combined � nal image.
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Figure 13.3C Shadow boxer, Ester Gerrard, Year 12, gelatin silver photograph

This photograph was taken in a studio with limited light, using a tripod, B shutter speed and an exposure  

of approximately 2 seconds.
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 13.4  Focus

Figure 13.4A Close-up of a �ower, Alice Halpin, Year 12, digital photograph

This photograph was taken on a close-up setting (�ower symbol), creating a small depth of �eld.
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Figure 13.4B  

Trees, Emily Russell, Year 12, Infra-red �lm, scanned and 

enhanced with Photoshop

This photograph was taken with infra-red �lm, 

with two red �lters placed on the lens. This 

method creates photographs with unusual tones 

and high grain. It was captured with a small 

depth of �eld. 

Figure 13.4C The fab 4, Jacob de Weger, Year 10, digital photograph

This photograph was taken on a close-up setting (�ower symbol), creating a small depth of �eld.
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 13.5  narratives

Figure 13.5A The horror of it all, Genevieve Brady, Year 12, digital photograph

This image was created from two digital photographs; 

the �rst is of the girl walking down the stairs and the 

second of the shadow. The shadow from the second 

photograph was selected, feathered, scaled and 

placed into the �rst image using Photoshop.
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Figure 13.5B They�re here!, Clair Weller, Year 12, digital photograph

This image was entirely staged and taken using dramatic lighting.
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Figure 13.5C  

Dana, Amiel Courtin-Wilson, Year 11, 

gelatin silver photograph

This photograph was taken 

using bright natural lighting.

Figure 13.5D  

Child, Joe Hurley, Year 12,  

gelatin silver photograph

This image was 

created by sandwiching 

two negatives together 

in the enlarger during 

printing. One of the 

negatives would have 

been of the boy and the 

other of the text.



PART 6 GALLERY OF STUDENT PHOTOGRAPHS232

 13.6  sPeciaL eFFects

Figure 13.6A Ageing, Jessica Healey, Year 12, digital photograph

Two digital photographs were taken in a studio using a 

tripod to capture the models at the same distance and 

using the same lighting. The neck and eyes of the elderly 

woman were selected and feathered and then layered on 

top of the young girl�s face using Photoshop.

Figure 13.6B The car, Marlo Slavin, Year 12, gelatin silver photograph

This image was solarised in the darkroom.

Figure 13.6C Clone, Rhys Grif�ths, Year 12, digital photograph
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Figure 13.6D Making faces, Ruby Carrodus, Year 12, digital photograph

This image was created from the combination of two 

digital photographs. The �rst image was taken of the woman 

knitting, sitting on the chair. Her eyes and mouth were 

removed through cloning and painting in Photoshop.  

The face from the second photograph was selected and 

layered on top of the �rst photograph. It was then scaled 

to �t and merged into the knitting using cloning and eraser 

tools.
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Figure 13.6E Delicensed, Scott Ferguson, Year 6, gelatin silver photograph

This image was produced in the darkroom using a textured screen.

Figure 13.6F My twin sister and eternity, Marina Blank, Year 12, gelatin silver photograph

Both photographs were taken and printed the same size so that when the older portrait was ripped, it matched directly 

with the youthful portrait.
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Figure 13.6G Light in the darkness, Romy Baker, Year 12, digital photograph

Figure 13.6H The market, Chloe Paul, Year 11, ink on gelatin silver photograph

The photograph was printed and processed in the darkroom. The artist then drew on the photograph 

with an ink pen and scratched into it using a needle tool.

Two digital 

photographs 

were taken; the 

�rst of a large 

sign at Luna 

Park, which 

was converted 

to greyscale 

in Photoshop. 

The image was 

then reverted 

back to RGB 

colour before 

the content of 

the sign was 

selected; the 

second coloured 

image was then 

pasted into the 

selection.
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Figure 13.6I Places they don�t belong, Lauren D�Aprano, Year 12, digital photograph

Six different photographs were used to create this image. The photograph of the city was initially opened on the 

computer. Then each of the images of the animals (taken at the zoo) were each selected, feathered and scaled into place 

using Photoshop. Shadows were created under each of the animals to make them appear more realistic.

Figure 13.6J Dreams of a suburban house wife, Eliza Ralph, Year 12, gelatin silver photograph

Although this image may look digital, it was, in fact, captured on � lm. The beater was placed on top of a mirror that was 

positioned on the ground outside. The photograph was then captured through a multivision lens � lter.
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Figure 13.6L  

Cloning, prepare for  

a possible future 2020,  

Frances Anderson, Year 12,  

digital photograph

This image was constructed from 

a variety of digital photographs 

and illustrations merged together 

using Photoshop.

Figure 13.6K  

Two faced,  

Georgina Dempsey, Year 12,  

digital photograph

Two photographs of the 

same model were taken from 

different angles then merged 

together in Photoshop using 

the cloning and eraser tools.
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Figure 13.6M 

Tribute to Ingres, 

Johanna McCubbin, Year 12, 

gelatin silver photograph

The model was photographed in a studio. An image from 

an overhead projector was them beamed onto her. The 

photographer may have used a fast � lm speed (ISO) to 

assist with the limited light available.

Figure 13.6M 

Tribute to Ingres, 

Johanna McCubbin, Year 12, 

elatin silv photograph
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Figure 13.6N The boneyard, Rhys Grif�ths, Year 12, digital photograph
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Figure 13.6O A face, Johanna McCubbin, Year 12, gelatin silver photograph

This image was taken in a studio using arti�cial light.
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General information about 
photography

14.

 14.1  CAREERS IN 

PHOTOGRAPHY
A career in the �eld of photography is generally considered  

to be highly competitive. However, if you are committed, 

motivated, talented and willing to work hard there is no 

reason why you should not �nd success working in this �eld.

There are generally two approaches you can take  

to receive training to become a professional photographer.  

The �rst is on-the-job training, which is often provided 

through internships offered by some newspapers, magazines 

and established photographers.  

The second, and most common, 

method is to complete a photographic 

course at a tertiary institution (see 

section 14.2,page 246).

Although most major companies, 

businesses and advertising agencies 

employ photographers fulltime, many 

photographers choose to be self-

employed. These photographers 

freelance and gain their salaries 

from a variety of jobs provided 

by advertising agencies, graphic 

design studios, retail manufacturers, 

architects, publishing companies and 

the community (such as portraits and 

wedding photographs).

Some photographers specialise in 

selected photographic areas. Some 

of these areas are listed and brie�y 

explained in this section.

Commercial photography
A commercial photographer can work for a company,  

have their own small business or work independently 

as a freelance photographer. They are generally skilled 

enough to handle almost any type of photographic 

assignment and will often �nd themselves working  

on a diverse range of projects.

Commercial photographers must show initiative, 

self-motivation, ingenuity and creativity. They have 

generally completed at least a three-year course  

in photography.

Figure 14.1A A commercial photographer at work
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Independent artist � fine art
Fine art photographers work as independent artists, 

exploring artistic ideas in the medium of photography. 

They are generally self-employed and may have 

an agent or gallery representing them. Fine art 

photographers display and sell their work through 

exhibitions. These photographers seldom rely on �ne 

art photography as their only income and may also 

work as commercial photographers.

Fine art photographers should demonstrate a 

creative, imaginative, original and artistic approach to 

the photographic medium. Although an education in 

photography is not mandatory, completing a course in 

the art of photography would be an advantage.

Portrait, wedding and home 
study photography
Portrait, weddings and home study photographers 

generally work for themselves or are involved in a 

small business. They specialise in photographing 

and recording images for the public. These can 

include personal and family portraits, debutantes, 

engagements, weddings and christenings. Until recently 

the role of these photographers was seen as purely 

documentation; however, over the past few years many 

of these photographers have taken a much more 

creative and imaginative approach when recording  

their images.

This profession generally requires some kind 

of photographic education, such as a diploma or 

Bachelor of Art majoring in photography and a  

creative �air combined with an aptitude  

for working with people.

Photojournalism and  
newsreel photography
Photojournalists are responsible for documenting, 

recording and communicating current affairs issues 

through their photographs. Most choose to work for 

selected newspapers and magazines, or freelance and 

sell their photographs to many different companies.

Photojournalists who work for large newspapers 

and magazines may choose to specialise in sport, 

entertainment, politics, business or foreign affairs. 

Photojournalists who work for smaller papers may 

need to take a large variety of photographs and 

may even do some journalistic work. In most cases, 

photojournalists have completed a photographic 

course. It is important that these photographers 

display initiative, an inquiring mind, be interested in 

current affairs issues and demonstrate a creative 

approach to documenting images.

Fashion photography
Fashion photographers are responsible for photographing 

images which relate to the fashion industry, including 

clothing, jewellery, fabrics and accessories. They are 

generally employed by a newspaper, magazine or fashion 

house, or they may be freelance.

Whether they are taking photographs for the local 

newspaper, a fashion parade in Paris, or the latest 

collection from a designer, these photographers need 

to demonstrate ingenuity and a creative �air. Fashion 

photographers must know and understand fashion, keep 

up to date with current trends and be aware of future 

trends. Most will have completed a photographic course.

Advertising photography
Advertising photographers are responsible for 

photographing a broad range of goods to assist in the 

promotion and sale of products. They generally work for 

an advertising agency and are required to demonstrate  

a high degree of creativity, imagination and ingenuity.

Advertising photographers must be experts in their 

�eld, have a thorough knowledge of photographic 

approaches and procedures and will need to use 

computer-aided photographic techniques. They have 

generally completed a comprehensive photographic 

course.

Industrial photography
Industrial photographers are responsible for recording 

images for major companies and businesses. These 

images include photographs of factories, mines, oil�elds, 

machines and machine parts, as well as images of 

workers. The photographs are used in pamphlets, 

brochures and annual reports to promote the industry. In 

addition to taking photographs, industrial photographers 

may also be required to produce staff training �lms or 

DVDs that will assist with sales, marketing and public 

relations.

Most industrial photographers have undertaken  

a three-year photographic course.

Medical photography
Medical photographers record images for use in medical 

practice. These images can be important aids in the 

diagnosis and evaluation of medical conditions, and may 

be used in the training and education of hospital staff.

Medical photographers may need to be pro�cient in 

the use of technically advanced cameras, as well as 

digital, �lm and DVD equipment. These photographers 

must be trained in aspects of anatomy and medicine in 

addition to photography. Some colleges and universities 

offer specialist courses in medical photography.
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Scientific photography
Scienti�c photographers document and record  

images relating to research and scienti�c experiments. 

This kind of work may range from microscopic images  

of animal tissues, cells and insects, to photographs  

of distant stars and planets.

The photographer in this profession must have a 

combined scienti�c and photographic education.

Marine and underwater 
photography
Marine photographers capture and record the 

underwater world for biological research and industrial 

inspections, and document shipwrecks and other 

historical artefacts. Many of their photographs also 

portray the beauty of the ocean�s depths.

A marine photographer must have a passion for water 

and the ocean, be a pro�cient diver, hold a commercial 

diver�s certi�cate and be trained as a photographer. It 

is also advisable to have an extensive understanding of 

marine life and/or be a certi�ed operator of underwater 

inspections and surveys to be able to undertake the 

many jobs required of underwater photographers.

Travel photography
Travel photographers capture and record images  

of holiday destinations and attractions. These images 

are generally used for promotional purposes in airline 

journals, brochures and travel features in newspapers 

and magazines. Travel photographers are generally 

employed by airlines, travel agencies, newspapers  

and magazines as well as holiday destinations,  

such as resorts.

These photographers must have a love of travel  

and a creative approach to the documentation of holiday 

locations. Most travel photographers have undertaken 

a three-year course in photography. Some may also be 

journalists who combine their photographs with travel 

and holiday articles they have written.

Radiography
The most common role of a radiographer is to take 

X-rays of teeth and bones. However, radiographers 

also work in industrial environments where they 

diagnose faults in the casting and welds of equipment, 

aircraft and machinery. They are able to test industrial 

manufacturing equipment and metal fatigue in aircraft 

and other machinery through the use of X-ray images.

Some colleges and universities offer specialist 

courses in radiography.

Police forensic photography
Police personnel are given the opportunity to specialise 

as photographers after they become a member of the 

police force. The role of the police photographer is to 

record images from crime scenes, such as �ngerprints, 

weapons and suspects, that will assist the police with their 

investigations. Police photographers are also called upon 

to document forensic evidence, car accidents, and assault 

and murder victims, as well as criminals.

Military photography
The airforce is the only division of the armed forces that 

offers members a career in photography. The RAAF initially 

requires a recruit to undergo 10 weeks of general basic 

training, followed by 42 weeks of specialist training in 

the �eld of photography. The photographic work is largely 

technical, with very little creativity required. Airforce 

photographers document different aspects of aircraft 

machinery and equipment, including recording technical 

faults. They are also required to photograph aerial 

views that aid in creating military maps and assist with 

reconnaissance work.

Aerial photography
Aerial photography requires the photographer to take 

photographs from the air. There are two main types of 

aerial photographs. Photographs for general industrial 

and commercial use are often taken by a commercial 

photographer through the window of an aircraft. These 

photographs are normally aerial views of buildings, 

factories, shopping centres and farms. The second type of 

aerial photography requires the image to be taken directly 

above the subject. These photographs are generally taken 

with an automatic camera placed underneath the aircraft. 

The camera is operated by a remote control. This type 

of photography is widely used as a tool in surveying, 

precision map making, and planning routes for highways 

and power lines.

Cinematography
A cinematographer is responsible for �lming movies. 

Cinematographers are accountable for the lighting and 

aesthetic qualities of the �lm, including the composition, 

focus and depth of �eld of each shot, as well as the 

technical aspects of the shoot, such as the type of �lm, 

lenses and �lters used.

There are two ways to become a cinematographer. The 

�rst is to work your way up to the position, beginning as 

a clapper loader, then working as a camera assistant, 

advancing to camera operator and eventually becoming 

director of photography. The second way is to complete a 

course in �lm making and specialise in cinematography. 
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The Australian Film, Television and Radio School in Sydney 

offers a three-year bachelor course and postgraduate 

extension course in the art of cinematography. The 

Victorian College of the Arts also offers a �lm-making 

course with the option to specialise in cinematography.

Film stills photography
A �lm stills photographer is generally employed on a 

�lm set to document the �lm-making process and record 

images of the �lm being made. After consulting with the 

cinematographer, they also take still photographs that  

record images from the �lm. These photographs are used  

to publicise the �lm and appear on posters and video 

covers, and in magazines and newspapers.

Film stills photographers generally have some 

photographic training and are often freelance 

photographers or are employed by a production company.

Digital imaging specialist
Computers and digital photography have led to the creation 

of career opportunities in digital imaging. The role of a 

digital imaging specialist can vary and includes everything 

from scanning �lm to downloading digital photographs, 

as well as enhancing, manipulating or combining images 

using computer software programs like Photoshop. 

Although some digital imaging specialists also work as 

photographers, it is not essential that they take the initial 

photographs themselves; such specialists often work 

alongside a photographer and/or art director to create  

a �nal image. Some imaging specialists are also expected 

to be able to produce design and layout work and, as 

a result, are expected to have knowledge of desktop 

publishing software programs such as Illustrator, Quark 

and InDesign. Digital imaging specialists need to have 

a passion and talent for computer-generated imagery, a 

strong visual awareness, advanced knowledge of digital 

software, colour and �le management, as well as skill in 

the calibration of computer and printing equipment. Most 

TAFE colleges and universities now offer certi�cates and 

degrees in digital imaging.

Photo-finishing
A wide range of employment opportunities and careers 

exists in the photo-�nishing area. Commercial laboratories 

offer a range of jobs that require a variety of skills, such 

as receipt or dispatch clerk, process or printing operator, 

quality controller, retoucher and customer relations of�cer. 

These positions are usually available in large commercial 

laboratories such as Kodak, small minilabs, or professional 

custom processing laboratories and computer bureaus.  

The positions are normally advertised in the employment 

section of newspapers and, in most cases, on-the-job 

training is provided. Frequently, it is a matter of starting 

at the bottom and working your way up to the more highly 

skilled positions.

Figure 14.1B  

A digital imaging 

specialist at work
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Teaching photography
After completing a three-year fulltime course in 

photography and receiving a bachelor degree, you may 

choose to complete an additional one-year postgraduate 

degree in education, enabling you to teach photography  

in secondary schools and some TAFE courses.

Other careers in photography
There are many other careers available in �elds  

relating to photography, including: darkroom technician; 

assistant photographer; photographic restorer; 

photographic conserver; laboratory and processing 

assistant; printing technician; photographic stylist; 

photographic framer; equipment supplier; equipment 

repairer; camera operator; �lm editor; studio engineer; 

animator; art director; special effects; and graphic artist.

 14.2  AUSTRALIAN 

PHOTOGRAPHIC 

COURSES
There are a variety of photographic courses available.  

Most institutions offer full- and part-time courses. These 

range from certi�cate to associate diploma, diploma, 

bachelor, masters and other postgraduate studies in 

photography. The courses vary considerably. Some courses 

specialise in the technical aspects of the medium, 

while others concentrate more on a creative and artistic 

approach. It is therefore important for you to research 

the courses offered and �nd the one most suitable  

for you.

Prerequisites
Entry to tertiary studies is usually based on:

1. a folio of the student�s work

2. an interview

3. secondary school results.

Folio of the student�s work
Your folio should demonstrate a variety of creative  

and imaginative approaches to photography and reveal  

a high level of technical skill. It should consist of at  

least 15 photographs demonstrating a diverse range  

of ideas and techniques. You may also include works in 

other media, such as a short �lm, drawings and paintings. 

The quality of your folio work is important, so be selective.

Be prepared to discuss the work in your folio at length, 

mentioning in�uences and the processes and techniques 

used, as well as the problems and outcomes of each 

piece.

The interview
Make sure that you are well prepared for the interview.  

Ask your teacher to look through your folio and help you 

research the course. It will help if you practise answering 

questions, so have a friend conduct a mock interview  

with you.

The qualities that institutions generally look for in 

prospective students are:

� an ability to complete the course to a high level

� commitment and understanding of the requirements  

of the course

� a willingness to learn

� demonstration of a realistic and passionate attitude 

towards a future working in photography.

During the interview these qualities are generally 

revealed through one or more of the following:

� a good folio which demonstrates creativity  

and technical skill

� the expression of your ideas, including an explanation 

of where your ideas came from and how you went 

about exploring them

� thinking skills � you will be judged on how you 

answer questions, so take the time to think about 

your answers

� knowledge of artists � the interviewer will be 

interested in the artists you have studied, the ones 

you admire and those who in�uence you. They may 

also like to know about any photographic exhibitions 

that you have visited.

� knowledge of the photographic industry and career 

options � familiarise yourself with section 14.1

� knowledge of photographic courses offered in  

your state � become aware of the similarities and 

differences between courses and visit institution 

open days.

Questions that may be asked during the  

interview include:

� Why do you want to be a photographer?

� What kind of photographer do you want to be?

� Why are you applying to this institution?

� What do you know about the course?

� What will you do if you miss out on selection?

� What kind of photography do you like the most? Why?

� Which photographers do you admire? Why?

� Which exhibitions did you go to this year? What did you 

think of them?

Secondary school results
Most courses require the successful completion of 

Year 12, with a reasonable result in English. The majority 

of courses do not have art and/or photography as 

prerequisites; however, these subjects will increase your 

understanding of the visual arts and bene�t you in the 

development of your folio.
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Tertiary photographic courses
Photography courses are currently available at the 

institutions listed below. For course details, special entry 

provisions and credit transfer between courses, contact 

the administration of�ce of the individual institution. 

Course details can also be obtained from university and 

TAFE websites. Tertiary entrance information can be found 

in each state�s tertiary requirements and entry guide to 

university and TAFE courses. This information is commonly 

available from TAFE and university websites.

Australian Capital Territory

school of art & centre for new media

Australian National University

Childers Street

Canberra ACT 2601

Websites: www.anu.edu.au/art

 www.anu.edu.au/newmedia

university of canberra

University Drive 

Bruce ACT 2617

Website: www.canberra.edu.au

canberra institute of technology

Reid Campus

Canberra ACT 2601

Website: www.cit.act.edu.au

Northern Territory

charles darwin university

Casuarina Campus NT

Alice Springs Campus

Darwin NT 0909

Website: www.cdu.edu.au

Queensland

griffith university

Queensland College of Art

Grey Street

South Bank Qld 4101

Website: www.grif�th.edu.au/qca

griffith university � gold coast campus

Queensland College of Art

Parkland Drive

Southport Qld 4215

Website:  www.grif�th.edu.au/visual-creative-arts/

queensland-college-art

university of the sunshine coast

Faculty of Arts and Social Services

Maroochydore DC Qld 4558

Website: www.usc.edu.au

james cook university of north queensland

Department of Art and Design

Townsville Qld 4810

Website: www.jcu.edu.au

south bank institute of tafe

Clearview Terrace

Morningside Qld 4170

Website: www.southbank.tafe.net

southern queensland institute of tafe

100 Bridge Street

Toowoomba Qld 4350

Website: www.sqit.tafe.qld.gov.au

New South Wales

the university of sydney

Parramatta Road

Broadway NSW 2006

Website: www.usyd.edu.au

national art school

Forbes Street

Darlinghurst NSW 2010

Website: www.nas.edu.au

southern cross university

Coffs Harbour Campus

Lismore Campus

Tweed Gold Coast Campus

Website: www.scu.edu.au

university of nsw (unsw)

Collage of Fine Art (COFA)

Cnr of Oxford Street and Greens Road

Paddington NSW 2021

Website: www.cofa.unsw.edu.au

university of newcastle

Newcastle (Callaghan) Campus 

Central Coast (Ourimbah) Campus

Website: www.newcastle.edu.au

university of technology sydney

Faculty of Design, Architecture & Building

702�730 Harris Street

Ultimo NSW 2007

Website: www.uts.edu.au

australian catholic university

40 Edward Street 

North Sydney NSW 2060 

Website: www.acu.edu.au

sydney college of the arts

The University of Sydney

Rozelle Campus

Balmain Road

(enter opposite Cecily Street)

Rozelle NSW 2039

Website: www.usyd.edu.au

australian film, television and radio school

Cnr Epping and Balaclava roads

North Ryde NSW 2113

Website: www.aftrs.edu.au
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charles sturt university

Albury Campus

Albury NSW 2640

Website: www.csu.edu.au/faculty/arts/vpa

university of western sydney

Penrith South DC NSW 1797

Website: www.uws.edu.au

university of wollongong

North�elds Avenue

Wollongong NSW 2522

Website: www.uow.edu.au

Regional centres

tafe nsw hunter institute

Faculty of Arts and Media

590�608 Hunter Street

Newcastle West NSW 2302

Website: www.hunter.tafensw.edu.au

tafe nsw � northern sydney institute

Art, Media and Design

213 Paci�c Highway

St Leonards NSW 2065

Website: www.tafestudy.info

South Australia

south australian school of art

University of South Australia

Adelaide SA 5001

Website: www.unisa.edu.au/art

tafe sa

Croydon Campus 

Goodall Avenue

Croydon Park SA 5008

Website: www.tafe.sa.edu.au

adelaide centre for the arts 

39 Light Square

Adelaide SA 5000

Website: www.tafe.sa.edu.au/aca

Tasmania

university of tasmania

Tasmanian School of Art

Hobart Tas. 7001

Website: http:// fcms.its.utas.edu.au/arts/artschool

institute of tafe tasmania

Design and Multi Media

Launceston Tas. 7250

Website: www.tafe.tas.edu.au

Victoria

university of melbourne

Website: www.unimelb.edu.au

victoria university

City Flinders Campus

St Albans Campus

Website: www.vu.edu.au

victorian college of the arts

234 St Kilda Road

Southbank Vic. 3006

Website: www.vca.unimelb.edu.au

rmit

School of Creative Media

Melbourne Vic. 3001

Website: www.rmit.edu.au/creativemedia

monash university

Faculty of Art and Design

900 Dandenong Road

Caul�eld East Vic. 3145

Website: www.artdes.monash.edu.au

swinburne university of technology

Faculty of Design

144 High Street

Prahran Vic. 3181

Website: www.swin.edu.au/design

australian catholic university

115 Victoria Parade 

Fitzroy Vic. 3065 

Website: www.acu.edu.au

deakin university

Melbourne Campus at Burwood 

Geelong Campus at Waurn Ponds

Warrnambool Campus

Website: www.deakin.edu.au

la trobe university bendigo

Edwards Road

Bendigo Vic. 3550

Website: www.latrobe.edu.au/bendigo

university of ballarat

Arts Academy

Ballarat Vic. 3350

Website: www.ballarat.edu.au

chisholm institute

Creative Arts

121 Stud Road

Dandenong Vic. 3175

Website: www.chisholm.edu.au

chisholm institute

Creative Arts

Frankston Campus

Fletcher Road

Frankston Vic. 3199

Website: www.chisholm.edu.au
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box hill institute of tAfe

465 Elgar Road

Box Hill Vic. 3128

Website: www.bhtafe.edu.au

gordon institute of tAfe

Geelong Mail Centre 

Geelong Vic. 3221

Website: www.gordontafe.edu.au

northern melbourne institute of tAfe

77�91 St Georges Road

Preston Vic. 3072

Website: www.nmit.vic.edu.au/courses/art_design

Western Australia

western AustrAliAn school of Art  

design And mediA

Central TAFE

12 Aberdeen Street

Perth WA 6000

Website: www.central.wa.edu.au

curtin university of technology

Kent St

Bentley WA 6845

Website: www.curtin.edu.au

In addition to the courses at the above institutions, 

a large number of privately run photographic courses 

are available. Some of these offer accredited 

certi�cate and diploma courses. However, these 

courses tend to be very expensive and it is important 

that you research the school to �nd out exactly what 

you will get for your money before committing to a 

course. Most of these schools can be found in the 

Yellow Pages.

 14.3  AUSTRALIAN 

PHOTOGRAPHIC 

GALLERIES
There are many galleries throughout Australia that 

stage a variety of photographic exhibitions. You 

can �nd information about these exhibitions from 

advertisements in local newspapers and from the 

magazine Art Almanac. By visiting galleries and 

viewing photographic exhibitions, you can educate 

yourself about current photographic trends and 

become aware of the diverse range of approaches 

taken. You will also learn about the different ideas 

explored and gain motivation and possible inspiration 

for your own work.

A few of the major galleries that exhibit photographic 

artworks are listed below.

Australian Capital Territory

Public galleries

nAtionAl gAllery of AustrAliA

Parkes Place

Parkes ACT 2600

Phone: (02) 6240 6411

Website: www.nga.gov.au

nAtionAl portrAit gAllery

Old Parliament House

King George Terrace

Parkes ACT 2600

Phone: (02) 6270 8236

Website: www.portrait.gov.au

cAnberrA contemporAry Art spAce

Gorman House

Ainslie Avenue

Braddon ACT 2612

Phone: (02) 6247 0188

Website: www.ccas.com.au

photo Access

The Huw Davies Gallery

Cnr Manuka Circle and New South Wales Crescent

Grif�th ACT 2603

Phone: (02) 6295 7810

Website: www.photoaccess.org.au

New South Wales

Public galleries

Art gAllery of new south wAles

Art Gallery Road

Sydney NSW 2000

Phone: (02) 9225 1700

Website: www.artgallery.nsw.gov.au

museum of contemporAry Art

140 George Street

The Rocks NSW 2000

Phone: (02) 9252 4033

Website: www.mca.com.au

Figure 14.3A Museum of Contemporary Art
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257 Oxford Street

Paddington NSW 2021

Phone: (02) 9331 6253

Website: www.acp.org.au

Regional public galleries

�������� �������� ��� �������

70�78 Keppel Street

Bathurst NSW 2795

Website: www.bathurst.nsw.gov.au

������� �������� �������

36 Webb Street

East Gosford NSW 2250

Website: www.gosfordregionalgallery.com

Commercial galleries

����� ������� �������

88 George Street 

Redfern NSW 2016 

Phone: (02) 9318 0404

Website: www.byronmcmahongallery.com.au

������ �������

36 Gosbell Street

Paddington NSW 2021

Phone: (02) 331 7775

Website: www.stillsgallery.com.au

������ ������ �������

8 Soudan Lane

(off Hampden Street)

Paddington NSW 2021

Phone: (02) 9331 1919

Website: www.roslynoxley9.com.au

Queensland

Public galleries

���������� ��� ������� � ������� �� ������ ���

Stanley Place

South Bank Qld 4101

Website: www.qag.qld.gov.au

���������� ������ ��� �����������

33 Oxford Street

Bulimba Qld 4171

Website: www.qcp.org.au

Regional public galleries

���� ����� ���� ��� ������

135 Bundall Road

Surfers Paradise Qld 4217

Website: www.gcac.com.au

��������� �������� ��� �������

22 Omrah Avenue

Caloundra Qld 4551

Website: www.caloundra.qld.gov.au/CaloundraGallery

Commercial art galleries

����� ������� ���������

482 Brunswick Street

Fortitude Valley Qld 4006

Website: www.libbyedwardsgalleries.com/

��� ������ �������

486 Brunswick Street

Fortitude Valley Qld 4006

Website: www.janmurphygallery.com.au

��� ������� ��������

Marina Mirage

Seaworld Drive

Main Beach Qld 4217

Website: www.art-galleries-schubert.com.au

Victoria

Public galleries

�������� ������� �� ��������� �������������

180 St Kilda Road

Melbourne Vic. 3004

Phone: (03) 8620 2222

Website: www.ngv.vic.gov.au/ngvinternational

�������� ������� �� ��������� ���������

The Ian Potter Centre

Federation Square

Cnr Russell and Flinders Streets

Melbourne Vic. 3000

Phone: (03) 8620 2222

Website: www.ngv.vic.gov.au/ngvaustralia

������ ��� ������������ �����������

404 George Street

Fitzroy Vic. 3065

Website: www.ccp.org.au

Public regional galleries 

������ ������� �� ���

860 Ferntree Gully Road

Wheelers Hill Vic. 3150

Website: www.mga.org.au

������� ��� �������

Bridge Street 

Benalla Vic. 3672

Phone: (03) 5762 3027

Website: www.benallaartgallery.com
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Figure 14.3C Art Gallery Schubert

Figure 14.3B Gallery of Modern Art, Brisbane
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geelong art gallery

Little Malop Street

Geelong Vic. 3220

Phone: (03) 5229 3645

Website: www.geelonggallery.org.au

bendigo art gallery

195�229 Lyttleton Terrace

Bendigo Vic. 3550 

Phone: (03) 5434 6000

Website: www.bendigoartgallery.com.au

warrnambool art gallery

165 Timor Street

Warrnambool Vic. 3280

Phone: (03) 5564 7832

Website:  www.warrnambool.vic.gov.au/Page/Page.

asp?Page_Id=77

Figure 14.3D National Gallery of Victoria, International

Figure 14.3E Flinders Lane commercial gallery
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Commercial galleries

arc one gallery

45 Flinders Lane

Melbourne Vic. 3000

Phone: (03) 9650 0589

Website: www.arc1gallery.com

metro 5 gallery

1214 High Street

Armadale Vic. 3143 

Phone: 03 9500 8511

Website: www.metro5gallery.com.au

flinders lane gallery

137 Flinders Lane

Melbourne Vic. 3000

Phone: (03) 9654 3332

Website: www.�g.com.au

South Australia

Public galleries

art gallery of south australia

North Terrace

Adelaide SA 5000

Website: www.artgallery.sa.gov.au

contemporary art centre of south australia

14 Porter Street

Parkdale SA 5063

Website: www.cacsa.org.au

Commercial galleries

the centre for creative photography

138 Richmond Road

Marleston SA 5033

Website: www.theccp.com.au

Figure 14.3F Art Gallery of South Australia
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greenaway art gallery

39 Rundle Street

Kent Town SA 5067

Website: www.greenaway.com.au

hill smith gallery

113 Pirie Street

Adelaide SA 5000

Website: www.hillsmithgallery.com.au

Tasmania 

Public galleries

tasmanian museum and art gallery

40 Macquarie Street

Hobart Tas. 7000

Website: www.tmag.tas.gov.au

Regional galleries

devonport regional gallery

45�47 Stewart Street

Devonport Tas. 7310 

Website: www.devonportgallery.com

Alternative art spaces

regional arts online

Website: www.tasregionalarts.org.au

Western Australia

Public galleries

the photography gallery  

of western australia

91 Brisbane Street

Perth WA 6865

Phone: (08) 9227 6620

Website: www.pcp.org.au

perth institute of contemporary arts

Perth Cultural Centre

James Street

Northbridge WA 6844

Phone: (08) 9228 6300

Website: www.pica.org.au

moores building 

Contemporary Art Gallery

46 Henry Street

Fremantle WA 6160

Website:  www.fremantle.wa.gov.au/things2c/html/ 

moores_art_gallery.cfm

Alternative art space

perth centre of photography

91 Brisbane Street

Perth WA 6865

Website: http://pcp.org.au

 14.4  RECOMMENDED 

MATERIALS
Ilford has a large range of excellent black and white �lm, 

paper and processing chemicals on the market. These 

materials are available from most major photographic 

suppliers. Following is a list of products recommended  

for use when developing skills in the practical aspects  

of photography.

Films

Ilford PAN F Plus produces sharp, �ne-grain images.  

At ISO 50, PAN F Plus gives maximum image de�nition, 

exceptional tonal range and grain that�s practically invisible, 

even under high magni�cation.

Ilford FP4 Plus is a new ISO 125 speed �lm which 

uses Ilford balance emulsion layer technology. Ilford FP4 

Plus exhibits �ne grain and excellent sharpness, without 

sacri�cing ease of use and is the ideal medium-speed �lm 

for all outdoor and studio situations.

Ilford HP5 Plus is a versatile ISO 400 speed �lm 

incorporating �ne grain and exceptional sharpness. 

Ilford HP5 Plus can be exposed under extreme lighting 

conditions and can be rated at a �lm speed of two stops 

or higher than its recommended speed, producing prints 

with �ne grain and remarkable sharpness. It can be 

processed in a wide range of developers.

Ilford 100 Delta Professional incorporates Ilford�s 

proprietary core-shell crystal emulsion technology. Ilford 

100 Delta is the world�s sharpest black and white ISO 

100 speed �lm. Offering many qualities, including excellent 

�ne grain and exposure latitude, 100 Delta produces 

enlargements of exceptional size without loss of detail. This 

�lm features a superb tonal range, making it easy to print 

while producing an excellent rendition of intermediate tones.

Ilford 400 Delta Professional is an ISO 400 black and 

white �lm that offers �ne grain and sharpness. Ilford 400 

Delta Professional uses a unique black and white  

core-shell crystal emulation technology that combines high 

speed with the image quality of an ISO 100 �lm. Ilford 400 

Delta Professional can be processed in a wide range  

of developers and can be pushed to up to twice the  

normal speed.

Ilford SFX 200 is a medium-speed black and white �lm 

for creative photography. It has extended red sensitivity (up 

to 740 nm) and is especially suited for use with a �lter 

to create special effects. Using a very deep red �lter, for 

example the Ilford SFX �lter, skies can be rendered almost 

black, and most green vegetation almost white. Its unusual 

tonal rendition ensures interesting results for a range 

of subjects, including portraits, landscapes, townscapes 

and architecture. Best results are often obtained in bright 

sunshine or in the studio under tungsten lighting.
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Ilford DELTA 3200 PROFESSIONAL������������������

����������������������������������������������������

�������������������������������������������������������������

�������������������������������������������������������������

������������������������������������������������������

�������������������������������������������������������

������������������������11�

Paper
Ilford Multigrade IV RC Deluxe�����������������������

�������������������m����������������������������������

���������������������������������������������������
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����������������������������������������������������

���������������������������������������������������

m�����������������

Ilford Multigrade FB������������������������������������

��������������������������������������������������������
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����������������������������������

Ilford Multigrade RC Xpress���������������������������
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����������������������������������������������������

m������������������1�������������������������������

Ilford Ilfospeed Deluxe���������������������������������
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Ilford multigrade RC cooltone�����������������������
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Ilford multigrade FB warmtone�����������������������
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1k��������������k��������������������

Ilford multigrade IV RC deluxe�����Ilford multigrade IV 

RC portfolio������������������������������������������������
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�������������k�������

Ilford multigrade IV FB �ber��������������������������������
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������������������������������������1k���������������������
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Ilford Ilfobrom galerie FB���������������������������������
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Film chemicals

Film developers
Plus Developer����������������������������������������
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�������������������������������������������������������

���������������������������������������������������������

������������������������

Ilfosol S������������������������������������������������

��������������������������������������������������������

��������������������������������������������������������

����������������������������������������������������������

����������������������������������������������������������

���������������������������������������������������������

�����������

Ilford ID-11 Developer������������������������������

������������������������������������������������������

����������������������������������������������������

��������������11���������������������������������������

������������������������������

Microphen������������������������������������������

�������������������������������������������������������

�����������������������������������������������������

��������������������������m������������������������������
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Perceptol���������������������������������������������
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����������������������������������������������

�������������������������������������������������
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Ilford Ilfotec DD-X��Ilfotec LC29���� Ilfosol S������
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Stop bath
Ilford IN-1 Stop Bath����������������������������������
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��������������

Fixer
Ilford Hypam Rapid Fixer�������������������������������
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Rapid hardener
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Wetting agent
Ilford Wetting Agent��������������������������������������
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Paper chemicals

Paper developers
Ilford PQ Universal Developer��������������������������
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Stop bath
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Toner
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Inkjet digital  
photographic paper  

Ilford Galerie
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student�s name:  class:  

task:  date:  

workbook/journal

���� 

���� ���� ������ ���

���  

������������

Design development 

Brainstorming, research and exploration of  

theme/topic

1.

Record of studio experience 

Analysis of proof sheet/s, trailing of techniques, 

selection and re�nement of image/s

2.

Self-evaluation 

Of completed artwork

3.

Layout/organisation4.

final grade

final piece

���� 

���� ���� ������ ���

���  

������������

Interpretation of aims1.

Appropriate use of design 

Composition, line, shape, tone, texture and colour

2.

Appropriate use of techniques and processes3.

Level of imagination/creativity in �nal piece4.

final grade

additional comments:  

 

teacher�s signature:  

 

 Assessment criteriA sheet: PrActicAl work 
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 student self-evAluAtion sheet 

student�s name:  class:  

task:  date:  

complete the following in your workbook or journal

How much did you enjoy this activity?  

(Circle your response.)

1. ���� 

���� ���� ������ ���

���� 

���

What new skills and/or techniques did you learn to use?  

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

2.

What do you think worked best in your �nished work? 

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

3.

What problems did you face in creating this work and how did you solve them? 

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

4.

How do you rate the quality of your �nished work? 

(Circle your response.)

5. ���� 

���� ���� ������ ���

���� 

���

additional comments:  

 

student�s signature:  
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 Assessment criteriA sheet: AnAlysis of An Artwork 

student�s name:  class:  

task:  date:  

���� 

���� ���� ������ ���

���� 

 ���

���  

������������

Ability to:

introduce the artwork•

describe the artwork•

analyse the working method•

analyse design features•

discuss the meaning and/or 

intention of the artwork

•

Evaluate the artwork•

Expression

Presentation

final grade

additional comments:  

 

teacher�s signature:  
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 Assessment criteriA sheet: comPArAtive essAy 

student�s name:  class:  

task:  date:  

���� 

���� ���� ������ ���

���� 

 ���

���  

������������

Ability to:

introduce the topic•

introduce the artists•

comparison of in�uences•

comparison of style•

comparison of working method•

comparison of artistic intention•

conclusion•

Bibliography

Expression

Presentation

final grade

additional comments:  

 

teacher�s signature:  
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A

advocate:  someone who supports and campaigns  

for others.

aesthetic:  the look of an artwork, the qualities of its 

appearance being pleasing and/or beautiful.

agitate: method used to ensure that photographic paper 

and �lm are evenly and regularly covered by chemicals 

throughout the developing processes. This method uses 

gentle movement of either the �lm development canister 

or the chemical tray.

ambiguous:  open to many and varied possible meanings. 

Sometimes the meanings are dif�cult to work out.

analysing:  the process of evaluating and interpreting 

something.

aperture:  the hole, in or near the lens, through which 

light rays travel onto the �lm and/or digital imaging 

sensor. The size of the hole can be altered by a ring on 

the outside of the lens marked in f-stop numbers. The 

higher the f-stop number, the smaller the hole.

appropriation:  to adapt, reuse and reinterpret an image 

from an existing artwork to produce a new artwork.

artwork:  a creation that expresses an idea and represents 

something of an imaginative and aesthetic nature.

autobiographical:  a story of a person�s life written or 

depicted in an artwork by himself or herself.

avant-garde:  term used to describe artists who are ahead 

of others in the use or creation of new ideas, methods, 

designs or styles.

B

balance:  when the different elements within an artwork 

are evenly distributed, creating a harmonious work.

Bauhaus movement:  a highly in�uential 20th-century 

German school of design, visual art and architecture 

that promoted pure, simpli�ed, unadorned and functional 

design.

black bag:  a light-proof bag made of dark cloth that 

serves as a portable darkroom. The photographer puts 

his or her hands into the bag to load �lm onto a reel, 

then into a developing tank for processing.

burning in:  a way of darkening speci�c areas of a 

photograph using digital software or during the printing 

process.

c

Cibachrome:  high-gloss, vivid-coloured photograph 

produced from a colour transparency (slide) using Ilford 

materials. Also known as Ilfochrome.

CMYK colour:  the best colour mode for printing 

photographic and graphic images. When using CMYK, 

an image is created by the combination of four colours 

C = cyan (blue), M = magenta (red), Y = yellow, and K = 

black. These are the same colours used in printing inks.

collage:  an artwork produced by sticking together various 

elements (including images and/or different media) onto 

a �at surface to produce a creative composition.

composition:  the structure and placement of all the 

components within a picture, including the subject 

matter and design elements.

computer bureau:  a company that offers services to 

the public involving computer-generated imagery (for 

example, scanning, printing and retouching).

concept:  the idea behind an artwork.

conceptualism:  an art movement in which the idea is 

more important than any other aspect of the work, 

particularly craftmanship and aesthetic appeal.

contemplative:  to be re�ective and appear lost in thought.

contemporary:  current, of this time.

contrast:  showing a distinct difference when compared 

with or placed beside another element of the same 

work. Differences are emphasised to heighten an effect.

conventional:  traditional, normal, conservative  

and customary.

cropping:  recomposing a photograph by printing only  

a selected area of a negative. The term also refers to 

the practice of framing out unwanted areas of a subject 

when the photograph is taken or being enhanced with 

digital software.

C-type colour:  the most common professional process 

for producing colour photographic enlargements from 

negative �lm.

cynical:  distrusting and mocking a situation with an 

element of sarcasm.
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d

dada:  a 20th-century rebellious art movement that 

challenged the notion of art by creating artworks that 

made little sense.

daguerreotype:  the �rst photographic process available to 

the general public, invented in 1839.

deception:  to be tricked and misled.

depth:  the illusion of distance in a picture.

depth of �eld:  the distance between the nearest  

and farthest objects that are clearly focused by  

a lens at a given aperture (f-stop).

digital imagery:  computer-aided artwork.

DIN (Deutsche Industrial Norm):  the European 

abbreviation for �lm speed.

dodging:  lightening part of a photograph by shading  

it digitally or during printing in the darkroom.

dioramas:  life-size museum exhibits of animals or birds  

in natural surroundings with painted backgrounds.

dpi (dots per inch):  the output resolution of a printer. 

e

empathise:  to identify with and understand a situation 

and/or person.

enlargement:  a print that is made larger than its negative.

ethnographic photographs:  images made for the purpose 

of scienti�c study, description and classi�cation  

(see �gure 5.4C, page 118).

exposure:  the time taken for an image to appear on a 

photographic �lm, imaging sensor or paper.

f

feathering:  the technique of blurring the edges  

of a selection of a digital image.

feminism:  a movement for the support of women�s rights.

�lm speed:  the sensitivity of a �lm to light (see ISO).

�lmic:  photographic images that re�ect characteristics  

of movies.

�xer:  the chemical used to �x and make a photographic 

image permanent.

focus:  the correct adjustment of a lens to make a clear 

and distinct image.

fogged:  when light accidentally reaches the photographic 

paper or �lm during the development process. Tends to 

make the �lm/paper turn black.

f-stop:  the size of the aperture to which a camera  

is adjusted.

g

grain:  small, separate particles of light-sensitive material 

emulsi�ed and deposited on photographic �lm. The size 

of the particle limits the possible enlargement of the 

image and affects the speed of exposure.

h

hand colouring:  the technique of applying colour to a black 

and white image. This can be done digitally or by hand 

using a variety of colouring agents and techniques.

high key:  a photograph that consists mainly of pale tones.

homage:  to honour and pay respect.

i

Ilfochrome:  see Cibachrome.

infra-red �lm:  �lm that responds to radiated heat rather 

than re�ected light. Using black and white infra-red 

�lm will result in unusual tones appearing in your 

photographs. The normal tones of grass and leaves 

will appear white, skies dark grey, with clouds stark 

white (see �gures 2.5E and 13.4B, pages 52 and 228 

respectively).

inkjet:  a digital printer that produces images by 

electronically spraying tiny jets of ink onto paper. 

input:  transporting an image into the computer (scanning).

ISO:  refers to the sensitivity of a �lm and/or a digital 

imaging sensor to light. A high number ISO (1600) does 

not need a lot of light to achieve correct exposure, 

whereas a small numbered ISO (100) does.

j

juxtapose:  to place side by side or close to.

l

LCD (Liquid Crystal Display):  screen seen on the back  

of most digital cameras.

m

majestic:  grand, regal and of splendour.

menacingly:  to appear threatening.

metaphysical:  abstract ideas that explore what is beyond 

the physical world (for example, spiritual, mystical, 

religious and subconscious worlds).

minimalism:  an art movement that started in the 1960s, 

usually characterised by simplicity and basic abstract or 

geometric shapes; often associated with repetition.

modernism:  a photographic movement of the early  

20th century where artists set out to explore the 

artistic potential of photography by capturing sharp-

focused images from the surrounding world. Modernist 

photographs have a strong emphasis on the design 

elements and are often taken from unusual viewpoints. 

montage:  an image made by combining a number of 

different images.

n

narrative:  an artwork that tells a story.

negative:  a photographic image appearing on developed 

�lm where the tones are reversed (the dark areas appear 

light and the light areas dark). A positive image is 

produced when a photograph is printed from the negative.

new objectivity:  an early 20th-century German art 

movement that opposed the symbolism used by 

expressionist artists in favour of selecting realistic, 

sharply de�ned subject matter.
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new photography: developed from other visual movements 

after World War 1. It promoted a move towards creating 

clear, sharp images that were distinctly photographic.

nostalgia: re�ecting on or desiring a return to the past.

0

opacity: the transparency of an image. An image that is low 

in opacity is highly transparent, whereas an image that is 

very high in opacity is generally not transparent at all.

output: retrieving an image from a computer (printing).

overexposed: occurs when too much light has reached  

the �lm, imaging sensor or photographic paper.

p

paper grade: refers to the light-sensitivity and qualities of 

photographic paper.

pictorialism: a photographic movement of the late 19th 

and early 20th centuries that attempted to emulate 

popular painting styles through capturing soft-focused, 

sentimental and narrative images.

picturesque: an attractive picture created by enhancing 

an element or principle of design (such as colour or 

balance), or leaving out or rearranging part of the 

composition.

pixels: the picture elements in a digital image. These 

elements appear as single square dots of colour that, 

when combined with thousands of others, produce a 

digital image. The more pixels an image contains, the 

higher the quality (clarity) of the image.

pixellation: when the pixels become obvious in a digital 

image and blocks of colour appear. This is normally the 

result of low resolution. There are only a limited number 

of pixel dots per inch and when the image is enlarged 

the pixels become increasingly obvious.

point of interest: the main subject of interest in a 

photograph.

postmodernism: an art movement of the late 20th and 

early 21st centuries that rejects or departs from many 

idealistic visions of 20th-century modernism and allows 

the freedom to explore artistic ideas without having to 

conform to any given technique or style. This movement 

may incorporate, appropriate and refer to a variety of 

classical and historical styles.

ppi (pixels per inch): the number of pixels (dots) per inch 

in a digital image (see resolution).

proli�c: working persistently to produce a great number  

of works.

proof sheet: a print containing miniature images from a 

photographic shoot. Often used by photographers to 

select which photographs to print or work with further. 

Also known as contact sheets. Proof sheets for digital 

photographs can be produced by software, whereas 

proof sheets from �lm need to be produced in the 

darkroom (see pages 38 and 77).

provocative: thought-provoking and challenging.

pure photography: see straight photography.

q

qualities: the successful characteristics, features  

and attributes of a photograph.

r

refute: to not accept and challenge.

reminiscent: remembering and re�ecting on the past.

replica: a copy or reproduction.

resolution: a digital image is made up of many tiny dots 

(pixels). The more pixels per inch, the better the quality 

of the image. These dots and their resulting quality are 

referred to as the resolution of the image.

retouching: improving a photograph or negative by spotting 

it with inks, dyes, paint or using digital software such as 

Photoshop (see page 82).

retrospective: the exhibition of an artist�s body of work, 

generally showing their development over a set period  

of time.

RGB colour: a common colour mode used on PC monitors. 

The colours are made by various combinations of red, 

green and blue. RGB colour is often used when creating 

graphic images. Such images are then often converted 

to CMYK for printing.

romantic: glori�ed and idealistic approach to capturing 

subject matter.

s

safelight: a lamp or a bulb used in a darkroom to 

provide light of a colour or intensity that will not affect 

photographic paper or emulsion.

satire: to criticise something by poking fun at it.

saturation: the colourfulness and intensity of a speci�c 

colour. A highly saturated colour is bright and vivid, 

whereas a low saturated colour appears dull. 

scanning: a way of converting a photograph, negative, 

transparency or object into digital information.  

The information can then be opened on a computer.

scenario: a particualr setting, situation and proposed 

chain of events.

selection: the notion of selecting a particular part of  

a digital image to enhance or import into or onto  

another image.

shutter speed: regulates the length of time a �lm or digital 

imaging sensor is exposed to light through the opening 

and closing of the camera�s shutter.

sinister: creepy and disturbing.

stereotype: to classify and typecast a particular person  

or group.

stop bath: an acid solution used to halt the developing 

process.

straight photography: photographs that have been taken 

directly from the subject (generally not staged) and have 

not been manipulated digitally or in the darkroom. 

surrealism: an early 20th-century art movement. Surrealist 

art depicts images derived from the world of myth, 

dreams and the subconscious.
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t

test strip:  a piece of photographic paper showing a series 

of different exposure times for the same negative. Test 

strips are used to determine the correct exposure time.

tonal range:  the extent of light and dark shade found  

in a photograph.toning:  adding colour to a black and 

white photograph (for example, sepia toning).

transcendent:  inspirational and awe-inspiring, moving  

far beyond the normal.

u

underexposure:  not enough light has reached the 

photographic paper, �lm or digital imaging sensor  

to produce a correctly exposed photograph.

USB (Universal Series Bus):  a portable digital memory 

device for storing and transporting data.
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INDEX

acidity

damaging effects on photographic artworks 136�7

Adams, Ansell 190�4

artwork 191�4

in�uences 191

style and working methods 191

themes and artistic intention 191

analysing photographs 157�62

format 159�62

procedure 157�8

aperture 16�19

alternative combinations with shutter speed for correct 

exposure 23

depth of �eld, controlling 17�19

35 mm SLR cameras 5

what aperture to use 17�19

appropriation 119�20, 177

art movements and genres 

dada 174�5

group f.64 176

high art 172

modernism 176

naturalists 172�3

photo-secessionists 173�4

pictorialists 173

postmodernism 177�8

surrealism 117�18, 174�5

artworks 2 

appropriation 119�20, 177

brainstorming ideas 102�3

design process 105�8

edition numbers 122

exhibitions 133�4 

genres and movements see art movements  

and genres

inspiration and motivation, �nding 103�5

landscapes 112�13, 223�4

mounting and framing 122�7

new media and converging technologies 178�80

personal themes 109�11

photographic theatre 118�19

portraits 111�12, 220�2

preservation and conservation 135�7

restoration 138�9

signature of artist 122

social commentary 114�17

still lifes 113�14

Australian photography

early years 181�2

future 188�9

modernism 184�5

pictorialists 182�3

postmodernism 185�8

black and white photographs

converting colour to 91�2

hand colouring 53�4

negative image 50

screening for textured prints 55

sepia toning 52�3

solarisation 51�2

special effects in 50�7

superimposing images 56�7

bracketing 23�4

burning in 47�8, 87�8

camera obscura 2

cameras 

digital see digital cameras

pinhole 58�60

SLR see SLR (single lens re�ex) cameras 

types of 2�3

careers 242�6

chemicals 253�4

�lm 253�4

paper 254

collodion wet plate 168�9

collotype 168

colour photographs

converting to black and white 91�2

development of 169�70

composition 27, 142�7

cropping 145

rules of 145�7

contact sheets see proof sheets

cropping 82, 145
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dada 174�5

daguerreotype 167�8

darkroom 38�9

safety see darkroom safety

techniques 44�9

darkroom safety 32�3

chemical spills 33

disposal of waste 33

�rst-aid advice 33

protective clothing and equipment 33

setting up the darkroom 32

depth of �eld 

controlling with aperture 17�19

depth of �eld scale 17

35 mm SLR cameras 5

design elements 107, 148�53

colour 151

line 148

pattern 150

shape 149

space 152

texture 150

tone 149

design principles 153�6

balance 155�6

emphasis 154

proportion 154

repetition and rhythm 154�5

unity 153

digital cameras 5

compact cameras 8�10

SLR cameras 6�7

digital imaging software 

common programs 63

Photoshop see Photoshop

purposes 62

types of 62�3

digital photographs 61

CD or DVD, burning onto 77

colour and tone 73�4

combining 96�8

converting colour to black and white 91�2

detail and clarity 74

development of 170�1

downloading 76

editing see editing

examining and selecting 78�80

�le types 75

�lters 95

modes 75

printed output 74�5

proof sheets 77�8

quality of image 72�5

resolution 9, 72, 170

screen output 75

special effects in 91�8

storing 76

toning 92�5

USB, saving onto 76

dodging 47�8, 87�8

dry plate negative 169

Dupain, Max 203�7

artwork 205�7

in�uences 204

style and working methods 204�5

themes and artistic intention 204

editing 80�8 

adjustment layers, on 84

brightness and contrast, adjusting 86�7

burning 87�8

colour, adjusting 85�6

cropping 82

dodging 87�8

retouching 82�3

straightening 81

tones, adjusting 84�5

educational courses 246�9

prerequisites 246

exhibitions 133�4

exposure 20

�lm 252�3

chemicals 253�4

developing into negatives 34�8

�lm speed see ISO

�lters 46�7, 95

focus 11�13

auto 12

examples of student work 227�8

manual 12

galleries 249�54

alternative exhibition spaces to 130

commercial 129�30

public 128�9

staff 130�3

Group f.64 176

hand colouring 53�4, 93�4

high art photographs 172

insects

damaging effects on photographic artworks 137

ISO 

digital cameras 21

35 mm SLR cameras 4, 21
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Kodak camera 169

landscapes 112�13

examples of student work 223�4

LCD panel 

digital SLR cameras 6

Leica camera 169

light 

damaging effects on photographic artworks 135�6

use of, when taking photographs 20�6

light meters 21�3

grey cards 22

hand-held 23

Lux, Loretta 198�203

artwork 200�3

in�uences 199

style and working methods 199, 200

themes and artistic intention 199�200

modernism 176

Australia, in 184�5

Moffatt, Tracey 212�18

artwork 213�18

in�uences 213

style and working methods 213

themes and artistic intention 213

mounting and framing 122�7

creative 125�7

cutting and pasting 126

non-traditional surfaces, on 127

photomontage 125

reversed images combined with normal images 126

several photographs on same mount 127

standard 123�5

window 124�5

naturalists 172�3

negative image 50

negatives

black 38

clear 38

developing �lm into 34�8

faulty 37�8

good quality 38

overdeveloped 37

overexposed 37

printing into photographs 38�43

proof sheets 45�6

underdeveloped 37

underexposed 37

photo-secessionists 173�4

photograms 44

photographic paper 253, 254

chemicals 254

external dangers to 135�7

graded 46�7

photographic theatre 118�19

photographs

analysing 158�61

artworks, as see artworks 

black and white see black and white photographs

colour see colour photographs

digital see digital imaging software; digital photographs

�rst photograph in history 167

printing from negatives 38�43

taking 26�31

Photoshop 

editing the image see editing

history 71

layers 70�1, 84

main window of program 63�4

managing images on screen 80

navigating 80

print dialogue boxes 98�100

selection of all or part of the image 66�9

tools 65�6

transforming the selected image 69�70

zooming 80

pictorialists 173

Australia, in 182�3

pinhole cameras 58�60

creating photographs with 59�60

making 58�9

pollution

damaging effects on photographic artworks 137

portraits 111�12

examples of student work 220�2

postmodernism 177�8

Australia, in 185�8

preservation and conservation 135�7

proof sheets 45�6, 77�8

restoration 138�9

scanners 88�91

�lm scanners 90

re�ection/�at-bed scanners 89

types of 89

scanning objects 90�1

screening for textured prints 55

sepia toning 52�3

selected 53

shutter speed 13�16

alternative combinations with aperture for correct 

exposure 23

digital cameras 14
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shutter speed continued

examples of student work 225�6

movement of subject, controlling 14�16

35 mm SLR cameras 14

what speed to use 14�16

SLR (single lens re�ex) cameras 3

digital cameras 6�7

35 mm cameras 4�5

solarisation 51�2

special effects 

black and white photographs, in 50�7

digital photographs, in 91�8

examples of student work 231�7

spotting 48�9

still lifes 113�14

storage and handling

damaging effects on photographic artworks 137

student work, examples 220�37

studio lighting 25�6

Sugimoto, Hiroshi 194�8

artwork 196�8

in�uences 195

style and working methods 195, 196

themes and artistic intention 195

superimposing images 56�7

surrealism 117�18, 174�5

technical developments 166�71

temperature and humidity

damaging effects on photographic artworks 136

toning 92�5

colour 94

hand colouring 93�4

highlights and shadows,  

different colour for 94�5

partial desaturation 92�3

white balance 24

Zahalka, Anne 208�12

artwork 209�12

in�uences 208

style and working methods 208�9

themes and artistic intention 208
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